iCare Population Management GUI

(BQI)

User Manual

Version 2.0 Patch 2
November 2009

Office of Information Technology (OIT)
Division of Information Resource Management
Albuquerque, New Mexico
Preface

The purpose of this manual is to provide you with the information you need to use the iCare (BQI) population management application. iCare is a Windows-based, client-server graphical user interface (GUI) to the IHS Resource and Patient Management System (RPMS). iCare retrieves key patient information from various components of the RPMS database and brings it together under a single, user-friendly interface. iCare is intended to help providers manage the care of their patients. The ability to create multiple panels of patients with common characteristics (e.g., age, diagnosis, community) allows users to personalize the way they view patient data.

This manual contains reference information about iCare views, examples of its processes, and step-by-step procedures to show you how to perform the activities supported by the application.
Table of Contents

1.0 Introduction...............................................................................................1
  1.1 Background ..........................................................................................1
  1.2 iCare Graphical User Interface .........................................................2
  1.3 Who Should Use iCare? ......................................................................2
  1.4 Current Features of Version 2.0 .........................................................3
  1.5 User Desktop (Client) Requirements ...............................................4

2.0 Orientation ................................................................................................5
  2.1 iCare Windows Overview.................................................................5
    2.1.1 iCare Main Window .................................................................5
    2.1.2 About the iCare Panel View Window .......................................6
    2.1.3 About the iCare Patient Window .............................................7
  2.2 Key iCare Concepts...........................................................................7
    2.2.1 Diagnostic Tags .........................................................................8
    2.2.2 Taxonomies ............................................................................9
    2.2.3 National Performance Measures ............................................10

3.0 Getting Started........................................................................................12
  3.1 Your First Login ...............................................................................12
    3.1.1 User Preferences Wizard .......................................................14
    3.1.2 Completing the User Preferences Wizard ................................20
  3.2 Modifying Your User Preferences ....................................................20
    3.2.1 Modifying My Patients Definition and Associated Panels ........21
    3.2.2 Flag Setup .............................................................................22
    3.2.3 Startup View ..........................................................................23
    3.2.4 Patient View...........................................................................23
    3.2.5 Layouts Tab ..........................................................................23
    3.2.6 Comm Alert Setup Tab ..........................................................24

4.0 Using iCare Features............................................................................26
  4.1 Working with Columns ....................................................................26
    4.1.1 Sorting .....................................................................................26
    4.1.2 Changing Column Width .......................................................26
    4.1.3 Moving Columns ....................................................................27
    4.1.4 Freezing One or More Columns ..............................................27
    4.1.5 Filtering ..................................................................................28
  4.2 Selecting Records .............................................................................32
  4.3 Menus ...............................................................................................32
    4.3.1 Edit Menu ...............................................................................32
    4.3.2 Window Menu .........................................................................33
    4.3.3 Help Menu .............................................................................33
  4.4 Quick Patient Search .........................................................................34
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.4.1 Find Patients in Open Panel</td>
<td>34</td>
</tr>
<tr>
<td>4.4.2 Search Criteria Fields</td>
<td>35</td>
</tr>
<tr>
<td>4.4.3 Find Patients in RPMS Database</td>
<td>37</td>
</tr>
<tr>
<td>4.5 Buttons on Right Side of Window</td>
<td>39</td>
</tr>
<tr>
<td>4.5.1 Reset View</td>
<td>39</td>
</tr>
<tr>
<td>4.5.2 Refresh</td>
<td>39</td>
</tr>
<tr>
<td>4.5.3 Search Button</td>
<td>39</td>
</tr>
<tr>
<td>4.5.4 Export to Excel</td>
<td>41</td>
</tr>
<tr>
<td>4.5.5 Print Button</td>
<td>42</td>
</tr>
<tr>
<td>4.5.6 Copy to Clipboard Button</td>
<td>43</td>
</tr>
<tr>
<td>4.6 Entering Data</td>
<td>43</td>
</tr>
<tr>
<td>4.6.1 Free Text Fields</td>
<td>43</td>
</tr>
<tr>
<td>4.6.2 Drop-Down Lists</td>
<td>44</td>
</tr>
<tr>
<td>4.6.3 Date Fields</td>
<td>44</td>
</tr>
<tr>
<td>4.6.4 Missing Data</td>
<td>45</td>
</tr>
<tr>
<td>4.7 Pop-up Functionality</td>
<td>45</td>
</tr>
<tr>
<td>4.8 Add/Remove Functionality</td>
<td>47</td>
</tr>
<tr>
<td>4.9 Layout Dialog Function</td>
<td>48</td>
</tr>
<tr>
<td>4.9.1 Template Group Box</td>
<td>49</td>
</tr>
<tr>
<td>4.9.2 Display and Available Columns</td>
<td>49</td>
</tr>
<tr>
<td>4.9.3 Columns to Sort</td>
<td>50</td>
</tr>
<tr>
<td>4.10 Mail Merge</td>
<td>51</td>
</tr>
<tr>
<td>4.11 Background Jobs</td>
<td>52</td>
</tr>
<tr>
<td>4.12 Table Lookup</td>
<td>53</td>
</tr>
<tr>
<td>4.12.1 Searching for Record</td>
<td>54</td>
</tr>
<tr>
<td>4.12.2 Clearing Data in Field with Ellipsis Button</td>
<td>56</td>
</tr>
<tr>
<td>4.13 Package Manager Functions</td>
<td>56</td>
</tr>
<tr>
<td>4.13.1 iCare User Access Maintenance</td>
<td>56</td>
</tr>
<tr>
<td>4.13.2 HMS Turn Off Date</td>
<td>57</td>
</tr>
<tr>
<td>4.14 Glossary Functions</td>
<td>58</td>
</tr>
<tr>
<td>4.14.1 Community Alerts Glossary</td>
<td>58</td>
</tr>
<tr>
<td>4.14.2 Diagnostic Tag Glossary</td>
<td>59</td>
</tr>
<tr>
<td>4.14.3 National Measures Glossary</td>
<td>59</td>
</tr>
<tr>
<td>4.14.4 Reminders Glossary</td>
<td>60</td>
</tr>
<tr>
<td>4.14.5 HIV/AIDS / Care Management Glossary</td>
<td>61</td>
</tr>
<tr>
<td>4.14.6 Best Practice Prompts Glossary</td>
<td>61</td>
</tr>
<tr>
<td>4.15 iCare Taxonomy Editor Function</td>
<td>62</td>
</tr>
<tr>
<td>4.15.1 Add Taxonomy Values</td>
<td>63</td>
</tr>
<tr>
<td>4.15.2 Remove Taxonomy Values</td>
<td>64</td>
</tr>
<tr>
<td>4.15.3 Apply Button</td>
<td>64</td>
</tr>
<tr>
<td>4.15.4 View Report of All Taxonomies Button</td>
<td>64</td>
</tr>
<tr>
<td>4.16 Creating a Community Taxonomy</td>
<td>64</td>
</tr>
<tr>
<td>4.17 Edit DPCP Providers</td>
<td>67</td>
</tr>
<tr>
<td>4.17.1 Add/Edit New Provider</td>
<td>67</td>
</tr>
<tr>
<td>4.17.2 Remove Provider Name</td>
<td>68</td>
</tr>
<tr>
<td>Section</td>
<td>Subsections</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>4.17.3</td>
<td>Save &amp; Close Button</td>
</tr>
<tr>
<td>4.17.4</td>
<td>File Menu on Edit Providers</td>
</tr>
<tr>
<td>4.17.5</td>
<td>Tools Menu on Edit Providers</td>
</tr>
<tr>
<td>4.17.6</td>
<td>Help Menu on Edit Providers</td>
</tr>
<tr>
<td>4.18</td>
<td>Graphing Measurement Data</td>
</tr>
<tr>
<td>4.18.1</td>
<td>Chart Data Group Box</td>
</tr>
<tr>
<td>4.18.2</td>
<td>Chart Options Group Box</td>
</tr>
<tr>
<td>4.18.3</td>
<td>File Menu for Charting Window</td>
</tr>
<tr>
<td>4.19</td>
<td>Select/Clear Functionality</td>
</tr>
<tr>
<td>4.19.1</td>
<td>Search and Select Data for a Field</td>
</tr>
<tr>
<td>4.19.2</td>
<td>Clearing Data in Field</td>
</tr>
<tr>
<td>4.20</td>
<td>Default Template for iCare Window Layouts</td>
</tr>
<tr>
<td>4.20.1</td>
<td>Template Group Box</td>
</tr>
<tr>
<td>4.20.2</td>
<td>Display Columns</td>
</tr>
<tr>
<td>4.20.3</td>
<td>Columns to Sort</td>
</tr>
<tr>
<td>5.0</td>
<td>Creating Patient Panels</td>
</tr>
<tr>
<td>5.1</td>
<td>Scenarios and Panel Examples</td>
</tr>
<tr>
<td>5.2</td>
<td>Steps to Create a Panel</td>
</tr>
<tr>
<td>5.3</td>
<td>Population Search Options</td>
</tr>
<tr>
<td>5.3.1</td>
<td>No Predefined Population Search</td>
</tr>
<tr>
<td>5.3.2</td>
<td>My Patients</td>
</tr>
<tr>
<td>5.3.3</td>
<td>Patients Assigned To</td>
</tr>
<tr>
<td>5.3.4</td>
<td>Scheduled Appointments</td>
</tr>
<tr>
<td>5.3.5</td>
<td>QMan Template</td>
</tr>
<tr>
<td>5.3.6</td>
<td>RPMS Register</td>
</tr>
<tr>
<td>5.3.7</td>
<td>EHR Personal List</td>
</tr>
<tr>
<td>5.3.8</td>
<td>Ad Hoc Search</td>
</tr>
<tr>
<td>5.4</td>
<td>Panel Definition Layouts Tab</td>
</tr>
<tr>
<td>5.4.1</td>
<td>Edit Patient List Layout</td>
</tr>
<tr>
<td>5.4.2</td>
<td>Edit Reminders Layout</td>
</tr>
<tr>
<td>5.4.3</td>
<td>Edit Nat’l Measures Layout</td>
</tr>
<tr>
<td>5.4.4</td>
<td>Edit Asthma Layout</td>
</tr>
<tr>
<td>5.4.5</td>
<td>Edit HIV/AIDS Layout</td>
</tr>
<tr>
<td>5.5</td>
<td>Sharing Tab</td>
</tr>
<tr>
<td>5.6</td>
<td>Preview Tab</td>
</tr>
<tr>
<td>5.7</td>
<td>Auto Repopulate Options Tab</td>
</tr>
<tr>
<td>6.0</td>
<td>Panel List</td>
</tr>
<tr>
<td>6.1</td>
<td>Panel List View Layout</td>
</tr>
<tr>
<td>6.2</td>
<td>Panel List Toolbar</td>
</tr>
<tr>
<td>6.2.1</td>
<td>New Panel</td>
</tr>
<tr>
<td>6.2.2</td>
<td>Open Panel</td>
</tr>
<tr>
<td>6.2.3</td>
<td>Delete Selected Panel</td>
</tr>
<tr>
<td>6.2.4</td>
<td>Repopulate Selected Panel</td>
</tr>
<tr>
<td>6.2.5</td>
<td>Modify Selected Panel</td>
</tr>
<tr>
<td>Section</td>
<td>Title</td>
</tr>
<tr>
<td>---------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>9.3.2</td>
<td>Flags Tab Toolbar</td>
</tr>
<tr>
<td>9.3.3</td>
<td>Panel View Flags Tab Menu Options</td>
</tr>
<tr>
<td>9.4</td>
<td>Reminders Tab</td>
</tr>
<tr>
<td>9.4.1</td>
<td>Reminders Tab Layout</td>
</tr>
<tr>
<td>9.4.2</td>
<td>Reminders Tab Toolbar</td>
</tr>
<tr>
<td>9.4.3</td>
<td>Reminders Tab Menu Options</td>
</tr>
<tr>
<td>9.5</td>
<td>Reminders Aggregated Tab</td>
</tr>
<tr>
<td>9.5.1</td>
<td>Reminders Aggregated Tab Layout</td>
</tr>
<tr>
<td>9.5.2</td>
<td>Reminders Aggregated Tab Toolbar</td>
</tr>
<tr>
<td>9.5.3</td>
<td>Reminders Aggregated Tab Menu Options</td>
</tr>
<tr>
<td>9.6</td>
<td>National Measures Tab</td>
</tr>
<tr>
<td>9.6.1</td>
<td>What is National Performance (GPRA)?</td>
</tr>
<tr>
<td>9.6.2</td>
<td>National Measures Tab Layout</td>
</tr>
<tr>
<td>9.6.3</td>
<td>National Measures Tab Toolbar</td>
</tr>
<tr>
<td>9.6.4</td>
<td>Nat'l Measures Tab Menu Options</td>
</tr>
<tr>
<td>9.7</td>
<td>Natl Aggregated Tab</td>
</tr>
<tr>
<td>9.7.1</td>
<td>Nat'l Aggregated Tab Layout</td>
</tr>
<tr>
<td>9.7.2</td>
<td>Nat'l Aggregated Tab Toolbar</td>
</tr>
<tr>
<td>9.7.3</td>
<td>Nat'l Aggregated Tab Menu Options</td>
</tr>
<tr>
<td>9.8</td>
<td>Diagnostic Tags Tab</td>
</tr>
<tr>
<td>9.8.1</td>
<td>Diagnostic Tags Tab Layout</td>
</tr>
<tr>
<td>9.8.2</td>
<td>Diagnostic Tags Toolbar</td>
</tr>
<tr>
<td>9.8.3</td>
<td>Diagnostic Tags Tab Menu Options</td>
</tr>
<tr>
<td>9.9</td>
<td>Care Mgmt Tab</td>
</tr>
<tr>
<td>9.9.1</td>
<td>Main Tab for HIV/AIDS Register</td>
</tr>
<tr>
<td>9.9.2</td>
<td>Reminders Tab for HIV/AIDS Register</td>
</tr>
<tr>
<td>9.9.3</td>
<td>Main Tab for Asthma</td>
</tr>
<tr>
<td>9.9.4</td>
<td>Care Management Tab Menus</td>
</tr>
<tr>
<td>10.0</td>
<td>Patient Record</td>
</tr>
<tr>
<td>10.1</td>
<td>Patient Demographic Group Box</td>
</tr>
<tr>
<td>10.1.1</td>
<td>Community Alerts for Community</td>
</tr>
<tr>
<td>10.1.2</td>
<td>Allergies Field</td>
</tr>
<tr>
<td>10.1.3</td>
<td>Barriers to Learning Field</td>
</tr>
<tr>
<td>10.1.4</td>
<td>Edit Patient Demographic Data</td>
</tr>
<tr>
<td>10.1.5</td>
<td>Edit Providers</td>
</tr>
<tr>
<td>10.1.6</td>
<td>Additional Demographics Button</td>
</tr>
<tr>
<td>10.2</td>
<td>Specifying the Default Tab</td>
</tr>
<tr>
<td>10.3</td>
<td>Cover Sheet Tab</td>
</tr>
<tr>
<td>10.3.1</td>
<td>Recent Visits Group Box</td>
</tr>
<tr>
<td>10.3.2</td>
<td>Scheduled Appointments Group Box</td>
</tr>
<tr>
<td>10.3.3</td>
<td>Providers Group Box</td>
</tr>
<tr>
<td>10.3.4</td>
<td>Insurance Group Box</td>
</tr>
<tr>
<td>10.3.5</td>
<td>Panels Group Box</td>
</tr>
<tr>
<td>10.3.6</td>
<td>Registers Group Box</td>
</tr>
<tr>
<td>10.3.7</td>
<td>Cover Sheet Tab Menus</td>
</tr>
<tr>
<td>Section</td>
<td>Title</td>
</tr>
<tr>
<td>---------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>10.4</td>
<td>Snapshot Tab</td>
</tr>
<tr>
<td>10.4.1</td>
<td>Active Diagnostic Tags Group Box</td>
</tr>
<tr>
<td>10.4.2</td>
<td>Family History Group Box</td>
</tr>
<tr>
<td>10.4.3</td>
<td>Reproductive Factors</td>
</tr>
<tr>
<td>10.4.4</td>
<td>Measurements (Last Visit) Group Box</td>
</tr>
<tr>
<td>10.4.5</td>
<td>Last Routine Events Group Box</td>
</tr>
<tr>
<td>10.4.6</td>
<td>Snapshot Tab Menus</td>
</tr>
<tr>
<td>10.5</td>
<td>Flags Tab</td>
</tr>
<tr>
<td>10.5.1</td>
<td>Flags Tab Layout</td>
</tr>
<tr>
<td>10.5.2</td>
<td>Flags Tab Toolbar</td>
</tr>
<tr>
<td>10.5.3</td>
<td>Flags Tab Menus</td>
</tr>
<tr>
<td>10.6</td>
<td>Reminders Tab</td>
</tr>
<tr>
<td>10.6.1</td>
<td>Reminders Tab Layout</td>
</tr>
<tr>
<td>10.6.2</td>
<td>Reminders Tab Toolbar</td>
</tr>
<tr>
<td>10.6.3</td>
<td>Reminders Tab Menus</td>
</tr>
<tr>
<td>10.7</td>
<td>BP Prompts Tab</td>
</tr>
<tr>
<td>10.7.1</td>
<td>BP Prompts Layout</td>
</tr>
<tr>
<td>10.7.2</td>
<td>BP Prompts Toolbar</td>
</tr>
<tr>
<td>10.7.3</td>
<td>BP Prompts Tab Menus</td>
</tr>
<tr>
<td>10.8</td>
<td>Natl Measures Tab</td>
</tr>
<tr>
<td>10.8.1</td>
<td>Natl Measures Tab Layout</td>
</tr>
<tr>
<td>10.8.2</td>
<td>Natl Measures Tab Toolbar</td>
</tr>
<tr>
<td>10.8.3</td>
<td>Natl Measures Tab Menus</td>
</tr>
<tr>
<td>10.9</td>
<td>Summ/Supp Tab</td>
</tr>
<tr>
<td>10.9.1</td>
<td>Summ/Supp Tab Toolbar</td>
</tr>
<tr>
<td>10.9.2</td>
<td>Summ/Supp Tab Menus</td>
</tr>
<tr>
<td>10.10</td>
<td>PCC Tab</td>
</tr>
<tr>
<td>10.10.1</td>
<td>PCC Tab Layout</td>
</tr>
<tr>
<td>10.10.2</td>
<td>PCC Tab Toolbar</td>
</tr>
<tr>
<td>10.10.3</td>
<td>PCC Tab Menus</td>
</tr>
<tr>
<td>10.11</td>
<td>Problem List Tab</td>
</tr>
<tr>
<td>10.11.1</td>
<td>Problem List Tab Layout</td>
</tr>
<tr>
<td>10.11.2</td>
<td>Problem List Tab Toolbar</td>
</tr>
<tr>
<td>10.11.3</td>
<td>Problem List Tab Menus</td>
</tr>
<tr>
<td>10.12</td>
<td>Care Mgmt Tab</td>
</tr>
<tr>
<td>10.12.1</td>
<td>Patient With No HIV/AIDS Tags</td>
</tr>
<tr>
<td>10.12.2</td>
<td>Patient With HIV/AIDS Tag</td>
</tr>
<tr>
<td>10.12.3</td>
<td>Main Tab</td>
</tr>
<tr>
<td>10.12.4</td>
<td>Reminders Tab</td>
</tr>
<tr>
<td>10.12.5</td>
<td>Patient with Asthma Tag</td>
</tr>
<tr>
<td>10.12.6</td>
<td>Care Management Tab Menus</td>
</tr>
<tr>
<td>10.13</td>
<td>Referrals Tab</td>
</tr>
<tr>
<td>10.13.1</td>
<td>Referrals Tab Layout</td>
</tr>
<tr>
<td>10.13.2</td>
<td>Referrals Tab Toolbar Options</td>
</tr>
<tr>
<td>10.13.3</td>
<td>Referrals Tab Menus</td>
</tr>
</tbody>
</table>
# Table of Content

## 10.14 DX Tags Tab
- 10.14.1 DX Tag Layout .......................................................................................................................... 247
- 10.14.2 Diagnostic Tags Toolbar .............................................................................................................. 248
- 10.14.3 DX Tags Tab Menus .................................................................................................................... 249

## 10.15 Family HX
- 10.15.1 Family History Layout ................................................................................................................ 250
- 10.15.2 Family History Toolbar ............................................................................................................... 251
- 10.15.3 Family History Menus .................................................................................................................. 253

## 10.16 Notes
- 10.16.1 Notes Layout ............................................................................................................................... 254
- 10.16.2 Notes Menus .................................................................................................................................. 255

## 11.0 Notifications
- 11.1 iCare Notifications Window .......................................................................................................... 256
- 11.2 Notifications Toolbar Buttons ...................................................................................................... 257

## 11.2.1 Select All Notifications ........................................................................................................... 257
- 11.2.2 Delete Notifications ..................................................................................................................... 257

## 12.0 HIV/AIDS Management in Care
- 12.1 Introduction .......................................................................................................................................... 258
- 12.2 Key Functional Features .................................................................................................................. 259
- 12.3 Using the HIV/AIDS Glossary ........................................................................................................ 259
- 12.4 Taxonomy Management .................................................................................................................... 260
- 12.4.1 What is a Taxonomy ...................................................................................................................... 260
- 12.4.2 Taxonomy Nomenclature ............................................................................................................... 261
- 12.4.3 Software-Defined (Hard-coded) Taxonomies ............................................................................. 262
- 12.4.4 Site Populated Taxonomies .......................................................................................................... 262
- 12.4.5 View a Taxonomy .......................................................................................................................... 271
- 12.4.6 Identify Empty Taxonomies ......................................................................................................... 273
- 12.4.7 Add a Member to a Site-Populated Taxonomy ............................................................................ 273
- 12.4.8 Remove a Member from a Site-Populated Taxonomy ................................................................ 274

## 12.5 HIV/AIDS Community Alert

## 12.6 Patient Management
- 12.6 Data Specifically Related to HIV/AIDS ............................................................................................ 276
- 12.6.2 Search for and View a Patient Record .......................................................................................... 279
- 12.6.3 Displaying Care Management as Default Tab ............................................................................. 279
- 12.6.4 Add/Edit Care Management Data .................................................................................................. 279

## 12.6.5 HIV/AIDS Diagnostic Tags .......................................................................................................... 280
- 12.6.6 HIV/AIDS Patient Care Supplement ............................................................................................ 283
- 12.6.7 HIV/AIDS-Related Reminders .................................................................................................... 285

## 12.7 Panel Management .......................................................................................................................... 287

## 12.8 Reports
- 12.8 HIV/AIDS Patient Care Supplement ........................................................................................................ 289
- 12.8.2 State Surveillance Report (SSR) .................................................................................................... 289
- 12.8.3 Quality of Care (QOC) Report ....................................................................................................... 290

## 13.0 Appendix A: iCare Predefined Diagnosis Definitions
- 13.0 Appendix A: iCare Predefined Diagnosis Definitions ........................................................................ 293
14.0 Appendix B: Performance Measure Logic Example ....................... 299

15.0 Appendix C: Definitions and Taxonomies Content ......................... 301

15.1 Opportunistic Infections ............................................................ 301

15.2 AIDS Defining Illnesses ............................................................ 301

15.3 HIV/AIDS Definitions, Codes, Taxonomies, Attributes ................ 303

16.0 Appendix D: HIV/AIDS-Related Reminders - Logic and Tooltip Text 316

17.0 Appendix E: CDC Clinical Classification ...................................... 332

18.0 Appendix F: Medications ............................................................ 335

18.1 ARV/HAART Definitions ............................................................ 335

18.2 Medication Categorization for Taxonomy Setup ........................... 335

19.0 Appendix G: Quality of Care Report Logic ................................... 338

19.1 Sample Format, Quality of Care Audit ......................................... 344

20.0 Appendix H: HMS Patient Care Supplement ............................... 349

20.1 Supplement Logic ................................................................. 349

20.2 Flow Sheet Logic ................................................................. 356

20.3 Example ................................................................................. 357

21.0 Appendix I: Keyboard Navigation ............................................... 360

21.1 General Instructions ................................................................. 360

21.2 iCare Main Window ................................................................. 360

21.2.1 Split Window ................................................................. 360

21.2.2 Panel View ................................................................. 360

21.2.3 Flag View ................................................................. 361

21.2.4 Patient Record View ....................................................... 361

21.2.5 Panel Definition Dialog Box ............................................. 361

21.3 Short-Cut Keys ................................................................. 362

21.3.1 Main View ................................................................. 362

21.3.2 Panel View ................................................................. 362

21.3.3 Patient Record ............................................................. 363

22.0 Appendix J: RPMS Rules of Behavior ......................................... 364

22.1 All RPMS Users ................................................................. 365

22.1.1 Access ................................................................. 365

22.1.2 Information Accessibility ................................................ 366

22.1.3 Accountability ............................................................. 366

22.1.4 Confidentiality ............................................................. 366

22.1.5 Integrity ................................................................. 367

22.1.6 System Logon ............................................................. 367

22.1.7 Passwords ............................................................... 368

22.1.8 Backups ................................................................. 369

22.1.9 Reporting ................................................................. 369

22.1.10 Session Timeouts ......................................................... 369
22.1.11 Hardware .................................................................369
22.1.12 Awareness ..............................................................370
22.1.13 Remote Access .........................................................370
22.2 RPMS Developers ..........................................................371
22.3 Privileged Users .............................................................372

23.0 Glossary ........................................................................374

24.0 Contact Information .......................................................377
1.0 Introduction

iCare is a Windows-based, client-server graphical user interface (GUI) to the IHS Resource and Patient Management System (RPMS). iCare retrieves key patient information from various components of the RPMS database and brings it together under a single, user-friendly interface. iCare is intended to help providers manage the care of their patients. The ability to create multiple panels of patients with common characteristics (e.g., age, diagnosis, community) allows users to personalize the way they view patient data.

The chapters included in the manual cover the main components of this system:

- **Panel List**: Content and Navigation (see Section 2.1.1 iCare Main Window and Section 6.0 Panel List)
- **Patient Panel (List)**: Content and Navigation (see Section 2.1.2 About the Panel View Window and Section 9.0 Panel View)
- **Community Alerts**: Content and Navigation (see Section 2.1.1.3 About Community Alerts and Section 8.0 Community Alerts)
- **Creating a New Panel**: Step-by-Step Instructions (see Section 5.0 Creating Patient Panels)
- **Patient Record**: Content (see Section 2.1.3 About the Patient Window and 10.0 Patient Record)
- **National Performance Measures (GPRA)**: Viewing and Changes Display (see Section 9.8 National Measures Tab and Section 10.8 National Measures Tab).

1.1 Background

Along with the rest of the healthcare industry, IHS has already developed a set of chronic condition management (or register) applications, including Diabetes, Asthma, and HIV. This type of application provides a way for healthcare providers to manage a specific group (register) of patients for a single disease state. Register management applications assist healthcare providers to identify high-risk patients, proactively track care reminders and health status of individuals or populations, provide more standardized and appropriate care by embedding evidence-based guidelines, and report outcomes.
Many patients, however, have more than one diagnosed disease. For instance, at the current time within the Indian Health system, a diabetic, asthmatic woman could be a member of four RPMS registers (diabetes, asthma, women’s health, and immunizations). This silo approach to patient care could potentially result in fragmented care, and could increase the risk of inadequate patient care management due to misidentification of the true level of risk.

1.2 iCare Graphical User Interface

The iCare GUI is intended to allow providers to see a more complete view of patients with multiple conditions, while maintaining the integrity of the user-defined disease-specific registers.

iCare can help IHS providers by

• Proactively identifying and managing different groups (populations) of patients who share user-defined characteristics.
• Providing an integrated view of a patient’s conditions that would minimize stove-piped care management.
• Providing an intuitive and integrated interface to the diverse patient data elements of the RPMS database.
• Facilitating providers a review of clinical quality of care measures for their own patients to enable improvement in the quality of healthcare delivery.
• Enabling views of traditional healthcare information from the perspectives of community, population, and public health.

1.3 Who Should Use iCare?

Any provider who needs to identify a group of patients for long-term management or to create a temporary list should think about using iCare. Do you fit any of the following scenarios?

• I am a nurse at a facility that assigns a primary care provider to each patient. Every day, I want to create a list of scheduled patients for two different doctors in my clinic.
• I want to identify which of my patients are considered obese so I can recommend nutrition counseling.
• Because providers at our clinic have performance goals related to annual GPRA clinical measures, I want to identify which of my patients are missing key clinical data.
• Our Women’s Health clinic wants to focus on two clinical performance improvement initiatives this year. We want to identify the performance problem areas for female patients between ages 18 and 50.

• I am one of two part-time case managers for a group of children, and I want to create a patient list that we both can use.

1.4 Current Features of Version 2.0

The following describes the current features of Version 2.0.

**Enhanced Panel Definition Capabilities.** Patients for a panel can be selected on the basis of ad hoc search using a clinic code; by scheduled appointment timeframes such as “next week,” by appointment status; based on Classification/Beneficiary category; and by timeframes for past visits.

**Community Alerts.** The application displays community alerts in three different iCare locations: (1) splash screen immediately after login, (2) **Community Alerts** view (similar to **Flags** view), and (3) **Patient Snapshot**. Community alerts provide users with de-identified visit data related to specific high-profile diagnoses that occurred within the past 30 days that can affect other patients in the community.

**Diagnostic Tags.** The application provides a comprehensive view of all tag history for a patient, provide auto-accept and auto-reject capabilities, allow user acceptance of proposed tags for multiple patients, allow user rejection for proposed tags, and allow user update of tag status.

**Taxonomy Display/Editing and Care Management Reports.** iCare displays the list of taxonomies used directly by iCare and other underlying care management systems. iCare allows authorized users to edit site-populated taxonomies, and to generate patient-specific and population reports associated with the HIV Care Management application.

**Patient Record Display.** The **Cover Sheet** tab and the demographics area have been redesigned to provide additional information, allow editing of some information, and to allow users to select the default tab when opening patient records.

**View/Update Care Management Data.** iCare provides a view of the HIV Care Management data for authorized users, including the ability for the user with Editor/Case File Manager access to update and/or enter new case-management specific Care Management data. Authorized users will also be able to view supplements.

**Patient Snapshot View.** The new **Snapshot** view of the patient record displays Community Alerts, Diagnostic Tags, Family History, Last Measurements, Last Events, and Treatment options.
### 1.5 User Desktop (Client) Requirements

iCare software resides on both your facility’s RPMS server and on the desktop computer that you use. In order to use iCare successfully, your computer should have the following minimum configuration.

<table>
<thead>
<tr>
<th>Client PC</th>
<th>Minimum Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft .NET Framework</td>
<td>V2.0</td>
</tr>
</tbody>
</table>
| Suggested Client PC Hardware                   | **Processor:** Minimum: Pentium III 800MHz; Suggested: Pentium 4 2GHz+  
**Memory (RAM):** Minimum: 256MB; Suggested: 512MB+ |
| Approximate Disk Space Requirements            | iCare Application Footprint 10MB  
.NET 2.0 Framework 100MB (if not already installed via Windows Updates) |
2.0 Orientation

This Section provides an overall look at the design and functions of the main screen elements of the iCare interface.

The core concept of iCare version 2.0 is the Patient panel. The Patient panel is a list of patients that the user defined, either manually by selecting individual patients or by using automated search definitions (see Section 5.0 Creating Patient Panels).

Section 21.0, Appendix I, Keyboard Navigation provides keyboard navigation on the views. This includes keyboard shortcuts to access the menus.

2.1 iCare Windows Overview

This Section reviews the three main windows within iCare.

2.1.1 iCare Main Window

The iCare Main window contains two lists, which can be displayed on separate tabs or viewed on a split screen (see Section 3.1.1.3 Startup View) as well as a third list, known as Community Alerts.

2.1.1.1 About the Panel List

The Panel List is displayed in columnar format. It contains a list of all the panels that have been defined by you or that have been shared with you by another user. See Section 6.0 Panel List for explanations of column data and the available toolbar icons.

Figure 2-1: Panel List
2.1.1.2 About the Flag List

The Flag List is displayed in columnar format. It displays flags for any patient on any of the panels in the Panel List, including shared panels. See Section 7.0 Flag List for more information.

![Figure 2-2: Panel List and Flag List in Split View](image)

2.1.1.3 About Community Alerts

The Community Alerts view is displayed in columnar format. It contains alerts associated with the patient’s Community of Residence (COR).

![Figure 2-3: Sample Community Alerts View](image)

See Section 8.2 Community Alerts Tab for more information about the buttons and other functionality of this view.

2.1.2 About the iCare Panel View Window

The Panel View displays a list of the patients in a particular panel. See Section 9.0 Panel View for explanations of column data and the available toolbar buttons.
2.1.3 About the iCare Patient Window

The Patient window displays information about the selected patient from data stored in the RPMS database. See Section 10.0 Patient Record for detailed information.

2.2 Key iCare Concepts

This Section discusses diagnostic tags, taxonomies, and national performance measures.
2.2.1 Diagnostic Tags

iCare provides a diagnostic tagging function that runs as a background process on your RPMS server and reviews all patient data. Tagging is a term that refers to running a series of logic algorithms on one or multiple patients that identifies (tags) them with one or more predefined diagnostic categories, listed below. The detailed logic for each of these diagnostic tags can be found in Section 13.0, Appendix A, iCare Predefined Diagnosis Definitions. These definitions are defined nationally and are consistent with definitions used in the Clinical Reporting System (CRS) and RPMS disease-specific registers, such as Diabetes Management System.

- Asthma
- COPD
- Cardiovascular Disease (CVD) Known (CVD Kn)
- CVC At Highest Risk (CVD AHR)
- CVC At Significant Risk (CVD ASR)
- CVD At Risk (CVD AR)
- Diabetes (DM)
- HIV/AIDS (HIV)
- Hypertension (HTN)
- Obese
- Prediabetes/Metabolic Syndrome w/o DM (PreDM)
- Current Smokers (Smoker)

One patient might have multiple diagnostic categories, e.g., diabetes, asthma, and known cardiovascular disease (CVD). The overall purpose of the diagnostic “tag” is two-fold: (1) to enable iCare to quickly create a panel for a user based on the same categories and (2) to enable application of fully integrated healthcare reminders that reflect the prevention and treatment priorities for the full spectrum of a patient’s disease conditions.

**Note:** Integrated reminders will not be available until a future phase of iCare.

In future versions of iCare, the “tag” will become a more formal concept. Appropriate users (providers) will be required to “accept” or “not accept” the iCare proposed tags; the accepted tags will be used to provide fully integrated reminders and provide access to existing case (register) management functions. It is anticipated that “accepted” diagnostic tags will eventually be incorporated into the Health Summary and other RPMS logic functions.
2.2.2 Taxonomies

RPMS clinical applications, including the Diabetes Management System, the Clinical Reporting System, the PCC Health Maintenance Reminders, and iCare contain logic (artificial intelligence) statements that compare and calculate various types of patient data to arrive at a conclusion.

For example, in order for a Pap Smear Reminder to appear on the Health Summary, RPMS has to calculate the following about the patient:

- Is the patient a woman
- If yes, does she fall into a certain age range
- If yes, was a pap smear ever performed
- If yes, what is the date of the most recent papa smear
- If the most recent test is over a year ago, a reminder needs to appear

To produce results with comparable data across every facility, the clinical definition of a “pap smear” has been defined nationally. Clinical definitions use RPMS taxonomies to contain the various elements of a definition. As much clinical logic as possible is based on standard national codes, including ICD, CPT, LOINC, NDC, and national IHS standard code sets (e.g., Health Factors, patient education codes, etc.). For terminology that is not standardized across each facility, such as lab tests or medications, RPMS uses taxonomies that can be populated by each individual facility with its own codes.

For data elements like diagnoses, procedures, or lab tests identified by LOINC codes, the taxonomy simply identifies the standard codes that a software program should look for. These codes are hard-coded by the programmer into several software-defined taxonomies that are distributed with the RPMS software that uses those taxonomies. These taxonomies can only be updated by the software programmer at the direction of a national clinical logic review process.

Site-populated taxonomies are used to mitigate the variations in terminology for other types of data elements that vary from one facility to another, including medications and lab tests. This means, for example, that one site’s pap smear data can be compared to another site, even though the same term is not used for the pap smear lab test. Or, one site’s beta-blocker data can be compared to another site, even though the same names are not used for beta-blocker drugs.
For example, one site’s Lab table might contain the term *Glucose Test* while another site’s table might contain the term *Glucose* for the same test. PCC programs have no means for dealing with variations in spelling, spacing, and punctuation. Rather than attempting to find all potential spellings of a particular lab test, the application would look for a pre-defined taxonomy name that is installed at every facility. The contents of the taxonomy are determined by the facility. In this example, the application would use the “DM AUDIT GLUCOSE TESTS TAXONOMY.” The individual facility will enter all varieties of spelling and punctuation for Glucose Tests used at that particular facility.

### 2.2.3 National Performance Measures

Performance assessment measures what an organization does and how well it does it. For a healthcare organization, such as the Indian Health Service, this means measuring how well we deliver healthcare services to our population, measured by documentable improvement in various standard health measures. Standardized clinical performance measures provide a systematic approach to health improvement for our organization. Results from performance assessment are used internally within the IHS, at national and local levels, to support and guide performance improvement in those clinical areas that need it.

Additionally, the Government Performance and Results Act (GPRA) requires federal agencies to report annually to Congress on how the agency measured up against the performance targets set in its annual Plan. IHS GPRA measures include measures for clinical prevention and treatment, quality of care, infrastructure, and administrative efficiency functions. The RPMS Clinical Reporting System (CRS) is the reporting tool used by the IHS Office of Planning and Evaluation to collect and report clinical performance results annually to the Department of Health and Human Services (DHHS) and to Congress.

#### 2.2.3.1 Clinical Reporting System (CRS)

The Clinical Reporting System (CRS) is an RPMS software application designed for national reporting as well as for local and Area monitoring of clinical GPRA and developmental measures. CRS was first released for FY 2002 performance measures (as GPRA+) and is based on a design by the Aberdeen Area (GPRA2000).

Each year, an updated version of CRS software is released to reflect changes in the logic descriptions of the different denominators and numerators. Additional performance measures might also be added. Local facilities can run reports as often as they want to and can also use CRS to transmit data to their Area. The Area Office can use CRS to produce an aggregated Area report for either annual GPRA or Area Director Performance reports.
2.2.3.2 **Performance Measures Displayed in iCare**

iCare uses exactly the same logic as the Clinical Reporting System to display results for national performance measures. Results can be seen for a panel of patients or for an individual patient. See Section 9.6 Nat’l Measures Tab for more detailed explanations of the available panel view and see Section 10.7 BP Prompts Tab.

2.2.3.3 **Reminders Displayed in iCare**

The **Reminders** view is similar to the **National Measures** view. The values in the individual reminders columns will be the due date of the test/procedure. Active reminders are reminders that are *turned on* at the site. See Section 9.4 Reminders for more information.

The **Patient** panel has a separate **Reminders Aggregate** view that displays aggregate reminders performance data for the panel population for all national health maintenance reminders that are active at the site. See Section 9.5 Reminders Aggregated for more information.
3.0 Getting Started

This Section describes the process for your first access to the iCare system and how to change your user preferences.

3.1 Your First Login

Before you begin your first login, make sure the iCare software has been loaded on your computer desktop and that the iCare shortcut is available. If the shortcut is not there, see your Site Manager.

You will need the following information from your Site Manager: the IP address and the port number of your facility’s RPMS server.

You will need to complete three activities at your first login:

- the RPMS server address information
- the RPMS login information
- the user preferences wizard

Follow these steps to complete your first login:

1. Double-click the iCare shortcut on your Windows desktop to display the **RPMS Server Address** dialog. This dialog generally only displays when you first login; iCare will remember your server information.

![Sample RPMS Server Address Dialog](image)

Figure 3-1: Sample RPMS Server Address Dialog
• **RPMS Server Address.** Type the number, including punctuation, of the server’s IP address. An IP address is typically four groups of two or three numbers, separated by a period (.), e.g., 161.223.99.999. Your Site Manager will provide this information.

• **Server Port.** Type the number of the server port. Your Site Manager will provide this information.

• **Server Namespace.** If your site has multiple databases on one server, you will additionally need to type the namespace, which is typically a text string, e.g., DEVEH.

2. Click **OK**.

• If the server address or port is incorrect, an error message will display. Click **Retry** and enter the correct information. (Otherwise, click **Cancel** to leave the login process.)

![Figure 3-2: Error Message for Incorrect Server Address](image)

3. The **RPMS Login** dialog will display.

![Figure 3-3: RPMS Login Information](image)

• Type your RPMS access and verify codes. These are the same access and verify codes that you would use to open any RPMS session.

4. Click **OK** to continue. (Otherwise, click **Cancel** to dismiss the **RPMS Login** dialog.)
• If you typed your access and verify codes incorrectly, the application will display the “Unable to connect to RPMS. Not a valid ACCESS CODE/VERIFY CODE pair” error message. Click Retry to reenter your access and verify codes. (Otherwise, click Cancel to leave the login process.)

3.1.1 User Preferences Wizard

The first time you log in to iCare, the application will guide you through a Wizard for specifying your initial user preferences. Once you have finished with this brief IHS iCare Preferences Setup Wizard and clicked OK, the application will display its initial view.

Any user preference that you set now can be modified at any time by selecting User Preferences in the Tools menu to display the User Preferences window. See Section 3.2 Modifying Your User Preferences for more information.

Figure 3-4: Introduction Tab on Wizard

Follow these steps to complete the wizard:

1. The Introduction tab provides basic information about your user preferences. Click Next.

2. On the Define My Patients tab you select one or more provider types to identify who “belongs” to your panel. See Section 3.1.1.1 Define My Patients Tab about using this tab.
   • Click Next to continue.

   Note: You can click the Back button at any time to return to the previous window. Likewise, you can click the Next button to move to the next tab in the wizard.

3. On the Flag Setup tab, you select the flag types you want displayed and their associated time frames. See Section 3.1.1.2 Flag Setup Tab for more information.
• Click **Next** to continue.

4. On the **Startup View** tab, you select the type of screen you want to appear when you login to iCare. See Section 3.1.1.3 Startup View for descriptions of each of the screen option.

5. Click Finish.

• If you selected a provider type definition in the **Define My Patients** tab, iCare will automatically create a default patient panel (list) titled “My Patients” and will display the main **Panel List** view with the **My Patients** panel listed. Otherwise, an empty **Panel List** view will be displayed.

![Sample Panel List with Default My Patients Panel](image)

**Figure 3-5: Sample Panel List with Default My Patients Panel**

### 3.1.1.1 Define My Patients Tab

**My Patients** is a way to easily identify a group of patients assigned to you as a provider. Selecting a My Patients definition when you first log in will cause iCare to create a default **My Patients** panel.

You can select your own name (the default) or set up a definition for another provider (surrogate) by selecting the other name.

![Define My Patient Tab on Wizard](image)

**Figure 3-6: Define My Patient Tab on Wizard**

For example, if your site empanels patients (assigns each patient to a specific primary care provider), you would use the DPCP (Designated Primary Care Provider) provider type to create a core list of patients assigned to you.
If your site does not use the DPCP designation, you might consider “your” patients to be anyone you saw at least twice in the past year as a primary provider.

1. Check the “No Provider Selected” checkbox if you do NOT want to define patients by selecting any provider. If this is the option you use, then the default “My Patients” panel will NOT be created.

   The remaining fields will then be grayed out, i.e., not available. This means iCare will NOT create the default My Patient panel. You can later change the User Preferences to a provider and create panels based on My Patients definition.

   OR

2. Select a provider name from the Provider drop-down list. The default name displayed will be the user’s name. All RPMS providers are available on the drop-down list.

3. Click the appropriate checkboxes to select one or more Provider Types from the list. See the Provider Definitions below for more information about the provider types. This applies to the name selected in the Provider field.

4. If you checked either Primary Visit Provider or Primary/Secondary Visit Provider, select both a minimum number of visits and a timeframe.

Below are descriptions of the Provider Types:

**DPCP (Designated Primary Care Provider).** Sites can assign a primary care provider to an individual patient through the Patient file or by using the RPMS Designated Specialty Provider Management (DSPM) application. Selecting the DPCP option will provide a list of patients assigned to you, regardless of when their last visits were.

**Specialty Provider.** Users are assigned as Specialty Providers to patients as defined in the Designated Specialty Provider Management (BDP) application. Selecting the Specialty Provider option activates the Specialty Type field. Click Edit to access the Add/Remove Specialty Provider Types dialog. See Section 4.8 Add/Remove Functionality for more information about using this dialog.
Primary Visit Provider. The provider name documented as the primary provider for a specific patient visit. Selecting this Provider Type also requires you to indicate the number of visits and a timeframe. For example, you might consider your patients to be anyone you have seen as a primary provider at least three times in the past two years; you would select 3 visits and 2 years. The default value is twice in the past year.

Primary/Secondary Visit Provider. The provider name documented as either the primary or secondary provider for a specific patient visit. Selecting this Provider Type also requires you to indicate the number of visits and a timeframe. For example, you might consider your patients to be anyone you have seen at least three times in the past two years; you would select 3 visits and 2 years. The default value is twice in the past year.

Below are descriptions of Minimum Visits and Timeframes:

Minimum Visits. You can select the minimum number of visits used in combination with a time frame to define whether a patient “belongs” to a provider, e.g., two (2) visits in the past year. Values are 1 through 9; the default value is 2. The Minimum Visits option is used with Provider Types “Primary Visit” and “Primary/Secondary Visit” only.

Minimum Visit Timeframe. You can select a timeframe to be used in combination with the minimum number of visits to define whether a patient belongs to a provider, e.g., 2 visits in the past year. The Minimum Visit Timeframe option is used with Provider Types “Primary Visit Provider” and “Primary/Secondary Visit Provider” only. Values are: Last 3 months; Last 6 months; Last year; Last 2 years.
3.1.1.2 Flag Setup Tab

Flags are critical, usually time-sensitive, information points related to a patient that might affect diagnosis or care. The default is to display all flag types for the past 30 days.

Currently, four flag types are available in iCare:

- Abnormal Labs
- ER Visits
- Unanticipated ER Returns
- Hospital Admissions

The user defines which flags, if any, are displayed by selecting or de-selecting from the available flag types. The timeframe for the display is calculated from the visit date of the flag event.

Changing flag types on the User Preference window will change the flag display for all panels. If all flags are de-selected, none is the implied value.

![Flag Setup Tab on Wizard](image)

Figure 3-8: Flag Setup Tab on Wizard

**Abnormal Labs.** This flag type informs the user when a patient has abnormal lab values within a user-defined time frame based on the RPMS Lab application and Kernel Alerts component. If your site is not running either of these applications, you will not see any alerts.

**ER Visits.** This flag type informs the user when a patient has an emergency room visit within a user-defined time frame. ER visits are defined only as clinic code 30 Emergency Medicine for any visit and does NOT include clinic code 80 Urgent Care.
**Unanticipated ER Returns.** This flag type informs the user when a patient has an emergency room visit designated as *unanticipated* by the RPMS Emergency Room System software within a user-defined time frame.

**Hospital Admissions.** This flag type informs the user when a patient has a hospital visit within a user-defined time frame.

**Timeframe.** For each Flag Type, you can select the number of days after the initial flag event that the flag should be displayed, e.g., Abnormal Lab flags should display for 30 days. Values are 1 week, 2 weeks, 1 month (30 days), 2 months (60 days), and 6 months.

![Figure 3-9: Sample of Flag List](image)

**3.1.1.3 Startup View**

The **Startup View** determines what window will be displayed when you login to iCare. The default selection is **Split View** which displays both the **Panel List** and the **Flag List**.

![Figure 3-10: Startup View Tab on Wizard](image)

**Split View** is a combination of the **Flag List** and **Panel List View**, side-by-side. This is the default view.
**Flag List** shows a list of patients who are members of your panel(s) and who have one or more of your defined flags.

**Panel List** shows the list of panels that you created or that have been shared with you by other users.

**Panel View** allows you to select a specific panel (from the drop-down list) to be your default view. This panel displays on top of the main iCare window.

![Sample Panel View to Select a Panel Name](image)

**3.1.2 Completing the User Preferences Wizard**

Click **Finish** on the **User Preferences** wizard to close the dialog and to access the iCare application.

**3.2 Modifying Your User Preferences**

You can access and modify your user preferences at any time by clicking **User Preferences** on the **Tools** menu to display the **User Preferences** window.
3.2.1 Modifying My Patients Definition and Associated Panels

If you change the definition of “My Patients” on the User Preferences window, you also might want to update the content of previous panels that were based on the “My Patients” definition.

3.2.1.1 Automatic Panel Repopulation

You can repopulate any of your panels that are based on the “My Patients” definition.

If only one panel exists based on “My Patients,” the warning message “Immediately repopulate the ‘My Patients’ panel in the Background?” will display.

Click OK to update the list of patients in your My Patients panel to the new “My Patients” definition.

OR

Click Cancel to maintain the current list with the old definition.

If more than one panel exists based on “My Patients,” you can select all or some of the panels to be updated.
Figure 3-13: Sample Repopulate "My Patients" Panels

1. Highlight one or more of any panel you want updated from the Available Panels on the left.
2. Click the Add button. The selected panels will move to the Repopulate area on the right.
3. Click OK to repopulate the selected panels. (Otherwise, click Cancel to maintain all panels with their previous definitions.)

### 3.2.1.2 Manual Panel Repopulation

You can manually repopulate panels after changing the “My Patients” definition.

1. From the Panel List, highlight the panel name.
2. Click the Repopulate button. The panel has been updated once the “clock” icon to the left of the name disappears. The Last Updated date and time will change.

![Figure 3-14: Example of Using the Repopulate Button from the Panel List](image)

If more than one panel exists based on “My Patients,” you can select all or some of the panels to be updated.

### 3.2.2 Flag Setup

This tab has the same fields as those on the Flag Setup tab during your first login. See Section 3.1.1.2 Flag Setup Tab for more information about this tab. This tab allows you to customize the flag that you want displayed.
3.2.3 **Startup View**

This tab has the same fields as those on the Flag Setup tab during your first login. See Section 3.1.1.3 Startup View for more information. This tab allows you to select the view that should be presented initially when you open the iCare application.

3.2.4 **Patient View**

You use the Patient View tab to specify the default tab (the tab on top) when you view a Patient Record window. For example, you might choose to have the patient view open directly to the Snapshot tab as opposed to the Cover Sheet, etc.

![Figure 3-15: Patient View Tab on User Preferences Window](image)

The default tab is the Cover Sheet as the startup tab for the Patient Record window. If you want to change to a different tab, select one from the drop-down list (lists the primary tabs that are on the patient view window). Also you determine the view size and clicking either the Minimized or Maximized radio button (the default is Minimized). When this tab is complete, click OK. (Otherwise, click Cancel to exit the User Preferences window.)

3.2.5 **Layouts Tab**

You use the Layouts tab to determine the default template for the layout of various windows in iCare.
You can use the defaults for the layouts when creating a panel instead of using the system generated default.

The Layouts tab is not available in the initial Startup Wizard.

See Section 4.20 Default Template for iCare Window Layouts for more information about each window displayed when you click Edit on the user preferences window.

### 3.2.6 Comm Alert Setup Tab

You use the Comm Alert Setup tab to specify which community alerts to display.

Figure 3-17: Comm Alert Setup Tab on User Preferences Window
Every diagnosis that triggers a Community Alert is placed into one of three categories: Mandatory; Recommended; Optional. This categorization allows for the customization of the Community Alert display in iCare.

- **Mandatory Community Alerts** are considered to be universally critical and will display for all users. They cannot be 'turned off'.
- **Recommended Community Alerts** are considered to be universally significant so they are included in the default display; however, you can choose to remove them from the display.
- **Optional Community Alerts** are not included in the default display; however, you can choose to add them to the display.

![Figure 3-18: Recommended Categories](image)

You can change the On/Off column. If the checkbox contains a check mark, then the recommended diagnosis will display on the Community Alert. To change from On to Off, select the appropriate check box.

You can filter any column and resize it. See Section 4.1 Working with Columns for more information.

When you have finished the Comm Alert Setup tab, click OK. (Otherwise, click Cancel to exit the User Preferences window.)

See Section 12.5 HIV/AIDS Community Alert for more information about HIV/AIDS community alerts.
4.0 Using iCare Features

Several iCare features are made available across multiple views and windows within the iCare application. Tools or features that are unique to a particular view are explained within the Section that discusses that view.

4.1 Working with Columns

This Section reviews how you can customize the view by manipulating the columns in a window.

- Sorting
- Changing Column Width
- Moving Columns
- Making Column First Column (on a panel window only)
- Filtering

4.1.1 Sorting

You can sort a column by clicking on the column’s name.

This changes the column’s heading to having a sort-by (arrow) image.

![Owner](Figure 4-1: Column Heading With Arrow Image)

Click the column’s heading again and the arrow changes direction.

![Owner](Figure 4-2: Column Heading With Arrow in Opposite Direction)

If you click another column’s name, the sort-by image disappears and the most recently-selected column contains the sort-by image.

4.1.2 Changing Column Width

You can modify the column widths displayed in iCare lists by selecting and dragging either of column’s left or right borders.
To change the default column width, do the following:

1. Move your pointer over either the left or right edge of the column’s header. The arrow will change into an icon.

![Last Updated](image)

Figure 4-3: Icon for Moving Column’s Edge

2. Click and drag this icon to the left or right to resize the column’s width in that direction; release your mouse when you reach the desired new width.

3. The other columns will adjust to the new “view” of the columns.

### 4.1.3 Moving Columns

You move a column from one position to another position by the drag-and-drop method, using your mouse. As you move from one place to another, a pair of red indicator arrows display above and below the column header row at that point.

![View](image)

Figure 4-4: Red Arrow as You Move Column

Release your mouse when you have the selected column in the new position.

### 4.1.4 Freezing One or More Columns

You can force a column to move to the far left and freeze in place. Then, as you scroll across your data, that column stays stationary in the first column position. In the views with a flag column, the pinned column moves to the second position and stays there as you scroll across your data.

1. Click the stick pin icon on the column (that will become the first column).

2. The column becomes the first column and the stick pin changes (혹).

3. As you move the horizontal bar across, the first column always displays.
4. You can use the stick pin icon on more than one column. The next selected column will position to the right of the previously frozen column(s). Those columns will remain stationary (at the beginning of the columns) as you move the horizontal bar.

5. You can “un-stick” the stick pin by clicking it.

4.1.5 Filtering

Filtering is a means by which you can display a sub-set of the current set of data. You can use the filters on more than one column.

Click a column’s Filter icon to display the options for that column from which to choose. The options include each of the values found in that column, as well as (All), (Custom), (Blanks), and (NonBlanks).

4.1.5.1 Creating a Filter

Select (Custom) from the drop-down list to display the filter criteria dialog for the column. Using the custom filter allows you to filter using multiple criteria for the column.
You will create the filter criteria statement on this dialog, using these guidelines.

- The Operator and Operand fields make up the condition for the statement.
- Click the drop-down list for the Operator field to select the correct operator. These operators vary according to the column selected.
After selecting the correct operator, click the drop-down list for the Operand field (the operand is a value for the column you want to filter). Select the appropriate operand or type the value you want to use as a filter (the value does not need to be on the drop-down list).

If you need a second condition, click the “Add a condition” button to add another row to the filter criteria statement. After selecting an operator (for the second condition), the “And” and “Or” radio buttons become active.

- **AND** = Returns TRUE if all its arguments are TRUE; returns FALSE if one or more arguments are FALSE. This means that a record will be returned only if all the AND statements are true.

- **OR** = Returns TRUE if any argument is TRUE; returns FALSE if all arguments are FALSE. This means that a record will be returned if any of the OR statements are true.

If you need to remove one of the criteria statements, click the left-most box (of the row) to select it and click the “Delete Condition” button.

- When the filter criteria statement is complete, click OK. (Otherwise, click Cancel to dismiss the dialog.)

The rows displayed will be limited to those that match the conditions in your statement.

The column’s Filter icon changes color ( ); this color change happens even if there was no apparent change to the rows displayed, because all records matched the specified conditions.

For example, assume you want the patients born between two dates. You would filter based on the values in the DOB column (the Operand). The dialog could look like the following:
4.1.5.2 Returning to All Rows

Generally you use this action after you have filtered the column. Click the Filter icon and select [All] from the drop-down list. The Filter icon changes to its original color (✓) and all rows are restored to the display.

Tip: If you wish to filter based on values in more than one column, use the custom feature and specify all the conditions at once. If you filter the columns separately, you will need to select [All] from the drop-down lists on each filtered column to restore all rows.

4.1.5.3 Other Filter Choices

If you want to view all the rows where the value is blank for a particular column, select (Blank) from that column’s filter drop-down list.

If you want to view all the rows that are not blank for a column, select (NonBlank) from the filter drop-down list.
4.2 Selecting Records

You select records on a window by clicking in the row selector column. If you do not click in this particular column, then it might appear that you cannot select more than one record.

Below is any example of where the row selector column is located:

![Row Selector Column](image)

- To select adjacent records, click the first record (in the row selector column), hold down the Shift key, and then click the last record (in the row selector column).
- To select non-adjacent records, click the first record (in the row selector column), hold down the Ctrl key, click the next record (in the row selector column), etc.
- To select all records, use the key combination Ctrl+A on your keyboard (or select Edit | Select All).

4.3 Menus

Each type of iCare window (iCare Main, Panel View, and Patient Record) has a Menu bar. These windows have the following Menu options in common: File, Edit, Tools, Window, and Help.

The following provides information about the Edit, Window, and Help menus. These menus are common to all of the iCare windows.

4.3.1 Edit Menu

![Edit Menu](image)

Select All. Use this option to select all of the records. This is the same as using the key combination Ctrl+A on your keyboard.

Deselect All. Use this option to deselect all of the records currently selected.
4.3.2 Window Menu

The options on the Window menu display the windows that are currently open in the iCare application. Click on the name to move to that window.

![Sample Window Menu Options](image)

Figure 4-12: Sample Window Menu Options

4.3.3 Help Menu

![Help Menu](image)

Figure 4-13: Help Menu

**iCare Help**: use this option to go to the online help system.

**Care Mgmt Glossaries**: expand this option to display the glossaries available for the Care Management tab (currently the HMS Register Glossary).

**Diagnostic Tag Glossary**: use this option to display the detailed logic for each national performance measure defined in the Clinical Report System.

**Reminders Glossary**: use this option to display the Reminder descriptions (from RPMS).

**Nat’l Measures Glossary**: use this option to display the detailed logic for each national performance measure defined in the Clinical Reporting System.

**Community Alerts Glossary**: use this option to display the information about the community alerts: purpose of a community alert, notice that alerts are not linked to an individual patient, categories of diagnosis that triggers the alert, how to customize the Community Alert display, and list of diseases/conditions and associated codes that trigger Community Alerts in iCare.
**Best Practice Prompts Glossary**: use this option to display information (name, default status, denominator, definition of clinical group) about best practice prompts for the several clinical groups.

**About iCare**: use this option to view the version number of the iCare application.

## 4.4 Quick Patient Search

All iCare views have a **Quick Patient Search** field located on the upper right side of the screen to assist you in quickly finding a patient and displaying the Patient Record.

![Quick Patient Search Field](image)

Figure 4-14: Quick Patient Search Field

Type the patient’s last name, HRN, SSN, or the Date of Birth. Then click the arrow button.

**Quick Patient Search** is context-sensitive to the view the user is in.

- **iCare Main** searches the RPMS database. If it finds more than one record, it displays the **Quick Patient Search** dialog. Otherwise, it opens the Patient Record.

- **Panel View** first searches the open panel and highlights any matches. If no matches are found, you are asked if you want to search the RPMS database.

- **Patient Record** searches the RPMS database. If it finds more than one record, it displays the **Quick Patient Search** dialog. Otherwise, it opens the Patient Record.

If you enter the patient name, HRN, or Date of Birth, iCare first searches the open panel then the RPMS patients for any matching results. See Section 4.4.1 Find Patients in Open Panel for more information below.

If you enter the SSN, iCare searches the RPMS patients for any matching results. See Section 4.4.3 Find Patients in RPMS Database for more information.

### 4.4.1 Find Patients in Open Panel

When the system searches for the last name, HRN, or Date of Birth and finds one in the open panel, it highlights the first record containing the name in the open panel and displays the **Quick Patient Search (within Panel)** window.
The **Find What** field contains the characters used in the search. You can change these characters any time before clicking the Find Next button.

Check the **Match Case** checkbox if you want the search to match the case of the characters in the **Find What** field.

If there is more than one patient that matches your entry in the open panel, click **Find Next** to move to the next patient.

The fields below the **Show Additional Search Options** checkbox display the additional criteria fields you can use in the search. See Section 4.4.2 Search Criteria Fields for more information.

If you uncheck the **Show Additional Search Options** checkbox, the additional search criteria fields are removed from the dialog. When you click **Find Next**, it will search all columns.

You use the **Search All RPMS** button to search the RPMS database for the patient name.

### 4.4.2 Search Criteria Fields

The following information provides information about the fields below the **Show Additional Search Options** checkbox. You can change any of these fields.

#### 4.4.2.1 Look In Field

Click the drop-down list for the **Look In** field on the **Quick Patient Search** (within the Panel) dialog to view the options for that field. The highlighted option determines what part of the window to search.
4.4.2.2 **Match Field**

Click the drop-down list for the **Match** field on the **Quick Patient Search** (within Panel) dialog to view the options for that field. The highlighted option determines what part of the **Find What** field will be matched in the search.

4.4.2.3 **Search Field**

Click the drop-down list for the **Search** field on the **Quick Patient Search** (within Panel) dialog to view the options for that field. The highlighted option determines the direction of the search.

4.4.2.4 **Completing the Search**

After all fields are populated with the search criteria, click the **Find Next** button.

If a match is found, the matching text will be highlighted on the open panel. If you want to continue the same search, click the **Find Next** button again (on the **Quick Patient Search (within Panel)** dialog); repeat this process as needed.
• When you find the patient name that you want to use, highlight it (on the open panel) and click **Cancel** to dismiss the **Quick Patient Search (within Panel)** dialog. Then double-click the highlighted record to display the Patient Record.

• If a match is not found, the system displays a warning message that asks you if you want to search the RPMS database. See Section 4.4.2.6 **No Patients in Open Panel** for more information.

### 4.4.2.5 Search All RPMS Button

If you want to search the RPMS database for the patient name, click the **Search All RPMS** button to display the **Quick Patient Search** dialog. See Section 4.4 **Quick Patient Search** for more information.

### 4.4.2.6 No Patients in Open Panel

When the system searches for the last name in the open panel and does NOT find one, it displays the “No matching patients were found within this panel, would you like to search all of RPMS?” warning message.

• Click **No** to cancel the search process.

• Click **Yes** to have the system go to RPMS to find the patient name. See Section 4.4.3 **Find Patients in RPMS Database** for more information.

### 4.4.3 Find Patients in RPMS Database

iCare searches the RPMS patients for any matching results in the following situations:

• If you entered the SSN on **Quick Patient Search** field

• If you use the **Quick Patient Search** field on the **Flag List**, **Panel List**, or **Patient Record** window

• If the system found no patients in the open panel and you asked the system to search all of the RPMS

If the search finds only one patient name that matches the search in the RPMS database, the system opens the **Patient Record** window. See Section 10.0 **Patient Record** for more information about that window.

If the search finds more than one patient name, it displays the **Quick Patient Search** dialog. See Section 4.4 **Quick Patient Search** for more information.

If the search finds no patient names, it displays a message. See Section 4.4.3.2 **No Records Found in RPMS Database** for more information.
4.4.3.1 Quick Patient Search Dialog

If the system searches the RPMS database and finds more than one record, it displays the Quick Patient Search dialog and highlights the first record containing the characters in the Quick Patient Search field; these characters are displayed in the Search field of the dialog.

![Sample Quick Patient Search Dialog](image)

Figure 4-19: Sample Quick Patient Search Dialog

You can refine your search by entering more or different characters in the Search field (if you cannot immediately find the patient’s name). After you have finished entering your new search criteria, click Find. This should reduce the number of records in the Quick Patient Search dialog.

When you find the patient’s name, highlight it and click Select to display the Patient Record window. (Otherwise, click Cancel to exit the search process.)

4.4.3.2 No Records Found in RPMS Database

If no records are retrieved from the search in the RPMS database, the “No matching patients were found” message displays.

Click OK on the message and you return to the Quick Patient Search dialog where you can modify your search. See Section 4.4 Quick Patient Search for more information.
4.5 Buttons on Right Side of Window

The buttons on the right side of any iCare window have the same functionality on any window.

![Figure 4-20: Buttons on Right Side of Window](image)

These buttons might not be visible; in that case, click the drop-down list button.

The application provides hover help for each button.

4.5.1 Reset View

Click the Reset View button (or select Tools | Reset View) to return the current view to the default view. You use this feature when you change the view, such as resize the column width. This is the same as using the Ctrl+R key combination.

4.5.2 Refresh

Click the Refresh button (or select Tools | Refresh) button to update any RPMS field values on the currently window with new data from the server. This is the same as pressing the F5 key on your keyboard.

4.5.3 Search Button

You can search for data in the current grid by clicking the Search button (or by selecting Tools | Search or by using the Ctrl+F key combination) to display the Search dialog.

![Figure 4-21: Search Dialog](image)
If you DO NOT check the **Show Additional Search Options** checkbox, the search looks in all columns for a match.

If you check the Show **Additional Search Options** checkbox, the **Search** dialog changes to show more options for the search.

![Search Dialog with Additional Search Options](image)

Figure 4-22: Search Dialog with Additional Search Options

You type in what you want to search for in the **Find What** field. The remaining fields determine the criteria for the search.

If you check the **Match Case** checkbox, that will cause the search to match the case of the text that you type into the **Find What** field.

The fields **Look In**, **Match**, and **Search Work** are described in the Section 4.4.2 Search Criteria Fields.

After all fields are populated with the search criteria, click the **Find Next** button. (Otherwise, click **Cancel** to dismiss the **Search** dialog.)

If a match is found, the matching text will be highlighted (in the grid). If you want to continue the same search, click the **Find Next** button again; repeat this process as needed.

If a match is not found, the **Datagrid Search Results** dialog displays. Click **OK** to close the message and to return to the **Search** dialog.

![Datagrid Search Results](image)

Figure 4-23: Sample Datagrid Search Results
4.5.4 **Export to Excel**

You can export the information in the window to Excel by clicking the **Export to Excel** button (or by selecting **Tools | Export to Excel** or by using the **Ctrl+E** key combination).

The application displays the warning message about the export.

![Figure 4-24: Warning Message about Exporting the Information](image)

- Click **No** to dismiss the warning and to exit the export process.
- Click **Yes** to continue the export process and to display the **Save As** window.

![Figure 4-25: Sample Save As Window](image)

Make sure the location where you want to save the file displays in the **Save in** field.

Type the name in the **File name** field. The system will add XLS as the extension to the field name (automatically).
Click **Save**. (Otherwise, click **Cancel** to not save.). If you save, the **Export Panel** message “Excel export has been created.” displays when the **Save** command is complete; click **OK** to dismiss the message.

When you view the Excel document, the application provides a Confidential Patient Information header in the document.

### 4.5.5 Print Button

You can print the selected rows in the grid by clicking the **Print** button (or by selecting **Tools** | **Print** or by using the **Ctrl+P** key combination) to display the **Print Preview** window.

![Sample Print Preview window](image)

Figure 4-26: Sample Print Preview window

Select **File** | **Print** or click the **Print** button (on the **Print Preview** window) to output the data.
4.5.6 Copy to Clipboard Button

You can copy the selected rows in the grid to the Windows clipboard by clicking the Copy to Clipboard button (or by selecting Tools | Copy Rows to Clipboard or by using the Ctrl+Shift+C key combination). You can paste the contents of the Windows clipboard to any Windows application.

4.6 Entering Data

The following information covers entering data in free text fields, drop-down lists, date fields, and missing data.

4.6.1 Free Text Fields

Free text fields are those fields that you can type information into; those types of fields do not have a drop-down list from which to select an option to populate it.

An example of the free text field is the Panel Name field (when creating/editing a panel definition).

There is a right-click menu to aid in editing the text.

![Right-Click Menu to Aid in Editing Text](image)

Figure 4-27: Right-Click Menu to Aid in Editing Text

These options operate just like those in any Windows application. Here are the meaning of the options:

- **Undo**: allows you to remove the last edit action.
- **Cut**: removes the selected text from its current position and places it on the clipboard.
- **Copy**: copies the selected text and places it on the clipboard (the text is NOT removed).
- **Paste**: copies the contents of the clipboard and places it in the field at the current cursor position.
- **Delete**: removes the selected text from its current position.
- **Select All**: highlights all of the text in the current field.
4.6.2 Drop-Down Lists

You can populate a field by selecting an option from the drop-down list for the field.

4.6.3 Date Fields

Each date field in iCare has a calendar associated with it OR you can manually enter the date using the mm/dd/yyyy format.

Click the date field’s drop-down list to display the calendar.

![Sample Calendar for Date Field](Image)

The calendar always indicates the date for today.

You can select another date by clicking on it; the selected date will display in the Date field.

4.6.3.1 Changing the Month

You can select from another month’s dates by clicking the appropriate arrow button (more than once, if needed).

If you click on the month label, iCare displays a month from which you can select another month.
4.6.3.2 Changing the Year

If you click on the year label, iCare displays up and down arrow buttons that you can click to change the year.

![Image of year change interface]

Figure 4-30: Changing the Year

4.6.4 Missing Data

If there is any missing data that is required, a missing data icon will display next to the field. Below is an example of a field that has missing data.

![Image of missing data]

Figure 4-31: Sample of Field Having Missing Data

4.7 Pop-up Functionality

Several places in iCare you will be viewing a pop-up. For example, if you double-click on any row in the Recent Visits group box on the Cover Sheet of the Patient Record window, you will view a pop-up.
You can take the following actions on this pop-up:

- Navigate through the information by using the scroll bar.
- Click the Find button to access a search tool to find data in the current window. This button works like the Search button. See Section 4.5.3 Search Button for more information.
- Click the Font button to display the Font dialog.
− Here you can change the Font name, style, and size of the text in the pop-up (applies to all of the text). In addition, you can add effects like “Strikeout” and “Underline” - these perform like those effects indicated in MS Word.

− Change the Script option if you need to see the text displayed in another language and you have that language pack installed on the machine you are using. If the language pack is not installed on your machine, the display does not change by selecting another script.

• Click OK to apply your changes to the text in the current pop-up. These changes are only effective for the current view of the pop-up. (Otherwise, click Cancel.)

• Click the Copy button to copy the selected text to the Windows clipboard.

• Click the Print Preview button to view the Print Preview dialog. You can print the contents of the pop-up from this dialog. See Section 4.5.5 Print Button for more information about this dialog.

• Click the Print button to display a print dialog where you specify the printer to output the contents of the pop-up, the page range, and number of copies.

The File menu contains the print actions (like the Print Preview and Print buttons), the Page Setup function, the find and copy functions, as well as a Close function (dismisses the pop-up). See Section 4.5.5 Print Button for more information on the print actions. The Find and Copy functions are discussed above.

4.8 Add/Remove Functionality

There are several Add/Remove dialogs that you use in iCare.

![Sample Add/Remove Visit Clinics Dialog](image)

Figure 4-34: Sample Add/Remove Visit Clinics Dialog
Use the Add/Remove dialog in the following manner:

- Type a few characters in the Find field to filter the list to those options containing those characters.
- To move a highlighted selection from the Available Selections area to the Current Selections area, click the Add button.
- To move a highlighted selection from the Current Selections area to the Available Selections area, click the Remove button.
- When the dialog is complete, click OK. This action populates the appropriate field with the data in the Current Selections area. (Otherwise, click Cancel).

4.9 Layout Dialog Functionality

There are several times in iCare that you will use a layout dialog to determine: (1) the columns on a particular window or tab, (2) the sort order of the columns, and (3) the direction of the sort. In addition, you can use a customized default template (that you define) or you can use the system default template.

For example, you can determine the columns for the Patient List tab by using the Patient List Layout window. You can expand or collapse the column levels as needed.
• After you have changed the Display Columns and/or Sort Columns, click OK to save your changes.
• Use the Reset button to restore the layout to the most recently saved configuration.
• Use the Cancel button to dismiss the window.

4.9.1 Template Group Box

Figure 4-36: Template group box

When you first access the layout dialog, the application displays the System Default template. The Template and Customized radio buttons are not selected.

• If you leave the System Default radio button enabled, then the application displays the system default columns. In this case, the Add and Remove buttons are not active (and you cannot change anything) on the Patient List Layout dialog. You can change the column layout for the default template by using the Layouts tab on the User Preferences dialog. See Section 4.20 Default Template for iCare Window Layouts.

• If you select the Customized radio button, the application lets you change the columns (the Add and Remove buttons become active, for example). Anything you change on the layout dialog will be used for the Customized template.

• You can name the customized template by selecting the Template radio button. This action causes the field with the drop-down list to become active (and the Customized and System Default radio buttons are not selected). Once you add a name, it is added to the Template name drop-down list. Later, you can choose which template you want to use during an iCare session.

4.9.2 Display and Available Columns

Figure 4-37: Sample Display and Available columns
You use the Display Columns to determine what columns you want to display for the particular window or tab. The listing in the Display Columns area shows the columns that will be displayed for your population. The column names in italics are required and cannot be removed.

To move a Column name in the Available Columns area to the list in the Display Columns area, highlight a column name in the Available Columns area and click **Add**. This moves the column name from the left panel to right panel.

Likewise, you can remove a column in the Display Columns area and move it to the Available Columns area by highlighting the column name (in the Display Columns area) and clicking **Remove**. This moves the column name from the right panel to the left panel.

As noted about the Display Columns area, you cannot remove any column names in italics.

You can determine the order the columns display in the Display Columns area by using the **Up** and **Down** buttons. Highlight a column name and click the appropriate button. You might have to click the button more than once to move it to the desired location.

### 4.9.3 Columns to Sort

Sorting a column means you want to arrange the items in the column in alphabetic order.

![Sample Available Sorts and Sort Columns area](image)

To move a Column name in the Available Sorts area to the list in the Sort Columns area, highlight a column name in the Available Sorts area and click **Add**. This moves the column name from the left panel to right panel.

Likewise, you can remove a column in the Sort Columns area and move it to the Available Sorts area by highlighting the column name (in the Sort Columns area) and clicking **Remove**. This moves the column name from the right panel to the left panel.
4.9.3.1 Column Sort Order

You use the Sort Columns area to determine what columns you want to sort for the particular window or tab. The column names in italics are required and cannot not be removed.

You determine which order the columns are sorted in the Sort Columns area by using the Up and Down buttons. Highlight a column name and click the appropriate button. You might have to click the button more than once to move it to the desired location. For example, if you have Gender, Patient Name, and Diagnosis Tags in the right column, the Gender sort is applied first then the Patient Name and then the Diagnosis Tags is last.

4.9.3.2 Switch Sort Direction

The names of columns in the Sort Columns area show “ASC” appended to the name, for example Patient Name ASC. You can switch the sort order for a selected column by clicking the Switch Sort Direction button. In the example, the name changes Patient Name DESC. You can use the “switch sort direction” action on more than one column.

4.10 Mail Merge

The iCare application provides the capability to export patient demographic data in a format that can be used by word processing mail merge files. This is a Demographic Data Export for Letter Generation function.

Follow these steps:

1. Select the patients that you want to include in the mail merge process. (See Section 4.2 Selecting Records for more information about selecting records.)

2. Click the Mail Merge button (or select Tools | Mail Merge) to display the Mail Merge Export dialog.
Figure 4-39: Sample Mail Merge Export Dialog

See Section 4.5 Buttons on Right Side of Window to learn about how to use the buttons on the right side of the toolbar.

3. Click the Mail Merge Instructions button to display the Mail Merge Instructions pop-up. Here will be the instructions for completing the mail merge process.

Figure 4-40: Mail Merge Instructions Dialog

**Note:** You can print the contents by clicking the Print button or by selecting File | Print.

See Section 4.7 Pop-up Functionality for more information about the File menu and the buttons on the pop-up.

4.11 Background Jobs

The background jobs information displays in several places in iCare.
Click the Background Jobs button (or select File | Background Jobs) to display the Background Jobs pop-up.

Figure 4-41: Sample Background Jobs Pop-up

See Section 4.5 Buttons on Right Side of Window to learn about how to use the buttons on the right side of the toolbar.

The File menu has the following options:

- **Page Setup**: This option allows you to set Margin, Paper, Layout characteristics (like landscape or portrait orientation), and the Printer to use.
- **Print Preview**: This option displays the print preview dialog.
- **Print**: This option sends the page to the printer using the settings in Page Setup.
- **Close**: This option closes the Background Jobs window.

The Edit menu has one option: **Select All** (used to select all of the records).

The Tools menu has options that have the same functions as those of the buttons on the right side of the toolbar.

### 4.12 Table Lookup

The Ellipsis button next to the field means you can search for a particular record in the Table Lookup dialog by clicking the button. In addition, you can clear the information in the particular field (on the form).
4.12.1 Searching for Record

![Table Lookup Dialog](image)

This dialog provides two types of searches: for all items or for a particular item.

Let’s use an example to demonstrate each type. Assume you are going to search for CPT Code.

4.12.1.1 Using the Show All Button

If you do not enter anything in the Search field and just click Show All, the application will display all CPT codes, as shown below. (The retrieval might take a little time.)
4.12.1.2 Using the Find Button

To search for a particular CPT code, type a few characters in the Search field and then click Find. The retrieved records will display in the bottom area (if any).
4.12.1.3 Completing the Search

In either case, select a record and click Select. This will close the dialog and populate the field (on the form) with the selected record. (To exit the Table Lookup dialog, click the Cancel button.)

4.12.2 Clearing Data in Field with Ellipsis Button

To clear the data in a field with the Ellipsis button (on a form), click the Ellipsis button to display the Table Lookup dialog. Click Clear (on Table Lookup). This will close the Table Lookup dialog and clear the data in the field on the form. (To exit the Table Lookup dialog, click the Cancel button.)

4.13 Package Manager Functions

When you have the Package Manager security key, you can access the functions by selecting Tools | Package Manager on the iCare main window.

![Package Manager](image)

Figure 4-45: Package Manager Functions

4.13.1 iCare User Access Maintenance

The iCare User Access Maintenance function accesses iCare User Access Maintenance dialog where the Package Manager can assign Package Manager and/or Editor roles to a particular user.
The users displayed on this list (those with the iCare user icon in first column) have been given basic access to the iCare application by your Site (IT) Manager. You cannot give Editor or Package Manager access to iCare to a user who doesn’t have basic access. See your Site Manager to require basic iCare access for other users. This information displays when you click the Help menu.

If you are the Site Manager, you can assign roles to a particular user, scroll to the name on the iCare User Access Maintenance dialog and check the appropriate check boxes for the roles. If you want to remove an assigned role, de-select the particular check box.

- The Editor role will give the person the right to edit the care management function (e.g., HMS Care Management). It also allows the person to enter Historical Data.
- The Package Manager does everything an editor does and also has the ability to access the list of patients who have triggered the Community Alerts. This person also assigns Editor access to other users.

Click OK to save your changes. (Otherwise, click Cancel to not save.)

4.13.2 HMS Turn Off Date

The HMS Turn Off Date function displays the HMS Turn Off Date Dialog. This function allows the package manager to specify the date that the end user will no longer have access to the HIV Management System (v1.x) from the RPMS menu.
The default date is the current date (in the HMS Turn Off Date field). If you want to select another date, click the drop-down list and select from the calendar (see Section 4.6.3 Date Fields for more information). Click OK to save the turn off date (otherwise, click Cancel).

4.14 Glossary Functions

You can access glossary information by clicking the Glossary button on the current window or by selecting a glossary option on the Help menu.

4.14.1 Community Alerts Glossary

The Community Alerts Glossary pop-up provides the following information:

- Purpose of a community alert
- Notice that alerts are not linked to an individual patient
- Categories of diagnosis that triggers the alert
- How to customize the Community Alert display
- List of diseases/conditions and associated codes that trigger Community Alerts in iCare
4.14.2 Diagnostic Tag Glossary

The Diagnostic Tag Glossary pop-up provides the detailed logic for each national performance measure defined in the Clinical Reporting System.

4.14.3 National Measures Glossary

The National Measures Glossary pop-up defines the detailed logic for each of the national performance measures defined in the Clinical Reporting System.
See Section 4.7 Pop-up Functionality for more information about the buttons and the File menu on the pop-up.

4.14.4 Reminders Glossary

The Reminders Glossary pop-up displays the Reminder descriptions (from RPMS). The pop-up has descriptions of the logic behind each national health summary reminder available for display in iCare.

See Section 4.7 Pop-up Functionality for more information about the buttons and the File menu on the pop-up.
4.14.5 HIV/AIDS / Care Management Glossary

The HIV/AIDS / Care Management Glossary pop-up provides information about the HIV/AIDS Diagnostic Tag Definition, HMS Register Specific Data/ Patient Record, HMS Panel Layout Options, What is a Taxonomy?, HMS Supplement Logic, HMS Reminder Logic, and HIVQUAL Report Synopsis. These are Sections that you can access individually within the glossary. See Section 12.3 Using the HIV/AIDS Glossary for more information.

![HIV/AIDS / Care Management Glossary]

Figure 4-52: HIV/AIDS / Care Management Glossary

See Section 4.7 Pop-up Functionality for more information about the buttons and the File menu on the pop-up.

4.14.6 Best Practice Prompts Glossary

The Best Practice Prompts Glossary pop-up is accessed from the Best Practice Prompts tab of the Patient Record window or by using the Best Practice Prompts Glossary option on the Help menu.

The Glossary text is created by combining the following labels and fields from the Treatment Prompts file: Clinical Group (Category field), Prompt Name, Status (e.g. On or Off at the site), Description, Currently Defined Criteria field (display label ONLY if there is data), and Current Summary types (display label even if NO data).

Glossary entries are displayed alphabetically by Clinical Group, then by Name (Title).
4.15 iCare Taxonomy Editor Function

The iCare Taxonomy Editor holds the security key (BQIZTXED) allowing that person to read/edit iCare taxonomies.

You access the iCare Taxonomy View/Edit dialog by either selecting Tools | Taxonomy Maintenance | View/Edit Taxonomy Entries (on the main iCare Tools menu) or by double-clicking the Factor cell in the Active Diagnostic Tags group box on the Snapshot tab of the patient record window.

Note: if you do not hold that security key, you can only view the information on the dialog. The following information “You do not currently have access rights to edit taxonomies. In order to edit taxonomy entries, you will need to have the iCare Taxonomy Editor security key (BQIZTXED) added to your RPMS user account” will display on the dialog.

Please note that not all taxonomies will be editable. iCare will display a message on the view/edit dialog when this condition exists.

When you first access this view/edit dialog, all parts of the tree structure will be collapsed. You need to expand one of the tree parts and find the taxonomy you want to edit.
4.15.1 Add Taxonomy Values

Click the **Add** button to create a value for a selected item in the left group box. The system displays a dialog box where you can search for a taxonomy item. Highlight the item you want to add and click **Select**. The application checks to see if it is already there. If it already exists, you receive a message about that. If it does not exist, it appends the selected item to the bottom of the list. See Section 12.4.7 Add a Member to a Site-Populated Taxonomy for more information.

After you finish adding taxonomy values, click **Apply** to save your changes. If you do NOT click **Apply** and try to move to another taxonomy or another part of the iCare application, the “Save Taxonomy changes?” information message displays, asking if you want to apply the changes now. In this case, click **Yes** to apply the changes (otherwise, click **No**).
4.15.2 Remove Taxonomy Values

If you want to remove one or more items from the list, highlight them and click **Remove**. The “Confirm taxonomy item remove” message displays. Click **Yes** to remove the items (otherwise, click **No**). See Section 12.4.8 Remove a Member from a Site-Populated Taxonomy for more information about the remove process.

4.15.3 Apply Button

The **Apply** button becomes active during the “Add” process (using the Add button) on the iCare Taxonomy View/Edit dialog. After you have completed the add process, click Apply to “save” your changes.

4.15.4 View Report of All Taxonomies Button

Click the “View Report of All Taxonomies” button to display the Taxonomy Report pop-up.

![Taxonomy Report](image)

**Figure 4-55: Taxonomy Report**

This pop-up provides information about various Taxonomy Categories (listed in alphabetical order).

See Section 4.7 Pop-up Functionality for more information about the buttons and the File menu on the pop-up.

4.16 Creating a Community Taxonomy

You access the Community Taxonomy function in the panel definition process, under the Ad Hoc search.
You create a taxonomy by populating the By Name communities. You can determine how many patients will be in the taxonomy by selecting an option on the drop-down list for the By Name radio button.

Click the **Edit** button to access the Add/Remove Communities dialog.

The goal is to populate the area under the Current Selections area. After you populate this area, click OK. This populates the By Name communities area of the Community group box on the Ad Hoc search dialog. See Section 4.8 Add/Remove Functionality for more information about how to use the Add/Remove Communities dialog.

After selecting your communities, click the **Create Taxonomy** button to display the Create/Update Community Taxonomy dialog.
Populate the fields on the dialog. The Community Taxonomy Name field is required. Then click OK. The application confirms savings the data to the RPMS server.

![Confirm save to RPMS]

Figure 4-59: Confirm save to RPMS

Click Yes to save the data. (Otherwise, click No to not save the data).

If you use Yes, the application displays the following message:

![Community Taxonomy Created]

Figure 4-60: Community Taxonomy Created message

Click OK. The Community group box will change, as shown below.

![Sample Community group box with taxonomy]

Figure 4-61: Sample Community group box with taxonomy

If the user uses a duplicate taxonomy name to a previous taxonomy created by that user, iCare will provide a warning that the user might be overwriting the user’s taxonomy. The user can overwrite (Yes), save as another name (No), or cancel.

The taxonomy creating function is independent of the panel save function, that is, the taxonomy will be saved to the server once the user selects the Taxonomy Save function. The user has the potential for creating multiple community taxonomies within the Panel Definition function, and can create a community taxonomy without actually creating a panel.

The iCare application will observe the underlying business rules for taxonomy creation: a user can only edit the user’s created taxonomy. iCare will not allow a duplicate taxonomy name if the user is not the owner of the original taxonomy.
4.17 Edit DPCP Providers

When you edit the DPCP providers, the application displays the Edit Providers dialog (for the current patient).

![Sample Edit Provider dialog](image)

Figure 4-62: Sample Edit Provider dialog

The Edit Providers window is divided into two areas: (1) Add/Edit area that has fields to add/edit a provider record and (2) Specialty Provider List area that lists the providers for the patient. See Section 4.5 Buttons on Right Side of Window for information on how to use the buttons on the right side of the Specialty Provider List area.

4.17.1 Add/Edit New Provider

Move the cursor to the row of the Provider Category (in the Specialty Provider List grid) where you want to add/edit the provider.

The Provider Category field (in the Add/Edit area) will show the provider category that you selected, for example, Cancer. This field is view-only.
You can add the provider for the category and clicking the ellipsis button to search for the provider name (or initial) on the Table Lookup window. See Section 4.12 Table Lookup for more information.

Select the provider name and click Select; this name populates the Provider Name field (in the Add/Edit group box). Then click Apply Changes to move the data to the Specialty Provider List group box.

### 4.17.2 Remove Provider Name

You can remove the provider for the category by first selecting the category (in the Specialty Provider List grid). Then, click the Ellipsis button by the Provider Name field (in the Add/Edit area) to access the Table Lookup window. Click Clear. This removes the provider name from the Provider Name field. Then click Apply Changes to remove the provider name from the Specialty Provider List group box.

### 4.17.3 Save & Close Button

Click the Save & Close button (or select File | Save & Close) to display the “Confirm save to RPMS” information message. Click Yes to save all changed data to RPMS (otherwise, click No to not save). The Edit Providers window closes.

If you saved the data, it will be reflected in the Provider group box on the Cover Sheet tab of the Patient Record window.

### 4.17.4 File Menu on Edit Providers

The options on the File menu are:

- **Save & Change**: this is the same as clicking the Save & Close button. This action displays the RPMS information message. Click Yes to save the data to RPMS (otherwise, click No to not save). If you use Yes, the data populates the Providers group box on the Cover Sheet of the patient record window.

- **Close**: use this option to close the Edit Providers dialog.

### 4.17.5 Tools Menu on Edit Providers

The options on the Tools menu are: Search, Excel to Export, Print, and Copy Rows to Clipboard. These options perform like the button on the right side of the window. See Section 4.5 Buttons on Right Side of Window for more information.
4.17.6 Help Menu on Edit Providers

The options on the Help menu are:

- **iCare Help**: use this option to access the online help information about the Edit Providers dialog. This is the same as pressing the F1 key on your keyboard.

- **About iCare**: use this option view the version of the iCare GUI.

4.18 Graphing Measurement Data

You can create a graph of measurement data on the patient record window by clicking the Graph It button. The application displays the Charting window, showing a graph of the various measurement types.

The application creates a line chart of the measurement data. This type of graph shows trends over time.

- The x-axis is the time axis.
- The y-axis shows the data range that includes the maximum and minimum values (this is the default setting).
The default chart will be Blood Pressure, the first option in the Measurement Type field. All of the patient’s blood pressure data appears in the Chart Data group box, listed by date.

### 4.18.1 Chart Data Group Box

The data for the graph are listed in the Chart Options group box.

The data is determined by what you select in the Measurement Type field.

See Section 4.5 Buttons on Right Side of Window for more information about the buttons in the Chart Data group box.
4.18.2 Chart Options Group Box

What you select in the Chart Options group box determines what the graph looks like. For example, you can determine the scale units for the x-axis in the X-axis Date Range field.

Figure 4-65: Sample Chart Options group box

- **Measurement Type**: this determines what is being charted. The default is Blood Pressure.

- **Time Interval**: this determines the time interval for the data on the chart. The default is what you selected (in the Last field) on the PCC tab of the patient record window.

- **Selected Rows**: use this check box to graph the selected row(s) in the Chart Data grid. If you do **not** use this check box, the application uses all of the measurement values.

- **Set Grid to Zero**: use this check box to cause the y-axis values to start at zero and go to the maximum value of the data. When you **do not** use this check box, the application uses the minimum and maximum values for the y-axis.

- **Lines Visible?**: use this check box to display the lines that connect the data points.

- **Values**: use this check box to display the values at each data point.

- **Grid Lines**: use this check box to display the grid lines on the chart.

- **Enable Zooming/Scrolling**: use this check box to display zooming/scrolling of the grid lines.

- **X-axis Data Range**: this determines the time units of measure on the x-axis of the graph. The options are: Not Set, Days, Weeks, Months, Years.
• **Icon**: this determines the icon for each data point. The options are: circle, diamond, none, plus, square, triangle, upside down triangle, X. The default is None.

• **Show Legend**: check this check box to show the legend for the graph. The field below determines the location of the legend.

### 4.18.3 File Menu for Charting Window

Below are the options on the File menu for the Charting window.

![Figure 4-66: Options on File menu for the Charting window](image)

- **Page Setup**: this option allows you to set Margin, Paper, and Layout characteristics (like landscape or portrait orientation) for printing. You can select a different printer.

- **Print Preview**: this option displays the Print Preview dialog.

- **Print**: this option outputs the information, using the settings from Page Setup.

- **Save Chart for Office**: this option saves the current chart for use in any MS Office product (just as MS Word). After selecting this option, the application displays the Save As dialog where you indicate the location where you want to save the file and the name of the file.

- **Save Chart as PDF**: this option saves the current chart in PDF format. After selecting this option, the application displays the Save As dialog where you indicate the location where you want to save the file and the name of the file. The user viewing the file in PDF format opens the file using the Acrobat Reader application. When using Acrobat Reader to view the file, the user cannot change the contents of the file.

- **Close**: this option dismisses the Charting window.
4.19 Select/Clear Functionality

You use the select or clear dialog to do the following:

- To search and then select a record to populate a field
- To clear the data in an existing field

4.19.1 Search and Select Data for a Field

Type a few characters in the Search field and then click Find. The application will display the retrieved record in the lower part of the grid of the dialog.
Highlight the record you want to populate the field and click Select (otherwise, click Cancel to stop the search).

4.19.2 Clearing Data in Field

If you want to clear data in a field, click the drop-down list for the field. The application displays the select/clear dialog. Click Clear.

4.20 Default Template for iCare Window Layouts

When you use the Layouts tab on the User Preferences dialog and you click Edit, the application displays the Window Default - Window Template dialog. For example if you click the Edit button for the Patient List window, the application displays the Patient List Default - Patient List Template window.
This window is similar to all of the default templates for Patient List, Reminders, Natl Measures, and Case Mgmt.

After you have changed the Display Columns and/or Sort Columns, click OK to save your changes.

Use the Reset button to restore the layout to the most recently saved configuration.

Use the Cancel button to dismiss the window.

4.20.1 Template Group Box

You use the template group box to determine the columns for default template.

If you want to change the columns, you can do so and then check the “Set as default?” check box. This action will re-define the default template.

If you want to reset to the system default, then click the Reset to System Default button.
4.20.2 Display Columns

You use the Display Columns to determine what columns you want to display for the customized template.

Figure 4-71: Sample Display Columns area

You might need to expand an option the in Available columns area by click the + button (next to the name).

The listing to the Display Columns area shows the columns that will be displayed for your population. The column names in italics are required, and cannot be removed.

You might need to expand a name in the Available Columns area in order to view the names of the columns.

To move a column name in the Available Columns area to the list in the Display Columns area, highlight a column name in the left panel and click Add. This moves the column name from the left to right panel.

Likewise, you can remove a column in the Display Columns area and move it to the Available Columns area by highlighting the column name (in the right panel) and clicking Remove. This moves the column name from the right to the left panel.

As noted about the Display Columns area, you cannot remove any column names in italics.

You can determine the order the columns display in the Display Columns area by using the Up and Down buttons. Highlight a column name and click the appropriate button. You might have to click the button more than once to move it to the desired location.

4.20.3 Columns to Sort

Sorting a column means you want to arrange the items in the column in alphabetic order.
You might need to expand an option in the Available Sorts area by clicking the + button (next to the name).

To move a Column name in the Available Sorts area to the list in the Sort Columns area, highlight a column name in the left panel and click Add. This moves the column name to right panel and removes it from the left panel.

Likewise, you can remove a column in the Sort Columns area and move it to the Available Sorts area by highlighting the column name (in the right panel) and clicking Remove. This moves the column name from the right panel to the left panel.

4.20.3.1 Column Sort Order

You determine which order the columns are sorted in the Sort Columns area by using the Up and Down buttons. Highlight a column name and click the appropriate button. You might have to click the button more than once to move it to the desired location. For example, if you have Gender, Patient Name, and Diagnosis Tags in the right column, the Gender sort is applied first then the Patient Name and then the Diagnosis Tags is last.

4.20.3.2 Switch Sort Direction

If you have column names in the Sort Columns area in alphanumerical order, you can reverse the sort order by clicking the Switch Sort Direction button. For example, the name Patient Name ASC means the sort direction is ascending. If you select this name and click the Switch Sort Direction button, the name of the column will change to Patient Name DESC.
5.0 Creating Patient Panels

A patient panel is a group of patients that needs to manage collectively. Some users will have only one patient panel while others will have many.

You can create and use a panel for a day, a month, permanently. iCare provides you with many pre-defined search options to populate your panels, or you can add individually selected patients.

The key categories of a pre-defined population search include:

- Your “My Patients” definition, with additional filters such as visit date range, sex, age, community, and diagnosis.
- Surrogate Provider - a provider different from yourself
- By scheduled appointments, defined by date range and/or clinics
- From an existing QMan search template
- From a Register
- By any combination of patient data including age, sex, visit date range, primary visit provider, community, or pre-defined diagnosis

5.1 Scenarios and Panel Examples

- I am a nurse at a facility that assigns a primary care provider to each patient. Every day, I want to create a list of scheduled patients for two different doctors in my clinic.
- I want to identify which of my patients are considered obese so I can recommend nutrition counseling.
- Because providers at our clinic have performance goals related to annual GPRA clinical measures, I want to identify which of my patients are missing key clinical data.
- Our Women’s Health clinic wants to focus on two clinical performance improvement initiatives this year. We want to identify the performance problem areas for female patients between ages 18 and 50.
- I am one of two part-time case managers for a group of children, and I want to create a patient list that we both can use.
5.2 Steps to Create a Panel

To create a panel, follow the steps below. Detailed information about each option is presented in the following Sections.

1. From the Panel List window, do any of the following:

   • Click the New button
   • Select the New option on the right-click menu
   • Select File | Panel | New

   The Panel Definition window will display where you can define the search criteria to be used to populate the list of patient members for the new panel.

   ![Initial Panel Definition Window](image)

   **Figure 5-1: Initial Panel Definition Window**

2. Type the unique name of the new panel in the required Panel Name field, limited to 120 characters (required field).
   - If you enter a duplicate name, iCare displays the “Panel Name is not unique, please choose another name” warning message when you try to move to another tab. Click OK on the message and enter a new name. (Otherwise, click Cancel.)

3. Type a description of your panel (limited to 250 characters). This is not a required field but is strongly recommended.

4. Select one of the Population Search Options radio buttons.
• **No Predefined Population Search**: a blank panel will be created and you can add patients individually. See Section 5.3.1 No Predefined Population Search for more information. This panel will not have an search logic associated with it and therefore all panel patient members will be added manually.

• **My Patients**: the panel will be based on the “My Patients” definition set in your User Preferences. See Section 5.3.2 My Patients for more information.

• **Patients Assigned to**: the panel will be based on a “My Patients” definition for another provider. See Section 5.3.3 Patients Assigned To for more information.

• **Scheduled Appointments**: the panel will be based on the RPMS Scheduling application. You will select an appointment date range and appointment locations. See Section 5.3.4 Scheduled Appointments for more information.

• **Qman Template**: the panel will be based on an existing QMan template. See Section 5.3.5 QMan Template for more information.

• **RPMS Register**: the panel will be based on any existing Register that was created with case management software, including the Diabetes Management System (BDM), the Case Management System (ACM), the Asthma Register System (BAT), or the HIV Management System (BKM). See Section 5.3.6 RPMS Register for more information. This option searches for patients that are members of various register applications on the RPMS server.

• **EHR Personal List**: the panel will be based on a selected personal list from the RPMS-EHR application. See Section 5.3.7 EHR Personal List for more information.

• **Ad Hoc Search**: the panel will be based on one or more data items. See Section 5.3.8 Ad Hoc Search for more information.

5. To preview the list of patients created from your population search logic, click the Preview tab. This will provide you with the opportunity to change logic as needed before saving the panel (on the Definition tab). See Section 5.6 Preview Tab for more information.

If you are ready to save your panel, skip to step 9 below. Otherwise, you can perform the following actions (in steps 6-8) before you save your panel.

6. To change the screen layout of your panel, click the Layouts tab. See Section 5.4 Panel Definition Layouts Tab for more information.

7. To share the panel with others, click the Sharing tab. See Section 5.5 Sharing Tab for more information.

8. To have your panel repopulated automatically (add or delete patients based on your panel logic), click the Auto Repopulate Options tab. See Section 5.7 Auto Repopulate Options Tab for more information.
9. Click OK to save and close the panel or Cancel to discard the incomplete panel.

If you click OK and it takes time to populate the panel, the “Background populate?” information message will display, asking you if you want to populate in the background. Click Yes to populate in the background. Click No to populate in the foreground.

If you have forgotten to enter a panel name or complete any of the search options, the warning message “Complete the required information in the highlighted field(s)” will display. See Section 4.6.4 Missing Data for more information on missing data fields.

After all of the tabs have been completed, click OK on the Panel Definition dialog. Your new patient panel will display on your Panel List window.

If you decide to NOT create a Patient Panel, click Cancel on the Panel Definition window to display a warning message.

Figure 5-2: Warning Message About Saving Changes

- Click Yes to save the changes to the panel. You will be warned about any missing information, if any.
- Click No to exit the Panel Definition window.
- Click Cancel to return to the current panel where you can continue to create the panel.

5.3 Population Search Options

To create a patient panel, you must select one of the Population Search Options radio buttons on the Panel Definition window. The following Sections provide details about each of the Search Options.

5.3.1 No Predefined Population Search

The default option “No Predefined Population Search - Add Patients Manually” creates an empty panel. You add the patients to the panel using a search tool. On the Definition tab, do the following:

1. Enter a panel name and description.
2. Click the “No Predefined Population Search” radio button from the Population Search Options list.

3. Click OK to create the panel. An empty panel is created and the Select Patients dialog is displayed.

4. Type the name, HRN, SSN, or DOB of the individual patient you want to add to your panel in the Search box. Then click Find. There are two conditions: (a) one or more matches are found or (b) no matches are found.

5. If one or more matches are found, they will be displayed.
Highlight the patients and click Add. (See Section 4.2 Selecting Records for more information about selecting patients). This adds the selected patients to the new panel. The Search field will be cleared of data.

6. If no matches are found, the warning message “No matching patients were found” will display. Click OK to dismiss the message. You return to the Select Patients dialog. Try another search criteria.

7. Search for additional patients by continuing to type name, HRN, SSN, or DOB in the Search box. Continue to highlight and add patients.

8. Click Add when you have added all of your patients. The Select Patients dialog will close and your panel will be displayed. (Otherwise, click Close; the panel will display with no patients in it.)
5.3.2 My Patients

If you select My Patient, you must have “My Patients” defined in the User Preferences (see Section 3.1.1.1 Define My Patients Tab). This search logic applies to any panel created using the “My Patients” option. On the Definition tab, do the following:

1. Type a name and definition for your panel.
2. Click the My Patients radio button. If you have “My Patients” defined, the Panel Definition will display, as below:

![Sample Populated New Panel]

Figure 5-5: Sample Populated New Panel
• If you do NOT have “My Patient” defined, you will have to Cancel the Panel Definition and set a definition for “My Patients” from the Tools | User Preferences menu (see Section 3.2 Modifying Your User Preferences).

3. Check the Apply Additional Filters check box to display additional data that can be used to refine the search.

• These are the same fields that display when you select the Ad Hoc Search radio button. See Section 5.3.8 Ad Hoc Search for detailed information.

4. Click OK on the Panel Definition dialog. The application displays the “Background populate?” information message, asking if you want to background process. Click Yes to populate the panel in the background. Otherwise, click No to populate in the foreground.

For example, you want the panel to contain female patients ages 45 to 47 for whom you are either the Designated Primary Care Provider or the Primary Visit Provider for at least three years in the past two years.
In this example, here are the steps to follow:

1. Make sure your “My Patients” definition has the following selections: the DPCP type and Primary Visit Provider type with 3 visits in the past 2 years. You can check this by holding your mouse over “Current Definition” phrase. If you need to modify “My Patient” definition, access it under Tools | User Preferences.

2. On the Panel Definition window, select My Patients and check the Apply Additional Filters checkbox.

3. Select Sex option Female.

4. Select Age “in range (inclusive)” and enter 45 and 47 for the age range.

**Note:** You can also create this same search logic by using the Patients Assigned To search option and selecting your name and provider definition.

### 5.3.3 Patients Assigned To

The Patients Assigned To option is similar to the “My Patients” definition but does not become a permanent User Preference. You will select your name or another provider’s name and then select one or more provider types that best define patients that are “assigned” to the provider selected. See Section 3.1.1.1 Define My Patients Tab for a more detailed explanation of each provider name and timeframe option.
This is a good option to use if you want to use a different definition for yourself for “your patients.” For example, if your User Preference designates “your” patients as Designated Primary Care Provider (DPCP) only, you might want to use both DPCP and primary visit provider.

This is also a good option for nurses or case managers who are responsible for working with two or three individual physicians. You can quickly create individual panels for each physician based on the physician’s specific role.

1. Type a name and definition for your panel.
2. Click the Patients Assigned to radio button. Additional data options are displayed.
3. Click the drop-down list for the Provider field (required) and select a name (a provider or surrogate provider). To search for a name, type the last name of the provider and the appropriate names will be displayed. Highlight the name. NOTE: you must have entered a name for your panel before the drop-down list becomes available.
4. After you populate the Provider to field, you need to indicate what type of provider the selected name is. The choices are:
   - DPCP (Designated Primary Care Provider): any patient who’s documented DPCP is the selected provider/surrogate. You use this option if the selected provider is using the Designated Specialty Provider Management (DSPM) option, in the RPMS application.
   - Specialty Provider: Users are assigned as Specialty Providers to patients as defined in the Designated Specialty Provider Management (BDP) application.

If the selected provider is NOT running DSPM, then you use the last two options, the Primary Visit Provider or the Primary/Secondary Visit Provider.
• **Primary Visit Provider**: any patient whose Primary Visit Provider is the selected provider/surrogate for a user-defined number of visits within a user-defined timeframe, e.g., a patient where the selected provider/surrogate was the Primary Visit Provider at least two times in the past six months. The defaults for the user-defined values are two visits within the past year.

• **Primary/Secondary Visit Provider**: any patient whose Primary/Secondary Visit Provider is the selected provider/surrogate for a user-defined number of visits within a user-defined timeframe. The defaults for the user-defined values are two visits within the past year.

• **Minimum Visits**: you can select the minimum number of visits used in combination with a time frame to define whether a patient “belongs” to a provider, e.g., two (2) visits in the past year. Values are 1 through 9; you must select the value from the drop-down list. The Minimum Visits option is used with Provider Types “Primary Visit” and “Primary/Secondary Visit” only.

• **Minimum Visit Timeframe**: you can select a timeframe to be used in combination with the minimum number of visits to define whether a patient “belongs” to a provider, e.g., 2 visits in the past year. Values are: 3 months, 6 months, 1 year, 2 years; you must select the value from the drop-down list. The Minimum Visit Timeframe option is used with Provider Types “Primary Visit Provider” and “Primary/Secondary Visit Provider” only.

5. If you checked the Primary Visit Provider or Primary/Secondary Visit Provider, select both a minimum number of visits and a timeframe (required).

6. Select the “Apply Additional Filters?” check box to display additional data that can be used to refine the search. These are the same fields that display when you select the Ad Hoc Search radio button. See the Section 5.3.8Ad Hoc Search for detailed information.

### 5.3.4 Scheduled Appointments

You use the Scheduled Appointments search option to find the patients with scheduled appointments in a specified date range or time frame for your new panel.

This is a good option to use if you are a nurse in a clinic that empanels patients (assigns a primary care provider to each patient), and you manage the patients for multiple physicians.

1. Type a name and definition for your panel.

2. Click the Scheduled Appts radio button.

3. You use the Appointment Range group box to set either a date range or a time frame. You must select one of the radio buttons.
Figure 5-9: Sample Scheduled Appointments Selection Options

By Date

Click the By Date radio button where you enter the date range for the scheduled appointments. See Section 4.6.3 Date Fields for more information. If you want one day only, both the beginning and end dates must be the same. The default is today’s date.

By Timeframe

If you select this option, the panel should be set to automatically Auto Repopulate at first login (see Section 5.7 Auto Repopulate Options Tab for more information).

Click the Timeframe radio button to select time frame associated with the date range (cannot be blank). Valid choices are on the drop-down list:

- Today
- Tomorrow
- This Week (to include today)
- Next Week (beginning one week from today)
- Next 30 Days (to include today)
- Yesterday
- Last Week (beginning yesterday)
- Last 2 weeks (beginning yesterday)
- Last 30 (beginning yesterday)

4. You use the Appointment Locations group box to select the appoint locations by which to search. You must select one of the radio buttons (By Scheduling Clinic or Visit Clinic). Generally you will use the Appointment code to display the list from the RPMS Scheduling application.
After selecting **By Scheduling Clinic** or **By Visit Clinic** and clicking Edit, you move to the “Add/Remove” dialog.

Figure 5-10: Sample Add/Remove Scheduling Clinics Dialog

See Section 4.8 Add/Remove Functionality for more information about the Add/Remove dialog.

When the Add/Remove dialog is complete, click OK. This action populates the By Scheduled Clinic/By Visit Clinic field on the Panel Definition window. (Otherwise, click Cancel). iCare searches for the patients in the clinics in the By Scheduled Clinic/By Visit Clinic field.

The *Appointment Status* field is populated by clicking the Edit button to display the Add/Remove Appointment Statuses. The intent of this option is to define a panel once and have it auto populate every day without having to manually change the date range. If you use this option, the panel should be set to Auto Repopulate (see Section 5.7 Auto Repopulate Options Tab for more information).

Figure 5-11: Add/Remove Appt Types

See Section 4.8 Add/Remove Functionality for more information about the Add/Remove dialog.
When the Add/Remove dialog is complete, click OK. This action populates the Appointment Status field on the Panel Definition window. (Otherwise, click Cancel). The search will be OR (not AND).

5. Select the “Apply Additional Filters?” check box to display additional data that can be used to refine the search.

These are the same fields that display when you select the Ad Hoc Search radio button. See Section 5.3.8 Ad Hoc Search for detailed information.

5.3.5 QMan Template

You use the QMan Template option to populate your panel with the patients identified in a specified QMan search template.

This is a good option to use if you or another RPMS user has already spent time creating QMan searches that you would like to reuse. For the expert user, QMan can produce highly complex searches.

1. Type in a name and definition for your panel.
2. Click the QMan Template radio button.
3. Click the Template Name drop-down list to display a list of available templates arranged in alphabetical order.

![Sample QMan Template List](image)

Figure 5-12: Sample QMan Template List

4. You can search for a template by typing a few characters in the QMan Template field; the list will scroll to the first instance of the name containing those characters.

   OR

   Use the scroll bar to browse through the list.

5. Highlight the template name.
6. If you need additional filters, check the “Apply Additional Filters?” check box; additional filter fields display at the bottom of the window (they are the same fields that display when you select Ad Hoc Search). See Section 5.3.8 Ad Hoc Search for more information.

User Tip: You can only select one QMan template for each panel. To create a panel containing multiple templates, create one panel for each template, and then copy all patients out of each panel into one combined panel. Duplicate patients will not be included.

Please note that if the QMan template is removed from the database and you try to modify that panel (using the template), the Template Name field will empty. In this case, close the Panel Definition window and create a new panel and copy the patients to the new panel.

5.3.6 RPMS Register

You use the RPMS Register option to populate your panel with patients who are already on a Register for any existing RPMS case management system. Examples of case management systems are Diabetes Management System (BDM), Case Management (ACM), the Asthma Register System (BAT), and the HIV Management System (BKM). Currently, only the Case Management System has multiple Registers.

Note: Any Register created within the Diabetes Management System that is NOT the “official” IHS Diabetes Register can be located by selecting the Case Management System option, and then scrolling to the named diabetes sub registers.

1. Type the name and definition for your panel.
2. Click the RPMS Register radio button.
3. Click the Register Name drop-down list to display the list of RPMS registers in alphabetical order.
4. Begin by typing the name of the Register and the list will scroll to the first occurrence of the typed letters. Highlight your selection.

The Case Management System option requires secondary data.

You must select a sub-register from the drop-down list.

The default Status is ACTIVE (for any of the Register options). To change the Status, click Edit to display the Add/Remove Register Statuses dialog.

See Section 4.8 Add/Remove Functionality for more information about the Add/Remove dialog.
When the dialog is complete, click OK. This action populates the Status field on the RPMS Register Parameters dialog. (Otherwise, click Cancel).

5. If you need additional filters, check the “Apply Additional Filters?” check box; additional filter fields display at the bottom of the window (they are the same fields that display when you select the “Ad Hoc Search” radio button). See the Section 5.3.8 Ad Hoc Search for more information.

5.3.7 EHR Personal List

You use the EHR Personal List option to use an existing defined personal list from the RPMS-EHR application.

After you select this option and there is no existing personal list, the application displays the Warning: No Selections Available message that reads: There is no EHR Personal Lists for selection. Click OK to dismiss the message.

If there are personal lists available, follow these steps:

1. Type a name and definition for your panel.
2. Click the Edit button associated with the Personal List field. The application displays The Add/Remove EHR Personal Lists dialog. You can use one or more selections. See Section 4.8 Add/Remove Functionality for more information. When this dialog is complete, click OK (otherwise, click Cancel).
3. If you need additional filters, check the “Apply Additional Filters?” check box; additional filter fields display at the bottom of the window (they are the same fields that display when you select the “Ad Hoc Search” radio button). See the Section 5.3.8 Ad Hoc Search for more information.

5.3.8 Ad Hoc Search

You use the Ad Hoc Search option to combine one or more common search criteria, such as age, gender, community, or visit date range, to define the patient population that you want.

1. Type a name and definition for your panel.
2. When you click the Ad Hoc Search radio button, the Definition tab displays with all of the filter collapsed, as shown below:
The information after the name of the filter shows any filters defined on it. For example, in the above screen capture, Visit Range and # of Visits were defined for the Visit filter.

After completing the filter options, click OK to use the filter options in creating a new patient panel.

3. Expand the Filters area to display the criteria that you can select.

4. The Ad Hoc Search allows you to use one or more filter options to define the patient population that you want. The following Sections discuss the filter options: Patient, Visit, Other.
5.3.8.1 **Patient Group Box**

You can enter a filter by using the field in the Patient group box. You can expand/collapse the Patient group box by clicking the button in the upper, left corner.

![Patient Criteria Group Box](image)

Figure 5-18: Patient Criteria Group Box

Age: You can enter a filter by age by using a criteria statement and age. Click the drop-down to select the criteria statement.

- Less than, e.g., a panel of children could be defined as ages less than 19.
- Less than or equal to, e.g., the same panel of children in the previous example could be defined as ages less than or equal to 18.
- Equal to, e.g., create a panel of patients aged 50 to identify those who should have a colorectal exam.
- Greater than or equal to, e.g., a panel of adults could be defined as ages greater than or equal to age 19.
- Greater than, e.g., the same panel of adults in the previous example could be defined as ages greater than age 18.
- In range (inclusive), e.g., create a panel of women ages 45 through 60 with this option.
- Out of range (exclusive), e.g., 20-25, exclusive means ages 21, 22, 23, 24. There will be a date range for Age if you select: (1) in range (inclusive) or (2) out of range (exclusive). For example: 20-25, inclusive means 20, 21, 22, 23, 24, 25 whereas 20-25, exclusive means 21, 22, 23, 24.

Type the age to be used in the search in the middle field (limited to 3 characters).

The drop-down list for the last field for the Age criteria defines the units of measure for the age: YRS (for years), MOS (for months), DYS (for days).
Beneficiary: You use the Beneficiary field to search for either AI/AN or non-AI/AN Classification/Beneficiary patient categories. This is similar to the CRS reports where users can select a patient population based on the Classification/Beneficiary categories in Patient Reg. Click the Edit button to display the Add/Remove Beneficiaries dialog. **NOTE:** a blank (selection) will include all patients.

**Figure 5-19: Add/Remove Beneficiaries Dialog**

See Section 4.8 Add/Remove Functionality for more information about the Add/Remove dialog.

When the Add/Remove dialog is complete, click OK. This action populates the Beneficiary field in the Patient group box. (Otherwise, click Cancel).

Category: Use this option to restrict your search to one of the following: Living, Decease, Both.

**Figure 5-20: Sample Category group box**

If you use Deceased or Both, you can select a Date of Death date range. By selecting either of these categories, this activates the Date of Death fields. If you do not use a date of death date range, all deceased patients are searched.

Community: Use this option to restrict your search to patients defined in a community either by taxonomy or by name. This option used the Active patients in the database for each associated Community of Residence. Active is defined as a patient with at least one active HRN on the server, regardless of the division that the user is logged in to.
To define the community by taxonomy, click the By Taxonomy radio button. Then select an option from the drop-down list. This populates the By Taxonomy and Including fields in the Community group box.

To define the community by name, click the By Name radio button. You select an option from the drop-down list for the By Name field; your selection determines the number of patients in the community (or least one or all); With At Least One Patient is the default.

Use the Edit button to determine which community to use in the search. Click Edit to display the Add/Remove Communities.

See Section 4.8 Add/Remove Functionality for more information about the Add/Remove dialog.

Click OK when the Add/Remove dialog is complete. This populates the field by the Edit button.

If you select more than one community, this activates the Create Taxonomy button.
The use the Create Taxonomy button, the user must have the iCare Editor (BQIZCMED) or iCare Package Manager (BQIZMGR) security key.

Clicking the Create Taxonomy allows you to save those communities as a Community taxonomy. This action will change the panel definition from a list of communities to the new Community taxonomy name. See Section 4.16 Creating a Community Taxonomy for more information.

Diagnostic Tag: Use this option to restrict your search to patients with one or more of the predefined diagnostic tags. See Section 2.2.1 Diagnostic Tag for a detailed explanation of how iCare creates proposed diagnosis tags. You need to expand the Diagnostic Tag selection to display the entire Diagnostic Tag group box.

Click the Edit button. There are two conditions that could be present: (1) taxonomies that do not have any entries or (2) all taxonomies have entries. If there are any taxonomies that do not have any entries, the iCare Taxonomy Check warning message displays, giving you information about the entries. This message makes you aware that some definitions are missing and might affect the accuracy of the diagnostic tags. (Click OK to dismiss the message).

The Add/Remove Diagnostic Tags dialog displays.
See Section 4.8 Add/Remove Functionality for more information about the Add/Remove dialog.

After completing the Add/Remove dialog and clicking OK, the Diagnostic Tag group box becomes populated.

Below are the definitions of the labels for the tag:

- A = Accepted
- N = Not Accepted
- P = Proposed
- V = No Longer Valid
- S = Superseded

The default tag selection will be Proposed and Accepted, as shown in the above example. You can change the tag selection for any record by selecting or de-selecting any checkbox.

You can click the “use AND?” check box when there are multiple tags selected. The “And” option searches for patients who have ALL of the user-defined tags.
5.3.8.2 **Visit Group Box**

You can enter a filter by using the fields in the Visit group box. You can expand/collapse the Visit group box by clicking the button in the upper, left corner.

![Visit Group Box](image)

**Figure 5-27: Visit Group Box**

You can either criteria for either BY DATE or BY TIMEFRAME (not both).

By Date: You can enter a filter by Visit Date. Enter the beginning and ending dates. See Section 4.6.3 Date Fields for more information. If you want one day only, both the beginning and ending dates must be the same. The intent of this feature is to allow the user to define a panel once and have it auto populate every day without having to manually change the Date range.

By Timeframe: This feature allows you to define a panel once and have it auto populate every day without having to manually change the Date range. After clicking the By Timeframe radio button, select an option from the drop-down list:

- Last Week (beginning yesterday)
- Last 2 Weeks (beginning yesterday)
- Last Month
- Last 6 Months
- Last Year

If you use this field, the panel should be set to Auto Repopulate at the first daily login; you can change the Auto Repopulate option. See Section 5.7 Auto Repopulate Options Tab to view the information this tab on the Panel Definition window.

Using the By Timeframe option activates the # of Visits in Range and Visit Clinic fields.

# of Visits in Range: You can specify the additional filter for the number of visits within the Timeframe option. The modifier option are the same as those of age (less than, less than or equal to, equal to, greater than, greater than or equal to, in range, out of range). The purpose of the additional field is to allow you to create panels of patients who have had so many visits within a user-defined timeframe. The default value is 1, with available values of 1 through 99.
Visit Clinic: You can filter the within the Timeframe option by visit clinic. To populate this field, click the Edit button to display the Add/Remove Visit Clinics dialog. See Section 4.8 Add/Remove Functionality for more information about this dialog.

![Add/Remove Visit Clinics Dialog](image)

Figure 5-28: Add/Remove Visit Clinics Dialog

You can search for a clinic by entering either the clinic name or the clinic code in the Find field.

See Section 4.8 Add/Remove Functionality for more information about the Add/Remove dialog.

When the Add/Remove dialog is complete, click OK. Your selections will populate the Visit Clinic field.

Provider: You can enter a filter by Visit Provider. Click the drop-down list and select a name. Only the names on the list are valid entries.

5.3.8.3 Other Group Box

You can enter a filter for panels in the Other group box. This restricts your search to those patients who are members of a panel (you can select one or more panels).

![Other Group Box](image)

Figure 5-29: Other Group Box

To search by Panels, click the Edit button to display the Add/Remove Panels dialog.
See Section 4.8 Add/Remove Functionality for more information about the Add/Remove dialog.

When the Add/Remove dialog is complete, click OK. This populates the Panel field in the Other group box.

5.4 Panel Definition Layouts Tab

The Layouts tab allows you to permanently change your panel display by defining the Patient List, Reminders, Nat’l Measures, Asthma, and HIV/AIDS layouts.
All of the layouts have the same functionality in that you add and remove the columns to be displayed, add or remove the columns to be sorted, determine the sort order of the columns.

5.4.1 Edit Patient List Layout

After you click the “Edit Patient List Layout” button on the Panel Definition window, the Patient List Layout for the selected patient panel displays.

![Patient List Layout](image)

Figure 5-32: Patient List Layout for Selected Panel

See Section 4.9 Layout Dialog Functionality for information on how to use this layout dialog.

5.4.2 Edit Reminders Layout

After you click the “Edit Reminders Layout” button on the Panel Definition window, the Reminders Layout for the selected patient panel displays.
Figure 5-33: Reminders Layout for Patient Panels

See Section 4.9 Layout Dialog Functionality for information on how to use this layout dialog.

5.4.3 Edit Nat’l Measures Layout

After you click the “Edit Natl Measures Layout” button on the Panel Definition window, the National Performance Layout for the selected patient panel displays.
See Section 4.9 Layout Dialog Functionality for information on how to use this layout dialog.

5.4.4 Edit Asthma Layout

After you click the “Edit Asthma Layout” button on the Panel Definition window, the Asthma Layout for the selected patient panel displays.
See Section 4.9 Layout Dialog Functionality for information on how to use this layout dialog.

5.4.5 Edit HIV/AIDS Layout

After you click the “Edit HIV/AIDS Layout” button on the Panel Definition window, the HIV/AIDS Layout for the selected patient panel displays.
5.5 Sharing Tab

If you want to share your panel with other RPMS users, click the Sharing tab in the Panel Definition window. You can select one or more users who can share your panel and assign access rights the selected user will have.

When you share a panel, the shared user will receive a notification about the shared panel. If you do not see a panel that is shared with you, select View | Refresh on the Main Window menu.

This tab will not be available if the Share button is inactive on the Panel List view for the patient list.
See Section 4.5 Buttons on Right Side of Window to learn about how to use the buttons on the right side of the Sharing tab window.

**Note:** You can share a panel at any time by opening the panel and clicking the Share button.

The lower grid shows a history of the users (that have not been removed/deleted) with whom you have shared the current panel.

The following information describes the fields and buttons on the Sharing tab.

- **Shared with:** Your selection from the drop-down list is the person with whom you want to share your panel.
- **Shared Access:** The radio buttons become active after you populate the “Shared with” field.
• **Read Only**: use this radio button to allow the person sharing your panel to only view your panel. The shared user can change the layout of a panel.

• **Read/Write**: use this radio button to allow the person sharing your panel to view and change your panel (for example, add or delete patients).

• **Inactive**: use this radio button to assign the person sharing your panel inactive access rights.

• **Temporary**: Select the Temporary check box to display a date range for the temporary status of the shared user. The access rights will only apply during the specified data range and will automatically expire once the specified date range has passed.

![Temporary Status](image)

Figure 5-40: Sample Temporary Status

For Temporary status you must select a date range. See Section 4.6.3 Date Fields for more information about entering dates. The default is today’s date.

• **Shared Layouts?**: check this checkbox if you want to share the your layouts of one or more of three panel views: Patient List, Reminders, and/or National Measures. The shared user will see the same layout modifications made by the creator.
  – This causes the Shared Layouts cell to contain Y.
  – The shared user will continue to be able to make modifications to the layouts of that shared panel. These modifications will not affect the creator’s layouts.

• **Add**: click this button to add the information in the Shared with, Shared Access, Temporary, and Shared Layouts fields to the lower grid. This action clears the existing fields (before the Add).

![Lower Grid](image)

Figure 5-41: Shared User Information in Lower Grid

• **Apply**: click this button to change the Shared Access and/or Temporary status of a selected user in the lower grid. You can change the shared access rights; for example, change the access rights from Read Only to Read/Write. Then click the Apply button to reflect the changes in the lower grid.

• **Remove**: highlight one or more names in the lower grid and click this button to remove the name(s) from the lower grid. It might be more useful to inactivate the user instead of removing the user. After clicking the Remove button, the “Delete Row” information message displays, asking if you want to delete the selected names. Click Yes to delete (otherwise, click No).
5.6 **Preview Tab**

Click the Preview tab to show the patients retrieved from the characteristics for the patient population indicated on the Definition tab. The Preview tab does not require any edits or changes. Changing the column order, sort order, and filters are not preserved; instead use the Layout tab for column and sort order. Filters should be applied in the panel view in order to save the filter criteria.

5.7 **Auto Repopulate Options Tab**

Use the Auto Repopulate Options if you want the contents of your panel to be dynamic, i.e., *automatically* refreshed. This is a good option to use if you have defined panels by ages or by visit dates; patients will be automatically added or deleted based on the search logic.

*Note:* You can manually repopulate a panel at any time by selecting the panel from the Panel List and clicking the Repopulate button.

![Auto Repopulate Options Tab](image)

Figure 5-42: Auto Repopulate Options Tab

The only group box that is active on this tab is the Repopulate Settings. (This option is not active if the panel definition was based on No Predefined Population Search.)
Check the Auto Repopulate check box to specify that you want the panel to automatically refresh the patient list based on the panel’s defined search criteria. You must then select when you want your panel to be re-populated, either During Nightly Job or First Login Each Day.

**Note**: A large panel (over 1,000 records) might take a lot of time to repopulate. It is recommended that you use the During Nightly Job option for the larger panels.
6.0 Panel List

The Panel List shows a list of your current panels, including the default panel, the panels created by the user, and the panels shared with you by other users.

![Sample Panel List View](image)

Figure 6-1: Sample Panel List View

The Startup View tab on User Preferences determines the view that will display when you first login to iCare. See Section 3.1.1.3 Startup View for more information.

To view the Panel List window, do one of the following:

- If you are in Split View, the Panel List will be in the left frame.
- If you are not in Split View, you need to click the Panel List tab.
- If you are in another window, select the iCare Main option from the Window menu.

6.1 Panel List View Layout

The Panel List has the following data columns:

- **Flag**: the Flag Indicator icon displays in the first column if one or more patients in any of the panels have any flags.
- **Panel Name**: user-defined name of the panel (required).
- **Panel Description**: user-defined description of the panel.
- **# of Pts**: the number of patients in the panel.
- **Last Updated**: the date and time the contents of the panel was last updated by a manual (user) repopulate, by an auto-repopulate, or the panel created date, if the panel has never been repopulated.
- **Last Updated By**: the name of user who either created or last repopulated the panel.
- **Owner**: the name of the user who created (“owns”) the panel.
• **Shared With:** this column has different icons representing whether a panel has been shared by you with other user or shared with you by a user.

You can view how your patient panel is shared by hovering your mouse over the last column of the panel.

![Shared with: ADAM,ADAM [R] (Apr 16, 2007 - Apr 23, 2007)](image)

Figure 6-2: Sample Shared With Information

The icons in the Shared With column have the following meanings:

- The icon means you have Read/Write access to the panel.
- The icon means you created the panel and have shared it with other users.
- The icon means you have read-only access to the panel.

You can sort and/or filter any column, re-arrange the order of the columns, etc. See Section 4.1 Working with Columns for more information.

### 6.2 Panel List Toolbar

See Section 4.5 Buttons on Right Side of Window to learn about how to use the buttons on the right side of the toolbar.

The toolbar buttons and menu options determine what actions you can take on this window.

#### 6.2.1 New Panel

You use the New function to create a new panel. You can create a patient panel in one of the following ways:

- Clicking the New button
- Selecting the New option on the right-click menu
- Selecting File | Panel | New
- Pressing the key combination of Ctrl+N

Any of the above actions displays a blank Panel Definition window where you can create a new panel. See Section 5.0 Creating Patient Panels for more information about this window.
6.2.2 Open Panel

You use the Open function to show the patients in one or more selected panels. Highlight the panels by holding down the Ctrl key and then use the Open function.

You can open selected panels by doing one of the following:

- Clicking the Open button
- Selecting File | Panel | Open
- Selecting the Open option on the right-click menu
- Double-clicking on the panel
- Pressing the Ctrl+O key combination
- Selecting File | Recent Panels and selecting the panel name (the list is limited to the last five panels that you have viewed)

A Panel View window displays for each of the selected panels, showing the patients for the panel. See Section 9.0 Panel View for more information about this window.

More than one user can open a shared panel simultaneously. The second and subsequent users to open the same panel will have “read only” access to the panel content. If the first user closes the panel, the second user will be notified that the panel is now available for “edit” access, unless the user only has been provided with Shared Read Only access by the panel creator.

6.2.3 Delete Selected Panel

You can delete panels that are no longer useful. There are two conditions for the delete function: (1) when you delete a panel you created and (2) when you delete a panel that was shared with you.

6.2.3.1 Delete Panel You Created

You can delete a panel that you created. Highlight one or more panels by holding down the Ctrl key and then use the Delete function.

You can delete the selected panels by doing one of the following:

- Clicking the Delete button
- Selecting File | Panel | Delete
- Selecting the Delete option on the right-click menu
• Pressing the Delete key on your keyboard

The “Confirm panel delete” dialog displays, asking if you want to delete the selected panel. Click Yes to delete the panel. Its name will no longer appear in the Panel List view. (Otherwise, click No to not delete the panel).

Shared users with shared access to the deleted panel will receive notification that you (the person who deleted the panel) are no longer sharing the panel. See Section 11.0 Notifications for more information about this window.

![Figure 6-3: Sample iCare Notification for Deleting a Shared Panel](image1)

If you are in the Delete Process and you clicked Yes and the selected panel is open in another window, the following message will display:

![Figure 6-4: Warning Message About Panel Open in Another Window](image2)

Click OK to dismiss the warning and you return to the Panel List window. In order to delete the panel, you need to close it and then use the Delete process.

6.2.3.2 Delete Panel Shared with You

If you delete a panel that was shared with you, you will no longer see the panel on your list, i.e., the shared access is deleted but the panel remains for the panel creator and other shared users.
6.2.4 Repopulate Selected Panel

You use the Repopulate function on the Panel List when the patients in a selected panel need to be updated with new data (for example, some patients have moved). Repopulate reruns the panel definition against the cached data (from the nightly job) where it adds patients who meet the criteria and removes the patients that no longer meet the criteria.

You can repopulate the highlighted panel by doing one of the following:

- Clicking the Repopulate button
- Selecting File | Panel | Repopulate
- Selecting the Repopulate option on the right-click menu
- Setting the Auto Repopulate Options under the panel modifications (use the Modify button)

The “Repopulate Panel” warning message displays asking if you want to update the patient list for the panel. Click Yes to repopulate the patient list. (Otherwise, click No to not process and to return to the Panel List.) This message does not appear for Auto Repopulate.

The repopulate process (cannot be undone) will run as a background operation.

The “clock” icon will appear to the left of the panel name while the process takes place; the date and time of the Last Updated column will be updated.

![Figure 6-5: Example of Panel List During Repopulate Process](image)

6.2.4.1 Other Warning Message

If you manually edited (added or removed) patients in the panel, the Maintain Manual Changes warning message will display.
6.2.4.2 Panel Open in Another Window

If you are in the Repopulate Process and you clicked Yes and the selected panel is open in another window, the following message will display:

Figure 6-7: Warning Message about panel open in another window

Click OK to dismiss the warning and you exit the repopulate process.

6.2.4.3 Repopulate Not Active

You will not be able to repopulate a panel if your shared access is read-only. The following repopulate options are:

- The Repopulate button will be inactive
The Repopulate option on the right-click menu will be inactive
The Repopulate option on File | Panel will be inactive

6.2.5 Modify Selected Panel

You use the Modify function to change the panel definition for a selected panel.

You can modify a highlighted panel by doing one of the following:

- Clicking the Modify button
- Selecting File | Panel | Modify
- Selecting the Modify option on the right-click menu

If the selected panel is already open, a message about the panel being already open displays.

![Figure 6-8: Panel Already Open Message](image)

Click OK and you move to the panel described in the message. You will modify the panel from this window.

When you select the Modify process, the Panel Definition window displays, showing the population criteria.
Below is an overview of the tabs on this window:

- **Definition**: allows you to specify the panel’s name and description as well as what criteria to use to populate the panel. See Section 5.3 Population Search Options.

- **Layouts**: allows you to select the columns for your panel. See Section 5.4 Panel Definition Layouts Tag.

- **Sharing**: allows you to share your panel with RPMS users. See Section 5.5 Sharing Tab for more information.

- **Preview**: allows you to view the patients retrieved for the panel. This tab requires no edits.

- **Auto Repopulate Options**: allows you to have your panel automatically refreshed. See Section 5.7 Auto Repopulate Options Tab for more information.

### 6.2.6 Share Selected Panel

You use the Share function to define users who can share your panel.

You can share a highlighted panel by doing one of the following:

- Clicking the Share button
• Selecting File | Panel | Share
• Selecting the Share option on the right-click menu

The Panel Definition window opens to the Sharing tab. See Section 5.5 Sharing Tab for more information about sharing a panel.

You will not be able to share a panel if your Share access is read-only. In this case, the following Share options are:

• The Share button will be inactive
• The Share option on File | Panel will be inactive
• The Share option on the right-click menu will be inactive

6.2.7 Copy Panel

You use the Copy function to create a new panel by copying one of your existing panels and saving it with a new name. What is copied is the patient population and the panel definition along with any added or deleted patients.

You can copy a highlighted panel by doing one of the following:

• Clicking the Copy button
• Selecting File | Panel | Copy
• Selecting the Copy option on the right-click menu

The Copy Panel dialog displays.

Figure 6-10: Sample Copy Panel Dialog

The default name displays in the Panel Name field. You can edit the name.

The Panel Name field contains a right-click menu for editing the text. See Section 4.6.1 Free Text Fields for more information about this menu.

The Copy Layouts check box determines if the layouts of the columns are in the copy process. The default is checked.
Click OK to have the “new” panel added to the Panel List view. (Otherwise, click Cancel to exit the copy process.)

Once copied, you can modify the panel in any way, such as changing the panel definition, adding and deleting the patient names, etc.

If the entered name is a duplicate name, the “Panel Name is unique, please choose another name” warning message displays. Click OK to dismiss the message and you return to the Copy Panel dialog.

6.2.8 Panel Properties

You can view the properties of a highlighted panel by selecting File | Panel | Properties (or by selecting the Properties option on the right-click menu). The Panel Properties pop-up displays. Click OK to dismiss the pop-up.

The information shows data related to the weekly and nightly background processes, including start and stop times.

![Sample Panel Properties Pop-up](image)

Figure 6-11: Sample Panel Properties Pop-up

The **General** tab provides information about the panel name, when the panel was created and who created it, the panel description, and any filters used to create the panel.
The **Update History** tab provides information about the auto repopulate status, when the panel definition was last modified and who modified it, when the patient list was last populated and who modified it, and when the patient list was manually updated.

The **Shared/Access** tab provides information about the shared users for the current panel and their access rights.

The **Flag Setup** tab provides information about the timeframes for the flag types (defined in User Preferences).

### 6.3 Panel List Menus

The File, Tools, and View menus for the panel list window are reviewed below.

See Section 4.3 Menus for an overview of the Edit, Window, and Help menus.

#### 6.3.1 File Menu on Panel List

Below are the options on the File menu.

![Figure 6-12: File Menu Options](image)

**Panel**: The sub-menus contain the actions that you can take on this window. For example, the Open option will display the patients in the selected panel.

See Section 3.1 Your First Login for more information about the Change RPMS Server and the Change RPMS Login options.

**Change RPMS Server**: This option allows you to change the server information on the RPMS Server Address dialog.
**Change RPMS Login:** This option allows you to change your access and verify codes to the iCare application on the RPMS Login dialog.

**Change RPMS Division:** This option allows you to change the RPMS Division on the Select Division dialog. This option applies to a site that uses more than one RPMS database.

![Sample Select Division Dialog](image)

**Recent Panels:** This sub-menu shows your recent panels. If you select one, you can view the patients in the selected panel in a new window. The list of panels is the last five panels that you have viewed.

**Page Setup:** This option allows you to set Margin, Paper, Layout characteristics (like landscape or portrait orientation), and the Printer to use. These settings are used when you use the Print option.

**Print Preview:** This option displays the print preview dialog.

**Print:** This option sends the page to the printer using the settings in Page Setup. Note that only the selected tab (Panel List or Flag List) will be printed.

**Background Jobs:** This option displays the Background Jobs pop-up. This pop-up displays, for example, the start and end dates for the nightly and weekly background jobs. See Section 4.11 Background Jobs for more information.

**Exit iCare:** The option allows you to leave the iCare application. You will be reminded to save any changed panels (if needed).
6.3.2 Tools Menu on Panel List

Below are the options on the Tools menu.

![Tools menu options](image)

**Quick Patient Search**: This option allows you to search for a patient name. This is the same as using the F8 key on your keyboard. See Section 4.4 Quick Patient Search for more information.

**Reset View**: This option resets the current view (one that was altered, such as changing the columns) to the default view.

**Refresh**: This option updates any RPMS field values on this view with new data from the server. This is the same as using the F5 key on your keyboard.

The **Search**, **Excel Export**, **Print**, and **Copy Rows to Clipboard** options work like the buttons on the right side of the window. See Section 4.5 Buttons on Right Side of Window for more information.

**User Preferences**: This options opens the User Preferences window. See Section 3.2 Modifying Your User Preferences for more information.

**View iCare Notifications**: This option open the iCare Notifications pop-up. See Section 11.1 iCare Notifications Window for more information.

**Package Manager**: This option is active for those users with Package Manager security key. See Section 4.13 Package Manager Functions for more information.
**Taxonomy Maintenance:** This option is used by those users who can maintain taxonomies. Also, you use this option to view the taxonomy elements. This option has the following two features:

**View/Edit Taxonomy Entries:** this feature displays the iCare Taxonomy View/Edit dialog. See Section 4.15 iCare Taxonomy Editor Function for more information. This option will have “Edit” in its label only if you can edit the taxonomy.

**Taxonomy User Access:** this feature is active for those user with the proper security key. Selecting this option displays the iCare Taxonomy User Access Management window.

![Figure 6-15: iCare Taxonomy User Access Management for Taxonomy Editor](image)

This window displays the users who have been given basic access to the iCare application by your Site (IT) Manager. You cannot give Editor or Package Manager access to iCare who does not have basic access. See your Site Manager to request basic iCare access for other users. This information is available when you click the Help menu.

The Site Manager can select or de-select the Taxonomy Editor role for a user on the list. The taxonomy editor role allows the user to view/edit the iCare taxonomies. Click OK to save the changes (otherwise, click Cancel).

**Web Links:** this option shows several categories (such as Asthma) that have Web links. When you select a Web link, the Internet browser for the particular category opens.
6.3.3 View Menu on Panel List

The View menu on the iCare Main window provides a way to change between the Split View and tab view. If the Split View option is selected, a Refresh option is also displayed.

![Sample View Menu](image)

Figure 6-16: Sample View Menu

**Split View**: When this option is checked, that means that the current view is the split view. You can change to the Panel List view or the Flag List view by removing the checkmark; this is a temporary setting. When you exit iCare and reopen iCare, the settings set under User Preferences for the default screen are used.

**Refresh**: Use this option to refresh the current window (usually after a panel is shared with you while you are in iCare). This is the same using the F5 key on your keyboard.
7.0 Flag List

The Flag List displays specific data about the flags for any patients on any of the panels on the panel list, including shared panels. This is referred to as the Master Flag List.

![Sample Flag List Window](image)

Figure 7-1: Sample Flag List Window

If you are in Split View, the Flag List will be in the right frame. If you are not in Split View, you need to click the Flag List tab. If you are in another window, select iCare Main from the Window menu.

7.1 Flag List Layout

The default display has the flag listed alphabetically by flag date (most recent first), by patient name, and then by flag type. No duplicate values are displayed in the first column. This means if a particular date has more than one flag, the date will be displayed only on the first row.

The iCare application will display an initial list of flags at first login only for the timeframe that is defined in the User Preferences. See Section 3.1.1.2 Flag Setup Tab for more information. Likewise, you can change the flag view to display modified flag types and/or timeframes if you change the User Preferences. After changing the flag settings in User Preferences, refresh the flag view.

7.1.1 Flag List Columns

The Flag List view has the following columns:

- **Flag Date**: The date the flag became active, e.g., the date of the hospital admission.
- **Patient Name**: This is a required field and will link to the patient’s Patient Record if you double-click on it. See Section 10.0 Patient Record for more information.
• **HRN**: Health Record Number (required)
• **Sex**: Either F (for Female) or M (for Male)
• **Age**: The patient’s age.
• **DOB**: Date of Birth (required)
• **Flag Type**: This can be Abnormal Lab Values, ER Visit, Unanticipated ER Return Visit, Hospital Visit. See Section 7.1.2 Flag Types for more information.
• **Flag Description**: A brief description of the event that caused the trigger.
• **Designated PCP**: Designated Primary Care Provider, if any. Not all facilities use this field to empanel patients.

You can sort/filter the columns and perform other functions on the columns. See Section 4.1 Working with Columns for more information.

### 7.1.2 Flag Types

The Flag Type column contains various flag types, as defined in the following table:

<table>
<thead>
<tr>
<th>Flag Type</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abnormal Lab Values Alert</td>
<td>This flag type informs the user when a patient has abnormal lab values within a user-defined timeframe, based on the Kernel Alerts component. The Abnormal Lab Values alerts, generated from the RPMS Laboratory application, reside in the Kernel Alerts component. If the ALV alert is closed by the provider in Kernel Alerts, it will no longer display in iCare, regardless of the Flag Display Timeframe selected by the user in the User Preferences.</td>
</tr>
<tr>
<td>ER Visit</td>
<td>This flag type informs the user when a patient has an emergency room visit within a user-defined timeframe. This flag is generated directly by iCare. ER visits (clinic code 30) is the trigger for this flag.</td>
</tr>
<tr>
<td>Unanticipated ER Return Visit</td>
<td>This flag type informs the user when a patient has an emergency room visit designated as “unanticipated” within a user-defined timeframe. This flag is generated directly by iCare. ER visits (clinic code 30) with Visit Type “Unscheduled Revisit” is the trigger for this flag.</td>
</tr>
<tr>
<td>Hospital Admission</td>
<td>This flag type informs the user when a patient has a hospital visit within a user-defined timeframe. This flag is generated directly by iCare. Any visit with service category H where the discharge date is not the same day as the admission date is the trigger for this flag.</td>
</tr>
</tbody>
</table>

### 7.2 Flag Toolbar

The text near the top right of the toolbar shows the flag set-up information.
See Section 4.5 Buttons on Right Side of Window to learn about how to use the buttons on the right side of the Flag List window.

7.2.1 Show Field

What flags are displayed on this window is determined by the option selected on the Show field. Your choices are:

- **Active Flags**: Active is defined as a flag that has not expired and has not been hidden by the users.
- **Hidden Flags**: Those flags that you specified to be hidden, using the Hide button.
- **All Flag**: All flags, hidden as well as active.

7.2.2 Hide

You can hide a highlighted row in the Flag List grid by doing any of the following:

- Clicking the Hide button
- Selecting File | Flags | Hide
- Selecting the Hide option on the right-click menu
- Pressing the F3 key on your keyboard

You can view the hidden flags by selecting the Hidden Flags option on the Show field.

7.2.3 Show

If you need to cause a hidden flag to re-appear in the current view, select it from the list on the Hidden Flags option (from Show field) and do any of the following:

- Click the Show button
- Select File | Flags | Show
- Select the Show option on the right-click menu
- Press the F4 key on your keyboard
7.2.4 Status of Background Jobs

You can check the status of the background jobs on the RPMS iCare - Background Jobs window. See Section 4.11 Background Jobs for more information.

To check on the status of the background jobs, do one of the following:

- Click the Background Jobs button
- Select File | Background Jobs

7.2.5 Mail Merge

Click the Mail Merge Export button (or select Tools | Mail Merge or press Ctrl+M) to display the Mail Merge Export window. See Section 4.10 Mail Merge for more information about the mail merge process.

7.3 Flag List Menus

See Section 4.3 Menus for information on using the Edit, Window, and Help menus.

7.3.1 File Menu

The File menu for the Flag List window has the same options as the iCare Main File Menu, except for one option. The Flags option that has the following selections:

- **Hide**: this hides a highlighted row in the Flag List grid.
- **Show**: this causes a hidden flag to re-appear in the current view.
- **Refresh**: this updates any RPMS field values on this view with new data from the server.

7.3.2 View Menu

The View menu on the Flag List window provides a way to change between the Split View and tab view. When the Split View option is checked, that means that the current view is the split view. You can change to the Panel List view or the Flag List view by removing the checkmark; this is a temporary setting. When you exit iCare and reopen iCare, the settings set under User Preferences for the default screen are used.
7.3.3 Tools Menu

The options on the Tools menu for the Flag List window is the same as those on the Tools Menu on the Panel List window. See Section 6.3.2 Tools Menu on Panel List for more information.
8.0 Community Alerts

Community Alerts inform providers that there has been an occurrence of either a communicable disease listed in the CDC’s Nationally Infectious Notifiable Diseases or suicidal behavior in a specific community. The intention is to provide information as soon as it is known to providers so that early intervention is possible. The alert is anonymous and does not display the name of the patient that triggered the alert; only the name of the community where patient resides when the incident occurred displays.

- The CDC Nationally Notifiable Infectious Diseases (NND) alert is defined as: Any primary care visit within the past 30 days with any Purpose of Visit (POV) identified in the CDC NND table. The CDC NND logic will review primary care visits only.
- The Suicidal Behavior alert is defined as: Any AMH or PCC visit within the past 30 days with Suicide Ideation, Attempt, Completion or Not Categorized.

Only one (1) alert per patient per 30 day period should be displayed.

The triggers for a Community Alert are placed into one of three categories: Mandatory, Recommended, Optional. You can determine which Recommended and Optional alerts that you want to display on the alert (all mandatory ones will display). The default display will be the Mandatory and Recommended diagnosis groups. See Section 3.2.5 Comm Alert Setup Tab for more information.

For this version, the logic will only display each alert for 30 days from the visit occurrence date.

The Community Alerts display at the following different times:
- as a splash screen after you logon into iCare
- as a tab (Community Alerts) on the iCare main window
- on the Patient Record screen in the demographic information group box

8.1 iCare Community Alerts Pop-up Window

Community alerts will display on the Splash Screen. You can close (dismiss) the splash screen but cannot turn it OFF.
Community Alerts are related to the individual patient’s Community of Residence (COR). **You must dismiss the alert in order to use other features of the application.**

### 8.1.1 iCare Community Alerts Pop-up Layout

You can sort/filter the columns and perform other functions on the columns. See Section 4.1 Working with Columns for more information.

### 8.1.2 iCare Community Alerts Pop-up Toolbar

The information on the pop-up is effective as of the date range shown in the toolbar.

### 8.1.3 Buttons on the iCare Community Alerts Pop-up

See Section 4.5 Buttons on Right Side of Window to learn about how to use the buttons on the right side of the toolbar.

Click the Glossary button (or select Help | Community Alerts Glossary) to display the Community Alerts Glossary pop-up. See Section 4.14.1 Community Alerts Glossary for more information about this pop-up.
8.2 Community Alerts Tab

The Community Alerts tab on the iCare main window displays the alerts by the communities listed (in the Community Column).

![Sample Community Alerts Tab on iCare Main Window](image)

Figure 8-2: Sample Community Alerts Tab on iCare Main Window

8.2.1 Community Alerts Tab Layout

You can sort/filter the columns and perform other column functions. See Section 4.1 Working with Columns for more information.

The default sort order is: Community, Type, Diagnosis Category, and Most Recent Occurrence.

The Community Alerts information has the following data columns:

**Community**: The community where the alert type occurs.

**Type**: The following describes the alert types: (1) CDC Nationally Notifiable Infectious Diseases (NND) and (2) Suicidal Behavior: Ideation, Attempt and Completion. For this version, the logic will only display each alert for 30 days from the visit occurrence date.

The CDC Nationally Notifiable Infectious Diseases (NND) alert is defined as: Any primary care visit within the past 30 days with any POV identified in the CDC NND table. Only one (1) alert per patient per 30 day period will be displayed. The CDC NND logic will review primary care visits only. Primary care clinics are defined in CRS (BGP) in the BGP CONTROL FILE, Field 1201 CLINIC CODES FOR 2ND VISIT (90241.0112). Any primary care visit within the RPMS database will be reviewed, regardless of the facility location.

The Suicidal Behavior alert is defined as: Any AMH or PCC visit within the past 30 days with Suicide Ideation, Attempt, Completion or Not Categorized (see definitions below). Only one (1) alert per patient per 30 day period should be displayed. Both AMH (Behavioral Health) and PCC Visit files will be reviewed for visit data. First identify any AMH visits with BH visit codes 39, 40 or 41. Next, identify any additional PCC visits in the timeframe that were not documented in AMH with diagnosis or Ecode defined below.
- AMH Attempt: BH 40
- AMH Completion: BH 41
- PCC Ideation: V62.84
- PCC Not Categorized: Ecodes E950-E959

**Diagnosis:** The diagnosis category for the alert.

**Number of Cases:** This value is calculated for each Diagnosis Category for each COR. For example, Community 1 has 3 separate incidents of syphilis, the Number of Cases would be 3.

**Most Recent Occurrence:** The date for the most recent occurrence.

### 8.2.2 Community Alerts Tab Toolbar

See Section 4.5 Buttons on Right Side of Window to learn about how to use the buttons on the right side of the window.

#### 8.2.2.1 Web Link

Click the Web Link button (or select File | Community Alerts | Web Link) to go to the CDC NND Web site.

#### 8.2.2.2 View Detail

Click the View Detail button (or select File | Community Alerts | View Detail) to view the details about the community alert. See Section 8.3 Community Alerts Patient View Pop-up for more information.

#### 8.2.2.3 Background Jobs

Click the Background Jobs button (or select File | Background Jobs) to display the Background Jobs pop-up. See Section 4.11 Background Jobs for more information.
8.2.2.4 Glossary Button

Click the Glossary button (or select Help | Community Alerts Glossary) to display Community Alerts pop-up. See Section 4.14.1 Community Alerts Glossary for more information about this glossary window.

8.2.3 Community Alerts Tab Menus

The **File** menu has options like those on the Panel List window (see Section 6.3.1 File Menu on Panel List). The difference is that instead of the Panel option, the Community Alerts tab has the Community Alerts option. The Community Alerts option has the following selections:

**Web Link**: use this option to go to the CDC NND Web site.

**View Detail**: use this option to view the details about the community alert.

**Refresh**: use this option to re-display the pop-up by retrieving the most up-to-date information from the server.

The **Tools** menu has options like those on the Panel List window (see Section 6.3.2 Tools Menu on Panel List). This Tools menu on the Community Alerts tab has this extra option:

**Glossary**: use this option to display Community Alerts pop-up. See Section 4.14.1 community Alerts Glossary for more information about this pop-up.

For more information about the **Edit**, **Window**, and **Help** menus, see Section 4.3 Menus.

8.3 Community Alerts Patient View Pop-up

The purpose of this feature is to allow for monitoring of appropriate care and follow-up for the patient.

The Package Manager can double-click any record on the Community Alerts tab to display the Community Alerts Patient View pop-up. The pop-up shows the patients in the community alert.
If you are not a Package Manager, the message “You do not have the correct security access to see the Community Alerts Patient detail view. Please check with the iCare Package Manager to request access.”

You must close the pop-up in order to do further work in iCare.

8.3.1 Community Alerts Patient View Toolbar

The toolbar provides information about when the data on the pop-up was last updated as well as the date range for the Community Alerts.

See Section 4.5 Buttons on Right Side of Window for information about the buttons on the right side of the pop-up.

8.3.1.1 Create Panel Button

You use the Create Panel button to create a panel from the selected patient names listed on the pop-up.

Follow these steps to create a panel:

1. Select the patient names that you want on the panel. See Section 4.2 Selecting Records for more information about selecting the patient names.

2. Click the Create Panel button to display the Create Panel dialog.
The application provides a name for the new panel that you can change by manually typing the name. This is a free text field that has a right-click menu to aid in editing the “new” name. See Section 4.6.1 Free Text Fields for more information.

3. Click OK to create the panel with the selected patients. The application displays the “Panel create successfully!” message; click OK to dismiss the message. If you do not want to create the panel, click Cancel on the Create Panel dialog.

After you click OK and exit the pop-up, your new panel will be listed on the Panel List window (otherwise, click Cancel to not save). This new panel uses the “No Predefined Population Search - Add Patients manually” population search option. You can share this panel with other RPMS users.

8.3.1.2 Web Link Button

Click the Web Link button to go the CDC NND Web page.

8.3.1.3 Glossary Button

Click the Glossary button (or select Help | Glossary or select Tools | Glossary) to display the Community Alerts glossary pop-up.

The Community Alerts Glossary provides the following information:

- Purpose of a community alert
- Notice that alerts are not linked to an individual patient
- Categories of diagnosis that triggers the alert
- How to customize the Community Alert display
- List of diseases/conditions and associated codes that trigger Community Alerts in iCare

See Section 4.14.1 Community Alerts Glossary for more information about this pop-up.
8.3.2 Menus on the Community Alerts Patient View Pop-up

The following provides information about the options on the menus.

8.3.2.1 File Menu

The File menu has the following options:

Community Alerts: This option has two choices: Create Panel and Web Link. These choices work like the buttons on the toolbar.

Page Setup: This option allows you to set Margin, Paper, Layout characteristics (like landscape or portrait orientation), and the Printer to use.

Print Preview: This option displays the print preview dialog.

Print: This option sends the page to the printer using the settings in Page Setup. Note that only the selected tab (Panel List or Flag List) will be printed.

Close: This option dismisses the pop-up.

8.3.2.2 Edit Menu

The Edit menu has the Select All option. You use this option to select all of the patient names on the pop-up. This is the same as using the key combination Ctrl+A.

8.3.2.3 Tools Menu

The Tools menu has the following options:

Reset View: This option resets the current view (one that was altered, such as changing the width of columns) to the default view.

Search: This option will display the Search dialog. See Section 4.5.3 Search Button for more information.

Excel Export: This option will export the information in the window to Excel. See Section 4.5.4 Export to Excel for more information.

Copy Rows to Clipboard: This option will copy the selected information to the Windows clipboard.
8.3.2.4 Help Menu

The Help menu has the Glossary option. Select this option to display the Community Alerts glossary. See Section 8.3.1.3 Glossary Button for more information about this glossary.
9.0 Panel View

You can view the patients in a selected panel on the Panel List window either by using the Open function or by double-clicking a record. This action opens the Panel View window.

Figure 9-1: Sample Panel View

**Note:** The Repopulate button will not display on the Panel View if the patients in the panel were added manually (that is, it has no predefined logic).

The application displays the loading progress (in percentage) in the lower, left corner of the Panel List view when the panel contains a large number of patients. This feature applies to the Patient List (when you first access the Panel View window), Reminders, Nat’l Measures, Diagnostic Tags, and Care Management tabs.

Figure 9-2: Loading Progress Information (Need new - no repopulate)

You can cancel the load by clicking Cancel; the application confirms that you want to cancel the loading process. Click Yes to cancel the load (otherwise, click No) on the “Cancel display of data?” dialog.
iCare will provide the ability for more than one user to open the same shared panel simultaneously. The second and subsequent users to open the same panel will have “read only” access to the panel content, similar to Word or Excel functionality. If the first user closes the panel, the second user will be notified that the panel is now available for “edit” access, unless the user only has been provided with Shared Read Only access by the panel creator.

The Panel View displays a list of patients with key identifier and clinical data, presented in columnar format. From the open Panel, you can perform any of the following functions:

- Open individual patient records
- Add or remove patients
- Change your view by sorting, moving, and/or filtering any column
- Change the content of the list by changing the population search definition
- Share the panel with other users

The Panel View contains the following tabs (discussed in detail below):

- Patient List
- Flags
- Reminders
- Reminders Aggregated
- National Measures
- National Aggregated
- Diagnostic Tags
- Care Management

9.1 Panel View Toolbar

Below find information about the toolbar and the Properties button.

9.1.1 Information on Toolbar

The following data are displayed in the panel information area located between the menu bar and the Panel View tabs:

- Panel Name and Panel Description: both data are user-defined.
Figure 9-3: Sample Panel Name and Panel Description

- Owner Name (only displayed if you are not the creator of the panel): Name of the user who created the panel and shared with you.

Diabetic Teens (Owner: GEBREMARIAM,CINDY)

Figure 9-4: Sample Owner Name in Parenthesis

- Total Patients: Number of patients in the panel.
- Last Updated: Date and time the panel was last repopulated, either manually or auto-repopulated.
- By: Name of user who last repopulated the list.

Note: If the panel has been shared with others who have read/write access, the displayed Owner and Last Updated By might be different names.

Figure 9-5: Sample Information About Total Number of Patients, Last Updated, Panel Creator

This area also contains a Properties button. Click this button to display the Panel Properties window for the current panel. See Section 9.1.2 Properties for more information.

The bottom right bar shows information about the rows in the panel. Visible rows will be a smaller number than Total Rows if a filter has been applied.

Figure 9-6: Sample Row Information

9.1.2 Properties

Click the Properties button located above the tabs in the Panel Information area (or select File | Panel Properties) to view the properties about the current panel. Click OK to dismiss the window. See Section 6.2.8 Panel Properties for more information.
9.2 Patient List Tab

The Patient List tab of the Panel View window shows the patients in the panel. The default grid will display the standard demographic columns (Name, HRN, Sex, Age, DOB) in addition to the Diagnostic Tag related data and the condition-specific (register) fields.

![Sample Patient List Tab of Panel View](image)

**Note:** You can add a patient to the current panel by using the Add function or by copying a patient from another panel and pasting the patient into the current panel.

9.2.1 Patient List Tab Layout

You can change the columns that display on the view. See Section 5.4 Panel Definition Layouts Tag for more information.

You can sort/filter the columns and perform other functions on the columns. See Section 4.1 Working with Columns for more information.

You use the Layout function to determine what columns display on Patient List tab. See Section 4.9 Layout Dialog Functionality for more information.

The following table provides information about the default columns on the Patient List tab.

<table>
<thead>
<tr>
<th>Column</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flag ** indicator</td>
<td>Displays when a patient has a flag. This column is always the first column and can only be removed by turning all flags &quot;off&quot; in the User Preferences (see Section 3.1.1.2 Flag Setup Tab).</td>
</tr>
<tr>
<td>Patient Name</td>
<td>Required field that cannot be removed from the layout.</td>
</tr>
<tr>
<td>HRN</td>
<td>The active health record numbers for the patient (required field). The HRN will display as the HRN number followed by the facility code.</td>
</tr>
</tbody>
</table>
### Information

<table>
<thead>
<tr>
<th>Column</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sex</td>
<td>F (for female) or M (for male)</td>
</tr>
<tr>
<td>Age</td>
<td>The patient’s age.</td>
</tr>
<tr>
<td>DOB</td>
<td>Date of Birth - required field that cannot be removed from the layout</td>
</tr>
<tr>
<td>Designated PCP</td>
<td>Designated Primary Care Provider, if any. Not all facilities use this field to empanel patients.</td>
</tr>
<tr>
<td>Community</td>
<td>The patient’s community of residence.</td>
</tr>
<tr>
<td>Active DX Tags</td>
<td>One or more predefined diagnosis definitions (“tags”) that iCare has proposed for the patient that has a Proposed or Active status. See Section 2.2.1 Diagnostic Tags for more information.</td>
</tr>
</tbody>
</table>

The application shows when there is a Community Alert (in the Community column) for a patient. The following shows that there is a community alert for Snowbird (the COR for the patient). The icon does not affect the sorting of the Community column.

![Community Alert](image)

Figure 9-8: Community Alert in Community Column

You can view the Community Alert text by hovering your mouse over the Community cell.

### 9.2.1.1 Diagnostic Tags

iCare provides a diagnosis tagging function that runs as a background process on your RPMS server and reviews all patient data. Tagging is a term that refers to running a series of logic algorithms on one or multiple patients that identifies (“tags”) them with one or more predefined diagnosis categories, listed below:

- Asthma
- COPD
- Cardiovascular Disease (CVD) Known (CVD Kn)
- CVC At Highest Risk (CVD AHR)
- CVC At Significant Risk (CVD ASR)
- CVD At Risk (CVD AR)
- Diabetes (DM)
- HIV/AIDS (HIV)
- Hypertension (HTN)
- Obese
- Prediabetes/Metabolic Syndrome w/o DM (PreDM)
- Current Smokers (Smoker)

iCare will classify tags into one of five statuses: proposed (pending) (P), accepted (A), not accepted (NA), No longer valid (NLV), and Superseded (S). In the Diagnostic Tag column on any Panel View, the status value should be concatenated with the tag name, e.g., Asthma (A); CVD AHR (P); DM (A).

The detailed logic for each of these diagnosis tags can be found in Section 13.0, Appendix A, iCare Predefined Diagnosis Definitions. These definitions are defined nationally and are consistent with definitions used in the Clinical Reporting System (CRS) and RPMS disease-specific registers, such as Diabetes Management System.

### 9.2.1.2 Patient Classified as Sensitive

You can identify a “sensitive patient” in the Patient Name column when the name is preceded by the symbol.

When you double-click the sensitive patient record, a warning message displays.

![Sample Sensitive Patient Warning Message](image.png)

Figure 9-9: Sample Sensitive Patient Warning Message

Click Yes to open the patient record. Otherwise, click No.

### 9.2.2 Patient List Tab Toolbar

See Section 4.5 Buttons on Right Side of Window for more information about the buttons on the right side of the toolbar.

The following Sections provide information about the buttons on the toolbar and the actions available on the menus.
9.2.2.1 Add Patients

Only the panel creator or the shared user with Read/Write access can add patient names to the current panel. This is a manual add function. You can add a patient name even if the panel was originally created from a pre-defined search definition. The panel stores the original definition as well as any patients added. This is important during the repopulate action.

You can add a patient to the Panel View by doing one of the following:

- Clicking the Add button
- Selecting Patients | Add Patient(s)
- Selecting the Add Patient(s) option on the right-click menu

The Select Patients dialog displays.

![Select Patients Dialog](image)

Type a few characters of the patient’s name, HRN, SSN, or the Date of Birth in the Search field and click Find. The retrieved records display in the lower panel of the Select Patients dialog. You can refine your search (if needed) by using the Search field again.

More than one row at time can be added by selecting multiple rows using Ctrl and Shift keys while highlighting the row. See Section 4.2 Selecting Records for more information.
When you highlight the correct patient(s), click Add. This action adds the patient(s) to the Patient List tab on the Panel View window. (Otherwise, click Close to not add any patient).

### 9.2.2.2 Open Patient Records

You use the Open function to move to another window to view the patient record (patient data information stored in the RPMS database).

Highlight the patient name and open the record by doing one of the following:

- Clicking the Open button
- Selecting Patients | Open Patient(s)
- Selecting the Open Patient(s) option on the right-click menu
- Double-clicking on the row
- Using the key combination Ctrl+O

This action opens your default tab of the patient record in another window. See Section 10.0 Patient Record for more information about this window.

By highlighting more than one row, multiple patient records open in individual windows.

### 9.2.2.3 Remove Patients

You use the Remove function to delete one or more patients from the Patient List tab on the Panel View window. The removed patients are NOT deleted from the RPMS database but are only removed from your panel display. Only the panel creator or the shared user with Read/Write access can remove patients from the Patient List tab.

The panel stores the original definition as well as any patients removed or added. This is important during the repopulate action.

You can remove the highlighted patients in the Panel View by doing one of the following:

- Clicking the Remove button
- Selecting Patients | Remove Patient(s)
- Selecting the Remove Patient(s) option on the right-click menu
- Pressing the Delete key on your keyboard
The “Confirm patient remove” dialog displays, asking if you want to delete the selected patients. Click Yes to remove the selected patients. Otherwise, click No.

### 9.2.2.4 Repopulate

You use the Repopulate function when you want iCare to rebuild the contents of the panel. Repopulate reruns the panel definition against the cached data (from the nightly job) and will add patients who meet the criteria and remove the patients that no longer meet the criteria. Only the panel creator or the shared user with Read/Write access can repopulate the panel on the Panel View.

**Note:** The Repopulate button will not display on the Panel View if the patients in the panel were added manually (that is, it has no predefined logic).

You can repopulate a panel by doing one of the following:

- Clicking the Repopulate button
- Selecting Patients | Repopulate
- Selecting the Repopulate option on the right-click menu

A warning message displays asking if you want to update the patient list.

![Warning Message About Updating Patient List](image)

Click Yes to repopulate the panel. Otherwise, click No.

If you manually edited (added or removed) patients in the panel, the Maintain Manual Changes warning message displays.

![Maintain Manual Changes warning message](image)
Click Cancel to cancel the repopulate process for the selected panel.

Click Yes to repopulate the current panel and to keep the manually added or removed patients.

Click No if you want the patient list totally refreshed. In this case, the patient list will be totally refreshed and any added patient names will be lost as well as any deleted patient names will be added back to the panel.

If you use Yes or No and the current panel contains many patients, iCare displays the “Background populate” dialog.

![Background populate information message](https://example.com/background_populate.png)

Click Yes to run the repopulate process in the background. Otherwise, click No to repopulate in the foreground.

### 9.2.2.5 Copy Patient Information

You use the Copy function to copy the selected patient’s information to the iCare clipboard. Then you can go to another panel view (for a different patient panel) and paste the patient’s information.

You can copy the selected patient’s information by doing one of the following:

- Clicking the Copy button
- Selecting Patients | Copy Patient(s)
- Selecting the Copy Patient(s) option on the right-click menu
- Using the keyboard combination Ctrl+C

You need to move to another patient panel and use the Paste function.

You use the Select All function to select all the patients on the current Panel View window. Once the patients are selected, you could copy-paste them into another panel, for example.

You can select all the patients by doing one of the following:
• Selecting Edit | Select All
• Using the keyboard combination Ctrl+A

If you need to deselect the patients, select the Deselect All option on the Edit menu.

9.2.2.6 Cut Patient Information

You use the Cut function to copy the selected patient’s information to the iCare clipboard and to remove the selected patient from the current Panel View. Then you can go to another panel view (for a different patient panel) and paste the patient’s information. Only the panel creator or the shared user with Read/Write access can cut patient data from the Panel View. This function is useful for moving patients from one panel to another.

You can cut the selected patient’s information by doing one of the following:

• Clicking the Cut button
• Selecting Patients | Cut Patient(s)
• Selecting the Cut Patient(s) option on the right-click menu
• Using the keyboard combination Ctrl+X

You need to move to another patient panel and use the Paste function.

9.2.2.7 Paste Patient Information

You use the Paste function to place the contents of the iCare clipboard (containing patient data) into the current Panel View (this cannot be duplicate patient data). If there are duplicate patients in the paste operation, the system displays a message about this condition. Only the panel creator or the shared user with Read/Write access can paste patient data on the Panel View.

Patients that are pasted into a panel are considered “manually added.” This means that they are considered to be members of the panel that were manually selected to be on the patient list, and therefore are considered outside of the patient list that exists due to the panel’s search logic.

You can paste the contents of the clipboard by doing one of the following:

• Clicking the Paste button
• Selecting Patients | Paste Patient(s)
• Selecting the Paste Patient(s) option on the right-click menu
• Using the keyboard combination Ctrl+V

The patients on the clipboard are added to the current Panel View. (If there are no patients on the iCare clipboard, a warning message will display.)

If there is a duplicate patient to be pasted, the Duplicate patient message displays. Click OK to dismiss the message.

![Duplicate Patient Message](image)

Figure 9-14: Duplicate Patient Message

### 9.2.2.8 Modify Patient Panel

You use the Modify function to modify the patient panel definition information. Only the panel creator or the shared user with Read/Write access can modify patient data on the Panel View.

You can modify the current panel by doing one of the following:

• Clicking the Modify button
• Selecting File | Modify

The Panel Definition window for the panel displays. See Section 5.3 Population Search Options for more information about completing/modifying this window.

Below is an overview of the tabs on the Panel Definition window:

**Definition**: allows you to specify the panel’s name and description as well as what criteria to use to populate the panel.

**Layouts**: allows you to edit the patient, reminders, and/or national measures layouts.

**Sharing**: allows you to select other users who can share your panel.

**Preview**: shows the population in your panel.

**Auto Repopulation Options**: allows you to select the options that determines when to auto-populate your panel.
9.2.2.9 **Share Current Panel**

You use the Share function to define users that can share the current panel. Only the panel creator or the shared user with Read/Write access can share patient data on the Panel View.

You can share the patient panel by doing one of the following:

- Clicking the Share button
- Selecting File | Share

The Panel Definition window opens to the Sharing tab of the Panel Definition window. See Section 5.5 Sharing Tab for more information about sharing the panel.

9.2.2.10 **Modify Patient List Tab Layout**

You use the Layout function to select which data columns to show, the order of the columns chosen for display, and the initial sort order of the patients in the list. This layout information is stored with the panel if you decide to save the panel changes. Users with read-only access can change the layout of a panel.

You can select the view layout function by doing one of the following:

- Clicking the Layout button
- Selecting File | Layout

The Patient List Layout window opens, showing the current layout for the panel. See Section 4.9 Layout Dialog Functionality for information on how to use this layout dialog.

9.2.3 **Patient List Menu Options**

This Section describes the menus available on all tabs on the Patient List tab.

See Section 4.3 Menus for more information about the Edit, Window, and Help menus.

9.2.3.1 **File Menu**

The options on the File menu of the Patient List tab are described below.
New: This option displays the Panel Definition window where you can define a new patient panel. See Section 5.0 Creating Patient Panels for more information about this window.

Modify, Share, Layout: These options work like the buttons on the toolbar. See Section 9.2 Patient List Tab Toolbar for more information.

Save: This option saves the changes you made to the current Panel View window.

Page Setup: This option allows you to set Margin, Paper, and Layout characteristics (like landscape or portrait orientation) for printing.

Print: This option displays the Print Preview dialog where you can view the output. Select File | Print to output the content. The application provides a header stating Confidential Patient Information for all printed panel views.

Panel Properties: This option displays the Panel Properties window. This view-only window provides information about the panel properties. See Section 9.1.2 Properties for more information.

Background Jobs: This option displays the Background Jobs pop-up. See Section 4.11 Background Jobs for more information.

Close: This option closes the current Panel View window. If there are changes that need to be saved, you will be notified about this condition.
9.2.3.2 Tools Menu

![Tools Menu](image)

Figure 9-16: Tools Menu on Patient List tab

**Quick Patient Search:** This option opens the Quick Patient Search (within Panel) dialog. See Section 4.4.1 Find Patients in Open Panel for more information about this functionality.

**Mail Merge:** This option allows you to export patient demographic data in a format that can be used by word processing mail merge files. See Section 4.10 Mail Merge for more information about the mail merge process. This is the same as clicking the Mail Merge button.

**Reset View:** This option resets the current view (one that was altered, such as changing the width of columns) to the default view. This is the same as clicking the Reset View button.

**Refresh:** This option refreshes the current view by retrieving the most up-to-date information from the server.

**Search, Excel Export, Print, Copy Rows to Clipboard:** These options work like the buttons on the right side of the window. See Section 4.5 Buttons on Right Side of Window for more information.

**User Preferences:** This option opens the User Preferences window. See Section 3.2 Modifying Your User Preferences for more information.

**Web Links:** This option provides links to Web sites for related clinical guidelines.

9.3 Flags Tab

The Flags tab of the Panel View displays the flags for the patients in the open panel.
The flag logic is updated nightly by a system job. You can determine when the last system job was run by looking at the date in the “Flag data current as of” message in the toolbar.

The Flags tab displays the flag type shown in the Show field.

You can change the default flag display by changing the flag settings under User Preferences. See Section 3.1.1.2 Flag Setup Tab for more information.

Double-click any record on this tab to go to the Flags tab of the Patient Record window. See Section 10.5 Flags Tab for more information.

### 9.3.1 Flags Tab Layout

The Flags Tab layout on the Panel View has the same default columns as those on the Flag List window. See Section 7.1.1 Flag List Columns for more information.

### 9.3.2 Flags Tab Toolbar

The Flags tab toolbar on the Panel View is the same as the toolbar on the Flag List window. See Section 7.2 Flag Toolbar for more information.

### 9.3.3 Panel View Flags Tab Menu Options

The options on File and Tools menus are the same those on the Patient List tab. See Section 9.2.3 Patient List Menu Options for more information.

The Flags menu is only available when the Flags tab is selected.
9.4 Reminders Tab

The Reminders tab displays the national reminders that are pulled from the same data as the Health Summary report reminders in RPMS (such as lab test, immunization, etc.)

You can double-click on any record on the Reminders tab to open the Reminders tab of the Patient Record window. See Section 10.6 Reminders Tab for more information.

9.4.1 Reminders Tab Layout

The default view displays the fields in the following order:

<table>
<thead>
<tr>
<th>Column</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flag</td>
<td>Flag indicator displays when a patient has a flag.</td>
</tr>
<tr>
<td>Patient Name</td>
<td>Required field and will link to the Patient Record if you double-click on it. See Section 10.0 Patient Record for more information.</td>
</tr>
</tbody>
</table>
### Column Meaning

<table>
<thead>
<tr>
<th>Column</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>HRN</td>
<td>Health Record Number (required).</td>
</tr>
<tr>
<td>Sex</td>
<td>Either F (for female) or M (for male)</td>
</tr>
<tr>
<td>Age</td>
<td>The patient’s age.</td>
</tr>
<tr>
<td>DOB</td>
<td>Date of Birth (required).</td>
</tr>
<tr>
<td>Designated PCP</td>
<td>Designated Primary Care Provider, if any. Not all facilities use this</td>
</tr>
<tr>
<td></td>
<td>field to empanel patients.</td>
</tr>
<tr>
<td>Community</td>
<td>The patient’s community of residence.</td>
</tr>
<tr>
<td>Active DX Tags</td>
<td>Predefined Diagnosis definitions (“tags”) that iCare has proposed for</td>
</tr>
<tr>
<td></td>
<td>this patient, based on the tagging function, that has a Proposed or</td>
</tr>
<tr>
<td></td>
<td>Active status.</td>
</tr>
<tr>
<td>Date/Time Added</td>
<td>The date and time the patient was added to the panel.</td>
</tr>
<tr>
<td>Individual Columns</td>
<td>There are individual columns for each Reminder.</td>
</tr>
</tbody>
</table>

The Panel View will display the Community Alert icon in the Community field for any patient whose community of residence matches the COR for any current Alerts. The icon does not affect sorting of the column. You can view the Community Alert text by hovering your mouse over the Community cell.

Hover your mouse over a reminder (column heading) to view information about it. The tool tips will include the Reminder Title, Status, Description, and Currently Defined Criteria field if there is any data.

You use the Layout function to determine the columns that display on the Reminders tab. See Section 9.6.3.2 Layout for more information.

You can sort/filter the columns and perform other functions on the columns. See Section 4.1 Working with Columns for more information.

Double-click any row on the Reminders view to display the Reminders tab of the Patient Record window.

#### 9.4.1.1 Due/Overdue Dates

A date (or “N/A”) will be displayed under each of the Reminders columns. If the test or procedure is currently due or overdue, an icon will be displayed next to the date, as shown below. The icon is not displayed for dates that are not yet due (in the future).

![Figure 9-20: Sample Overdue Date for Pelvic Exam Reminder](image)

Figure 9-20: Sample Overdue Date for Pelvic Exam Reminder
9.4.1.2 **Tooltip for Test/Procedure**
You can hover your mouse over a test/procedure column heading to view information about it. The information is pulled from the Reminders application.

9.4.2 **Reminders Tab Toolbar**
The reminder logic is calculated with Flags/Tags/Performance data runs and cached for display. The reminder logic is updated nightly by a system job. You can determine when the last system job was run by looking at the date in the “Reminders data current as of” message in the toolbar.

See Section 4.5 Buttons on Right Side of Window for more information about the buttons on the right side of the toolbar.

9.4.2.1 **Copy Patient(s)**
This action copies the patients information to the iCare clipboard.

Select one or more patients (see Section 4.2 Selecting Records for more information about selecting patients) and then do one of the following:

- Click the Copy Patient(s) button
- Select Reminders | Copy Patient(s)
- Use the keyboard combination Ctrl+C

You must go to another panel view (for a different patient panel) and paste the patient’s information. See Section 9.2.2.7 Paste Patient Information for more information.

9.4.2.2 **Layout**
You use this function to select which reminder columns to display as well as the order and sorting that should be used.

To change the layout, do one of the following:

- Click the Layout button
- Select Reminders | Layout

The Reminders Layout screen of the Panel Definition will display for the current panel. Here you can select the Reminders columns you want to display on your panel. See Section 5.4.2 Edit Reminders Layout for more information.
9.4.2.3 Status of Background Jobs
You can check the status of the background jobs; this displays the RPMS iCare - Background Jobs window. See Section 4.11 Background Jobs for more information.

To check on the status of the background jobs, do one of the following:

- Click the background jobs button
- Select File | Background Jobs

9.4.2.4 Mail Merge
Click the Mail Merge Export button (or select Tools | Mail Merge or press Ctrl+M) to display the Mail Merge Export window. See Section 4.10 Mail Merge for more information about the mail merge process.

9.4.2.5 Glossary
Click the Glossary button (or select Help | Reminders Glossary or select Tools | Glossary) to display the Reminders Glossary pop-up. The information provides Reminder descriptions (from RPMS). The pop-up has descriptions of the logic behind each national health summary reminder available for display in iCare. You can display, print, and save the Glossary text. See Section 4.14.4 Reminders Glossary for more information about this glossary.

9.4.3 Reminders Tab Menu Options
The File menu on the Reminders tab is the same as the one on the Patient List Tab. See Section 9.2.3.1 File Menu for more information.

The options on the Reminders tab Tools menu perform the same actions as the Copy Patient(s) and Layout buttons on the toolbar.

The options on the Tools menu on the Reminders tab are the same as those on the Diagnostic Tags tab. See Section 9.8.3 Diagnostic Tag Tab Menu Options.

9.5 Reminders Aggregated Tab
The Reminders Aggregated tab displays the percentages and counts of patients within a panel that have or have not met reminder criteria. Active reminders are reminders that are “turned on” at a site. Reminders will be calculated at the time the view is opened.
9.5.1 Reminders Aggregated Tab Layout

The default view displays the fields on the Reminders Aggregated tab in the following order:

<table>
<thead>
<tr>
<th>Column</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clinical Group</td>
<td>The name of the clinical group for the reminder.</td>
</tr>
<tr>
<td>Reminder Name</td>
<td>The name of the reminder.</td>
</tr>
<tr>
<td># Patients Eligible</td>
<td>The total number of patients in this panel who need individual reminders.</td>
</tr>
<tr>
<td># Patients Current</td>
<td>“Current” is defined as any due date in the future (not including today).</td>
</tr>
<tr>
<td>% Current</td>
<td>The total percentage of patients in this panel who are current for an individual reminder, that is, [# Patient Current] divided by [#Patients Eligible]. Because of the one month “grace” period for the overdue definition, the total percentage of Current and Overdue cannot equal 100%.</td>
</tr>
<tr>
<td># Patients Overdue</td>
<td>“Overdue” is defined as the due date equal or is before [today - 30 days]. This means the reminder is NOT counted as overdue for purposes of performance until at least a month. The total of the Patients Current and the Patients Overdue cannot equal the total Patients Eligible because of the one month “grace” period for the overdue definition.</td>
</tr>
<tr>
<td>% Overdue</td>
<td>The total percentage of patients in this panel who are overdue for an individual reminder.</td>
</tr>
</tbody>
</table>

You can hover your mouse over a cell in the Reminder Name column to view a tooltip that provides additional descriptive information about the reminder.

There is hover help for the last five column headings (# Patients Eligible through % Overdue).
You can sort/filter the columns and perform other functions on the columns. See Section 4.1 Working with Columns for more information. However, you cannot change the layout by adding or deleting columns.

### 9.5.2 Reminders Aggregated Tab Toolbar

The toolbar displays the date/time the data was updated.

See Section 4.5 Buttons on Right Side of Window for more information about the buttons on the right side of the toolbar.

#### 9.5.2.1 Status of Background Jobs

You can check the status of the background jobs; this displays the RPMS iCare - Background Jobs window. See Section 4.11 Background Jobs for more information.

To check on the status of the background jobs, do one of the following:

- Click the background jobs button
- Select File | Background Jobs

#### 9.5.2.2 Glossary Button

Click the Glossary button (or select Help | Reminders Glossary or select Tools | Glossary) to display Reminders Glossary pop-up that shows the descriptions of the logic behind each national health summary reminder available for display in iCare (from RPMS). See Section 4.14.4 Reminders Glossary for more information.

### 9.5.3 Reminders Aggregated Tab Menu Options

The options on the File menu for the Reminders Aggregated tab are the same as those on the Patient List tab. See Section 9.2.3.1 File Menu for more information.

The options on the Tools menu for the Reminders Aggregated tab are shown below.
Figure 9-22: Options on the Tools menu of the Reminders Aggregated Tab

**Quick Patient Search:** This option opens the Quick Patient Search (within Panel) dialog. See Section 4.4.1 Find Patients in Open Panel for more information about this functionality. This is the same as pressing the F8 key on your keyboard.

**Glossary:** This option displays the Reminders Glossary pop-up. The information provides Reminder descriptions (from RPMS). The pop-up has descriptions of the logic behind each national health summary reminder available for display in iCare. You can display, print, and save the Glossary text. See Section 4.14.4 Reminders Glossary for more information about this glossary. This is the same as clicking the Glossary button.

**Reset View:** This option resets the current view (one that was altered, such as changing the width of columns) to the default view. This is the same as clicking the Reset View button.

**Refresh:** This option refreshes the current view by retrieving the most up-to-date information from the server. This is the same as clicking the Refresh button or pressing the F5 key on your keyboard.

**Search, Excel Export, Print, Copy Rows to Clipboard:** These options work like the buttons on the right side of the window. See Section 4.5 Buttons on Right Side of Window for more information.

**User Preferences:** This option opens the User Preferences window. See Section 3.2 Modifying Your User Preferences for more information.

**Web Links:** This option provides links to Web sites for related clinical guidelines.
9.6 National Measures Tab

The National Measures tab displays IHS national clinical performance measure as defined and reported in the RPMS Clinical Reporting System (CRS). iCare uses CRS performance logic to display whether “your” patients are meeting annual performance goals.

![Sample National Measures Tab of Panel View](image)

Figure 9-23: Sample National Measures Tab of Panel View

9.6.1 What is National Performance (GPRA)?

The Government Performance and Results Act (GPRA) requires federal agencies to report annually to Congress on how the agency measured up against the performance targets set in its annual Plan. See Section 14.0 Appendix B: Performance Measure Logic Example or the CRS User Manual for additional information about the IHS quarterly and annual performance reporting process.

Most performance measures have a denominator and a numerator defined.

- The denominator is the total population being reviewed
- The numerator is the number of patients from the denominator who meet the definition of the measure.

Some measures are just a count, such as Sealants and Topical Fluorides.

**Measure example:** GPRA Measure Cancer Screening: Pap Smear Rates: Maintain the proportion of female patients ages 21 through 64 without a documented history of hysterectomy who have had a Pap screen within the past three years at the previous year’s level (60.0%).
The denominator is the total population that is being reviewed for a specific measure. For the Pap Smear measure, the denominator is all female patients ages 21 through 64 at the beginning of the Report period. The numerator is the number of patients in the denominator who meet specific criteria. For Pap Smear, the numerator is the number of patients in the denominator who had either a Pap smear, defined by certain codes, documented in RPMS any time in the three years prior to the end of the report period or a refusal of a Pap smear in the past year.

If you are not familiar with your facility’s policies and practices related to national performance reporting, you might want to talk with your site GPRA coordinator.

### 9.6.2 National Measures Tab Layout

The National Measures Layout determines the columns, sort order, etc. on the National Measures tab.

The default columns are described below. Additional data columns are available, including non-GPRA national performance measures. Use the Layout toolbar button to sort, add, or delete columns.

<table>
<thead>
<tr>
<th>Column</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flag</td>
<td>Flag 🔄 indicator displays when a patient has a flag. This column is always the first column and can only be removed by turning all flags “off” in the User Preferences (see Section 3.1.1.2 Flag Setup Tab).</td>
</tr>
<tr>
<td>Patient Name</td>
<td>Required field and will link to the Patient Record if you double-click on it. See Section 10.0 Patient Record for more information.</td>
</tr>
<tr>
<td>HRN</td>
<td>Health Record Number (required).</td>
</tr>
<tr>
<td>Sex</td>
<td>F (for female) or M (for male)</td>
</tr>
<tr>
<td>Age</td>
<td>Patient’s age today. NOTE: many of the performance measures use the patient’s age as of one year prior to today to calculate performance.</td>
</tr>
<tr>
<td>DOB</td>
<td>The date of birth.</td>
</tr>
<tr>
<td>Designated PCP</td>
<td>Designated Primary Care Provider, if any. Not all facilities use this field to empanel patients.</td>
</tr>
<tr>
<td>Community</td>
<td>The patient’s community of residence.</td>
</tr>
<tr>
<td>Active DX Tags</td>
<td>Predefined Diagnosis definitions (“tags”) that iCare has proposed for this patient, based on the tagging function, that has a Proposed or Active status.</td>
</tr>
<tr>
<td>Date/Time Added</td>
<td>The date/time the patient was added to the panel.</td>
</tr>
<tr>
<td>Individual Perf Met</td>
<td>The value of the performance met.</td>
</tr>
</tbody>
</table>

If you double-click any record, the patient record window opens to the National Measures tab. See Section 10.8 Nat’l Measures Tab for more information.

The Panel View will display the Community Alert 🔄 icon in the Community field for any patient whose community of residence matches the COR for any current Alerts. The icon does not affect sorting of the column. You can view the Community Alert text by hovering your mouse over the Community Alert icon.
You can sort/filter the columns and perform other functions on the columns. See Section 4.1 Working with Columns for more information.

If you hover your mouse over a performance column name, the tooltip displays the GPRA definition.

9.6.3 National Measures Tab Toolbar

The data was updated by the date/time shown in the “National Performance Measures data for CRS 2008” message in the National Measures toolbar.

See Section 4.5 Buttons on the Right Side of Window for more information about the buttons on the right side of the toolbar.

9.6.3.1 Copy Patient(s)

This action copies the patients information to the clipboard. This is useful for selecting patient that need additional follow-up based on the measure information displayed.

Select one or more patients (see Section 4.2 Selecting Records for more information about selecting patients) and then do one of the following:

- Click the Copy Patient(s) button
- Select National Measures | Copy Patient(s)
- Use the keyboard combination Ctrl+C

You must go to another panel view (for a different patient panel) and paste the patient’s information.

9.6.3.2 Layout

You use this function to select which performance measures to display as well as the order and sorting that should be used.

To change the layout, do one of the following:

- Click the Layout button
- Select National Measures | Layout
The National Measures Layout screen of the Panel Definition for the current panel will display. Here you can select the National Measures columns you want to display on your panel as well as the sort order. See Section 5.4.3 Edit National Measures Layout for more information.

If you choose to add the “CRS Pop” column to the National Measures tab, it will display the value(s) describing the population category defined by CRS. The CRS Population categories include: UP (User Population), AC (Active Clinical), AD (Active Diabetic), etc. The population is a text string from the Denominator column of the CRS Patient List report that will be calculated for each patient within the weekly performance measures background process.

9.6.3.3 Status of Background Jobs

You can check the status of the background jobs; this displays the RPMS iCare - Background Jobs window. See Section 4.11 Background Jobs for more information.

To check on the status of the background jobs, do one of the following:

- Click the background jobs button
- Select File | Background Jobs

9.6.3.4 Glossary Button

Click the Glossary button (or select Help | National Measures Glossary or select Tools | Glossary) to display the National Measures Glossary pop-up. The information defines detailed logic for each of the national performance measures defined in the Clinical Reporting System.

See Section 4.14.3 National Measures Glossary for more information about this glossary window.

9.6.4 Nat’l Measures Tab Menu Options

The options on the File and Tools for the Nat’l Measures tab is the same as those on the Patient List tab. See Section 9.2.3 Patient List Tab Menu Options.

9.7 Natl Aggregated Tab

The National Aggregated tab information is based on the format of the Summary Page from the CRS National GPRA report. It displays a summarized overview of the national performance measure data for patients in the panel being viewed.
Figure 9-24: Sample National Aggregated Tab

This window displays aggregated performance for this panel expressed in percentages and compared to the predefined Agency-level values from the previous year and 2010 performance goals.

9.7.1 Nat’l Aggregated Tab Layout

The following data are displayed on the Nat’l Aggregated tab.

**Category:** the name of the category, either GPRA or other national measures (National, Non-National, Other).

**Clinical Group:** the name of the clinical performance group.

**Measure Name:** the measure title derived from the Summary Report (iCare pulls from the first column of the CRS Summary Report). A description of the performance logic (tooltip) will display when you hover the mouse over the name.

**# Patients in Denominator:** the total number of patients in this panel who meet the denominator definition.

**# Patients in Numerator:** the total number of patients in this panel who meet the numerator definition.

**% Met:** the percentage of the panel who meet the measure, derived by dividing the denominator total by numerator total. The display of the percentage will be color coded to demonstrate the relationship of the current percentage to the IHS National Performance value, unless there is no number value in the previous performance column. If the percent met is at least two percentage points below the previous performance, the display is red. If the percent met equals or exceeds the previous performance, the display is green.
In certain cases, the code indicates if “good” performance is indicated by a decreased percentage, rather than increased. This affects measures such as Poor Glycemic Control, Obese Children, Tobacco Prevalence, PreDM Metabolic Syndrome where the desired outcome is for the percent “met” to decrease.

**Year Goal:** the value will be the same as the one that displays in the “GPRA” column on the Summary Page from the CRS National GPRA report.

**IHS National year Performance:** the value will be the same as the one that displays in the “Nat’l” column on the Summary Page from the CRS National GPRA report. The “year” is the most recent year with final performance results recorded.

**2010 Goals:** the value will be the same as the one that displays on the Summary Page from the CRS National GPRA report.

If you choose to add the “CRS Pop” column to the National Measures tab (using the Layout button), it will display the value(s) describing the population category defined by CRS. The CRS Population categories include: UP (User Population), AC (Active Clinical), AD (Active Diabetic), etc. The population is a text string from the Denominator column of the CRS Patient List report that will be calculated for each patient within the weekly performance measures background process.

You can view the tooltip of any cell in the Measure Name column that provides additional descriptive information about the measure.

You can sort/filter the columns and perform other functions on the columns. See Section 4.1 Working with Columns for more information.

### 9.7.2 Nat’l Aggregated Tab Toolbar

The toolbar provides information about the date/time for which the data is current.

See Section 4.5 Buttons on Right Side of Window for more information about the buttons on the right side of the toolbar.

### 9.7.2.1 Status of Background Jobs

You can check the status of the background jobs; this displays the RPMS iCare - Background Jobs window. See Section 4.11 Background Jobs for more information.

To check on the status of the background jobs, do one of the following:

- Click the background jobs button
- Select File | Background Jobs
9.7.2.2 Glossary

Click the Glossary button (or select Help | Natl Measures Glossary or select Tools | Glossary) to display the National Measures Glossary pop-up. The information defines detailed logic for each of the national performance measures defined in the Clinical Reporting System. See Section 4.14.3 National Measures Glossary for more information.

9.7.3 Nat’l Aggregated Tab Menu Options

The options on the File menu for the Nat’l Aggregated tab are the same as those on the Patient List tab. See Section 9.2.3.1 File Menu for more information.

The options on the Tools menu for the Nat’l Aggregated tab are the same as those on the Reminders Aggregated tab. See Section 9.5.3 Reminders Aggregated Tab Menu Options for more information.

9.8 Diagnostic Tags Tab

The Diagnostic Tags tab provides a comprehensive view of all tag history for a patient (regardless of the tag status), provides auto-accept and auto-reject capabilities, allows the user to accept a proposed tags for multiple patients, allows the user to reject proposed tags, and allows the user to update of tag status.

![Figure 9-25: Sample Diagnostic Tags Tab](image)

Tags that are identified through iCare’s execution of the pre-defined tag criteria will start with an initial tag status of PROPOSED. From there you have several options including “Accepting” a tag or “Not Accepting” the validity of a tag for any patient. These statuses are editable from within this tab.

9.8.1 Diagnostic Tags Tab Layout

The following table provides information about the columns.
<table>
<thead>
<tr>
<th>Column</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patient Name</td>
<td>Required field and will link to the Patient Record if you double-click on it. See Section 10.0 Patient Record for more information.</td>
</tr>
<tr>
<td>HRN</td>
<td>Health Record Number (required).</td>
</tr>
<tr>
<td>DOB</td>
<td>Date of Birth (required).</td>
</tr>
<tr>
<td>Age</td>
<td>The patient’s age.</td>
</tr>
<tr>
<td>Tag Name</td>
<td>The name of the tag for the patient.</td>
</tr>
<tr>
<td>Status</td>
<td>ACCEPTED: means the patient is a member of specified formal case management registers with status of Active, Decease, Transient, Non IHS, Lost to Follow Up, or Noncompliant. PROPOSED: means the patient has Status Un-reviewed or Inactive in the register.</td>
</tr>
<tr>
<td>Status Change Reason</td>
<td>The pre-reason the status changed: System Generated (system), RPMS Data No Longer Supports Tab (system), Patient Data Does Not Support Acceptance (user), Manually Designated (user), Other (user - with required comment field), on Existing RPMS Register (system).</td>
</tr>
<tr>
<td>Status Comment</td>
<td>The text of any comments entered about the status change (used with the Other status change reason).</td>
</tr>
<tr>
<td>Last Updated</td>
<td>The date the content of the panel was last updated by a manual (user) repopulate, by an auto-repopulate, or the panel created date, if the panel has never been repopulated.</td>
</tr>
<tr>
<td>Last Updated By</td>
<td>The name of the user who either created or last repopulated the panel.</td>
</tr>
</tbody>
</table>

You can display tooltip information about a Tag Name by hovering your mouse over the Tag Name cell.

Double-click any record to go the Diagnostic Tags tab of the Patient Record window. See Section 10.14 DX Tags Tab for more information.

You can sort/filter the columns and perform other functions on the columns. See Section 4.1 Working with Columns for more information.

### 9.8.2 Diagnostic Tags Toolbar

The toolbar provides information about the date for which the data is current.

iCare will classify tags into one of five statuses: proposed (pending) (P), accepted (A), not accepted (NA), No longer valid (NLV) and Superseded (S). Those tags with a classification of NA will not display.

See Section 4.5 Buttons on Right Side of Window for more information about the buttons on the right side of the toolbar.

### 9.8.2.1 Copy Patient(s)

This action copies the patients information to the clipboard.
Select one or more patients (see Section 4.2 Selecting Records for more information about selecting patients) and then do one of the following:

- Click the Copy Patient(s) button
- Select Diagnostic Tags | Copy Patient(s)
- Use the keyboard combination Ctrl+C

You must go to another panel view (for a different patient panel) and paste the patient’s information.

9.8.2.2 Add Tag

Select a patient to which you want to add a tag and then click the Add Tag button (or select Diagnostic Tags | Add Tag) to display the Add Diagnostic Tag dialog. This is a manual add that allows a provider to manually assign one or more of the diagnosis tags to patients that did not meet the tag’s criteria for being proposed automatically. (See Section 4.2 Selecting Records for more information about selecting patients.)

![Add Diagnostic Tag dialog](image)

Figure 9-26: Add Diagnostic Tag dialog
This dialog shows information about the patient named in the Patient Name field (the one you selected).

When you have completed the dialog, click OK to add the information to the Diagnostic Tags tab on the Panel View. (Otherwise, click Cancel.)

**Tag Activity**

You can view existing tag activity about the patient by clicking the View Tag Activity button. The Diagnostic Tag Activity pop-up displays. See Section 9.10.2.4 Activity for more information about this pop-up.

**Fields on Add Diagnosis Tag Dialog (All are Required):**

- **Patient Name:** the name of the patient to which to add tag information.
- **Diagnostic Tag:** the name of diagnostic tag to add for the patient. Select from the drop-down list for this field.
- **New Status:** the status of the tag being added.
- **ACCEPTED:** this option allows you to “Accept” a proposed tag to provide an affirmation of its validity for a given patient.
- **NOT ACCEPT:** this option allows you to disapprove or “Not Accept” a diagnostic tag that has been proposed for a patient.
- **PROPOSED:** this option allows you to change the status of a diagnosis tag back to “Proposed” so that further review can take place.

**Reason:** click the appropriate reason for adding the tag.

- **Patient Data Supports Acceptance:** use this when the patient data does support the tag.
- **Manually Designated:** use this when you want to manually change the tag status.
- **Other:** use this when the other reasons do not fit.

**Status Comment:** here you type the reason for the change. This feature provides a rich audit history for reasons for providers’ decisions to accept or not accept proposed tag assignments.

**9.8.2.3 Change Status**

You use the Accept, Not Accept, and Proposed buttons (or select these options on the Diagnostic Tags menu) to change the Status on an existing record.
Select the patient record whose status you want to change and click the appropriate “change status” button to display the Update Diagnostic Tag dialog.

![Update Diagnostic Tag dialog](image)

Figure 9-27: Sample Update Diagnostic Tag dialog

All fields are required on this dialog.

The “Not Accept” status cannot be performed on multiple patients or multiple tags.

See Section 9.8.2.2 Add Tag for more information about the fields and “View Tag Activity” button on this dialog.

### 9.8.2.4 Activity

You can view existing tag activity about the selected patient by clicking the Activity button (or by selecting Diagnostic Tags | Activity) on the Panel View toolbar. The Diagnostic Tag Activity pop-up displays. This is a view-only pop-up. Multiple people can enter the tags, so this pop-up shows all of the activity.
Figure 9-28: Sample Diagnostic Tag Activity Pop-up

See Section 4.5 Buttons on Right Side of Window for more information about the buttons on the right side of the toolbar.

Click the Glossary button to display the Diagnostic Tag Glossary. See Section 4.14.1 Diagnostic Tab Glossary for more information.

You can sort/filter the columns and perform other functions on the columns. See Section 4.1 Working with Columns for more information.

You can view various tags by selecting from the drop-down list for the Tag field.

If you check the “Display Factor Details” check box, the following columns will display: Factor, Date, Item, Value. This allows you to view additional details about the tags. The default view is unchecked.

You must dismiss the pop-up.

9.8.2.5 Status of Background Jobs

You can check the status of the background jobs; this displays the RPMS iCare - Background Jobs window. See Section 4.11 Background Jobs for more information.

To check on the status of the background jobs, do one of the following:

- Click the background jobs button
- Select File | Background Jobs
9.8.2.6 **Mail Merge**

Click the Mail Merge Export button (or select Tools | Mail Merge or press Ctrl+M) to display the Mail Merge Export window. See Section 4.10 Mail Merge for more information about the mail merge process.

9.8.2.7 **Glossary Button**

Click the Glossary button (or select Help | Diagnostic Tag Glossary) to display the Diagnostic Tag Glossary pop-up. This pop-up provides the detailed logic for each national performance measure defined in the Clinical Reporting System.

See Section 4.14.2 Diagnostic Tag Glossary for more information about using the pop-up.

9.8.3 **Diagnostic Tags Tab Menu Options**

The options on the File and Tools menus for the Diagnostic Tags tab are the same as those on the Reminders tab. See Section 9.2.3.1 File Menu and Section 9.2.3.2 Tools Menu for more information.

The Diagnostic Tags menu has options that perform the same actions as the buttons on the left side of the window.

9.9 **Care Mgmt Tab**

The Care Mgmt tab displays any related care management or asthma data for the patients in the panel.

![Sample Care Mgmt tab](image)

**Figure 9-29: Sample Care Mgmt tab**

iCare provides you with existing Register capabilities for iCare panels for specific underlying case management applications.
This tab displays information from the register (shown in the Care Mgmt Group field) for the patients in the panel. You must select an option for this field in order to view the data.

The underlying RPMS application for the HIV/AIDS Register option is BKM.

9.9.1 Main Tab for HIV/AIDS Register

When you select HIV/AIDS register in the Care Mgmt Group field, the Main tab displays the HMS management system register information.

See Section 4.5 Buttons on Right Side of Window to learn about how to use the buttons on the right side of the toolbar.

9.9.1.1 Main Tab for HIV/AIDS Register Layout

The following table provides information about the default columns.

<table>
<thead>
<tr>
<th>Column</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flags</td>
<td>Flag 🔄 indicator displays when a patient has a flag. This column is always the first column and can only be removed by turning all flags “off” in the User Preferences (see Section 3.1.1.2 Flag Setup Tab).</td>
</tr>
<tr>
<td>Patient Name</td>
<td>Required field and will link to the Patient Record if you double-click on it. See Section 10.0 Patient Record for more information.</td>
</tr>
<tr>
<td>HRN</td>
<td>Health Record Number (required).</td>
</tr>
<tr>
<td>Sex</td>
<td>F (for female) or M (for male).</td>
</tr>
<tr>
<td>DOB</td>
<td>Patient’s date of birth (required).</td>
</tr>
<tr>
<td>Designated PCP</td>
<td>Designated Primary Care Provider, if any. Not all facilities use this field to empanel patients.</td>
</tr>
<tr>
<td>Community</td>
<td>The patient’s community of residence.</td>
</tr>
<tr>
<td>Active DX Tags</td>
<td>Predefined Diagnosis definitions (“tags”) that iCare has proposed for this</td>
</tr>
</tbody>
</table>
If a Community cell contains the Community Alert icon, you can view the Community Alert text by hovering your mouse over the icon.

There is hover help for the columns displaying HMS register-specific data. For example, you can view the help by hovering your mouse over the HIV Provider column heading.

Use the Layout function (on the Care Management tab) to determine the columns that display on the Main tab. See Section 9.9.1.1 Main Tab for HIV/AIDS Register Layout for more information.

You can sort/filter the columns and perform other column functions. See Section 4.1 Working with Columns for more information.

9.9.1.2 Main Tab for HIV/AIDS Register Toolbar

See Section 4.5 Buttons on the Right Side of Window for more information about the buttons on the right side of the toolbar.

Copy Patient(s)

This action copies patient information to the iCare clipboard.

Select one or more patients (see Section 4.2 Selecting Records for more information about selecting patients) and then do one of the following:

- Click the Copy Patient(s) button
- Select Care Management | Main | Copy Patient(s)
- Use the keyboard combination Ctrl+C

You must go to another panel view (for a different patient panel) and paste the patient’s information.

Layout

Click the Layout button (or select File | Layout or select Care Management | Main | Layout) to display the Register Main Layout dialog, where you can determine the columns in the Main tab.

The following shows the layout dialog when you are using AIDS/HIV register.
Figure 9-31: Sample Care Mgmt Main Tab Layout window for HIV/AIDS

A similar dialog displays when you are using the Asthma register.

Figure 9-32: Sample Care Mgmt Main Tab Layout window for Asthma
See Section 4.9 Layout Dialog Functionality for information on how to use this layout window.

**Change Status**

You use the Accept, Not Accept, and Proposed button (or select these options on the Care Mgmt | Main menu) to change the Status on an existing record.

Select the patient record whose status you want to change and click the appropriate “change status” button to display the Update Diagnostic Tag dialog.

![Sample Update Diagnostic Tag dialog](image)

Figure 9-33: Sample Update Diagnostic Tag dialog

All fields are required on this dialog.

The radio buttons available for the Status Change Reason changes according to what you select in the New Status field.

The “Not Accept” function cannot be performed on multiple patients or multiple tags.

See Section 9.8.2.2 Add Tag for more information about the fields and “View Tag Activity” button on this dialog.
Update

You can batch update register data for selected patients by clicking the Update button (or by selecting Care Management | Main | Update). (See Section 4.2 Selecting Records for more information about selecting patients.) The Batch Update Data dialog will display.

![Batch Update Data Dialog](image)

Figure 9-34: Sample Batch Update Data Dialog

After you choose an option from the Select drop-down list, a second field displays. When the second field has an ellipsis button, click it to search for the name on a lookup dialog; see Section 4.12 Table Lookup for more information.

Click OK to save your information. (Otherwise, click Cancel). After the update is complete, the “HMS Register data has been saved successfully to RPMS” message displays; click OK to dismiss this message.

After clicking OK, you need to refresh the screen in order to see the changes.

9.9.1.3 Reports Button

Select one or more patients and click the drop-down list on Reports button (or select Care Management | Main | Reports) to view the Quality of Care report. (See Section 4.2 Selecting Records for more information about selecting patients.) The reports define their scope based on the patients that are members of a given panel.

Quality of Care Report
If you selected more than one patient on the panel, the Report Population field will display “Selected Patient(s) (n selected)” where n is the number of patients selected.

You populate the fields on the Quality of Care dialog by selecting any option on the drop-down list. Then, click OK (otherwise, click Cancel).

iCare will provide the ability to display, print, and export the existing BKM Quality of Care Report from the Panel Register view.

This report includes all patients who have at least one HIV/AIDS POV or Active Problem List or HMS Initial HIV Dx Date or HMS Initial AIDS Dx Date at least 182 days (6 months) prior to Report End Date.

Below is an example of the first part of the report:
The following shows a page of the report, near the bottom, describes the criteria of the selected denominator for the report.

![Sample Report, Page 1](image-url)
The final page of the report displays all of the patients in the selected denominator (those patients on the report).

See Section 4.7 Pop-up Functionality about the buttons and File menu on this window.

### 9.9.1.4 Mail Merge

Click the Mail Merge Export button (or select Tools | Mail Merge or press Ctrl+M) to display the Mail Merge Export window. See Section 4.10 Mail Merge for more information about the mail merge process.
9.9.1.5  Glossary Button

Click the Glossary button (or select Help | Care Management Glossaries | HIV/AIDS Glossary or select Tools | Glossary) to display the HIV/AIDS / Care Management Glossary pop-up. This pop-up provides the detailed logic for each national performance measure defined in the Clinical Reporting System. See Section 4.14.5 HIV/AIDS / Care Management Glossary for more information.

9.9.2  Reminders Tab for HIV/AIDS Register

The Reminders tab view displays the disease/register-specific reminders for the patient, effective for the date shown in the toolbar.

Figure 9-38: Sample Reminders Tab

If you are using the Asthma option on the Care Mgmt Group field, there is NO Reminders tab.

9.9.2.1  Reminders Tab for HIV/AIDS Register Toolbar Options

The toolbar shows the date for which the data is valid.

The fields on the view are based on what is selected in the Care Management Group field (of the Care Management tab).

You can display a tooltip about a reminder by hovering your mouse over the column heading.

You can sort/filter the columns and perform other column functions. See Section 4.1 Working with Columns for more information.

See Section 4.5 Buttons on Right Side of Window for more information about the buttons on the right side of the toolbar.
Due/Overdue Dates

A date (or “N/A”) will be displayed under each of the Reminders columns. If the test or procedure is currently due or overdue, an icon will be displayed next to the date, as shown below. The icon is not displayed for dates that are not yet due (in the future).

Figure 9-39: Sample Overdue Date for Chlamydia Reminder

Tooltip for Exam/Procedure

You can hover your mouse over a exam/procedure column heading to view information about it. The information is pulled from the Reminders application.

Copy Patient(s) Button

Click the Copy Patient(s) button to copy the selected patients information to the iCare clipboard.

Mail Merge

Click the Mail Merge Export button (or select Tools | Mail Merge or press Ctrl+M) to display the Mail Merge Export window. See Section 4.10 Mail Merge for more information about the mail merge process.

Glossary Button

Click the Glossary button (or select Help | Reminders Glossary or select Tools | Glossary) to display the Reminders Glossary pop-up. This pop-up displays the Reminder descriptions (from RPMS). It contains descriptions of the logic behind each national health summary reminder available for display in iCare. See Section 4.14.4 Reminders Glossary for more information.

9.9.3 Main Tab for Asthma

Only the Main tab displays for the Asthma option for the care management group.
When using the Asthma option on the Care Mgmt Group field, the application displays the date the asthma-related data was updated.

### 9.9.3.1 Main Tab for Asthma Layout

When using the Asthma option on the Care Mgmt Group field, you should add Asthma specific data columns, such as Asthma Severity, Asthma Tag Status, Last Asthma Visit Date (link to visit record), most recent (and highest) Peak Flow (date has hover help), most recent Asthma Control value (date has hover help), most recent (and highest) FEV1/FVC values, Last Action Plan Date (link to visit record), Last Flu Shot date (link to visit record). See Section 9.9.3.1 Main Tab for Asthma Layout for more information about selecting these fields.

The following table provides information about the default columns.

<table>
<thead>
<tr>
<th>Column</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flags</td>
<td>Flag 🚩 indicator displays when a patient has a flag. This column is always the first column and can only be removed by turning all flags “off” in the User Preferences (see Section 3.1.1.2 Flag Setup Tab).</td>
</tr>
<tr>
<td>Asthma</td>
<td>Indicates if the patient has asthma diagnosis.</td>
</tr>
<tr>
<td>Patient Name</td>
<td>Required field and will link to the Patient Record if you double-click on it. See Section 10.0 Patient Record for more information.</td>
</tr>
<tr>
<td>HRN</td>
<td>Health Record Number (required).</td>
</tr>
<tr>
<td>Sex</td>
<td>F (for female) or M (for male)</td>
</tr>
<tr>
<td>Age</td>
<td>Patient’s age today.</td>
</tr>
<tr>
<td>DOB</td>
<td>Patient’s date of birth (required)</td>
</tr>
<tr>
<td>Column</td>
<td>Meaning</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Designated PCP</td>
<td>Designated Primary Care Provider, if any. Not all facilities use this field to empanel patients.</td>
</tr>
<tr>
<td>Community</td>
<td>The patient’s community of residence.</td>
</tr>
<tr>
<td>Active DX Tags</td>
<td>Predefined Diagnosis definitions (“tags”) that iCare has proposed for this patient, based on the tagging function.</td>
</tr>
<tr>
<td>Remaining Columns</td>
<td>The Asthma register-specific data.</td>
</tr>
</tbody>
</table>

If a Community cell contains the Community Alert icon, you can view the Community Alert text by hovering your mouse over the icon.

There is hover help for the columns displaying Asthma register-specific data. For example, there is view the help by hovering your mouse over the Asthma Severity column heading.

You use the Layout function (on the Care Management tab) to determine the columns that display on the Main tab. See Section 9.9.3.1 Main Tab for Asthma Layout for more information.

You can sort/filter the columns and perform other column functions. See Section 4.1 Working with Columns for more information.

### 9.9.3.2 Main Tab for Asthma Toolbar

See Section 4.5 Buttons on the Right Side of Window for more information about the buttons on the right side of the toolbar.

The Reports button is inactive on the Asthma toolbar. See Section 9.9.3.2 Main Tab for Asthma Toolbar for more information about the buttons on the Main tab for the Asthma toolbar.

Use the Glossary button to access the HIV/AIDS/Care Management Glossary. See Section 4.14.5 HIV/AIDS / Care Management Glossary for more information.

### 9.9.4 Care Management Tab Menus

The options on the File menu for the Care Management Tab are the same as those on the Patient List Tab. See Section 9.2.3.1 File Menu for more information.

The options on the Tools menu for the Care Management Tab are the same as those on the Diagnostic Tags tab. See Section 9.8.3 Diagnostic Tags Tab Menu Options for more information.

The Care Management menu has options that depend on the tab (Main or Registers) you are on.
The Care Management menu options for the Main tab are:

- **Copy Patient(s):** this option allows you to copy the selected patient’s information to the iCare clipboard.
- **Layout:** this option displays the Register Main Layout dialog, where you can determine the columns in the Main tab.
- **Update:** this option performs a batch update of register data.
- **Reports:** the submenu lists the available reports.

The Care Management menu option for the Reminders tab is:

- **Copy Patient(s):** this option allows you to copy the selected patient’s information to the iCare clipboard.
10.0 Patient Record

The patient record window has several tabs and other information that shows patient data information stored in the RPMS database. This window provides a wide range of clinical data, with a focus providing quick access to data that is accessed frequently.

The iCare application allows the user to navigate to an individual patient and display the patient record, even if the patient is not on any of the user’s panels.

The patient record window can be accessed either by opening a patient record on a panel or by a direct search for a patient name. The Patient Search function is available on several iCare windows. See Section 4.4 Quick Patient Search for more information.

![Sample Patient Record window](image)

Figure 10-1: Sample Patient Record window

As a general rule, when you double-click any date that is underlined (in the Date column), the Visit File dialog will display.

10.1 Patient Demographic Group Box

The top group box shows the patient demographic information. This information remains visible from any tab.
10.1.1 Community Alerts for Community

The Community field shows any alerts about the community in which the patient resides. If the community alert icon is displayed, you can click it to display the “Community Alerts for” pop-up.

Figure 10-3: Sample Community Alerts for Community pop-up

See Section 8.2.1 Community Alerts Tab Layout for more information about the columns on this pop-up.

10.1.1.1 Menus on Community Alerts for Community

The File menu contains the following options:

**Page Setup**: This option allows you to set Margin, Paper, Layout characteristics (like landscape or portrait orientation), and the Printer to use.

**Print Preview**: This option displays the print preview dialog.

**Print**: This option sends the page to the printer using the settings in Page Setup. Note that only the selected tab (Panel List or Flag List) will be printed.

**Close**: The option closes the alert.
The Edit menu contains the Select All option. This option will select all of the records in the grid.

The Tools menu contains the **Search**, **Excel Export**, **Copy Rows to Clipboard** work like the buttons on the right side of the window. See Section 4.5 Buttons on Right Side of Window for more information.

### 10.1.1.2 Buttons on Community Alerts for Community

See Section 4.5 Buttons on Right Side of Window to learn about how to use the buttons on the right side of the toolbar.

### 10.1.2 Allergies Field

The Allergies field pulls data (about the patient) directly from the Adverse Reaction Tracking application. Each reaction shows a tooltip (Causative Agent, Reaction, Date of Onset, Historical or Observed).

### 10.1.3 Barriers to Learning Field

The Barriers to Learning field lists the current values for any health factor categorized as Barriers to Learning, e.g., Blind.

### 10.1.4 Edit Patient Demographic Data

The user with appropriate iCare Editor access can edit any of the available phone number fields (Home Alternate, Work) on the Demographic header area.

Click the “pencil” button next to the phone number to display the Edit patient demographic fields dialog.
Use this dialog to change the particular phone numbers, the ethnicity, and/or the race of the patient.

**Phone:** Populate the phone field with the appropriate number, using 4-60 characters in length. This applies to the Home Phone, Work Phone, and Alternate Phone fields.

**Ethnicity:** Use any option on the drop-down list. After populating this field, the Method of Collection field become active.

**Method of Collection:** Use any option on the drop-down list.

**Race:** Use any option on the drop-down list.

When you are finished with this dialog, click OK to save the data (otherwise, click Cancel to not save.)

If you click OK, the application displays the “Confirm save to RPMS” dialog, asking if you want to save the data to the RPMS server. Click Yes to save (otherwise click No). This dismisses the dialog.

If you click Cancel and you have changed any data, the application displays the “Save to RPMS?” information message, asking if you want to save the data to RPMS. Click Yes to save, click No to not save, or click Cancel. Any option dismisses the dialog.

### 10.1.5 Edit Providers

You can edit the DPCP providers by clicking the “pencil” button next to the DPCP field. The application displays the Edit Providers dialog (for the current patient).
Figure 10-5: Sample Edit Provider dialog

Use the Edit Providers dialog to add, edit, or remove providers. See Section 4.17 Edit DPCP Providers for more information about this dialog.

10.1.6 Additional Demographics Button
You can view more information about the patient’s demographics by clicking the Additional Demographics button on the Patient Record window. The Additional Demographics pop-up will display. Click OK to dismiss this dialog.

10.1.6.1 Demographic Detail Tab
Below is the information on the Demographic Detail tab.
You can change the Race and/or Ethnicity field by clicking the “pencil” button next to either field. This action displays the Edit patient demographic fields dialog. See Section 10.1.4 Edit Patient Demographic Data for more information.

10.1.6.2 Household Tab

You can view additional household information by clicking the Household tab. These data values are from the RPMS Patient Registration application (and are view only).
10.2 Specifying the Default Tab

You can set the default tab for the Patient Record window by defining it on the User Preferences (select Tools | User Preferences) and using the Patient View tab. This means that when you access the Patient Record window, the default tab will be on top. See Section 3.2.4 Patient View for more information.

If you do NOT specify a default tab, the default tab will be Cover Sheet.

10.3 Cover Sheet Tab

The Cover Sheet tab includes several categories of data, such as Providers, Recent Visits, etc.
The icon next to each group box name is the expand-collapse symbol. These symbols work like they do in any Windows application.

- Click the Expand symbol to expand group box.
- Click the Collapse symbol to collapse a group box.

See Section 4.5 Buttons on Right Side of Window to learn about how to use the buttons on the right side of each group box.

You can sort/filter the columns and perform other functions on the columns. See Section 4.1 Working with Columns for more information.

10.3.1 Recent Visits Group Box

The Recent Visits group box displays the visits in order of most recent visit first, within the selected timeframe. You can determine the time range for the visit display by selecting an option from the drop-down list: 1 month, 3 months, 6 months, 1 year, 2 years, and Ever (the default is 1 month).

10.3.1.1 Tooltip for Key Visit Information

Hover your mouse over a record to view key visit information (such as diagnosis, provider, etc.) about the visit.
10.3.1.2 Visit Detail

Double-click any row of the Recent Visits group box to display the Visit Detail pop-up. See Section 4.7 Pop-up Functionality for more information about the buttons and the File menu on the pop-up.

10.3.2 Scheduled Appointments Group Box

The Scheduled Appointments group box displays the patient’s scheduled appointments in order of closest upcoming appointment first, within the selected timeframe. You can determine the time interval for the appointments display by selecting an option from the drop-down list: 2 weeks, 1 month, and 3 months (the default is 1 month).

10.3.3 Providers Group Box

The Providers group box displays the provider roles designated in the RPMS Designated Specialty Provider Management System if provider names have been assigned. If your facility is actively using this application, you will see a list of providers and case managers for this patient.

![Sample Providers Group Box](image)

Figure 10-9: Sample Providers Group Box

10.3.3.1 Link to Last Visit Date

The Last Visit date is linked to the RPMS visit record. Double-click any record to view the Visit Detail pop-up. See Section 4.7 Pop-up Functionality for more information about pop-ups.
10.3.3.2 Edit Button

You can add and edit provider entries. This feature requires either the iCare Editor (BQIZCMED) or iCare Package Manager (BQIZMGR) security key. Choices for new entries will be limited to the existing BDP Category Name list. The user will NOT be able to enter a new BPD Category Name; this function will continue to be performed by an assigned manager within the BDP interface. All additions and changes, including the user name and date the record is edited via the iCare interface will be recorded in BDP (Designated Specialty Provider).

Click the Edit button to display the Edit Providers window.

![Sample Edit Providers Window](image)

Figure 10-10: Sample Edit Providers Window

Use this dialog to add, edit, or remove providers. You can dismiss the Edit Providers window by selecting File | Close.

See Section 4.17 Edit DPCP Providers for more information about this dialog.

10.3.4 Insurance Group Box

The Insurance group box displays all insurances defined as “active” in Patient Registration and the effective date. There can be multiple active insurances.
10.3.5 Panels Group Box

The Panels group box displays the names of all iCare panels available to the user of which this patient is a member.

10.3.5.1 Tooltip for Panel Description

Hover your mouse over a record to display a description of the panel.

10.3.5.2 Add to Panel Button

If you want to add the patient to another panel, click the Add to Panel button to display the Add/Remove Panels dialog.
Figure 10-13: Sample Add/Remove Panels Dialog

See Section 4.8 Add/Remove Functionality for more information about the Add/Remove dialog.

Click OK to add this patient to the specified panels (listed in the Current Panels area). The panels will now display under the Panels group box. (Otherwise, click Cancel.)

10.3.6 Registers Group Box

The Registers group box displays the Register names of which the patient is a member. Register names that the user does not have security access will be displayed as grayed out. The data shows the patient’s register status (in the Status column).

Hover your mouse over a record to display a tooltip about the status (Status, Status Date, and Category).

10.3.7 Cover Sheet Tab Menus

For information about the Edit, Window, and Help menus, see Section 4.3 Menus for more information.

10.3.7.1 File Menu

The options on the File menu for the Cover Sheet tab are:

**New**: this option displays the Panel Definition dialog where you create a new panel definition. See Section 5.0 Creating Patient Panels for more information about this window. This is the same as pressing the Ctrl+N key combination.

**Page Setup**: this option allows you to set Margin, Paper, and Layout characteristics (like landscape or portrait orientation) for printing. You can select a different printer.
**Print Preview**: this option displays the Print Preview dialog.

**Print**: this option outputs the information, using the settings from Page Setup. This is the same as pressing the Ctrl+P key combination.

**Background Jobs**: this option displays a pop-up showing background jobs information. See Section 4.11 Background Jobs for more information.

**Close**: this option dismisses the current open patient record window.

### 10.3.7.2 Tools Menu

The options on the Tools menu for the Cover Sheet tab are:

**Quick Patient Search**: this option executes a patient search. See Section 4.4 Quick Patient Search for more information about this functionality.

**User Preferences**: this option takes you to the User Preferences window where you can change your user preferences. See Section 3.2 Modifying Your User Preferences for more information about the tabs on this window.

**Web Links**: this option shows several categories (such as Asthma) that have Web links. When you select a Web link, the Internet browser for the particular category opens.

### 10.4 Snapshot Tab

The Snapshot tag has Sections of information that are linked to the underlying RPMS visit record. This tab shows several types of data with a more clinical focus that are useful for case management review. The intention is to highlight more urgent information on this screen in considering various patient conditions.
The visit date listed within any of the Sections of the Snapshot view will be a link to the underlying RPMS visit record. You can open the visit related to the various Sections in the same manner currently used in Diagnostic Tags on the Cover Sheet.

You can sort/filter the columns and perform other functions on the columns. See Section 4.1 Working with Columns for more information.

See Section 4.5 Buttons on Right Side of Window to learn about how to use the buttons on the right side of the group boxes.

### 10.4.1 Active Diagnostic Tags Group Box

The Active Diagnostic Tags group box displays a list of Predefined Diagnosis definitions (“tags”) that iCare proposed for this patient, based on the tagging function.

You can navigate to the diagnostic tags tab on the patient view to find more detail about the tags and the qualifying criteria identified while evaluating tag logic criteria.
10.4.1.1 Details Button

Select a record and then click the Details button to move to the DX Tags tab for the particular tag. Here you view the status, date, item, value, and factor about the selected tag.

10.4.1.2 Tooltip for Active Diagnostic Tags Tab

Hover your mouse over a value in the Tag Name column to display the definition of the tag.

Hover your mouse over a value in the Status column to display status information (Last Updated, Updated By, Status Change Reason, Status Comment)

Hover your mouse over a value in the Factor column to display factor information (Compliance Value, Last Updated).

10.4.1.3 iCare Taxonomy View/Edit

Double-click any Factor cell in the Active Diagnostic Tags group box to display the iCare Taxonomy View/Edit dialog.

![Sample iCare Taxonomy View/Edit Dialog](image)

Figure 10-16: Sample iCare Taxonomy View/Edit Dialog
If you do not have access rights to edit taxonomies, this dialog will display that information.

In the iCare Taxonomy View/Edit window you can view the high and low values used for the Factor data. Other taxonomies you can view are (besides All): All Site Populated, CPT Procedures, ICS Procedures, Lab Tests, Medications, Other, Procedures, Registers. Click OK to dismiss the dialog.

If you have edit privileges (iCare Taxonomy Editor with security key BQIZTXED), you can add/remove values. See Section 4.15 iCare Taxonomy Editor Function for more information.

Click OK to save any changed data (otherwise, click Cancel).

10.4.2 Family History Group Box

The Family History group box displays an overview of the family history information that is relevant to case management. This data is pulled directly from the IHS Dictionaries/Patient: Family History File (9000014).

![Sample Family History Group Box](image)

Figure 10-17: Sample Family History Group Box

The default display will be sorted by the Sort Order and then by Relationship.

10.4.2.1 Tooltip for Columns

Hover your mouse over any record to view a tooltip (Diagnosis Code, Date Noted).

10.4.2.2 Details Button

Select a record and then click the Details button to move to the Family HX tab of the Patient Record screen. This tab displays the following information about the selected record: relative, relation modified, DX code, condition narrative, age of onset, status, age of death, cause of death, multiple birth value, multiple birth type, and last modified.
10.4.3 Reproductive Factors

The Reproductive Factors group box displays the current patient’s reproductive history (from the AUPN IHS Dictionaries/ Patient Reproductive Factors file). This applies to female patients only. This group box will display only for patients who have an entry.

![Sample Reproductive Factors Group Box](image)

**Last Menstrual Period**: the value shows the date of the patient’s last menstrual period.

**Estimated Date of Confinement (EDC)**: the value shows the patient’s estimated delivery date.

**Gravida**: the value shows the number of times this patient has been pregnant.

**Full Term Births (Parity)**: the value shows the number of full term births for the patient.

**Premature Births**: the value shows the number of premature births for the patient.

**Therapeutic Abortions**: the value shows the number of abortions induced when pregnancy constitutes a threat to the physical or mental health of the mother.

**Spontaneous Abortions**: the value shows the number of naturally occurring expulsions of a nonviable fetus.
**Ectopic Pregnancies:** the value shows the number of gestations elsewhere than in the uterus (such as in a fallopian tube or in the peritoneal cavity).

**Multiple Births:** the value shows the number of multiple births for the patient.

**Living Children:** the value shows number of living children of the patient.

**Current Contraception Method:** the value displays the current method of contraception.

**Current Contraception Begun:** the value shows the date the current contraception method started.

### 10.4.4 Measurements (Last Visit) Group Box

The Measurements (Last Visit) group box displays two sets of data: (1) the patient’s most recent Height and Weight data and (2) all measurement data documented at the patient’s last visit. This will include a calculated BMI only if the height and weight meets the standard CRS definition. This information comes from PCC, the V Measurement file.

![Sample Last Measurements Group Box](image)

Figure 10-19: Sample Last Measurements Group Box

There will always be height and weight values. After height and weight, the measurements are displayed in alphabetical order by Measurement Name.

Double-click any record in this group box to display the Visit Detail pop-up. See Section 4.7 Pop-up Functionality for more information about the buttons and the File menu on the pop-up.

### 10.4.5 Last Routine Events Group Box

The Last Routine Events group box displays a list of the most recent routine screenings, based on Health Summary Reminders logic, that are tailored to the specific patient based on age, sex, etc. This information comes from PCC.
10.4.6 Snapshot Tab Menus

The options on the File menu of the Snapshot tab are the same as those on the Cover Sheet tab. See Section 10.3.7.1 File Menu for more information.

To review the options on the Edit, Window, and Help menus, see Section 4.3 Menus.

The options on the Tools menu of the Snapshot tab are the same as those on the Cover Sheet tab. See Section 10.3.7.2 Tools Menu for more information.

10.5 Flags Tab

The Flags tab displays a list of the patient’s “flags” identified by the iCare application.

10.5.1 Flags Tab Layout

The Flags Tab layout on the Patient Record has the same default columns as those on the Flag List window. See Section 7.1.1 Flag List Columns for more information.
10.5.2 Flags Tab Toolbar

The Flags tab toolbar on the Patient Record is the same as the toolbar on the Flag List window. See Section 7.2 Flags Toolbar for more information.

10.5.3 Flags Tab Menus

The options on the File menu of the Flags tab are the same as those on the Cover Sheet tab. See Section 10.3.7.1 File Menu for more information.

To review the options the Edit, Window, and Help menus, see Section 4.3 Menus for more information.

10.5.3.1 Flags Menu

The options on the Flags menu work like the action buttons on the left side of the Flags tab. See Section 7.0 Flag List for more information.

10.5.3.2 Tools Menu

The options on the Tools menu for the Flags tab are:

Quick Patient Search: this option executes a patient search. See Section 4.4 Quick Patient Search for more information about this functionality. This is the same as pressing the F8 key on your keyboard.

Reset View: this option causes the default view of the Flags tab to display (used when you alter the columns, for example). This is the same as pressing Ctrl+R key combination.

Refresh: this option refreshes the Flags tab by retrieving the most up-to-date information from the server. This is the same as pressing the F5 key on your keyboard.

Search, Excel Export, Print, Copy Rows to Clipboard: these options operate like the buttons on the right side of the window. See Section 4.5 Buttons on Right Side of Window for more information about these functions.

User Preferences: this option takes you to the User Preferences window where you can change your user preferences. See Section 3.2 Modifying Your User Preferences for more information about the tabs on this window.
Web Links: this option shows several categories (such as Asthma) that have Web links. When you select a Web link, the Internet browser for the particular category opens.

10.6 Reminders Tab

The Reminders tab lists the national reminders that are pulled from the same data as the Health Summary report reminders in RPMS (such as lab test, immunization, etc.). The Show field determines what reminders that will display. You can check more than one selection by clicking the up or down arrows.

![Sample Reminders Tab](image)

This tab has a due date highlighting feature where overdue reminder dates are highlighted with a warning indicator (▲).

The default sort order is by due date, with the most overdue first, then sorted by Category, Clinical Group, and Reminder Name.

You can display the Asthma Reminders on the Reminders view by selecting Asthma check box in the Show field.

You can display the HIV Management System (HMS) reminders on the Reminders view by selecting the HMS Register check box in the Show field.

The category will be “Care Management” and “HIV” will be the clinical group. The denominator for the HMS reminders will be any patient with a proposed or accepted tag for HIV. The default display will continue to be by due date, most overdue first, and then alpha by Category, Clinical Groups, and Title. Note: the register status is NOT considered for the denominator definition.

iCare will display a warning message if the HMS Reminders category (in the SHOW field) is selected and the patient does not meet the denominator (proposed or accepted HIV tag). Message reads: HIV Reminders will not display for this patient because he/she does not have a diagnostic tag for HIV/AIDS.
If the patient has no diagnostic tag or register status, the application displays the message: HIV Reminders will not display for this patient because he/she does not have a diagnostic tag or register status for HIV/AIDS. Click OK to dismiss the message.

If the patient has no diagnostic tag or register status, the application displays the message: Asthma Reminders will not display for this patient because he/she does not have a diagnostic tag or register status for Asthma. Click OK to dismiss the message.

10.6.1 Reminders Tab Layout

Below is an overview of the columns.

**Category**: the “source” of the reminder logic. Examples are: Health Summary (i.e., Health Maintenance Reminders), HMS (HIV Management System), DMS (Diabetes Management System), EHR, etc.

**Clinical Group**: the name of the clinical performance group.

**Reminder Name**: the name of the clinical procedure that needs to be done. This data comes from PCC Reminders. You can view a tooltip by hovering your mouse over any Reminder Name cell.

**Due Date**: the date the reminder procedure is due. This column will display the warning indicator (⚠️) if any of the patient’s reminders are overdue. This date is derived from the Health Summary Reminders Next Due text.

**Next Due**: the actual text from the Reminders Next Due display on the Health Summary.

**Last Date Performed**: the date that the reminder procedure was most recently completed.

You can sort/filter the columns and perform other functions on the columns. See Section 4.1 Working with Columns for more information.

10.6.2 Reminders Tab Toolbar

The Patient Reminders data is current as of the date shown on the toolbar. The reminders are calculated on-the-fly.

See Section 4.5 Buttons on Right Side of Window to learn about how to use the buttons on the right side of the toolbar.

You can display a tooltip by hovering your mouse over the Reminder Name field.
10.6.2.1 **Recalc**

Click the Recalc button (or select Reminders | Recalc) to get the latest data from the server and to run the algorithm.

10.6.2.2 **Background Jobs**

Click the Background Jobs button to display the Background Jobs pop-up. See Section 4.11 Background Jobs for more information.

10.6.2.3 **Glossary**

Click the Glossary button (or select Help | Reminders Glossary or select Tools | Glossary) to display the Reminders Glossary pop-up. See Section 4.14.4 Reminders Glossary for more information.

10.6.3 **Reminders Tab Menus**

To review the options on the Edit, Window, and Help menus, see Section 4.3 Menus.

10.6.3.1 **File Menu**

The options on the File menu of the Reminders tab are the same as those on the Cover Sheet tab. See Section 10.3.7.1 File Menu for more information.

10.6.3.2 **Tools Menu**

The options on Tools menu for the Reminders tab are:

**Quick Patient Search**: this option executes a patient search. See Section 4.4 Quick Patient Search for more information about this functionality. This is the same as pressing the F9 key on your keyboard.

**Glossary**: this option displays the Reminders Glossary pop-up. See Section 4.14.4 Reminders Glossary for more information. (This is the same as selecting Help | Reminders.) This is the same as using the Ctrl+G key combination.

**Reset View**: this option returns current view to the default view (use after altering the columns, for example). This is the same as using the Ctrl+R key combination.
Refresh: this option refreshes the Reminders tab by retrieving the most up-to-date information from the server. This is the same as pressing the F5 key on your keyboard.

Search, Excel Export, Print, Copy Rows to Clipboard: these options operate like the buttons on the right side of the window. See Section 4.5 Buttons on Right Side of Window for more information.

User Preferences: this option takes you to the User Preferences window where you can change your user preferences. See Section 3.2 Modifying Your User Preferences for more information about the tabs on this window.

Web Links: this option shows several categories (such as Asthma) that have Web links. When you select a Web link, the Internet browser for the particular category opens.

10.7 BP Prompts Tab

The Best Practice (BP) Prompts tab displays a list of suggested treatments based on pre-determined prompt logic (including new CVD and existing Asthma reminders). CVD Treatment prompts are callable by the Health Summary or other RPMS applications. The best practice prompts can be turned off via the PCC Health Summary functions.

![Sample BP Prompts tab](image)

Figure 10-23: Sample BP Prompts tab

10.7.1 BP Prompts Layout

The data columns on the Best Practice Prompts tab are described below.

Clinical Group: the name of the clinical group.

Prompt Name: the name of the best practice prompt.
Guidance: the text that defines the diagnosis.

A tooltip displays by hovering your mouse over the Prompt Name cell. The text is pulled from the Tooltip field in the Treatment Prompt file.

10.7.2 BP Prompts Toolbar

The field with the drop-down list determines what data within each clinical group will be displayed: either the TOP 5 or ALL. The default is TOP 5.

The time/date for the last data update is shown in the toolbar.

See Section 4.5 Buttons on Right Side of Window to learn about how to use the buttons on the right side of the toolbar.

10.7.2.1 Recalc

Click the Recalc button (or select Best Practice Prompts | Recalc) to get the latest data from the server and to run the algorithm.

10.7.2.2 Background Jobs

Click the Background Jobs button (or select File | Background Jobs) to display the Background Jobs pop-up. See Section 4.11 Background Jobs for more information.

10.7.2.3 Glossary

Click the Glossary button (or select Help | Best Practice Prompts Glossary or select Tools | Glossary) to display the Best Practice Prompts Glossary pop-up. See Section 4.14.6 Best Practice Prompts Glossary for more information.

10.7.3 BP Prompts Tab Menus

The options on the File menu of the Best Practice Prompts tab are the same as those on the Cover Sheet tab. See Section 10.3.7.1 File Menu for more information.

The options on the Tools Menu on the Best Practice Prompts tab are the same as those on the Reminders tab. See Section 10.6.3.2 Tools Menu for more information.

For information about the Edit, Window, and Help menus, see 4.3 Menus for more information.
10.8 Natl Measures Tab

The Natl Measures tab displays the patient’s GPRA performance status (based on the CRS national summary report).

![Sample National Measures tab](image)

Figure 10-24: Sample National Measures tab

This detailed list shows all national CRS measures broken down by clinical group along with the current patient’s status with respect to the measure.

The toolbar on this tab displays the date that iCare most recently processed the National Measures logic on your facility’s RPMS database. The default setting for the National Measures’ logic “run” is weekly; your Site Manager might have selected a different time frame.

10.8.1 Natl Measures Tab Layout

The data columns on the Natl Measure tab are described below.

- **Category**: the name of the category, National GPRA, Non-National, or Other National Measures.

- **Clinical Group**: the name of the clinical performance group.

- **Measure Name**: the measure title derived from the Summary Report. A description of the performance logic (tooltip) will display when you hover the mouse over the name.
**Performance Status**: displays the current status (as of the date listed on the toolbar) of this patient’s performance to the specific measure. The logic is derived from CRS. Values are Yes, No, or N/A; in some cases, it will be an integer, such as total number of dental sealants. If the patient does not meet the denominator definition, the value is N/A.

**Adherence Value**: displays the visit date and clinical procedure that meets the performance numerator definition.

You can sort/filter the columns and perform other functions on the columns. See Section 4.1 Working with Columns for more information.

### 10.8.2 Natl Measures Tab Toolbar

The time/date for the last data update is shown in the toolbar.

See Section 4.5 Buttons on Right Side of Window to learn about how to use the buttons on the right side of the toolbar.

#### 10.8.2.1 Recalc

Click the Recalc button to get the latest data from the server and to run the algorithm.

#### 10.8.2.2 Background Jobs

Click the Background Jobs button to display the Background Jobs pop-up. See Section 4.11 Background Jobs for more information.

#### 10.8.2.3 Glossary

Click the Glossary button (or select Help | National Measures Glossary or select Tools | Glossary) to display the National Measures Glossary pop-up. See Section 4.14.3 National Measures Glossary for more information.

### 10.8.3 Natl Measures Tab Menus

The options on the File menu of the Natl Measures tab are the same as those on the Cover Sheet tab. See Section 10.3.7.1 File Menu for more information.
The options on the Tools Menu on the Nat’l Measures tab are the same as those on the Reminders tab. See Section 10.6.3.2 Tools Menu for more information.

For information about the Edit, Window, and Help menus, see Section 4.3 Menus for more information.

10.9 Summ/Supp Tab

The Summ/Supp tab displays a selected type of report (shown in the Type field): Face Sheet, Health Summary, Patient Wellness Summary, and Supplement. These reports are from RPMS.

When you first access this tab, it will be blank. You must select an option from the drop-down list for the Type field.

You can display and print existing condition-specific (i.e., register specific) Supplements.

![Figure 10-25: Sample Summ/Supp Tab](image)

See Section 12.8.1 HIV/AIDS Patient Care Supplement for more information about the different types of supplements.

10.9.1 Summ/Supp Tab Toolbar

The Type field determines the summary/supplement reports to be displayed.

The health summary type has a secondary selection (the Adult Regular is the default view).
The Supplement and the Patient Wellness Handout reports also have a secondary selection.

The Refresh button is not intuitive to the users that when they select a second HS type, and then return to the initial HS, they have to use Refresh in order to display updated data, e.g., after entering PCC data.

The Find button allows you to search for a specific text string within the report text. This is especially useful for finding information within long reports.

The Print Preview button provides a preview of page layout prior to printing the report on a printer.

The Print button outputs the report, using the selected setup and printer settings for the selected print.

10.9.2 Summ/Supp Tab Menus
To review the options on the Edit, Window, and Help menus, see Section 4.3 Menus.

10.9.2.1 Tools Menu
The options on the Tools menu for the Summ/Supp tab are:

Quick Patient Search: this option executes a patient search. See Section 4.4 Quick Patient Search for more information about this functionality. This is the same as pressing the F8 key on your keyboard.

Refresh: this option when you select a second HS type, and then return to the initial HS, you have to Refresh in order to display updated data, e.g., after entering PCC data. This is the same as pressing the F5 key on your keyboard.

Find: this option finds data in the current window. This button works like the Search button. See Section 4.5.3 Search Button for more information.

User Preferences: this option takes you to the User Preferences window where you can change your user preferences. See Section 3.2 Modifying Your User Preferences for more information about the tabs on this window.

Web Links: this option shows several categories (such as Asthma) that have Web links. When you select a Web link, the Internet browser for the particular category opens.
10.9.2.2 File Menu

The options on the File menu of the Summ/Supp tab are the same as those on the Cover Sheet tab. See Section 10.3.7.1 File Menu for more information.

10.10 PCC Tab

The PCC tab allows you to display various types of PPC data associated with the patient. This data comes from the V Lab file from PCC.

The PCC data that displays is determined by the selection in the Type field on the toolbar. The time interval is controlled by what is selected in the Last drop-down list.

When you have Type = Medication, the toolbar changes to show other medication that you use in the display.

Controllers are defined as the following medication name taxonomies: BAT ASTHMA CONTROLLER MEDS; BAT ASTHMA INHALED STEROIDS; BAT ASTHMA LEUKOTRIENE MEDS

OR the following NDC values: BAT ASTHMA CONTROLLER NDC; BAT ASTHMA INHLD STEROIDS NDC; BAT ASTHMA LEUKOTRIENE NDC

Relievers are defined as the following medication names: BAT ASTHMA SHRT ACT RELV MEDS; BAT ASTHMA SHRT ACT INHLR MEDS; BGP RA GLUCOCORTIOCOIDS

OR the following NDC codes: BAT ASTHMA SHRT ACT RELV NDC; BAT ASTHMA SHRT ACT INHLR NDC
OR the following VA Class codes: BGP RA GLUCOCORTICOCOIDS CLASS

10.10.1 PCC Tab Layout

No duplicate values are displayed; e.g., if a patient has multiple immunizations on the same day, the date should be displayed only on the first line.

The display can show any of the following PCC data types (shown in the Type field):

The **CPT** data has these data elements: Date, CPT Code, Modifier 1, Modifier 2, Quantity.

The **Elder Care** data has these data elements: Date, Toileting, Bathing, Dressing, Transfers, Feeding, Continence, Finances, Cooking, Shopping, Housework/Chores, Medications, Transportation, Functional Status Change, Is Patient a Caregiver?.

The **Exams** data comes from PCC V Exam files. Data Elements: Date, Exam, Result, Encounter Provider, Comments.

The **Health Factor** data come from PCC V Health Factor files. Data Elements: Date, Health Factor Category, Health Factor, Level/Severity, Quantity, Provider, Comments.

The **Immunizations** data comes from PCC V IMM files. The following elements for immunizations should be displayed: Date (visit), Immunization, Series, Reaction, and Encounter Provider.

The **Lab** data comes from the PCC V Lab file. Data Elements: Date, Parent Panel, Panel, Test, Result, Normal/Abnormal, Range, Ordering Physician, Units. When entering historical data, you are limited to lab tests only (you are not allowed entry of lab panels because panels have no result since they are comprised of multiple individual tests with associated results). You can filter Lab data by “Related to” (currently HIV register-related).

The **Measurement** data comes from PCC V Measurements files. Data Elements: Date, Measurement Type, Value, Percentile.

The **Medication** data comes from PCC V Medications file. Data Elements: Date, Medication (name), Instructions, Quantity, Days, Ordering Physician. You can filter Medication data by “Related to” Asthma (Controllers or Relievers), HIV/AIDS.
The **Patient Education** data comes from PCC V Patient Ed files. Data Elements: Date, Disease/Topic, Level of Understanding, Time Spent, Provider, Goal Status, Comments. When entering historical data, you are limited to entering patient education items to the existing Patient Education Protocol Codes (PEPC) diagnosis category codes (note you are not permitted to enter ICD codes or other non-standard text).

The **Procedures** data comes from PCC V Procedures files. Data Elements: Date, Operation/Procedure, Provider Narrative.

The **Radiology** data comes from PCC V Radiology file. Data Elements: Date, Procedure, Impression, Result.

The **Skin Test** data comes from PCC V Skin Test files. Data Elements: Date, Skin Test, Results, Reading.

### 10.10.2 PCC Tab Toolbar

The default date range for all data is one year; you can select different predefined date ranges (3 months; 6 months; 1 year; 2 years; ever). The default display is in reverse order of date with most recent first.

You can display the HIV Management System (HMS) register data by selecting the checkbox next to the HIV/AIDS (for the Related To field). This field displays for Medications and Lab (from the Type field). There are other register data that you can select for other data types.

See Section 4.5 Buttons on Right Side of Window to learn about how to use the buttons on the right side of the toolbar.

#### 10.10.2.1 Graph It Button

The Graph It button only appears when Type = Measurement. This feature allows you to display, print, and save a graph of the measurements data.

When the current patient has measurement data, click the Graph It button. The application displays the Charting window, showing a graph of the various measurement types.
10.10.2.2 Add PCC Event

You use this feature to record historical PCC data for the current patient. This feature requires either the iCare Editor (BQIZCMED) or iCare Package Manager (BQIZMGR) security key.

In PCC, this data is categorized with a Service Category of “Historical Event” and does not enter the normal facility visit billing cycle. Historical data might need to be entered to complete the patient record in the following circumstances:

- The facility uses an off-site reference lab and is not using the RPMS Reference Lab application to send and receive lab data electronically directly into RPMS.
- A test or procedure was documented in the patient’s chart but was not entered into RPMS.
- The patient was traveling and received care at another facility that should be documented in their home facility.
• The patient received an immunization or similar public health procedure at an off-site community event.

Click the Add Event button (or select PCC | Add Event) to display the Add PCC Event dialog.

![Sample Add PCC Event](image)

Figure 10-29: Sample Add PCC Event

You can dismiss the Add PCC Event window by selecting File | Close.

When you click a ellipsis button by a field, the Table Lookup dialog displays. See Section 4.12 Table Lookup for more information about this dialog.

The Add PCC Event window has two areas: (1) Add/Edit Event Info contains fields to adding or editing PCC data and (2) Pending Events displays the records that are pending events that you can remove, add new ones, and save to PCC.

**Add/Edit Event Info Group Box**

The default Patient Name is the name of the open Patient Record.

The default location is the service unit associated with the current user. You can change this by clicking the ellipsis button to search for a location name. If the Location field is populated with OTHER, then the Outside Location and Outside Provider Name fields become active; here you type in each free-text field to populate it.
Pending Events Group Box

You can add new records, remove existing records, or save existing records to PCC in this group box.

See Section 4.5 Buttons on Right Side of Window to learn about how to use the buttons on the right side of the toolbar of the Pending Events area. These same functions can be found on the Tools menu of the Add PCC Event window.

If you double-click a record in Pending events group box, the Visit Detail pop-up will display. See Section 4.7 Pop-up Functionality for more information about the buttons and the File menu on the pop-up.

10.10.2.3 Add New Button

Click the Add New button (or select File | Add New) to clear the fields in the Add/Edit Event Info group box where you can define a new PCC type record.

You need to populate the appropriate fields for the selected PCC Type. When all fields are complete, click Add. This action adds a new record to the Pending Events area.

10.10.2.4 Editing a Record

Double-click a record in the Pending Events area to cause the existing record data to populate the fields in the Add/Edit Event Info group box.

You can change the fields, as needed. When all fields are complete, click the Apply Changes button. This changes the record in the Pending Events group box.

10.10.2.5 Remove Button

You can remove the highlighted records in the Pending Events group box by clicking the Remove button (or selecting File | Remove). The “Confirm remove” window displays, confirming the deletion. Click Yes to remove the records. (Otherwise, click No.)
10.10.2.6 Save to PCC Button

You need to save your changes/additions to PCC (that are listed in the Pending Events group box). Click the Save to PCC button (or select File | Save to PCC) to display the “Confirm save to PCC?” information message, confirming that you want to save the PCC data to the patient’s PCC visit file. Click Yes to save the information. (Otherwise, click No.).

Please note that for each type of added event, you will need to save. When you try to enter a new type, iCare asks if you want to save the existing records.

10.10.3 PCC Tab Menus

The options on the File menu of the PCC tab are the same as those on the Cover Sheet tab. See Section 103.7.1 File Menu for more information.

The options on Tools Menu on the PCC tab are the same as those on the Flags tab. See Section 10.5.3.2 Tools Menu for more information.

To review the options on the Edit, Window, and Help menus, see Section 4.3 Menus.

10.11 Problem List Tab

The Problem List tab shows the patient’s current problem list. The Problem List data comes from the PCC Problem List.

![Problem List Tab](image)

Figure 10-30: Sample Problem List Tab

You can add, edit, and delete problem list items, including notes, on this tab.

The default Problem List display shows the Active Problems first, then the Inactive ones.
The default for the Date Assigned field is to display the oldest problem first. This preserves the date order of the problem list for multi-facility databases.

10.11.1 Problem List Tab Layout

The data columns are described below:

- **Problem ID**: the identification label assigned to the problem.
- **Status**: status of the problem, either Active or Inactive.
- **Provider Narrative**: the narrative entered for the ICD code for the problem.
- **Date of Onset**: the date the symptoms started.
- **DX Code**: the ICD code for the problem.
- **Problem Notes**: any notes entered about the problem (like a Comment field).
- **Classification**: this shows any staging associated with the problem (for example, in Asthma Severity).
- **Date Last Modified**: the date the problem was last modified.
- **User Last Modified**: the name of the person who last modified the record.
- **Facility**: the name facility where the login user (who entered the problem) resides.
- **Class**: this will be blank or contains Personal History.

The default display (sort) order will be: Status (Active first), Date Entered (oldest first), Problem ID.

You can sort/filter the columns and perform other functions on the columns. See Section 4.1 Working with Columns for more information.

10.11.2 Problem List Tab Toolbar

See Section 4.5 Buttons on Right Side of Window to learn about how to use the buttons on the right side of the toolbar.
10.11.2.1 Add Problem

You can add a problem by clicking the Add Problem button (or by selecting Problem List | Add Problem). The Add New Problem window will display. This feature requires either the iCare Editor (BQIZCMED) or iCare Package Manager (BQIZMGR) security key.

![Add New Problem Dialog](image)

- You use the Add/Edit area for the problem information.
- You use the lower area for the notes associated with the problem.
- The required fields are: DX Code, Provider Narrative, and Status.

**DX Code:** the ICD code for the problem (required). Click the ellipsis button to search for the ICD code. See Section 4.12 Table Lookup for more information.

**Provider Narrative:** This is a free-text field used to describe the problem (required).

**Classification:** This field will observe the server-side business rules and only be available for entry (currently) when an asthma ICD code is entered. Users will select a value for this field from a predefined list.

**Date of Onset:** Enter the date the symptoms started, if known. Click the drop-down list to display a calendar. See Section 4.6.3 Date Fields for more information about selecting a date from the calendar.

**Status:** The status of the problem (required). The default is Active for a new problem.

**Class:** This indicates if this problem is documented for historical purpose (Personal History is the only option).
**Problem Notes:** Use this area to add/delete notes about the problem.

To add a note, click the **Add** button. iCare will populate the Note Number with a number that identifies the note. You type the text of the note in the free-text field (Note Narrative).

When you have completed the information about the new problem, click OK. The system displays the “Confirm save to RPMS” information message, asking if you want to save to the RPMS server. Click Yes to save. (Otherwise, click No to not save.)

After you click OK, the application displays the Confirm save to RPMS information message: This data will be saved to the RPMS server. Do you want to continue? Click Yes to save (otherwise, click No). If you use Yes, the problem is added to the Problem List tab of the Patient Record window. iCare assigns a problem ID, adds the name of the facility (of the user who entered the problem), and uses today’s date as the Date Last Modified.

### 10.11.2.2 Edit Problem List

You can change a highlighted record by clicking the Edit Problem button (or by double-clicking the record or by selecting Problem List | Edit Problem). The Edit Problem List window will display.

![Figure 10-32: Edit Problem List Dialog](image)

To dismiss the Edit Problem List dialog, select File | Close.
You can edit the fields in the Add/Edit area. See Section 10.11.2.1 Add Problem for more information about these fields.

If you click the ellipsis button for the DX Code field, you access the Table Lookup dialog. See Section 4.12 Table Lookup for more information about using this dialog.

After you have completed your changes, click OK. The system displays a confirmation asking if you want to save to the RPMS server. Click Yes to save. (Otherwise, click No to not save.)

After clicking yes, you can view your changes on the Problem List tab of the Patient Record window. The Last Date Modified changes to the current date.

10.11.2.3 Delete Problem

You can delete one or more highlighted problems on the Problem List tab by clicking the Delete Problem button (or select Problem List | Delete Problem). iCare displays the “Confirm problem record delete” information message, asking if you want to permanently delete the selected problems from the RPMS server. Click Yes to remove the problems. (Otherwise, click No.)

After clicking yes, the selected problems will be removed from the Problem List tab of the Patient Record window (and removed from the RPMS server).

10.11.3 Problem List Tab Menus

The options on the File menu of the Problem List tab are the same as those on the Cover Sheet tab. See Section 10.3.7.1 File Menu for more information.

The options on Tools Menu on the Problem List tab are the same as those on the Flags tab. See Section 10.5.3.2 Tools Menu for more information.

To review the options on the Edit, Window, and Help menus, see Section 4.3 Menus.

10.12 Care Mgmt Tab

The Care Management tab display any related care management data for the patient. You must select an option from the “Care Mgmt Group” field in order to display data. There are two conditions: (1) if the patient does not have any related care management data and (2) if the patient does have related care management data.
10.12.1 Patient With No HIV/AIDS Tags

Figure 10-33: Sample Care Management Tab for Patient with No Tag

The Care Management toolbar displays information that the patient does not have an associated HIV/AIDS tab.

If you want to manually add the patient to a register, use the Enter Data button.

If you want to add an associated tag, use the Add Tag button.

10.12.1.1 Enter Data

Click the Enter Data button to add the patient to a register.

The fields will display in the Main tab. This feature requires either the iCare Editor (BQIZCMED) or iCare Package Manager (BQIZMGR) security key. See Section 10.12.3 Main Tab for more information.

10.12.1.2 Add Tag

If there is no associated HIV/AIDS tag data, that information will display in the toolbar.

Click the Add Tag button (or select Care Mgmt | Add Tag) to add a diagnostic tab. The Add Diagnostic Tag dialog will display. This is a manual add. See Section 12.6.5.3 Manually Add an HIV/AIDS Diagnostic Tag for more information.
This is a manual add that allows a provider to manually assign one or more of the diagnosis tags to patients that did not meet the tag’s criteria for being proposed automatically.

You can edit the following fields:

New Status: the status of the tag being changed.

- **ACCEPTED**: this option allows you to “Accept” a proposed tag to provide an affirmation of its validity for a given patient.
- **NOT ACCEPT**: this option allows you to disapprove or “Not Accept” a diagnostic tag that has been proposed for a patient.
- **PROPOSED**: this option allows you to change the status of a diagnosis tag back to “Proposed” so that further review can take place.

Reason: click the appropriate radio button for changing the tag.

- **Patient Data Supports Acceptance**: use this when the patient data does not support the tag.
- **Manually Designated**: use this when you manually designate the tag.
- **Other**: use this when the other reasons do not fit. You must populate the Status Comment field to provide the text of the reason. Here you type the reason for the change (when the reason is “Other”). This feature provides a rich audit history for reasons for providers’ decisions to accept or not accept proposed tag assignments.

Click OK to save your changes. (Otherwise, click Cancel). If you save, you need to refresh the screen; the message besides the Care Management Group field will reflect the change.

### 10.12.2 Patient With HIV/AIDS Tag

![Sample Care Management Tab for Patient with HIV/AIDS Tag](image)

Figure 10-35: Sample Care Management Tab for Patient with HIV/AIDS Tag

See Section 12.6.5 HIV/AIDS Diagnostic Tags for more information.

#### 10.12.2.1 Accept

When the Accept button is active in the toolbar of the Care Management tab, you can change the status of the tag (displayed in the toolbar).

See Section 12.6.5.1 Accept/Do Not Accept Proposed HIV/AIDS Diagnostic Tab for more information.

Click the Accept button to display the Update Diagnosis Tag dialog.
10.12.2.2 Using the Update Diagnostic Tag Dialog

You can view existing tag activity about the patient by clicking the View Tag Activity button. The Diagnostic Tag Activity pop-up displays. See Section 9.8.2.4 Activity for more information about this pop-up.

The Update Diagnostic Tag dialog displays the patient name, diagnostic tag, and current status.

You can edit the following fields:

- **New Status**: the status of the tag being changed.
- **ACCEPTED**: this option allows you to “Accept” a proposed tag to provide an affirmation of its validity for a given patient.
- **NOT ACCEPT**: this option allows you to disapprove or “Not Accept” a diagnostic tag that has been proposed for a patient.
- **PROPOSED**: this option allows you to change the status of a diagnosis tag back to “Proposed” so that further review can take place.

Reason: click the appropriate radio button for changing the tag.
• **Patient Data Supports Acceptance**: use this when the patient data does not support the tag.

• **Manually Designated**: use this when you manually designate the tag.

• **Other**: use this when the other reasons do not fit. You must populate the Status Comment field to provide the text of the reason. Here you type the reason for the change (when using the reason “Other”). This feature provides a rich audit history for reasons for providers’ decisions to accept or not accept proposed tag assignments.

Click OK to save your changes. (Otherwise, click Cancel). If you save, you need to refresh the screen; the message besides the Care Management Group field will reflect the change.

### 10.12.3 Main Tab

You use the Main tab of Care Management to add/edit patient register information.

![Sample Care Management Tab After Clicking Enter Data](image)

Figure 10-37: Sample Care Management Tab After Clicking Enter Data

You need to expand any category (listed below the toolbar buttons) that you want to change. After completing your changes, use the Save button to save your changes.

Many of the drop-down lists (for fields) contain a “blank” option that you use when you want the particular field to have no data. Usually the “blank” option is the first one on the drop-down list.

### 10.12.3.1 General

Expand the General category to display the following fields on the General group box:
Figure 10-38: Fields for the General Group Box

For more information about using any field with an ellipsis button, see Section 4.12 Table Lookup.

**Register Status**: enter the status of the patient on this register from the drop-down list: Active, Deceased, Inactive, Transient (required field).

**Register Status Comments**: enter comments about the register status in this free-text field.

**HMS Diagnosis Category**: enter a specific HIV-related diagnostic category from the drop-down list: AIDS; HIV; At Risk - Exposed Source Unknown; At Risk - Infant Exposed; At Risk - Non-occupational Exposure; At Risk - Occupational Exposure;

**Diagnosis Comments**: enter comments about the HMS Diagnosis Category selection in this free-text field.

**Initial HIV DX Date**: enter the date of the initial HIV diagnosis. You can enter a month and year only; in this case the entry will be stored in BKM as MM-01-YYYY. This field is active only when you have populated the HMS Diagnosis Category field.

**Initial AIDS DX Date**: enter the date of the initial AIDS diagnosis. You can enter a month and year only; in this case the entry will be stored in BKM as MM-01-YYYY. This field is active only when you have populated the HMS Diagnosis Category field.

**CDC Cause (Etiology)**: select a cause (etiology) of the patient’s DX from the drop-down list.

**Etiology Comments**: enter comments about the CDC Cause selection in this free-text field.
**CDC Clinical Classification:** this field is active when the HMS Diagnosis Category contains AIDS or HIV. Select the clinical classification from the drop-down list.

The HIV Provider, HIV Case Manager, and Where Followed fields are populated by using the Table Lookup dialog. For more information about using the Table Lookup dialog after clicking the ellipsis button by a field, see Section 4.12 Table Lookup.

**HIV Provider:** click the ellipsis button to search for a HIV provider name.

**HIV Case Manager:** click the Ellipsis button to search for a case manager name.

**Where Followed:** click the Ellipsis button to search for name of a facility that primarily follows the patient’s care related to HIV/AIDS. If this is not your facility, select OTHER from the list, you can identify the specific facility in the outside location field and the provider in the Outside Provider field.

**Outside Location:** manually enter the name of the outside location.

**Outside Provider:** manually enter the name of the outside provider.

### 10.12.3.2 Partner Notification

This notification type is to document the notification of a patient’s partner of a potential exposure to HIV. The public health recommendation to notify the patient’s partner is a practice that is encouraged in all I/T/U facilities.

Expand the Partner Notification category to display the following fields on the Partner Notification group box:

![Figure 10-39: Fields for Partner Notification Group Box](Image)

**Partner Notification Status:** Enter if this patient’s partner been notified by selecting by the drop-down list: N/A, No. Remind Me Later, Unknown, Yes.

**Partner Notification Date:** This field is active when the Partner Notification Status contains Yes. Enter a date that the partner notification was accessed; you can select from a calendar by using the drop-down list.

### 10.12.3.3 Antiretroviral (ARV) Status

Expand the ARV category to display the following fields on the Antiretroviral ARV (Status) group box:
Figure 10-40: Fields on the ARV Group Box

You use this group box to enter ARV (Anti-Retro Viral Medications) data for ARV appropriate and ARV adherence. The medications are used to treat HIV/AIDS patients by reducing viral load and improving immunological function. See Section 17.1 ARV/HAART Definitions for more information.

Because the ARV status might change over time, HMS maintains a history of ARV Appropriate and Compliance statuses for the patient. The entire ARV history will be displayed on this screen with the most recent status listed first, so the provider can easily view the continuum of assessment.

For ARV Appropriate, click the Add button, each of the fields will have either a drop-down list from which to select or become a free-text field where you enter information.

**Date**: Enter the data for the record (required). Click the drop-down list to select from a calendar.

**Status**: Click the drop-down list and select one of the options: Yes Appropriate, No Not Appropriate, Unknown, Not Applicable.

**Comment**: Type a comment, if appropriate in this free-text field, using up to 50 characters.

**Last Edited By**: The name of the person who last edited the record (system populated).

**Last Edited Date**: The date the record was last edited (system populated).

After you click **Save**, iCare confirms that you want to add the record. After clicking Yes, iCare populates the Last Edited By field (name of user who populated the record) and today’s date in the Last Edited Date.
For **ARV Appropriate**, you can delete selected records by clicking the Delete button to display the Delete Rows information message. Click Yes to remove the records. Otherwise, click No to retain the records.

For **ARV Adherent**, click the Add button, each of the fields will have either a drop-down list from which to select or become a free-text field where you enter information.

**Date**: Enter the data for the record (required). Click the drop-down list to select from a calendar.

**Adherent**: Click the drop-down list and select one of the options: Compliant, Non-compliant, Unknown, and Not Applicable.

**Comment**: Type a comment, if appropriate, in this free-text field, using up to 50 characters.

**Last Edited By**: The name of the person who last edited the record (system populated).

**Last Edited Date**: The date the record was last edited (system populated).

After you click **Save**, iCare confirms that you want to add the record. After clicking Yes, iCare populates the Last Edited By field (name of user who populated the record) and today’s date in the Last Edited Date.

For **ARV Adherent**, you can delete selected records by clicking the Delete button to display the Delete Rows information message. Click Yes to remove the records. Otherwise, click No to retain the records.

### 10.12.3.4 State Notification

This notification type involves the requirement to notify the appropriate state Health Department of new AIDS diagnoses; most states also required notification of HIV diagnoses as well.

Expand the State Notification category to display the following fields on the State Notification group box:
If the HMS Diagnosis is HIV or AIDS, then the fields in this group box are active.

**State HIV Report Status**: Select the HIV Report Status from the drop-down list: NA, No, Remind Me Later, Unknown, Yes.

**State HIV Report Date**: This field is active if the Status HIV Report Status field contains Yes. You can select from a calendar by using the drop-down list.

**Status HIV Acknowledgment Status**: Select the HIV Acknowledgment status from the drop-down list: No, Unknown, Yes.

**Status HIV Acknowledgment Date**: This field is active if the Status HIV Acknowledgment Status field contains Yes. You can select from a calendar by using the drop-down list.

**State AIDS Report Status**: Select the AIDS Report Status from the drop-down list: NA, No, Remind Me Later, Unknown, Yes.

**State AIDS Report Date**: This field is active if the Status AIDS Report Status field contains Yes. You can select from a calendar by using the drop-down list.

**State AIDS Acknowledgment Status**: Select the AIDS Acknowledgment status from the drop-down list: No, Unknown, Yes.

**State AIDS Acknowledgment Date**: This field is active if the Status AIDS Acknowledgment Status field contains Yes. You can select from a calendar by using the drop-down list.

### 10.12.3.5 Save

You use the Save button to save the care management information entered or changed in RPMS. Click the Save button to display the “Confirm save to Care Mgmt” information message where you are asked if you want to save the patient’s care management record in RPMS. Click Yes to save (otherwise, click No.)

Below is one example of what happens after you click Yes. What displays after you click Yes depends upon if there is a tag status or not.
After clicking Yes, you will receive a message asking about changing the tag status.

![Image of message]

Figure 10-42: Message About Changing Status

If you click **Yes**, you go to the Update Diagnostic Tag dialog. See Section 10.12.2.1 Accept for more information about this dialog.

If you click **No**, the system displays the message “HMS Register data has been saved successfully to RPMS” and you need to click OK to dismiss the message.

If you click **Cancel**, the system asks if you want to cancel the entire Save process. If you click Yes, you exit the save process. If you click No, you return to the message about changing the status.

### 10.12.3.6 Glossary

Click the Glossary button (or select Help | Care Management Glossaries | HMS Register Glossary) on the Main tab to display the HMS Register / Care Management Glossary pop-up. See Section 4.14.5 HMS Register / Care Management Glossary Button for more information about this pop-up.

### 10.12.3.7 Reports

The Main tab provides reports. Select a patient and then click the drop-down list for the Reports button to select the type of report you want to view. This action displays the Health Summary dialog where you select the report parameters and click OK. The report displays in a pop-up. Below is a sample Health Summary pop-up report using the All Reminders Summary report parameter.
See Section 4.7 Pop-up Functionality for more information about the buttons and the File menu on the pop-up.

The following table provides an overview of what the reports are:

<table>
<thead>
<tr>
<th><strong>Report Selection</strong></th>
<th><strong>What You View</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Face Sheet</td>
<td>Ambulatory Care Record Brief report.</td>
</tr>
<tr>
<td>Health Summary</td>
<td>You first select a summary type to view. For example, if you select Lab, you will view the DMS Lab Report Summary.</td>
</tr>
<tr>
<td>Patient Wellness Handout</td>
<td>You first select the report parameter that determine the Wellness Handout type. You view the selected patient wellness handout type report.</td>
</tr>
<tr>
<td>Supplement</td>
<td>You first select a supplement type to view. For example, if you select Diabetic Care Summary, you will view the Diabetic Patient Care Summary.</td>
</tr>
<tr>
<td>State Surveillance</td>
<td>Adult HIV/AIDS Confidential Case Report to State (State Surveillance report in BKM) about the patient.</td>
</tr>
<tr>
<td>HMS Patient Care Supplement</td>
<td>HMS Patient Care Supplement report. See Section 12.6.6 HIV/AIDS Patient Care Supplement for more information.</td>
</tr>
<tr>
<td>State Surveillance (Blank)</td>
<td>Adult HIV/AIDS Confidential Case Report to State about the patient. This option gets as much data from RPMS that is available. This allows the providers to review this report and manually correct any incorrect or missing data. Then the report is to be sent to the appropriate state agency.</td>
</tr>
</tbody>
</table>
10.12.4 Reminders Tab

Figure 10-44: Sample Reminders Tab on Care Management

This display is like that shown on the Reminders tab of the patient record. See Section 10.6 Reminders Tab for more information.

If the patient does not have any HIV reminders, iCare displays the “HIV Reminders will not display for the patient because he/she does not have a diagnostic tag or register status for HMD Register” message. (Click OK to dismiss the message.)

10.12.5 Patient with Asthma Tag

Figure 10-45: Sample Patient with Asthma Tag

The information about the Accept button applies to this window. See Section 10.12.2.1 Accept Button for more information.

The Main tab displays the existing Asthma Patient Care Summary (Supplement) report. See Section 4.7 Pop-up Functionality for more information about the buttons on the report window. The Asthma Care Management view does not include the Reminders tab because there are no asthma-specific reminders.
10.12.6 Care Management Tab Menus

To review the options on the Edit, Window, and Help menus, see Section 4.3 Menus.

The options on the File menu of the Care Management tab (both Main and Reminders tabs) are the same as those on the Cover Sheet tab. See Section 10.3.7.1 File Menu for more information.

10.12.6.1 Tools Menu for Main Tab

The options on the Tools menu for the Main tab of Care Management are the same as those for Cover Sheet tab. See Section 10.3.7.2 Tools Menu for more information. For the Layout option, see Section 12.6.1 Data Specially Related to HIV/AIDS for more information.

10.12.6.2 Tools Menu for Reminders Tab

The options on the tools menu for the Reminders tab are the same as those for the Flags tab. See Section 10.5.3.2 for more information.

10.12.6.3 Care Mgmt Menu

The options on the Care Management window (both Main and Reminders tab) are shown below:

![Care Management Menu for the Reminders tab](image)

Figure 10-46: Care Management Menu for the Reminders tab

Add Tag: This option works like the Add Tag button. See Section 10.12.1.1 Add Tag for more information.

Accept Tag: This option works like the Accept button. See Section 10.12.2.1 Accept for more information.

The following options display if you are the Reminders tab:

Reset View: this option returns current view to the default view (use after altering the columns, for example).
Refresh: this option refreshes the Reminders tab by retrieving the most up-to-date information from the server. This is same as pressing the F5 key.

The following options display is you are on the Main tab:

Save: This option saves any new or changed data.

Reports: This option shows the available Report. See Section 10.12.3.7 Reports for more information.

10.13 Referrals Tab

The Referrals tab displays the referrals for the selected patient in the time range shown in the “Last” field. This data comes from the Referral Care information System (RCIS).

![Sample Referrals tab](image)

Figure 10-47: Sample Referrals tab

The default display is in reverse order of date, with the most recent first.

10.13.1 Referrals Tab Layout

The data comes from the RCIS (Referred Care Information System). You can review the user manual at the following URL: [http://www.ihs.gov/Cio/RPMS/index.cfm?module=home&option=documentschoice](http://www.ihs.gov/Cio/RPMS/index.cfm?module=home&option=documentschoice)

Select Referred Care Information System from the drop-down list. On the next page, select the User Manual.

You can sort/filter the columns and perform other functions on the columns. See Section 4.1 Working with Columns for more information.

Initiated Date: the date that the referral was initiated.

Referral Provider: the provider who requested the referral for the patient.

Purpose of Referral: this is a narrative that describes the purpose of the referral.
Outside Vendor: this is the name of the Outside vendor, such as outside providers, clinics, hospitals, labs etc. This information comes from the RCIS application.

Expected Begin Date: this applies to outpatient visits that is the expected begin date of service.

Actual Appointment Date: the date that the appointment for the referral was scheduled for this patient.

RCIS Status: the RCIS status of the referral.

Referral Type: the type of referral that was made:

- IHS - a referral to another IHS facility
- CHS - a referral to an outside facility that will be paid for with CHS funds
- In-house - a referral to another clinical area within the facility
- Other - any other type of referral that will be paid with funds other than CHS (such as Medicaid or private insurance).

Patient Type: either inpatient or outpatient.

10.13.2 Referrals Tab Toolbar Options

The Last field determines the date range for the data. The default is one year. You can select different predefined date range.

See Section 4.5 Buttons on Right Side of Window to learn about how to use the buttons on the right side of the toolbar.

10.13.3 Referrals Tab Menus

The options on the File menu of the Referrals tab are the same as those on the Cover Sheet tab. See Section 10.3.7.1 File Menu for more information.

The options on Tools Menu on the Referrals tab are the same as those on the Flags tab. See Section 10.5.3.2 Tools Menu for more information.

To review the options on the Edit, Window, and Help menus, see Section 4.3 Menus.
10.14 DX Tags Tab

The DX Tags tab displays the diagnostic tags information for the current patient. Diagnostic Tags are Predefined Diagnosis definitions ("tags") that iCare has proposed for this patient, based on the tagging function. The display includes the relevant qualifying criteria data.

![Sample DX Tags tab](image)

Providers can review tags that were automatically assigned by the system, and then decide whether or not the provider wants to accept the tags as valid for the patient.

This tab displays the “Active” tags for the patient, i.e., those tags having the Proposed or Accepted status.

10.14.1 DX Tag Layout

The data columns are described below.

Tag Name: the diagnostic tab name. You can view the tooltip by hovering your mouse over this column.

Status: the status of the tag. You can view the tooltip by hovering your mouse over this column.

Date: this field is linked to the PCC visit file. Double-click a cell to view the Visit file.

Item: this is where the tag was found (Visit or Problem).

Value: the value for the tag. The text that precedes the value determines what that value represent. For example: Problem: 250.00.

Factor: this is defined through the Taxonomy listed or other (like BMI).
The Visit Date will link to the underlying RPMS Visit record. Double-click any Date in the grid to display the Problem Detail or Visit Detail pop-up. See Section 4.7 Pop-up Functionality for more information about the buttons and the File menu on the pop-up.

You can view a tooltip about a value in the Tag Name column (shows the definition of the tag).

Double-click any item (where the name is underlined) in the Factor column to display the iCare Taxonomy View/Edit dialog. This dialog shows the low and high values for the selected taxonomy.

You can sort/filter the columns and perform other functions on the columns. See Section 4.1 Working with Columns for more information.

### 10.14.2 Diagnostic Tags Toolbar

The patient diagnostic tags are current as of the date shown on the toolbar.

See Section 4.5 Button on Right Side of Window to learn about how to use the buttons on the right side of the toolbar.

#### 10.14.2.1 Recalc

Click the Recalc button (or select Diagnostic Tags | Recalc) to update any values from a logic algorithm by recalculating the logic with new data from the server.

#### 10.14.2.2 Change the Tag Status

You can change the tag status by clicking the **Accept**, **Not Accept**, or **Propose** button (or selecting the options on the Diagnostic Tags menu). This causes the Update Diagnostic Tag dialog to display where you can change that tag status, select the reason for the change, and populate the Other (free-text) field. See Section 10.12.2.1 Accept for more information about this dialog.

When you are finished with this dialog, click OK to accept the changes. (Otherwise, click No.). You can view your changes in the grid of records on the DX Tags tab.
10.14.2.3 Add Tag

Click the Add Tag button (or select Diagnostic Tag | Add Tag) to add a tag to the current patient. The Add Diagnostic Tag dialog will display. This is a manual add that allows a provider to manually assign one or more of the diagnosis tags to patients that did not meet the tag’s criteria for being proposed automatically. See Section 10.12.1.1 Add Tag for more information about this dialog.

10.14.2.4 Activity

You can view existing tag activity about the patient by doing one of the following:

- Click the Activity button
- Select Diagnostic Tags | Activity

The Diagnostic Tag Activity pop-up displays. This is a view-only pop-up. Multiple people can enter the tags, so this pop-up shows all of the activity. See Section 9.8.2.4 Activity for more information about this pop-up.

10.14.2.5 Background Jobs

Click the Background Jobs button to display the Background Jobs pop-up. See Section 4.11 Background Jobs for more information.

10.14.2.6 Glossary Button

Click the Glossary button (or select Help | Diagnostic Tag Glossary) to display the Diagnostic Tab Glossary pop-up. See Section 4.14.2 Diagnostic Tag Glossary for more information about how to use the pop-up. The report includes definitions and descriptions of corresponding logic used to evaluate each of the diagnostic tags.

10.14.3 DX Tags Tab Menus

The options on File menu on the DX Tags tab are the same as those on the Cover Sheet tab. See Section 10.3.7.1 File Menu for more information.

The options on Tools Menu on the DX Tags tab are the same as those on the Reminders tab. See Section 10.6.3.2 Tools for more information.

For information about the Edit, Window, and Help menus, see 4.3 Menus for more information.
10.15 Family HX

The Family HX tab displays any family history information about the patient.

![Sample Family HX tab](image)

Figure 10-49: Sample Family HX tab

This information comes from the Family History of the PCC patient record.

10.15.1 Family History Layout

You can sort/filter the columns and perform other functions on the columns. See Section 4.1 Working with Columns for more information.

Below is a description of the fields:

Relation: this is the family history relationship, such as Brother.

Relation Modifier: this is the relation description, if any.

Status: this is the status of the relative: Living, Deceased, Unknown, Patient Refused To Answer.

Age at Death: if the status is Deceased, this is age of death of the relative.

Cause of Death: if the status is Deceased, this is the cause of death of the relative.

Multiple Birth?: this determines is there was a multiple birth: Yes, No, Unknown.

DX Code: this is the family history ICD code that best describes the diagnosis of the relative.

Diagnosis Narrative (Provider Narrative): this is the provider narrative that the provider entered.

Provider: this is the provider for this record.

Age of Onset: this is the age of onset of the condition. This can be In Infancy, Before Age 20, specific age range (such as 30-39), Age Unknown.

Last Modified: this displays the name of the person who last modified the record (system populated).
10.15.2 Family History Toolbar

See Section 4.5 Buttons on Right Side of Window to learn about how to use the buttons on the right side of the toolbar.

10.15.2.1 Add Family HX Button

Click the Add Family HX button to add a family history record for the current patient. The application displays the Add New Family History Record dialog.

![Sample Add New Family History Record dialog]

This dialog contains two areas: Add/Edit and Conditions.

**Add/Edit Area**

To add a new family history record, complete the fields in the Add/Edit area of the dialog.

Relation: click the ellipsis button to access the Table Lookup dialog. See Section 4.12 Table Lookup for more information.

Relation Modified: populate this free text field with text the describes the relation.

Status: select an option from the drop-down list. This describes the status of the relation.
Age at Death: this field become active if you populate the Status field with Deceased. Use one of the options from the drop-down list.

Cause of Death: this field become active if you populate the Status field with Deceased. Use this free text field to describe the cause of death, if known.

Multiple Birth Status: select an option from the drop-down list.

Multiple Birth Type: this field becomes active if you populate the Multiple Birth status with YES. Select an option that describe the type of multiple birth.

**Conditions Area**

To add family conditions, click the Add button in the Conditions area. This highlights a row in the Conditions grids. Each field has a drop-down list that you use to populate it.

DX Code (Condition): click the drop-down list to access the Select DX Code (Condition) dialog. Use this dialog to populate or clear the DX Code (Condition) field. See Section 4.19 Select/Clear Functionality for more information about this dialog.

Diagnosis Narrative (Provider Narrative): use this free text field to enter the diagnosis narrative.

Provider: click the drop-down list to access the Select Provider dialog. Use this dialog to populate or clear the Provider field. See Section 4.19 Select/Clear Functionality for more information.

Age at Onset: click the drop-down list and select an option.

After all fields are populated, do one of the following:

- Click OK to display the Confirm save to RPMS information message that asks if you want to save the data to the RPMS server. Click Yes to save (otherwise, click No). to save the data.
- Click Cancel to not save and exit the Add/Edit process.

To delete a condition record, highlight it and click Delete. The application displays the Delete Rows information message asking if you want to delete the selected rows. Click Yes to delete the rows (otherwise, click No to not delete).

### 10.15.2.2 Edit Family HX

Use the Edit Family HX button to change the selected record’s family history. The application displays the Edit Existing Family History Record dialog.
Figure 10-51: Sample Edit Existing Family History Record dialog

The fields on this dialog are the same as those on the Add New Family History Record dialog. See Section 10.15.2.1 Add New Family History Record for more information.

10.15.3 Family History Menus

The options on the File menu of the Family History tab are the same as those on the Cover Sheet tab. See Section 10.3.7.1 File Menu for more information.

To review the options on the Edit, Window, and Help menus, see Section 4.3 Menus.

The options on the Tools menu of the Family History tab are the same as those on the Flags tab. See Section 10.5.3.2 Tools Menu for more information.

10.16 Notes

The Notes tab displays the existing TIU notes for the current patient.
You can determine the time range for the notes display by selecting an option from the drop-down list: 1 month, 3 months, 6 months, 1 year, 2 years, Ever (the default is 1 month).

10.16.1 Notes Layout

The sort order is only by date, most recent date first.

Below are the fields.

Class: the class of the note.

Title: the title of the note.

Subject: the subject of the note, if any.

Date of Note: the date/time the note was written.

Author: the person who wrote the note.

Status: the status of the note.

If you double-click a record in the grid, the application displays a pop-up window showing information about the particular note. (It does not show the text of the note.)
10.16.2 Notes Menus

The options on the File menu of the Notes tab are the same as those on the Cover Sheet tab. See Section 10.3.7.1 File Menu for more information.

To review the options on the Edit, Window, and Help menus, see Section 4.3 Menus.

The options on the Tools menu of the Notes tab are the same as those on the Flags tab. See Section 10.5.3.2 Tools Menu for more information.
11.0 Notifications

The user can receive notifications about certain actions that have taken place in iCare. For example, the panel creator decides to delete a panel. A deleted panel that was shared will no longer appear on the panel list of the shared users or the panel creator. All users with shared access to the panel will receive notifications that the panel was deleted. Another way to look at this is iCare will support notifications to users when panel content has been or will be significantly altered.

When you have new notifications, you receive an information message informing you that you have some new notifications and asks if you want to view them now. Click Yes to view the notifications (on the iCare Notifications window.) (Otherwise, Click No).

11.1 iCare Notifications Window

![Sample iCare Notifications Window]

Figure 11-1: Sample iCare Notifications Window

**Note:** You can access the iCare Notifications window by selecting Tools | View iCare Notifications on the Panel List window.

The New Notification indicator in the first column shows those notifications that are new.
You can sort/filter the columns and perform other functions on the columns. See Section 4.1 Working with Columns for more information.

See Section 4.5 Buttons on Right Side of Window to review the functions of the buttons on the toolbar.

The buttons on the left side of the toolbar determine what actions you can take on this window.

11.2 Notifications Toolbar Buttons

This Section reviews the buttons of the Notifications toolbar.

See Section 4.5 Buttons on Right Side of Window to review how to use the buttons on the right side of the toolbar.

11.2.1 Select All Notifications

You can select all of the notifications on the iCare Notifications window by doing one of the following:

- Clicking the Select All button
- Selecting Edit | Select All
- Selecting the “Select All” option on the right-click menu

11.2.2 Delete Notifications

You can delete the selected notifications by doing one of the following:

- Clicking the Delete button
- Selecting Edit | Delete
- Selecting the “Delete” option on the right-click menu

The “Confirm notification delete” dialog displays, asking you if you want to delete the selected notifications. Click Yes to remove the selected notifications from the list. (Otherwise, click No.)
12.0 HIV/AIDS Management in Care

The purpose of this Section is to provide you with the information you need to use the iCare (BQI) population management application, specifically for the care and management of Patients Living With HIV/AIDS (PLWH/A). In 2005, the Indian Health Service developed and deployed a software application related to the care of this population. That software, HIV Management System (HMS) has now been integrated in the iCare GUI. The original roll and scroll version will no longer be available for use.

This Section contains reference information about iCare views, examples of its processes, and step-by-step procedures to show you how to perform the activities supported by the application, specifically for HIV/AIDS patient management.

12.1 Introduction

AIDS (Acquired Immunodeficiency Syndrome) was first reported in the United States in 1981 and has since become a major worldwide epidemic. AIDS is caused by HIV. By killing or damaging cells of the body's immune system, HIV progressively destroys the body's ability to fight infections and certain cancers. People diagnosed with AIDS can get life-threatening diseases called opportunistic infections, which are caused by microbes such as viruses or bacteria that usually do not make healthy people sick.

More than 1 million cases of AIDS have been reported in the United States since 1981. Reports show that 21 percent of those infected with HIV are unaware of their infection. The epidemic is growing most rapidly among minority populations.

iCare provides Indian Health Service/Tribal/Urban (I/T/U) healthcare providers with another tool for improving the care and management of PLWH/A as well as those who are at risk for the disease.

This Section has been developed for physicians, mid-level practitioners, nurses, and case managers responsible for the care of this population. It provides descriptions of and instructions for the following:

- The setup and maintenance of the site-populated taxonomies related to specific medications and laboratory exams.
- The entry of HIV/AIDS-specific patient data.
- The creation and population of panels with PLWH/A patients living with HIV/AIDS.
- Report generation.
• Clinical decision support such as Reminders, Best Practice Prompts, and Performance Measures.

12.2 Key Functional Features

iCare does not duplicate the data from any other RPMS component. All data displayed in or entered will pass to and reside in the appropriate underlying RPMS component (e.g., PCC, HMS).

Key functional features of iCare include the following:

• The ability to identify a group of patients based on the HIV/AIDS Diagnostic Tag definition.
• The ability to create and manage a panel of patients living with HIV/AIDS and/or At Risk patients.
• The ability to automatically repopulate the panel with new patients who meet the definition.
• An HIV/AIDS Health Supplement that presents condition-specific patient data.
• An HIV Quality of Care report for population and/or individual that provides care statistics that can be used to evaluate care at the local level and sent to the Area and/or Headquarters as requested.
• The incorporation of artificial intelligence algorithms to provide reminders for tests, immunizations and other procedures related specifically to HIV/AIDS.
• The provision of both population and patient management and reporting capabilities.
• The identification of patients for state/CDC surveillance reporting.

Using iCare and accessing sensitive patient data requires compliance with all procedures related to the security of protected health information.

12.3 Using the HIV/AIDS Glossary

The HIV/AIDS Glossary is a valuable reference tool that can assist you with managing HIV/AIDS patient data. For example, you could reference the glossary to determine why you might be receiving CD4 reminders or to see what the logic is behind the Quality of Care report.

The HIV/AIDS Glossary describes in detail the logic and definitions pertaining to the following information:

• The HIV/AIDS Diagnostic Tag definition
The glossary will deepen your understanding of the HIV/AIDS-related data used in iCare; therefore, you might want to consider printing this glossary for easy reference when entering and interpreting data related to this population.

To open the glossary:

1. Open the Help menu.
2. Select Care Management Glossaries.
4. The glossary opens. Use the Find function to navigate quickly to the topics you are looking for.

12.4 Taxonomy Management

This Section describes the purpose of taxonomies, and how to view, edit, and add a site-populated taxonomy.

12.4.1 What is a Taxonomy

A taxonomy is the RPMS structure that holds the codes or terms that comprise any clinical definitions used by iCare and other RPMS clinical applications to calculate reminders and construct reports.

iCare is similar to other clinical applications that use programmed logic (algorithms or artificial intelligence) to compute due and overdue HIV/AIDS-related reminders and other calculations related to constructing a complex report. See Section 16 Appendix D: HIV/AIDS-Related Reminders – Logic and Tooltip Text for detailed algorithm logic used by iCare. The logic is composed of individual definitions of clinical elements, such as tests, immunizations, or diagnoses.
In order to provide comparable reminders and reporting across all I/T/U facilities, as much logic as possible is based on standard national codes. These codes include ICD-9, CPT, LOINC, drug class and national IHS standard codesets (e.g., Health Factors, patient education codes, or exam codes). For lab test and medication terminology that is not standardized across each facility, iCare uses taxonomies that are populated by each individual facility with its own codes.

Therefore, there are two different types of taxonomies distributed: software-defined (“hard-coded”) and site-populated.

### 12.4.2 Taxonomy Nomenclature

Codes and terms contained in a taxonomy are referred to as “members” of the taxonomy.

The names of the taxonomies generally describe the type of content. Each type of code (CPT, ICD, etc.) requires a separate taxonomy. The following terms are typically used in the taxonomy name:

- **CPTS**: CPT codes for procedures, tests, etc.
- **CVX**: standardized immunization codes maintained by the CDC and used by the RPMS Immunization application
- **DXS**: ICD9 codes used to describe diagnoses in the RPMS Purpose of Visit (POV) or Problem List
- **FACTORS or HLTH FACTORS**: IHS Health Factor codes
- **LOINC**: standardized codes used to identify lab tests, in addition to the site-populated lab test taxonomies
- **NDCS**: NDC (National Drug Classification) codes used to identify medications, in addition to the site-populated medication taxonomies
- **PROC or PROCEDURES**: ICD9 Procedure codes

See Section 15 Appendix C for a complete list of clinical definitions and associated taxonomies. Note that some of the taxonomies are new, while many have been in existence for quite some time and are used throughout RPMS.
12.4.3 Software-Defined (Hard-coded) Taxonomies

One clinical definition might be comprised of multiple code types with corresponding multiple taxonomies. For data elements like diagnoses, procedures, or lab tests identified by LOINC codes, a taxonomy is created for each code type within a definition that contains the standard codes that a software program should look for. These codes are hard-coded by the programmer into software-defined taxonomies that are distributed with the software. These taxonomies are defined nationally and cannot be modified at the local level. An example of a software-defined taxonomy is BGP CPT PAP that contains the list of CPT codes that define a pap smear.

You should become familiar with the contents of the taxonomies in order to understand how your site can better document patient records. If you feel that an existing, nationally defined taxonomy requires editing, the user should contact the OIT Help Desk.

12.4.4 Site Populated Taxonomies

Site-populated taxonomies are used to moderate the variations in terminology for medication and laboratory test names from one facility to another. PCC programs cannot deal with variations in spelling, spacing, and punctuation. Rather than attempting to find all potential spellings of a particular medication, the application looks in a specified taxonomy for the exact medication names that have been entered by that site.

Site-populated taxonomies are distributed without content, that is, the taxonomies are “empty.” The individual facility will enter all medication or lab test names used at that particular facility. This means that one site’s Hepatitis B test data, called Hep B Surface Antigen, can be compared to another site’s test called Hbsag Hep B Surface Ant. Or, one site’s NRTI medication data can be compared to another site, even though the same names are not used for these medications (“Zidovudine 100MG Cap” or “Zidovudine Cap/100 MG”).

If there is content in an existing site-populated taxonomy, it will not be overwritten/deleted in iCare.

iCare uses many site-populated taxonomies and some must be populated by a user with Taxonomy Editor access. Any taxonomy that does not currently exist on your server will be created on the server when the software was loaded, but there will not be any members (lab or med names) in them until they have been added, i.e., these new taxonomies will be empty.

**Important:** Taxonomy Editors must work with the pharmacist and the laboratory director at their facilities to identify the correct data to be added into these taxonomies.
A separate table for the laboratory and the medication site-populated taxonomies are provided below to use as a checklist.

Taxonomy names beginning with “BGP” are created and “owned” by the Clinical Reporting System (CRS) and should already be populated on your server. However, you should still plan to review the content for all site-populated taxonomies to ensure that they are accurate.

**Note:** All taxonomies should be reviewed for completeness and potential updates before running any functions.

### 12.4.4.1 Lab Test Taxonomies

The following is a list of lab taxonomies that must be populated by the site. It is recommended that you consult with your laboratory supervisor in order to include all lab tests that are being performed at your site. Each taxonomy has examples of common names for these lab tests, which can assist you in locating all appropriate tests for your site.

**Note:** To provide the most accurate reporting, you should include all test names that have been used by your facility at least since 1995, even if these codes are currently inactive. Some measures search for tests as far back as 10 years, e.g., tuberculosis.

Many sites designate inactive lab tests by adding one of the following characters at the beginning of the test name: “z,” “Z,” “xx,” “X,” or “*.” Search for these characters in your lab file and include these tests in your site-populated taxonomies because these tests can have been in use at one time.

The following table provides taxonomy names, their description, examples of member and associated CPT codes. Please note the column labeled “Example of Members” are just examples; your site might or might not use this terminology.
<table>
<thead>
<tr>
<th>Taxonomy Name</th>
<th>Description</th>
<th>Example of Members</th>
<th>Associated CPT Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>BGP CD4 TAX</td>
<td>All test names related to any element of a CD4 Lab Test, used to evaluate immune system status (Also known as: T4 count, T-helper cells) This taxonomy is used to determine that a patient had the test, but is not used to determine the test result (see BKM CD4 ABS TAX below). This taxonomy is also used by CRS NOTE: do NOT include HIV panels in this taxonomy.</td>
<td>CD4 Error! Bookmark not defined. Cells CD4 Lymphocytes CD4 Absolute or ABS CD4 Helper T-Lymphocyte Marker T-Lymphocyte Helper / Suppressor Profile T-Cell Activation Profile</td>
<td>86359, 86360, 86361</td>
</tr>
<tr>
<td>BGP CHLAMYDIA TESTS TAX</td>
<td>All lab tests for Chlamydia trachomatis, including panels</td>
<td>Chlamydia Culture Chlamydia IgG Chlamydia IgM Chlamydia Screen Chlamydia, DNA Probe Chl/Gc Combo Chlamydia &amp; Gonorrhea Probe Pap/HPV/Chlam/Gonorrhea Combo</td>
<td>86631; 86632; 87110; 87270; 87320; 87490-87492; 87810</td>
</tr>
<tr>
<td>BGP HIV TEST TAX</td>
<td>All lab tests to test for HIV NOTE: make sure you are NOT including any test name that is actually referring to an HIV panel (see CD4 and/or HIV Viral Load)</td>
<td>HIV Test HIV Screen HIV Proviral DNA HIV-1; by EIA; Abs by EIA HIV-2 by PCR; HIV2QUAL by PCR</td>
<td>86689, 86701-86703, 87390, 87391, 87534-87539</td>
</tr>
<tr>
<td>Taxonomy Name</td>
<td>Description</td>
<td>Example of Members</td>
<td>Associated CPT Code</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>BGP HIV VIRAL LOAD TAX</td>
<td>All HIV viral load tests (as measured by PCR or comparable test); used to assess prognosis of disease progression and to monitor the efficacy of antiretroviral therapy by measuring changes in HIV-1 RNA levels during the course of therapy. This taxonomy is also used by CRS. NOTE: do NOT include HIV panels in this taxonomy.</td>
<td>HIV Viral Load HIV RNA QNT</td>
<td>87536, 87539</td>
</tr>
<tr>
<td>BGP LIPID PROFILE CPTS</td>
<td>Lipid Profile includes: Cholesterol, HDL, LDL and Triglycerides</td>
<td>Lipid Panel</td>
<td>80061</td>
</tr>
<tr>
<td>BGP PAP SMEAR TAX</td>
<td>All Pap Smear tests Pap/HPV/Chlam/Gonorrhea Combo</td>
<td>Pap Smear Pap/HPV/Chlam/Gonorrhea Combo</td>
<td>88141-88167, 88174-88175, Q0091</td>
</tr>
<tr>
<td>BKM CD4 ABS TAX</td>
<td>Only CD4 Absolute tests. This taxonomy is used to identify the absolute count, or numeric value, of the result, which is a key identifying value for the health status of a patient. Any test included in this taxonomy should also be included in the BGP CD4 TAX (all CD4 lab tests). NOTE: do NOT include panels in this taxonomy.</td>
<td>CD4 Absolute ABS CD4 CD4 Lymphocytes</td>
<td>86361</td>
</tr>
<tr>
<td>BKM CMVTEST TAX</td>
<td>All lab tests for Cytomegalovirus (CMV)</td>
<td>CMV CMV Ab, IgG, Quantitative CMV Antibodies CMV by DFA, Direct Detection CMV Culture CMV DNA CMV IgG CMV IgM CMV PCR Rapid Viral Culture CMV</td>
<td>86644, 86645, 87271, 87496, 87497</td>
</tr>
<tr>
<td>Taxonomy Name</td>
<td>Description</td>
<td>Example of Members</td>
<td>Associated CPT Code</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>BKM COCCI ANTIBODY TAX</td>
<td>All lab tests for Coccidioides Antibodies</td>
<td>Coccidioides</td>
<td>86635</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Coccidioides Antibodies</td>
<td></td>
</tr>
<tr>
<td>BKM FTA-ABS TEST TAX</td>
<td>All FTA-ABS (Fluorescent Treponemal Antibody Absorption) Tests to confirm syphilis</td>
<td>FTA-Ab</td>
<td>86781</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FTA-ABS TP-PA Antibodies</td>
<td></td>
</tr>
<tr>
<td>BKM GONORRHEA TEST TAX</td>
<td>All lab tests for gonorrhea (<em>Neisseria gonorrhoeae</em>)</td>
<td>Gonorrhea, DNA Probe</td>
<td>87081, 87590-87592, 87850</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chlamydia &amp; Gonorrhea Probe</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>GC Culture</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>GC-PCA</td>
<td></td>
</tr>
<tr>
<td>BKM HEP A TAX</td>
<td>Lab tests to assess Hepatitis A virus infection</td>
<td>Hepatitis A antibody (HAAb)</td>
<td>86708; 86709</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IgM antibody</td>
<td></td>
</tr>
<tr>
<td>BKM HEP B TAX</td>
<td>Lab tests to assess hepatitis B virus infection; evaluation of possible immunity in individuals who are at increased risks for exposure NOTE: do NOT include Hepatitis Panel as a member of this taxonomy</td>
<td>Anti-HBe; HBeAb HBV DNA PCR Hep B Carrier Screen w/AFP Hep B Core AB, IgM Hep B Surface Ab Titer; Hbsab Hep B Surface Antibody; Hbsab Hep B Surface Antigen; Hbsag Hep B Tests Hepatitis B Core Antibodies Screen For Hep B Vaccination</td>
<td>86704-86707; 87340-87350, 87515-87517</td>
</tr>
<tr>
<td>BKM HEP C TAX (screening)</td>
<td>Includes any initial screening lab tests for Hepatitis C used at your site. Hep C confirmation tests should be included in the Hep C RIBA taxonomy below. NOTE: do NOT include Hepatitis Panel as a member of this taxonomy</td>
<td>Hepatitis C Virus AB HCV-Ab HEP Anti HCV</td>
<td>86803, 87520</td>
</tr>
<tr>
<td>Taxonomy Name</td>
<td>Description</td>
<td>Example of Members</td>
<td>Associated CPT Code</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>BKM HEP C TAX (confirmatory)</td>
<td>Includes <strong>any</strong> confirmatory lab tests for Hepatitis C, including RIBA (Recombinant Immunoblot Assay), RNA Viral Load or Genotype. NOTE: do NOT include Hepatitis Panel as a member of this taxonomy</td>
<td>Hepatitis C Virus Antibody Supplemental Testing; Hep C RIBA Recombinant Immunoblot Assay HCV RNA Hep C RNA NAT Hep C Genotype</td>
<td>86804, 87521, 87522</td>
</tr>
<tr>
<td>BKM HEPATITIS PANEL TAX</td>
<td>To include Hepatitis Panels only, containing Hepatitis A antibody, IgM; hepatitis B core antibody, IgM; hepatitis B surface antigen; hepatitis C virus antibody. NOTE: do NOT include the individual component parts of the panel in this taxonomy</td>
<td>Hepatitis Panel Acute Hepatitis Panel</td>
<td>80074</td>
</tr>
<tr>
<td>BKM PPD TAX</td>
<td>Any PPD skin test for tuberculosis. NOTE: PPDs are generally recorded through the skin test function of the Immunization application</td>
<td></td>
<td>86580, 86585, 87555-87557</td>
</tr>
<tr>
<td>BKM RPR TAX</td>
<td>All lab tests for Syphilis (Rapid Plasma Reagin (RPR))</td>
<td>RPR RPR Quant</td>
<td>86592, 86593, 87285</td>
</tr>
<tr>
<td>BKM TOXOPLASMOSIS TESTS TAX</td>
<td>All lab tests for Toxoplasmosis</td>
<td>Toxoplasma Toxoplasma IgG or IgM</td>
<td>86777, 86778</td>
</tr>
<tr>
<td>BKM TRICH TESTS TAX</td>
<td>All lab tests for Trichomoniasis</td>
<td>Trichimonas</td>
<td>None</td>
</tr>
<tr>
<td>BKMV HIV GENOTYPE TESTS TAX</td>
<td>Genotype tests for drug resistance NOTE: most sites are not currently using this test</td>
<td>HIV Genotype Resistance Testing Retroviral Genotype</td>
<td>87901</td>
</tr>
<tr>
<td>BKMV HIV PHENOTYPE TESTS TAX</td>
<td>Phenotype tests for drug resistance NOTE: most sites are not currently using this test</td>
<td>HIV Phenotype</td>
<td>87903</td>
</tr>
</tbody>
</table>

User Manual
November 2009

HIV/AIDS Management in Care

267
### 12.4.4.2 Medication Taxonomies

The following medication taxonomies will need to be populated by the Case File Manager with the drug names that are included on your site’s formulary. The table below includes the list of drugs that should be considered. Some sites might not have medications for all the taxonomies. Case File Managers should consult with their site pharmacists to ensure accurate population of the medication taxonomies.

<table>
<thead>
<tr>
<th></th>
<th>NRTI Meds</th>
<th>NNRTI Meds</th>
<th>NRTI Comb</th>
<th>NRTI/NNRTI</th>
<th>PI Meds</th>
<th>PI Booster</th>
<th>EI Meds</th>
<th>II Meds</th>
<th>PCP PROPH Meds</th>
<th>MAC PROPH Meds</th>
<th>TB Meds</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abacavir (Ziagen, ABC)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Didanosine (Videx, Videx EC)</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Emtricitabine (Emtriva)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lamivudine (Epivir)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lamivudine/Abacavir (Epziccom)</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stavudine (Zerit)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tenofovir (Viread)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zalcitibine (Hivid)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zidovudine (Retrovir)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zidovudine/Lamivudine (Combivir)</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zidovudine/Lamivudine/Abacavir (Trizivir)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delaviridine (Rescriptor)</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Efavirenz (Sustiva)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nevirapine (Viramune)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Etravirine (TMC-125) (Intelence)</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tenofovir/Emtricitabine (Truvada)</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tenofovir/Emtricitabine/Efavirenz (Atripla)</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Amprenavir (Agenerase)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Atazanavir (Revataz)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Drug</td>
<td>NRTI Meds</td>
<td>NNRTI Meds</td>
<td>NRTI Comb</td>
<td>NRTI/ NNRTI</td>
<td>PI Meds</td>
<td>PI Booster</td>
<td>EII Meds</td>
<td>II Meds</td>
<td>PCP PROPH Meds</td>
<td>MAC PROPH Meds</td>
<td>TB Meds</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------</td>
<td>------------</td>
<td>-----------</td>
<td>-------------</td>
<td>---------</td>
<td>------------</td>
<td>----------</td>
<td>---------</td>
<td>----------------</td>
<td>----------------</td>
<td>---------</td>
</tr>
<tr>
<td>Fosamprenavir (Lexiva)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HGC Saquinavir (Invirase)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Indinavir (Crixivan)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lopinavir/Ritonavir (Kaletra)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nelfinavir (Viracept)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SCG Saquinavir (Fortovase)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tipranovir (Aptivus)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Darunavir (Prezista)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ritonavir (Norvir)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enfurviridine (Fuzeon)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maraviroc (Selzentry)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Raltegravir (Isentress)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Atovaquone (Mepron)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dapsone</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pentamidine, Pentam 300, Pentobarbital (NebuPent)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sulfamethaxazole &amp; Trimethoprim/Cotrimoxazole (Bactrim, Septa)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trimethoprim (Proloprim, Trimex)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trimetrexate, Glururonate &amp; Leucovorin (Neutrexin)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Azithromycin (Zithromax)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clarithromycin (Biaxin, Klaricid)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rifabutin (Mycobutin, Ansamycin)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ethambutol (Myambutol)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Isoniazid (INH)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

User Manual
November 2009

HIV/AIDS Management in Care

269
<table>
<thead>
<tr>
<th>Medication</th>
<th>NRTI Meds</th>
<th>NNRTI Meds</th>
<th>NRTI Comb</th>
<th>NNRTI Comb</th>
<th>PI Meds</th>
<th>PI Booster</th>
<th>EI Meds</th>
<th>II Meds</th>
<th>PCP PROPH Meds</th>
<th>MAC PROPH Meds</th>
<th>TB Meds</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pyrazinamide</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Rifamate</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Rifampin</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Rifater</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Streptomycin</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>
12.4.5 View a Taxonomy

The majority of the taxonomies are hard coded (software-defined) and users will not have the ability to change their contents; however, users will be able to view them.

To view the members of a taxonomy in iCare:

1. From the main iCare window, open the Tools menu.
2. Select Taxonomy Maintenance.
3. Select View Taxonomies.
4. The iCare Taxonomy View/Edit window opens. In the left pane of the window, a tree view of the taxonomy organization displays.
5. Click the plus sign (+) next to the title of the taxonomy you want to view. Click any applicable sub-menu item(s).
6. Click the title of the taxonomy you want to view. The taxonomy members display in the right pane.

For example, to view the diagnosis codes associated with an HIV/AIDS diagnosis:

1. From the iCare Taxonomy View/Edit window, click the plus sign next to Diagnoses.
2. Select the BGP HIV/AIDS DXS taxonomy.

The list of diagnosis codes associated with HIV/AIDS is listed on the right, click to include diagnosis codes 042, 795.71, and V08.
12.4.5.1 **View a Report of All Taxonomies**

You can generate a report that displays all taxonomies and all associated members. To do so, from the iCare Taxonomy View/Edit window, click the View Report of All Taxonomies button. The application displays the RPMS iCare - Taxonomy Report.
12.4.6 Identify Empty Taxonomies

In the left pane of the iCare Taxonomy View/Edit window, some taxonomy names can have a yellow exclamation point icon next to them. This icon indicates that the taxonomy is empty. If you select an empty taxonomy name, no taxonomy members will display in the right pane.

![iCare Taxonomy View/Edit](image)

Figure 12-3: Sample of yellow exclamation point icon next to a taxonomy name

If you attempt to run a report involving an empty taxonomy, iCare will notify you that your report was not successful because the taxonomy was not populated.

12.4.7 Add a Member to a Site-Populated Taxonomy

Only users with the appropriate access rights can edit taxonomies. To edit taxonomy entries, you will need to have the iCare Taxonomy Editor security key. If you will be responsible for editing these taxonomies, discuss this with the iCare Package Manager at your site so that you can be assigned taxonomy editor access.

In order to readily identify which of the taxonomies are site-populated, a pencil icon is displayed next to a taxonomy name. There is also a category labeled ‘Site Populated.’

![iCare Taxonomy View/Edit](image)

Figure 12-4: Sample of paper/pencil icon next to a taxonomy name

At some point, you might want to add a member to a taxonomy; for example, to add a new lab test to the CD4 taxonomy.

The example below demonstrates how to add lab test members to a lab taxonomy. The steps are the same to add medication members.

1. From the main iCare window, open the Tools menu.
2. Select Taxonomy Maintenance.
3. Select View Taxonomies.
4. The iCare Taxonomy View/Edit window opens. In the left pane of the window, a tree view of the taxonomy organization displays.
5. Click the plus sign (+) next to Lab Tests.
6. Click the title of a taxonomy you want to edit. The taxonomy displays in the right pane.

**Note:** The pencil icon should be next to the taxonomy title, indicating that you have access rights to edit the taxonomy.

7. To add a member to the selected taxonomy, click the Add button.
8. The Select Taxonomy Item window opens. In the search field, enter the name of the lab test to add to the taxonomy. In this example, we’ll enter “Genital.”
9. Click the Find button. The results display.
10. Select the lab test to add to the taxonomy. In this example, we’ll select “Genital Culture.”
11. Click the Apply button. The item is now a member of the taxonomy.

### 12.4.8 Remove a Member from a Site-Populated Taxonomy

The example below demonstrates how to remove lab test members from a lab taxonomy. The steps are the same to remove medication members.

1. From the main iCare window, open the Tools menu.
2. Select Taxonomy Maintenance.
3. Select View Taxonomies.
4. The iCare Taxonomy View/Edit window opens. In the left pane of the window, a tree view of the taxonomy organization displays.
5. Click the plus sign (+) next to Lab Tests.
6. Click the title of a taxonomy you want to edit. The taxonomy displays in the right pane.

**Note:** The pencil icon should be next to the taxonomy title, indicating that you have access rights to edit the taxonomy.

7. In the right pane, select the member you want to remove from the taxonomy.
8. Click the Remove button.
9. Click Yes when you are prompted whether you are sure.
10. Click the Apply button. The lab test is now removed from the taxonomy.
12.5 HIV/AIDS Community Alert

iCare generates anonymous Community Alerts for the incidence of suicidal behavior, public health concerns and the Center for Disease Control’s (CDC) Nationally Notifiable Diseases (NND) about HIV/AIDS. During a nightly background job in iCare, POVs are mined for the incidence of each of these. The display of these community alerts are a user-specific preference, meaning that individual iCare users can choose whether or not to see a particular community alerts.

For display, the NNDs are divided into 3 levels of alerts: Mandatory, Recommended, and Optional.

- Mandatory alert displays are automatically set to display and users cannot be turned off.
- Recommended alert displays are automatically set to display but users can opt to turn these off.
- Optional alert displays are automatically set as off, but users can turn them on. The HIV/AIDS alert is a Optional alert.

To view the setting of your HIV/AIDS community alert:

1. Open the Tools menu.
2. Select User Preferences.
3. Go to the Comm Alert Setup tab. Scroll down to the HIV/AIDS alert. Click the check box so that the alert is “On.”

Figure 12-5: Scroll to HIV/AIDS alerts and click the check box
12.6 Patient Management

The individual patient management functions include displaying, entering, and editing data specifically related to HIV/AIDS.

12.6.1 Data Specifically Related to HIV/AIDS

iCare contains data fields that are specific to HIV/AIDS patient management. To view all the HIV/AIDS-related data fields in a panel view:

1. Click the Care Management tab.
2. From the Care Management Group drop-down list, select HIV/AIDS.
3. Under the Main sub-tab, click the Layout button.
4. The HIV/AIDS Patients – Care Mgmt Main Layout window opens.
5. Located in the top left of the window is the Available Columns area. Click the plus sign next to HIV/AIDS. All of the sub-items are the iCare data fields specific to HIV/AIDS.

Below is a list of all the data fields and associated field options.

<table>
<thead>
<tr>
<th>Field</th>
<th>Field Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register status</td>
<td>Active; Deceased; Inactive; Transient</td>
</tr>
<tr>
<td>Register status comments</td>
<td></td>
</tr>
<tr>
<td>HIV/AIDS Diagnosis Category</td>
<td>• AIDS</td>
</tr>
<tr>
<td></td>
<td>• HIV</td>
</tr>
<tr>
<td></td>
<td>• At Risk – Exposed source Unknown</td>
</tr>
<tr>
<td></td>
<td>• At Risk – Infant Exposed</td>
</tr>
<tr>
<td></td>
<td>• At Risk – Non-occupational Exposure</td>
</tr>
<tr>
<td></td>
<td>• At Risk – Occupational Exposure</td>
</tr>
<tr>
<td>Diagnosis comment</td>
<td></td>
</tr>
<tr>
<td>Initial HIV Diagnosis (DX) Date</td>
<td></td>
</tr>
<tr>
<td>Initial AIDS Diagnosis (DX) Date</td>
<td></td>
</tr>
</tbody>
</table>
### Field  |  Field Option
--- | ---
**CDC Cause (Etiology)**  | The Centers for Disease Control has categorized the ways in which an individual is exposed to HIV. Standardizing exposure categories enable epidemiologists to compare the same type of data and better understand the exposure trends regionally and nationally. The CDC will use this information anonymously in their semi-annual Surveillance reports.  
- BL – Receipt of blood transfusion, blood components or tissue  
- HEM – Hemophiliac/coagulation disorder  
- HET – Heterosexual contact  
- IDU – Injection drug use  
- MID – Male to male sexual contact + injection drug use  
- MOT – Mother with or at risk for HIV Infection  
- MTM – Male to male sexual contact  
- OCC – Occupational exposure  
- OTH – Other

**Etiology comments**

**CDC Clinical Classification**  |  
- A1 – Asymptomatic HIV infection + CD4 count > or = 500  
- A2 – Asymptomatic HIV infection + CD4 count between 200 and 499  
- A3 – Asymptomatic HIV infection + CD4 count less than 200  
- B1 – Symptoms attributable to HIV infection + CD4 count >= 500  
- B2 – Symptoms attributable to HIV infection + CD4 count between 200 and 499  
- B3 – Symptoms attributable to HIV infection + CD4 count less than 200  
- C1 – AIDS defining condition(s) + CD4 count > or = 500  
- C3 – AIDS defining condition(s) + CD4 count less than 200

**HIV Provider**

**HIV Case Manager**

**Where Followed**

**Outside Location**

**Outside Provider**
<table>
<thead>
<tr>
<th>Field</th>
<th>Field Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partner Notification Status</td>
<td>This notification type is to document the notification of a patient’s partner of a potential exposure to HIV. The public health recommendation to notify the patient’s partner is a practice that is encouraged in all I/T/U facilities. Options: N/A; No; Remind Me Later; Unknown; Yes</td>
</tr>
<tr>
<td>Partner Notification Date</td>
<td></td>
</tr>
<tr>
<td>ARV Appropriate</td>
<td>Anti-retroviral Therapy refers to specific combinations of ARV medications used to treat HIV/AIDS patients by reducing viral load and improving immunological function. ARV is a complex medication regimen and is not suitable for all patients. See Section 18 Appendix F for definition of ARV medication regimens. Options: Date; Status; Comment; Last Edited By; Last Edited Date</td>
</tr>
<tr>
<td>ARV Adherence</td>
<td>Date; Adherent; Comments; Last Edited By; Last Edited Date</td>
</tr>
<tr>
<td>State HIV Report Status</td>
<td>This notification type involves the requirement to notify the appropriate state Health Department of new HIV/AIDS diagnoses. Options: N/A; No; Remind Me Later; Unknown; Yes.</td>
</tr>
<tr>
<td>State HIV Report Date</td>
<td></td>
</tr>
<tr>
<td>State HIV Acknowledgement Status</td>
<td></td>
</tr>
<tr>
<td>State HIV Acknowledgement Date</td>
<td></td>
</tr>
<tr>
<td>State AIDS Report Status</td>
<td>This notification type involves the requirement to notify the appropriate state Health Department of new HIV/AIDS diagnoses. Options: N/A; No; Remind Me Later; Unknown; Yes.</td>
</tr>
<tr>
<td>State AIDS Report Date</td>
<td></td>
</tr>
<tr>
<td>State AIDS Acknowledgement Status</td>
<td></td>
</tr>
<tr>
<td>State AIDS Acknowledgement Date</td>
<td></td>
</tr>
</tbody>
</table>

Note: If you cannot move any of the fields from right to the left and vice versa, click the Customize radio button located at the top of the window.
12.6.2 Search for and View a Patient Record

Below are two methods for searching and viewing a patient record: (1) use a panel or (2) use quick search.

12.6.2.1 Use a Panel

See Section 12.7 Panel Management for more information about creating an HIV/AIDS-related panel specific to for your site.

Once you have created a panel, you can open a specific patient’s record by simply double-clicking the patient’s name. The patient’s record will open.

12.6.2.2 Use Quick Search

The Quick Patient Search is located in the top right corner of the main iCare window (also in the Tools menu). To search for and view a patient’s record:

1. In the Quick Patient Search field, enter your search criteria, such as the patient’s last name (e.g., Willis), HRN (e.g., 111222), or date of birth (e.g., 12/20/1965).
2. Click the green arrow icon or press Enter.
3. A Quick Patient Search window opens, displaying your search results.
4. In the search results, select the patient’s name for which you are searching.
5. Click Select. The patient’s record displays.

12.6.3 Displaying Care Management as Default Tab

The Care Management tab can be setup as the default tab when a Patient Record is opened.

1. From any iCare window select Tools/User Preferences.
2. Click the Patient View tab.
3. From the Start Up drop down list, select Care Mgmt.

12.6.4 Add/Edit Care Management Data

To enter Care Management information, follow these steps:

1. Open a patient record.
2. Click the Care Management tab.
3. From the Care Management Group drop-down list, select HIV/AIDS.
Note: If you selected a patient record from the Care Management tab on the panel view, the patient record opens to the Care Management tab and the HIV/AIDS group is already selected.

4. Click Enter Data.

5. The data entry area is organized into four Sections: General, Partner Notification; Antiretroviral (ARV) Status, and State Notification.

6. Enter data in each Section.

Important Note: It is highly recommended that you print and refer to the HIV/AIDS Glossary when entering data. To do so, click the Glossary button located above the General Section. See the “Using the HIV/AIDS Glossary” Section in for more information.

7. When you are finished, click Save. See Section 10.1.2.3 Main Tab for more information about completing the Main tab for HIV/AIDS on the Care Mgmt tab of the patient record.

The information will be updated in the patient record when you close the tab and click the Refresh button.

To edit Care Management information, follow these steps:

1. Open a patient record.
2. Click the Care Management tab.
3. Make changes to any of the data that has already been entered in each of the four main Sections.
4. Click Save.

12.6.5 HIV/AIDS Diagnostic Tags

Tagging is a term that refers to running a series of logic algorithms on one or multiple patients that identifies (“tags”) them with one or more diagnoses. These definitions are defined nationally and are consistent with other RPMS applications.

The HIV/AIDS Diagnostic Tag is based upon the following logic algorithm:

- At least two HIV POVs ever or 1 instance of HIV/AIDS active problem on the Problem List

OR

- Positive HIV screening test
OR

- At least 2 CD4 or HIV Viral Load lab tests in the past two years, at least 60 days apart.

### 12.6.5.1 Accept/Do Not Accept Proposed HIV/AIDS Diagnostic Tab

When a patient meets the diagnostic tag criteria, the system automatically tags the patient with the HIV/AIDS Diagnostic Tag. The tag will have a status of “Proposed.”

![Patient DIAGNOstic Tags data current as of 9:54 AM]

Figure 12-6: Patient DX Tag of proposed

To change the status to either ‘Accepted’ or ‘Not Accepted’:

1. Open a patient record.
2. Click the DX Tags tab.
3. Select the row that contains the HIV/AIDS Diagnostic Tag.
4. To accept the tag, click the Accept button.
   To deny the tag, click the Not Accept button.
5. The Update Diagnostic Tag window opens.
   In the New Status drop-down list, select Accepted or Not Accepted.
6. In the Status Change Reason area, select the Patient Data Supports Acceptance radio button.
7. Click OK.

**Note:** You can also change the status of a Diagnostic Tag from the Care Management tab.
12.6.5.2 **Change a Diagnostic Tag to Proposed**

To change an Accepted or Not Accepted diagnostic tag to proposed:

1. Open a patient record.
2. Click the DX Tags tab.
3. Select the row that contains the HIV/AIDS Diagnostic Tag.
4. Click Propose.
5. The Update Diagnostic Tag window opens.
   In the New Status drop-down menu, select Proposed.
6. In the Status Change Reason area, select the Manually Designated radio button.
7. Click OK.

**Note:** You can also change the status of a Diagnostic Tag from the Care Management tab.

12.6.5.3 **Manually Add an HIV/AIDS Diagnostic Tag**

You have the option of manually adding an HIV/AIDS Diagnostic tag.

A patient can only have one HIV/AIDS Diagnostic Tag. If a patient already has an HIV/AIDS Diagnostic Tag, an additional one cannot be added.

1. Open a patient record.
2. Click the DX Tags tab.
3. Click Add Tag.
4. The Add Diagnostic Tag window opens.
   In the Diagnostic Tag drop-down list, select HIV/AIDS.
5. In the New Status drop-down menu, select Accepted.
6. In the Status Change Reason area, select the appropriate radio button.
   • Patient Data Supports Acceptance
   • Manually Designated
   • Other
7. For a manually-added HIV/AIDS Diagnostic Tag, you must enter a comment in the Status Comment field.
8. Click OK.
12.6.6 HIV/AIDS Patient Care Supplement

The HIV/AIDS Patient Care Supplement displays information specifically related to HIV/AIDS. The provider will be able to see, at a glance, the relevant labs, related diagnoses, medications and reminders. The logic for the HIV/AIDS Patient Care Supplement is described in detail in Appendix H: HMS Patient Care Supplement.

There are two methods for viewing the HIV/AIDS Patient Care Supplement.

The first method is to access it from the Summary/Supplement tab.

1. Open a patient record.
2. Click the Summary/Supplement (Summ/Supp) tab.
3. From the Type drop-down list, select Supplement.
4. Another drop-down list opens beside it. From this new drop-down list, select HIV/AIDS Patient Care Supplement.
   The supplement displays.

The second method for viewing the HIV/AIDS Patient Care Supplement is to access it from the Care Management tab.

1. Open a patient record.
2. Click the Care Management (Care Mgmt) tab.
3. If not already selected, select the HIV/AIDS group from the Care Management Group drop-down menu.
4. On the Main sub-tab, click Reports.
5. Select HIV/AIDS Patient Care Supplement.
6. If your site has any empty taxonomies, you will receive the following system message: “The following taxonomies do not have any entries…” Click OK to continue, and to generate the HIV/AIDS Patient Care Supplement.
7. The report displays.
12.6.6.1 Opportunistic Infections and AIDS Defining Illnesses

Opportunistic Infections (OI) are conditions that many patients suffering with HIV/AIDS experience. HIV doesn’t kill anybody directly but rather weakens the body’s ability to fight disease. Infections that are rarely seen in those with normal immune systems are serious and can be deadly to those with HIV. They need to be treated, and some can be prevented. Many of these conditions are considered “reportable” to the State Health Department. Refer to Section 19.1 in Appendix F for a complete list of Opportunistic Infections.

AIDS Defining Illnesses (AIDS DI) are conditions that are used in conjunction with an HIV diagnosis to determine if a patient has progressed to AIDS. The definition of AIDS Defining Illnesses is established by the Centers for Disease Control (CDC) as part of its case definition of AIDS. Refer to Section 19.2 in Appendix F for a complete list of AIDS Defining Illnesses.

If the patient has one or more of these infections documented as the POV or on the Problem List, they will display from the patient record. The Opportunistic Infections are also displayed on the HIV/AIDS Patient Care Supplement.

The definitions for AIDS Defining Illnesses and Opportunistic Infections overlap. The following are the current definitions used in iCare.

<table>
<thead>
<tr>
<th>Diagnosis</th>
<th>ICD codes</th>
<th>OI</th>
<th>AIDS DI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aspergillosis</td>
<td>117.3</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Bartonellosis</td>
<td>088.0</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Campylobacter Enteric Disease</td>
<td>008.43</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Candidiasis, Bronchi</td>
<td>112.89; 112.9</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Candidiasis, Esophageal</td>
<td>112.84</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Candidiasis, Lung</td>
<td>112.4</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Candidiasis, Oral</td>
<td>112.0</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Candidiasis, Trachea</td>
<td>112.89; 112.9</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Carcinoma, invasive cervical</td>
<td>180*</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Coccidioidomycosis</td>
<td>114.1-3</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Cryptococcosis</td>
<td>117.5</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Cryptosporidiosis</td>
<td>007.4</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Cytomegalovirus disease</td>
<td>078.5</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Hemophilus Influenzae Respiratory Disease</td>
<td>041.5; 519.9</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Hepatitis B Virus</td>
<td>070.20-23; 070.30-33</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Hepatitis C Virus</td>
<td>070.41; 070.44; 070.51; 070.54; 070.70-71</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Herpes simplex</td>
<td>054*</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Histoplasmosis</td>
<td>115*</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>HIV Encephalopathy</td>
<td>042; 348.3*</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Human Papillomavirus</td>
<td>079.4</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Isosporias</td>
<td>007.2</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Kaposi’s Sarcoma</td>
<td>176*</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Lymphoma Burkitt’s</td>
<td>200.20-200.28</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Lymphoma Immunoblastic</td>
<td>200.80-200.88</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Lymphoma, primary in brain</td>
<td>202.8; 191*; 196*</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Microsporidiosis</td>
<td>136.8</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>
### Diagnosis

<table>
<thead>
<tr>
<th>Diagnosis</th>
<th>ICD codes</th>
<th>OI</th>
<th>AIDS DI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mycobacterium avium Complex (MAC)</td>
<td>031.0; 031.1; 031.2; 031.9</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Mycobacterium Tuberculosis</td>
<td>010-018</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Pneumocystis carinii Pneumonia (PCP)</td>
<td>136.3</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Pneumonia</td>
<td>480*- 486; 487.0</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Progressive Multifocal Leukoencephalopathy</td>
<td>046.3</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Pseudomonas respiratory Disease</td>
<td>519.9; 041.7</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Salmonella Enteric Disease</td>
<td>003.0; 003.8; 003.9</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Salmonella Septicemia</td>
<td>003.1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Shigella Enteric Disease</td>
<td>004.0-3; 004.8-9</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Staphylococcus Respiratory Disease</td>
<td>041.10; 041.11; 041.19; 519.9</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Streptococcal Respiratory Disease</td>
<td>041.0* 519.9</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Syphilis</td>
<td>090* - 097*</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Toxoplasmosis</td>
<td>130.0-9</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Varicella Zoster Virus</td>
<td>053*</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Wasting syndrome</td>
<td>261; 799.4</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

### 12.6.7 HIV/AIDS-Related Reminders

HIV/AIDS-related reminders are generated in order to “remind” the provider of the need for a particular lab test, procedure, immunization, health screen, or education session regarding HIV/AIDS patient care. These reminders are created based on current, expert recommendations and serve as a means to notify the provider when one of these functions is due or overdue. The decision to act on the reminder remains a clinical decision.

There are 23 HIV/AIDS Reminders available. The logic for the HIV/AIDS-related reminders is described in detail in Section 19 Appendix G: HIV/AIDS-Related Reminders – Logic and Tooltip Text.

You can view the reminders in one of three ways:

**Method 1**: Panel View > Reminders tab. Follow these steps:

1. From a Panel view, click the Reminder tab.
2. Click the Layout button. The Reminders Layout window opens.
3. Click Customize radio button located at the top of the window.
4. In the Available Columns area, click the plus sign next to the Reminders topic in order to view the sub-topics.
5. Click the plus sign next to Care Management.
6. Click the plus sign next to HIV. All of the items beneath HIV are the HIV/AIDS-related reminders available to use.
Method 2: From the Panel view, click the Care Management tab. Select the HIV/AIDS group. Click the Reminder sub-tab.

OR

Method 3: From the Patient record view, click the Reminders tab.

OR

Method 4: From the Patient Record view, click the Care Management tab. Select the HIV/AIDS group. Click the Reminder sub-tab.

For more detailed logic information associated with the reminder logic, see Section 16 Appendix D: HIV/AIDS-Related Reminders – Logic and Tooltip Text.

<table>
<thead>
<tr>
<th>Reminder Type</th>
<th>Frequency</th>
<th>Factors for Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>CD4</td>
<td>Every 4 months</td>
<td></td>
</tr>
<tr>
<td>HIV Viral Load Test</td>
<td>Every 4 months</td>
<td></td>
</tr>
<tr>
<td>PPD Test (TB)</td>
<td>Annually</td>
<td></td>
</tr>
<tr>
<td>Syphilis (RPR) Test</td>
<td>Variable, depending on diagnoses</td>
<td></td>
</tr>
<tr>
<td>FTA/ABS Syphilis Test</td>
<td>After a positive RPR</td>
<td>Displays for patients with positive RPR</td>
</tr>
<tr>
<td>Hepatitis C Screening</td>
<td>Annually</td>
<td></td>
</tr>
<tr>
<td>Test</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reminder Type</td>
<td>Frequency</td>
<td>Factors for Display</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------</td>
<td>--------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hepatitis C Confirmatory Test</td>
<td>After a positive Hep C EIA</td>
<td>Displays for patients with positive Hep C EIA only</td>
</tr>
<tr>
<td>Hep B Test</td>
<td>Once</td>
<td>Displays for patients with no documented Hep B test after 3 Hep B immunizations</td>
</tr>
<tr>
<td>Hep B Retest</td>
<td>After 3 Hep B immunizations</td>
<td>Displays only for female patients ages 18 through 64 without documented hysterectomy</td>
</tr>
<tr>
<td>Toxoplasmosis Test</td>
<td>Annually</td>
<td>Displays for patients with no history of positive Toxoplasmosis test</td>
</tr>
<tr>
<td>HMS Pap Smear</td>
<td>Variable, depending on CD4</td>
<td>Displays only for female patients ages 18 through 64 without documented hysterectomy</td>
</tr>
<tr>
<td>Chlamydia Test</td>
<td>Variable, depending on age, diagnoses, or test</td>
<td>Displays for patients ages 18 and older</td>
</tr>
<tr>
<td>Gonorrhea Test</td>
<td>Variable, depending on age, diagnoses, or test</td>
<td>Displays for patients ages 18 and older</td>
</tr>
<tr>
<td>Hep B IZ</td>
<td>Once, or a Hep B diagnosis</td>
<td></td>
</tr>
<tr>
<td>Hep A IZ</td>
<td>Once, or a Hep A diagnosis</td>
<td></td>
</tr>
<tr>
<td>HMS Pneumovax IZ</td>
<td>Every five years</td>
<td></td>
</tr>
<tr>
<td>HMS Influenza IZ</td>
<td>Annually</td>
<td></td>
</tr>
<tr>
<td>Tetanus IZ</td>
<td>Every 10 years</td>
<td>Displays for female patients ages 50-69 without documented bilateral mastectomy</td>
</tr>
<tr>
<td>HMS Mammogram</td>
<td>Annually</td>
<td>Displays for female patients ages 50-69 without documented bilateral mastectomy</td>
</tr>
<tr>
<td>HMS Eye Exam</td>
<td>Annually unless recent CD4</td>
<td>Displays for patients ages 13 and older</td>
</tr>
<tr>
<td>HMS Dental Exam</td>
<td>Variable depending on CD4</td>
<td>Displays for female patients ages 13-44 and male patients ages 13 and older</td>
</tr>
<tr>
<td>Safe Sex Education</td>
<td>Every 6 months</td>
<td></td>
</tr>
<tr>
<td>Family Planning Education</td>
<td>Every 6 months</td>
<td></td>
</tr>
</tbody>
</table>

### 12.7 Panel Management

A panel is an automated tool for maintaining a list of patients who meet criteria set by the user and providing various condition-specific reports, reminders, and plans to assist providers in managing the disease or condition.

iCare can be used to create and to maintain a panel of all HIV/AIDS patients.

There are many methods to creating an HIV/AIDS panel in iCare. For example, your site can choose to create panels by:

- Selecting patients who have either proposed or accepted HIV/AIDS Diagnostic Tag.
• Selecting every patient who has seen the provider(s) who is/are responsible for all of your site’s HIV/AIDS patients. For example, if you are an HIV Case Manager, you have specific HIV/AIDS patients assigned to you.

• Selecting all patients who have scheduled appointments at your HIV/AIDS clinic.

• Using the RPMS HMS Register. If your site has been using the roll-and-scroll HIV Management System (HMS) application to create a register, you might want to populate your iCare panel with that register.

• Using an RPMS QMAN template. Find the template in iCare and the panel will be automatically populated with the QMAN search results.

• Manually adding all known HIV/AIDS patients at your site. This method might be used by sites with a small HIV/AIDS patient population.

See the Section 5.0 Creating Patient Panels for more detailed information about creating panels.
12.8 Reports

Below is information about the various reports associated with HIV/AIDS.

12.8.1 HIV/AIDS Patient Care Supplement

From any patient’s record on the Summary/Supplement (Summ/Supp) tab, you can view and print the patient’s Health Summary or HIV/AIDS Patient Care Supplement. See Section 12.6.6 HIV/AIDS Patient Care Supplement for more information on how to generate the HIV/AIDS Patient Care Supplement.

12.8.2 State Surveillance Report (SSR)

The State Surveillance report is a multi-page report that can be filled out and sent to the state when a patient has been diagnosed with HIV or AIDS. The report format is based on standard CDC reporting requirements.

The State Surveillance Report is exclusively located in a patient’s record on the Care Management (Care Mgmt) tab.

The State Surveillance Report is just a guide for your site to use; it is not state-specific.

You can select to print out a blank report form and fill in all of the data manually, or print a patient-specific form. The patient-specific form will display many data items directly from RPMS, but several elements will still have to be confirmed and filled in manually.

Regardless of which form you choose to print, providers should review this report, manually correct or fill in any incorrect or missing data, then send the report to the appropriate state agency.

If your state has a specific format, running the SSR for a patient can provide you with RPMS data that can be transferred to your state’s form.

To generate the report, follow these steps:

1. Open a patient record.
2. Click the Care Management tab.
3. Click Reports.
12.8.3 Quality of Care (QOC) Report

The Quality of Care (QOC) provides a snapshot of key care indicators for HIV/AIDS patients at your site. Use the report to assess how well care is being extended to HIV/AIDS patients at your site, and to justify activities at your site.

The general format is based on HIVQual, an HRSA-sponsored program built upon a model of quality improvement consultation that was developed in New York State. The goal of the HIVQual Continuous Quality Project is to improve the quality of care delivered to persons with HIV.

Clinical elements that are documented in the Quality of Care report include the following. See Section 19 Appendix G: Quality of Care Report Logic for a description of the logic used to create the Quality of Care report.

- CD4 (T cell) and HIV Viral load test dates and categorization by test results
- STD testing: Completion of tests and categorization of test results for sexually-transmitted diseases (STDs), including syphilis, chlamydia, and gonorrhea
- Infectious disease prevention: testing for or immunization against tuberculosis, pneumococcal diseases, and tetanus.
- Relevant exams and procedures: completion of eye exam, dental exams and pap smears
- Medications: categorizes patients by types of medications, including ARV (anti-retroviral) therapy, PCP and MAC prophylaxis
- Related health factors: categorizes patient by Tobacco and substance abuse screening and use.

In order for the QOC report to be accurate and effective, Case Managers should ensure that the register fields and taxonomies are up to date, and that the report is run every month.

The QOC report is exclusively located in the panel view (not in a patient’s individual record).

You can run the report on everyone in your panel or on specific patients in your panel. You can also run the report on patients with an HIV/AIDS Diagnostic Tag or patients from the HMS Register.

**Note:** patients must have at least one HIV/AIDS POV or Active Problem List or HMS Initial HIV Dx Date or HMS Initial AIDS Dx Date 6 months or more prior to report end date. Patient names selected by the user that do not meet these criteria will be identified on the report.
To generate the report, follow these steps:

1. In your panel view, select the patients to be included in the QOC report.
2. Click Reports.
3. Select Quality of Care. The Quality of Care window opens.

4. From the Report Population drop-down menu, select the population on which you want to run the report. As mentioned above, you can select individual patients. You can also run the report on patients with an HIV/AIDS Diagnostic Tag or patients from the HMS Register.

5. In the Ending Date field, the default date is today.
   Note: It is important to understand that the QOC report is an annual, retrospective report, meaning that the start date of the report is always set at one year.
   You can change the end date by typing in a new date or selecting it from the pop-up calendar.

6. Click OK.
Figure 12-12: Sample Quality of Care report
13.0 Appendix A: iCare Predefined Diagnosis Definitions

Asthma (defined by CRS)
Patients with at least 2 POVs ever (not on the same date) or 1 instance on Active Problem List. Asthma defined as ICD 493.00-493.92 (BGP ASTHMA DXS taxonomy)

COPD (defined by CRS)
Patients with at least 2 POVs ever (not on the same date) or 1 instance on Active Problem List. COPD defined as ICD 491.20-491.21; 496.*; 506.0-506.9 (BGP COPD DXS taxonomy)

CVD Known (CVD Kn) (defined by Dr. Galloway and CVD Workgroup)
The patient is categorized with Known CVD if any of the following criteria are met:

1. One instance ever of specific cerebrovascular or peripheral vascular disease diagnoses or CABG or PCI/PTCA. Defined as ICD 431.*, 433.*1, 434.*1, 435.3, 440.3*, 557.1 (BQI KNOWN CVD-1 DXS taxonomy); ICD Procedures 36.1*, 36.2 (BGP CABG PROCES taxonomy); CPT 33510-33519; 33521-33523; 33553-33556; 35600, 33572 (BGP CABG CPTS taxonomy); ICD Procedures 36.01, 36.02, 36.05, 36.06, 36.09 (BGP CMS PCI-PTCA PROCEDURES taxonomy); CPT 33140, 92980-92982, 92984, 92995, 92996 (BGP CMS PCI-PTCA CPTS taxonomy).

OR

2. Two instances ever (not on the same date) of Acute Myocardial Infarction (AMI) (1 instance can be an Active Problem List) at least 90 days apart but no more than 2 years between first (most recent) and last diagnosis. AMI defined as ICD 410.*0; 410.*1 (BGP AMI DXS (HEDIS) taxonomy).

OR

3. Three different instances of Ischemic Heart Disease (IHD) on same day (1 instance can be an Active Problem List); defined as ICD 411.*, 413.*, 414.* (BQI IHD DXS taxonomy).
4. Three instances of any Ischemic Heart Disease (IHD) or other specific cerebrovascular or peripheral vascular disease at least 90 days apart but no more than 5 years between first and last diagnosis (1 instance can be an Active Problem List). Defined as ICD 411.*, 413.*, 414.* (BQI IHD DXS taxonomy); ICD 430.*; 432.*; 433.*; 434.*; 435.*; 436.*; 437.*; 440.*; 441.* (BQI KNOWN CVD-MULT DXS taxonomy); ICD Procedures 38.34, 38.44, 38.64, 39.71 (BQI KNOWN CVD-MULT PROCEDURES taxonomy); CPT 0001T, 0002T, 0033T, 0034T, 0035T, 0036T, 0037T, 33877, 34800, 34802, 34804, 34830, 34831, 34832 (BQI KNOWN CVD-MULT CPTS taxonomy)

CVD At Highest Risk (CVD AHR) (defined by Dr. Galloway and CVD Workgroup)

The patient is categorized as CVD At Highest Risk if he/she is not categorized with Known CVD and meets either of the following criteria:

1. Known Diabetes: the patient has 2 POVs ever (not on the same day) or 1 instance on Active Problem List. Defined as ICD 250.00-250.93 (Surveillance Diabetes taxonomy)

OR

2. End stage renal disease (ESRD) OR with dialysis: the patient has at least 2 instances ever (not on the same day) or 1 instance on Active Problem List. Defined as ICD 585.6, V45.1 (BGP ESRD DXS taxonomy) or CPT 90918-90925 (BGP ESRD CPTS taxonomy)

CVD At Significant Risk (CVD ASR) (defined by Dr. Galloway and CVD Workgroup)

The patient is categorized as At Significant Risk if he/she is not categorized with either Known CVD or At Highest Risk and meets either of the following criteria.

1. greater than (> ) age 18 and at least 2 CVD Risk Factors

OR

2. Male equal to or greater than (≥) age 45 OR Female equal to or greater than (≥) age 55; and at least 1 CVD Risk Factor

A risk factor is defined as any one of the following:
A. Current Smoker: the patient has at least 2 POVs ever (not on the same date) or 1 instance on the Active Problem List or most recent tobacco Health Factor or Dental (ADA) code 1320. Smoking defined as ICD 305.1; 301.10; 305.13; V15.82 (BGP GPRA SMOKING DXS taxonomy) or health factors Current Smoker, Current Smoker & Smokeless, Cessation Smoker, Cessation Smoker and Smokeless (BGP SMOKING HLTH FACTORS taxonomy)

B. Prediabetes Metabolic Syndrome: the patient has at least 2 POVs ever (not on the same date) or on 1 instance on the Active Problem List. Defined as ICD 277.7 (BGP PRE DM MET SYN DX taxonomy)

C. Hypertension: the patient has at least 3 POVs separated by 90 days or 1 instance on the Active problem list. Defined as ICD 401.0 - 401.9 (BGP HYPERTENSION DXS taxonomy)

D. Obese: The patient’s most recent BMI is equal to or greater than (≥) 30

E. High Blood Pressure: 2 of last 3 non-ER blood pressures are Systolic equal to or greater than (≥) 140 or Diastolic equal to or greater than (≥) 90

F. Most recent HDL lab test is less than (<) 40 for men or less than (<) 45 for women. HDL defined by the site in DM AUDIT HDL TAX taxonomy or predefined LOINC codes (BGP HDL LOINC CODES)

G. Evidence of High Cholesterol: defined as any one of the following:
   1. Prescription for Statin medication in the past year, defined by the site in the DM AUDIT STATIN DRUGS taxonomy or pre-defined NDC or class codes (BQI STATIN MEDS CLASS or BQI STATIN NDC taxonomies).
   2. Hyperlipidemia: at least 2 POVs ever (not on the same date) or 1 instance on the Active Problem List. Defined as ICD 272.0-272.9 (BQI HYPERLIPIDEMIA DXS taxonomy).
   3. LDL lab test value equal to or greater than (≥) 160 in past five years. Test is defined by the site in DM AUDIT LDL CHOLESTEROL TAX taxonomy or pre-defined LOINC codes (BGP LDL LOINC CODES taxonomy).
   4. Total cholesterol value equal to or greater than (≥) 240 in past five years. Test is defined by the site in DM AUDIT CHOLESTEROL TAX taxonomy or pre-defined LOINC codes (BGP TOTAL CHOLESTEROL LOINC taxonomy).
   5. Non HDL equal to or greater than (≥) 190 in past five years, defined as value of Total Cholesterol minus value of HDL, both results documented on the same date.
H. Evidence of Nephropathy: defined as any one of the following:

Patients with at least 2 instances (POV, Procedure or CPT) or 1 instance on Active Problem List in past 5 years. Defined as ICD 250.40-250.43; 403.0-405.01; 405.11; 405.91; 581.81; 582.9; 583.81; 584.5-586.; 588.0-588.9; 753.0-753.19; 791.0; V42.0; V45.1; V56.0-V56.8 (BGP NEPHROPATHY DXS taxonomy) or ICD Procedures 39.27; 39.42-39.43; 39.53; 39.93-39.95; 54.98; 55.4-55.69 (BGP NEPHROPATHY PROCEDURES taxonomy) or CPTs 36800-36815; 36818-36821; 50300; 50320; 50340; 50360; 50370-50380; 90920-90921; 90924-90937; 90945-90947; 90989; 90993; 90997; 90999; 99512 (BGP NEPHROPATHY CPTS taxonomy)

Creatinine test results equal to or greater than (≥) 2.0 over past year, separated by at least 90 days. Creatinine test defined by the site in DM AUDIT CREATININE TAX taxonomy or pre-defined LOINC codes (BGP CREATININE LOINC CODES).

Estimated GFR values less than or equal to (<=) 30 over past year, separated by at least 90 days. Estimated GFR test defined by the site in BGP GPRA ESTIMATED GFR TAX taxonomy or by LOINC code 33914-3.

CVD At Risk (CVD AR)

Patients NOT in CVD Known, Highest or Significant Risk categories who are Male equal to or greater than (≥) age 45 OR Female equal to or greater than (≥) age 55.

Diabetes (DM)

Patients with at least 2 POVs ever (not on the same date) or 1 instance on Active Problem List. Diabetes defined as ICD 250.00-250.93 (SURVEILLANCE DIABETES taxonomy)

HIV/AIDS (HIV)

Patients with at least 2 POVs ever (not on the same date) or 1 instance on Active Problem List. HIV/AIDS defined as ICD 042.-44.9; 795.71; V08 (BGP HIV/AIDS DXS).

Hypertension (HTN)

Patients with at least 2 POVs ever (not on the same date) or 1 instance on Active Problem List. Hypertension defined as ICD 401.0-401.9 (BGP HYPERTENSION DXS taxonomy).
Obese

Adult patients (ages 19 and older) with most recent adult BMI equal to or greater than (≥) 30. Values for patients ages 18 and under are based on standard tables. BMI is not a stored value but is calculated at the time the logic is run, based on the most recent height and weight data in the Measurement file. For ages 18 and under, a height and weight must be taken on the same day in the past year. For ages 19 through 50, height and weight must be recorded within last 5 years, not required to be on the same day. For ages over 50, height and weight within last 2 years but not required to be recorded on same day.

Prediabetes Metabolic Syndrome w/o DM (PreDM)

Patients with no documented diabetes

AND

2 POVs ever (not on the same date) or 1 instance on Active Problem List, defined as 277.7 (BGP PRE DM MET SYN DX taxonomy)

OR

One each of at least three of the following in the past year:

A. Adult BMI equal to or greater than (≥) 30 OR measurement type Waist Circumference: Male greater than (> ) 40 inches or Female greater than (> ) 35 inches.

B. Triglyceride test value equal to or greater than (≥) 150. Triglyceride test defined by the site in DM AUDIT TRIGLYCERIDE TAX taxonomy or pre-defined LOINC codes (BGP TRIGLYCERIDE LOINC CODES).

C. HDL test value is less than (<) 40 for men or less than (<) 50 for women. HDL defined by the site in DM AUDIT HDL TAX taxonomy or pre-defined LOINC codes (BGP HDL LOINC CODES)

D. Hypertension: patients with at least 2 POVs ever (not on the same date) or 1 instance on Active Problem List. Hypertension defined as ICD 401.0 -401.9 (BGP HYPERTENSION DXS taxonomy) OR mean Blood Pressure value is equal to or greater than (≥) 130/85 where systolic is equal to or greater than (≥) 130 OR diastolic is equal to or greater than (≥) 85
E. Mean value of last 3 Blood Pressures in the past year documented on non-ER visits. If 3 BPs are not available, uses mean of last 2 non-ER BPs. If a visit contains more than 1 BP, the lowest BP will be used, defined as having the lowest systolic value. The mean Systolic value is calculated by adding the last 3 (or 2) systolic values and dividing by 3 (or 2). The mean Diastolic is derived the same way with diastolic values.

F. Fasting Glucose value is equal to or greater than ($\geq$) 100 AND less than ($<$) 126. Test is defined by the site in DM AUDIT CHOLESTEROL TAXonomy or pre-defined LOINC codes (BGP TOTAL CHOLESTEROL LOINC taxonomy).

**Smokers, Current (Smoker)**

Patients with 1 instance (POV, Problem, Health Factor, ADA code) of any Smokers Tobacco user definition in the past year. Smoking defined as ICD 305.1; 301.10; 305.13; V15.82 (BGP GPRA SMOKING DXS taxonomy); health factors Current Smoker, Current Smoker & Smokeless, Cessation Smoker, Cessation Smoker and Smokeless (BGP SMOKING HLTH FACTORS taxonomy); Dental (ADA) code 1320.
14.0 Appendix B: Performance Measure Logic Example

Cancer Screening: Pap Smear Rates: Maintain the proportion of female patients ages 21 through 64 without a documented history of hysterectomy who have had a Pap screen within the previous three years at the previous level.

For CRS, the GPRA measure definition becomes:

- Denominator (total number of patients evaluated): Active Clinical female patients ages 21 through 64, excluding those with documented history of hysterectomy. (The clinical owner of the measure has determined based on current medical guidelines that “eligible” women are defined as ages 21-64.)

- Numerator (those from the denominator who meet the criteria for the measure): patients with documented Pap smear in past three years or refusal in past year.

For the programmer, the Pap Smear measure is described in terms of the following logic:

Begin with the Active Clinical population definition (see the User Manual for Clinical Reporting System for definitions of User Population and Active Clinical).

- Exclude any patients with the name of “DEMO,PATIENT.”

- Exclude any patients with a date of death in the Patient Registration file.

- Exclude any patients who do NOT have value 01 (American Indian/Alaska Native) in the Beneficiary field in Patient Registration file.

- Exclude any patients whose Community of Residence is not included in the site’s defined GPRA Community Taxonomy for this report.

- For the remaining patients, search visit files for the three years prior to the selected Report end date. Exclude any patients whose visits do not meet the “2 medical clinics” definition OR for facilities with the CHS-Only site parameter set to “Yes”, exclude any patients who do not have 2 CHS visits in the past 3 years.

From these patients, identify the subset that are female and that are ages 21 through 64 on the first day of the Current Report period.

Exclude patients with documented hysterectomy by searching the V Procedure file for procedure codes 68.4-68.9 or V CPT for CPT codes 51925, 56308, 58150, 58152, 58200-58294, 58550-54, 58951, 58953-58954, or 59135 any time before the end of the Report period.
For these patients (the denominator), check for a Pap smear in the past three years in the following order:

- V Lab is checked for a lab test called PAP SMEAR and for any site-populated pap smear lab test documented in the BGP PAP SMEAR TAX taxonomy, OR
- V Lab is checked for any LOINC code listed in the pre-defined BGP PAP LOINC CODES taxonomy (see the CRS Technical Manual for specific codes), OR
- Purpose of Visit file (V POV) is checked for: a diagnosis of: V76.2-Screen Mal Neop-Cervix, V72.31 Routine Gynecological Examination, V72.32 Encounter for Pap Cervical Smear to Confirm Findings of Recent Normal Smear Following Initial Abnormal Smear, V72.3 Gyneecological Examination, Pap Cervical Smear as Part of General Gynecological Exam, Pelvic Exam (annual) (periodic) (old code, to be counted for visits prior to 10/1/04 only), V76.47 Vaginal Pap Smear for Post-Hysterectomy Patients, or V76.49 Pap Smear for Women w/o a Cervix, OR
- V Procedures is checked for a procedure of 91.46, OR
- V CPT is checked for the following CPT codes: a) 88141-88167; b) 88174-88175 or HCPCS code Q0091 Screening Pap Smear, OR
- The Women’s Health Tracking package is checked for documentation of a procedure called Pap Smear, OR
- Refusals file is checked for Lab Test Pap Smear in the past year.

If a visit with any of the codes above is found, the patient is considered to have met the measure, and the program checks the next patient.

For a detailed description of the logic for each performance measure included in CRS, see the Administrator Manual, Section 2.0 Performance Measure Logic.
15.0 Appendix C: Definitions and Taxonomies Content

Below is information about the diagnosis and ICD-9 codes for Opportunistic Infections and AIDS Defining Illnesses.

15.1 Opportunistic Infections

<table>
<thead>
<tr>
<th>DIAGNOSIS</th>
<th>ICD 9 CODE(S)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aspergillosis</td>
<td>117.3</td>
</tr>
<tr>
<td>Bartonellosis</td>
<td>088.0</td>
</tr>
<tr>
<td>Campylobacter Enteric Disease</td>
<td>008.43</td>
</tr>
<tr>
<td>Candidiasis, Oral</td>
<td>112.0</td>
</tr>
<tr>
<td>Coccidioidomycosis</td>
<td>114.1-3</td>
</tr>
<tr>
<td>Cryptococcosis</td>
<td>117.5</td>
</tr>
<tr>
<td>Cryptosporidiosis</td>
<td>007.4</td>
</tr>
<tr>
<td>Cytomegalovirus disease</td>
<td>078.5</td>
</tr>
<tr>
<td>Hemophilus Influenza Respiratory Disease</td>
<td>041.5; 519.9</td>
</tr>
<tr>
<td>Hepatitis B Virus</td>
<td>070.20-23; 070.30-33</td>
</tr>
<tr>
<td>Hepatitis C Virus</td>
<td>070.41; 070.44; 070.51; 070.54; 070.70-71</td>
</tr>
<tr>
<td>Herpex Simplex virus</td>
<td>054*</td>
</tr>
<tr>
<td>Histoplasmosis</td>
<td>115*</td>
</tr>
<tr>
<td>Human Papillomavirus</td>
<td>079.4</td>
</tr>
<tr>
<td>Microsporidiosis</td>
<td>136.8</td>
</tr>
<tr>
<td>Mycobacterium Avium Complex</td>
<td>031.0; 031.1; 031.2; 013.9</td>
</tr>
<tr>
<td>Mycobacterium Tuberculosis</td>
<td>010-018</td>
</tr>
<tr>
<td>Pneumocystitis carinii Pneumonia</td>
<td>136.3</td>
</tr>
<tr>
<td>Progressive Multifocal Leukoencephalopathy</td>
<td>046.3</td>
</tr>
<tr>
<td>Pseudomonas respiratory Disease</td>
<td>519.9; 041.7</td>
</tr>
<tr>
<td>Salmonella Enteric Disease</td>
<td>003.0; 003.8; 003.9</td>
</tr>
<tr>
<td>Shigella Enteric Disease</td>
<td>004.0-3; 004.8-9</td>
</tr>
<tr>
<td>Staphylococcus Respiratory Disease</td>
<td>041.10; 041.11; 041.19; 519.9</td>
</tr>
<tr>
<td>Streptococcal Respiratory Disease</td>
<td>041.0* 519.9</td>
</tr>
<tr>
<td>Syphilis</td>
<td>090* - 097*</td>
</tr>
<tr>
<td>Toxoplasmosis</td>
<td>130.0-9</td>
</tr>
<tr>
<td>Varicella Zoster Virus</td>
<td>053*</td>
</tr>
</tbody>
</table>

15.2 AIDS Defining Illnesses

<table>
<thead>
<tr>
<th>DIAGNOSIS</th>
<th>ICD 9 CODE(S)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Candidiasis, Bronchi</td>
<td>112.89; 112.9</td>
</tr>
<tr>
<td>Candidiasis, Esophageal</td>
<td>112.84</td>
</tr>
<tr>
<td>Candidiasis, Lung</td>
<td>112.4</td>
</tr>
<tr>
<td>Candidiasis, Trachea</td>
<td>112.89; 112.9</td>
</tr>
<tr>
<td>Carcinoma, invasive cervical</td>
<td>180*</td>
</tr>
<tr>
<td>Coccidioidomycosis</td>
<td>114.1; 114.2; 114.3</td>
</tr>
<tr>
<td>Cryptococcosis</td>
<td>117.5</td>
</tr>
<tr>
<td>DIAGNOSIS</td>
<td>ICD 9 CODE(S)</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Cryptosporidiosis</td>
<td>007.4</td>
</tr>
<tr>
<td>Cytomegalovirus disease</td>
<td>078.5</td>
</tr>
<tr>
<td>Herpes simplex</td>
<td>054*</td>
</tr>
<tr>
<td>Histoplasmosis</td>
<td>115*</td>
</tr>
<tr>
<td>HIV Encephalopathy</td>
<td>042; 348.3*</td>
</tr>
<tr>
<td>Isosporiasis</td>
<td>007.2</td>
</tr>
<tr>
<td>Kaposi's Sarcoma</td>
<td>176*</td>
</tr>
<tr>
<td>Lymphoma Burkitt's</td>
<td>200.20-200.28</td>
</tr>
<tr>
<td>Lymphoma Immunoblastic</td>
<td>200.80-200.88</td>
</tr>
<tr>
<td>Lymphoma, primary in brain</td>
<td>202.8; 191*; 196*</td>
</tr>
<tr>
<td>Mycobacterium avium Complex (MAC)</td>
<td>031.0; 031.1; 031.2; 031.9</td>
</tr>
<tr>
<td>Mycobacterium Tuberculosis</td>
<td>010 - 018</td>
</tr>
<tr>
<td>Pneumocystis carinii Pneumonia (PCP)</td>
<td>136.3</td>
</tr>
<tr>
<td>Pneumonia</td>
<td>480*- 486; 487.0</td>
</tr>
<tr>
<td>Progressive Multifocal Leukoencephalopathy</td>
<td>046.3</td>
</tr>
<tr>
<td>Salmonella Septicemia</td>
<td>003.1</td>
</tr>
<tr>
<td>Toxoplasmosis</td>
<td>130.0-9</td>
</tr>
<tr>
<td>Wasting syndrome</td>
<td>261; 799.4</td>
</tr>
</tbody>
</table>
15.3 HIV/AIDS Definitions, Codes, Taxonomies, Attributes

The code definitions listed in the table should be located within RPMS PCC “V” files, as identified below:

**CPT**: 1) V CPT, CPT field; 2) if a procedure related to any radiology, also V Radiology, CPT Code field.

**ICD Diagnoses**: 1) V POV, POV field; 2) also Problem List but only if specified in the individual definition below, (PROBLEM file, file number 9000011. The .01 field is a pointer to ICD Diagnosis.

**ICD Procedures**: 1) V Procedure, Procedure field.

**LOINC**: 1) V Lab, LOINC Code field.

**NDC**: The NDC is not stored in the V MEDICATION file, you would get at it by using the .01 field which points to the DRUG file (file #50). There is a field in the drug file called NDC.

**Site-Defined Lab Tests**: 1) V Lab, Lab Test field.

**Site-Defined Medications**: 1) V Medication, Medication field.

**Health Factors**: 1) V Health Factors, Health Factor field.

**Dental (ADA) Code**: V Dental, Service Code field, the .01 field called service code that points to the ADA code table.

**Patient Education**: 1) V Patient Ed, Topic field.

**Clinic Codes**: 1) V Visit, Clinic field - .08 field in VISIT file is a pointer to the CLINIC STOP file, file 40.7 that has the name of the clinic and the code Immunization Codes: 1) V Immunization, the .01 field called immunization points to the standard immunization table.

**Exam Codes**: 1) V Exam, Exam Code field.
**Provider Codes:** 1) Visit Providers are entered into the V PROVIDER file. The .01 field (PROVIDER) points to file 200, the NEW PERSON file. The provider’s discipline and codes can be found in file 200.

The following tab was updated as of 09/10/2009.

<table>
<thead>
<tr>
<th>ID</th>
<th>Definition</th>
<th>CPT</th>
<th>ICD</th>
<th>LOINC</th>
<th>Site-Defined Taxonomy (Labs or Meds)</th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td>DX.1</td>
<td>AIDS Defining Illnesses</td>
<td>BKMV AIDS DEF ILL DXS</td>
<td>003.1; 007.2; 007.4; 010.00-018.96; 031.0;031.1; 031.2; 031.9; 046.3; 054*; 078.5; 112.4; 112.84; 112.89; 112.9; 114.1; 114.2; 114.3; 115*; 117.5; 130.0-9; 136.3; 176*; 180*; 191*; 196*; 200.20-200.28; 200.80-200.88;202.80-202.88; 261; 348.3*; 480*; 482*; 483*; 484*; 485*; 486*; 487*; 799.4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DX.2</td>
<td>Chlamydia DX</td>
<td>BKM CHLAMYDIA DXS</td>
<td>078.8*, 079.88, 079.98, 099.41, 099.5*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DX.1</td>
<td>Colorectal Cancer</td>
<td>BGP COLORECTAL CANCER CPTS</td>
<td>153.*, 154.0, 154.1; 197.5; V10.05</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DX.4</td>
<td>Gonorrhea</td>
<td>BKM GONORRHEA DXS</td>
<td>098.0 – 098.89</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DX.5</td>
<td>Hepatitis A</td>
<td>BKM HEP A DXS</td>
<td>070.0; 070.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DX.1</td>
<td>Hepatitis B</td>
<td>BKM HEP B DXS</td>
<td>070.20-.23; 070.30-.33</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DX.6</td>
<td>HIV/AIDS DX</td>
<td>BGPHIV/AIDS DXS</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ID</td>
<td>Definition</td>
<td>CPT</td>
<td>ICD</td>
<td>LOINC</td>
<td>Site-Defined Taxonomy (Labs or Meds)</td>
<td>Other</td>
</tr>
<tr>
<td>----</td>
<td>---------------------------------</td>
<td>-------------------------</td>
<td>--------------------------</td>
<td>-------------------------</td>
<td>-----------------------------------------------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>BGP NON TOBACCO USER FACTORS</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Health Factors: Non Tobacco User;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Previous Smokeless; Previous Smoker</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DX.7</td>
<td>Non Tobacco Users</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DX.8</td>
<td>Opportunistic Infections</td>
<td>BKMV HIV OPP INF DXS</td>
<td>003.0; 003.8; 003.9; 004.0-3;</td>
<td>004.8-9; 007.4; 008.43; 010-018.96; 031.0; 031.1; 031.2; 031.9; 041.0*; 041.10; 041.11; 041.19; 041.5; 041.7; 046.3; 053*; 054*; 070.20-23; 070.30-33; 070.41; 070.44; 070.51; 070.54; 070.70; 070.71; 078.5; 079.4; 088.0; 090*; 091*; 092*; 093*; 094*; 095*; 096*; 097*; 112.0; 114.1-3; 115*; 117.3; 117.5; 130.0-9; 136.3; 136.8; 176*; 180.-180.9; 200.20-200.28; 200.80-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DX.9</td>
<td>Other STD</td>
<td>BKM OTHER STD DXS</td>
<td>099.1-099.3; 099.40; 099.49; 099.8; 099.9</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DX.17</td>
<td>State Reportable Diagnoses</td>
<td>BKM STATE REPORTABLE DXS</td>
<td>003.1; 007.2; 007.4; 011*; 031.2; 031.9; 042; 046.3; 054*; 078.5; 112.4; 112.84; 112.89; 112.9; 114.1; 114.2; 114.3; 115*; 117.5; 130*; 136.3; 176*; 180.-180.9; 200.20-200.28; 200.80-</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ID</td>
<td>Definition</td>
<td>CPT</td>
<td>ICD</td>
<td>LOINC</td>
<td>Site-Defined Taxonomy (Labs or Meds)</td>
<td>Other</td>
</tr>
<tr>
<td>----</td>
<td>-----------------------------</td>
<td>-----------------</td>
<td>---------------------------------</td>
<td>----------------------------</td>
<td>--------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>1</td>
<td>Syphilis</td>
<td></td>
<td>200.88; 202.80-202.88; 261;</td>
<td></td>
<td>BGP SYPHILIS DXS</td>
<td>BGP TOBACCO USER HLTH FACTORS</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>348.3-348.39*; 363.15;</td>
<td></td>
<td>090.0-093.9; 094.1-097.9</td>
<td>Health Factors: Current Smokeless, Current Smoker, Current Smoker &amp; Smokeless, Cessation Smoker, Cessation Smokeless Smokeless</td>
</tr>
<tr>
<td>1</td>
<td>Tobacco Users</td>
<td>BGP TOBACCO</td>
<td>BGP SMOAKER ONLY DXS</td>
<td></td>
<td>POV or Current Problem List</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>USER CPTS</td>
<td>1034F; 1035F</td>
<td></td>
<td>305.1; 305.10-305.12; 649.00-649.04;</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Trichomoniasis</td>
<td></td>
<td>BKM TRICHOMONIASIS DXS</td>
<td></td>
<td>131.0-.9</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Tuberculosis (TB)</td>
<td></td>
<td>DM AUDIT PROBLEM TB DXS</td>
<td></td>
<td>010.00-018.96; 137.0-137.4; 795.5; V12.01</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Family Planning</td>
<td></td>
<td>BKM FAMILY PLANNING POV</td>
<td></td>
<td>Patient education (V PED) codes containing “FP-.”</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>HIV Counseling/ Education</td>
<td></td>
<td>BKMV HIV ED DXS</td>
<td></td>
<td>Patient education codes containing “HIV-”, “-HIV” or any HIV ICD codes (e.g., 042.-044.9, 795.71, V08</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Safe Sex Education</td>
<td></td>
<td></td>
<td></td>
<td>BKM SAFE SEX ED CODES</td>
<td>Patient education</td>
</tr>
</tbody>
</table>

User Manual November 2009

Appendix C: Definitions and Taxonomies Content
<table>
<thead>
<tr>
<th>ID</th>
<th>Definition</th>
<th>CPT</th>
<th>ICD</th>
<th>LOINC</th>
<th>Site-Defined Taxonomy (Labs or Meds)</th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td>ED.5</td>
<td>Tobacco Cessation Counseling</td>
<td>BGP TOBACCO CESS CPTS</td>
<td>99406, 99407, G0375, G0376, 4000F</td>
<td></td>
<td></td>
<td>Patient Ed codes: containing “TO”-, “-TO” or “-SHS” (NOTE: update to current CRS logic) BGP TOBACCO CESS DENTAL CODE Dental code 1320 BKM BCG IZ PROCEDURE V03.2 Tuberculosis (BCG)</td>
</tr>
<tr>
<td>IZ.1</td>
<td>BCG Tuberculosis Vaccine</td>
<td>BKM BCG IZ CPTS</td>
<td>BKM BCG IZ PROCEDURE V03.2 Tuberculosis (BCG)</td>
<td>90585, 90586, 90728</td>
<td>Immunization Codes (CVX): 19 BCG vaccine BKM BCG IZ CVX CODES</td>
<td>Immunization Codes (CVX): 29 CMV-IGIV BKM CMV IZ CVX CODES Immunization Codes (CVX): 85 Hep A NOS; :52 HEP A Adult; 83</td>
</tr>
<tr>
<td>IZ.2</td>
<td>CMV (IgG)</td>
<td>BKM CMV IZ CPTS</td>
<td>90291</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IZ.3</td>
<td>Hep A vaccine (defined as 2 occurrences of any of the codes at least 5 months)</td>
<td>BKM HEP A IZ CPTS</td>
<td>90632-34, 90636, 90730</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

User Manual
November 2009

Appendix C: Definitions and Taxonomies Content
<table>
<thead>
<tr>
<th>ID</th>
<th>Definition</th>
<th>CPT</th>
<th>ICD</th>
<th>LOINC</th>
<th>Site-Defined Taxonomy (Labs or Meds)</th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td>IZ.4</td>
<td>Hep B vaccine (defined as at least 3 occurrences of any of the codes where 1st and last are separated by at least 6 months)</td>
<td>BKM HEP B IZ CPTS</td>
<td>90636, 90723, 90731, 90740, 90743-90748</td>
<td></td>
<td>HEP A PED 2; 84 HEP A PED 3; 31 HEP A PED NOS; 104 HepA &amp; B</td>
<td>BKM HEP B IZ CVX CODES Immunization Codes (CVX): 30 HBIG; 08 HEP B PED; 43 HEP B ADLT; 45 HEP B NOS; 42 HEP B Adol/High Risk Inf dosage; 44 dialysis/ immunosup patient dosage; 51 HepB-HIB; 102 DTP/Hep B; 104 HEP A&amp;B; 110 DTaP-HepB-IPV</td>
</tr>
<tr>
<td>IZ.5</td>
<td>Influenza IZ</td>
<td>BGP CPT FLU 90655-90662; 90724; G0008; G8108</td>
<td>BGP FLU IZ DXS POV: V04.8, V04.81, V06.6 BGP FLU IZ PROCEDURES V Procedure: 99.52</td>
<td></td>
<td>Immunization Code (CVX): 88 INFL NOS; 111 INFL intranasal; 15 INFL Split; 16 INFL Whole</td>
<td>BGP FLU IZ CVX CODES</td>
</tr>
<tr>
<td>IZ.6</td>
<td>Pneumococcal IZ</td>
<td>BGP PNEUMO IZ CPTS 90669, 90732, G0009, G8115</td>
<td>BGP PNEUMO IZ DXS POV: V06.6; V03.82 BGP PNEUMO IZ PROCEDURES V Procedure: 99.55</td>
<td></td>
<td>Immunization Code (CVX): 33 PNEUMO-PS; 100 PNEUM CONJ; 109 PNEUM NOS</td>
<td>BKM PNEUMO IZ CVX CODES</td>
</tr>
<tr>
<td>IZ.7</td>
<td>Tetanus IZ</td>
<td>BKM TETANUS IZ CPTS 90698, 90700-</td>
<td>BKM TETANUS IZ DXS V03.7 Tetanus Vac; V06.1 DTP; V06.2 DTP+TAB;</td>
<td></td>
<td></td>
<td>BKM TETANUS IZ CVX CODES Immunization Code</td>
</tr>
<tr>
<td>ID</td>
<td>Definition</td>
<td>CPT</td>
<td>ICD</td>
<td>LOINC</td>
<td>Site-Defined Taxonomy (Labs or Meds)</td>
<td>Other</td>
</tr>
<tr>
<td>------</td>
<td>---------------------------------------------------------------------------</td>
<td>-------------------</td>
<td>----------------------</td>
<td>---------------------</td>
<td>-------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>M.09</td>
<td>Entry Inhibitors (EI) Medications</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>BKMV EI MEDS</td>
</tr>
<tr>
<td>M.10</td>
<td>Integrase Inhibitors</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>BKMV II MEDS</td>
</tr>
<tr>
<td>M.01</td>
<td>MAC Prophylaxis Medications</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>BKMV MAC PROPH MEDS</td>
</tr>
<tr>
<td>M.02</td>
<td>NNRTIs (Non-Nucleoside Reverse Transcriptase Inhibitors)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>BKMV NNRTI MEDS</td>
</tr>
<tr>
<td>M.03</td>
<td>NRTIs (Nucleoside / Nucleotide Reverse Transcriptase Inhibitors)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>BKMV NRTI MEDS</td>
</tr>
<tr>
<td>M.12</td>
<td>NRTI Combo (Nucleoside / Nucleotide Reverse Transcriptase Inhibitors) Combinations)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>BKMV NRTI COMBO MEDS</td>
</tr>
<tr>
<td>M.11</td>
<td>NRTI/NNRTI</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>BKMV NRTI/NNRTI MEDS</td>
</tr>
<tr>
<td>M.04</td>
<td>PCP Prophylaxis</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>BKMV PCP PROPH</td>
</tr>
</tbody>
</table>

User Manual
November 2009

Appendix C: Definitions and Taxonomies Content
<table>
<thead>
<tr>
<th>ID</th>
<th>Definition</th>
<th>CPT</th>
<th>ICD</th>
<th>LOINC</th>
<th>Site-Defined Taxonomy (Labs or Meds)</th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td>M. 13</td>
<td>Medications</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>M.13</td>
<td>PI Booster</td>
<td>Medications PROPH MEDS</td>
<td>BKMV PI BOOSTER MEDS</td>
<td>MED NDCS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>M.05</td>
<td>PIs (Protease Inhibitors)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>M.05</td>
<td>M.1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>M.08</td>
<td>Tuberculosis (TB) Treatment</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P.01</td>
<td>Mastectomy, Bilateral</td>
<td>BGP BILATERAL MASTECTOMY CPTS 19300-19307, 19180, 19200, 19220, 19240 (all codes to include modifier .50 or 09950 to indicate bilateral procedure)</td>
<td>BGP MASTECTOMY PROCEDURES 85.42, 85.44, 85.46, 85.48</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P.02</td>
<td>Dental Exam</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P.02</td>
<td></td>
<td>BGP DENTAL EXAMINATION V72.2 Dental Examination</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P.03</td>
<td>Dilated Eye Exam</td>
<td>BGP DM EYE EXAM CPTS 92002-92014, 67028, 67038, 67039, 67040 BGP RETINAL</td>
<td>POV V72.0</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

User Manual
November 2009

Appendix C: Definitions and Taxonomies Content
<table>
<thead>
<tr>
<th>ID</th>
<th>Definition</th>
<th>CPT</th>
<th>ICD</th>
<th>LOINC</th>
<th>Site-Defined Taxonomy (Labs or Meds)</th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td>P.04</td>
<td>Hysterectomy</td>
<td>EXAM CPTS 2022F, 2024F, 2026F, S0620, S3000</td>
<td>BGP HYSTERECTOMY CPTS 51925; 56308; 58150-58152; 58200-58294; 58548-58554; 58951; 58953-58954; 58956; 59135</td>
<td>BGP HYSTERECTOMY PROCEDURES V Procedure: 68.4-68.8</td>
<td>V POV 618.5</td>
<td></td>
</tr>
<tr>
<td>P.05</td>
<td>Mammogram</td>
<td>BGP CPT MAMMOGRAM VRad or VCPT 76090-76092; G0202; G0204; G0206; 76083; 77051-77059</td>
<td>BGP MAMMOGRAM POV: V76.11, V76.12; 793.80, 793.81, 793.89</td>
<td>BGP MAMMOGRAM PROCEDURES V Procedure: 87.36 – 87.37</td>
<td>Women’s Health: Screening, Mammogram, Mammogram Dx Bilat, Mammogram Dx Unilat</td>
<td></td>
</tr>
<tr>
<td>P.06</td>
<td>Total Colectomy</td>
<td>BGP TOTAL CHOLECTOMY CPTS 44150-44151,44152, 44153, 44155-44158, 44210-44212</td>
<td>BGP TOTAL CHOLECTOMY PROCS 45.8</td>
<td>BGP TOTAL CHOLECTOMY PROCS 45.8</td>
<td>BGP TOTAL CHOLECTOMY PROCS 45.8</td>
<td></td>
</tr>
<tr>
<td>S.1</td>
<td>Alcohol Screen</td>
<td>BGP ALCOHOL SCREENING CPTS 99408, 99409, G0396, G0397, H0049</td>
<td>BGP ALCOHOL SCREEN ICDS V POV: V79.1, V11.3</td>
<td>BGP ALCOHOL DXS 291.0-291.9. 303.00-303.93, 305.00-305.03, 357.5</td>
<td>BGP ALCOHOL HLTH FACTOR Any Alcohol Category, Health Factor Any Patient Ed codes containing “CD-“, “-CD”, “AOD-” or “-AOD” OR any alcohol diagnosis</td>
<td></td>
</tr>
<tr>
<td>ID</td>
<td>Definition</td>
<td>CPT</td>
<td>ICD</td>
<td>LOINC</td>
<td>Site-Defined Taxonomy (Labs or Meds)</td>
<td>Other</td>
</tr>
<tr>
<td>------</td>
<td>-----------------------------------</td>
<td>---------------------------</td>
<td>--------------------------</td>
<td>----------------------</td>
<td>-------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>S.05</td>
<td>Colorectal Cancer Screen</td>
<td>BGP COLO CPTS 44388-44394, 44397, 45355, 45378-45387, 45391, 45392, G0105; G0121 BGP FOBT CPTS 82270; 82274; 89205; G0107; G0328; G0394 BGP SIG CPTS 45330-45345; G0104 BGP BE CPTS 74280, G0106, G0120</td>
<td>PROCEDURES 94.46; 94.53; 94.61-94.63; 94.67-94.69</td>
<td>BGP SIG PROC 45.24; 45.42 BGP COLO PROC 45.22; 45.23; 45.25; 45.43 Colonoscopy VPOV V76.51</td>
<td>Exam Code 35 V Measurement AUDT, AUDC or CRFT BHS Problem codes: 29.1 BHS POV 10,27,29</td>
<td></td>
</tr>
<tr>
<td>S.2</td>
<td>Depression Screen</td>
<td></td>
<td>BGP MOOD DISORDERS 291.89; 292.84; 293.83; 296.*; 300.4; 301.13; 311.</td>
<td></td>
<td></td>
<td>Exam Code 36 BHS Problem Code 14.1 POV V79.0 Exam Code 34 Any Patient Education codes containing &quot;DV-&quot; or &quot;,DV&quot;</td>
</tr>
<tr>
<td>S.6</td>
<td>IPV/ DV Screen</td>
<td></td>
<td>BGP DV DXS 995.80-83; 995.85; V15.41- V15.49 BGP IPV/DV COUNSELING ICDS V61.11</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>S.3</td>
<td>Substance Use (not including Alcohol or Tobacco) Screen</td>
<td>BKM OTHER SUBSTANCE ABUSE DXS 304.00-.93, 305.20-305.93, 292.0-.9, 648.30-.34, 357.6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ID</td>
<td>Definition</td>
<td>CPT</td>
<td>ICD</td>
<td>LOINC</td>
<td>Site-Defined Taxonomy (Labs or Meds)</td>
<td>Other</td>
</tr>
<tr>
<td>-----</td>
<td>---------------------------</td>
<td>----------------------</td>
<td>-------------------------</td>
<td>------------------------</td>
<td>-------------------------------------</td>
<td>-------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>S.4</td>
<td>Tobacco Use Screen</td>
<td>BGP SMOKING CPTS</td>
<td>BGP GPRA SMOKING DXS</td>
<td>BGP TOBACCO SCREEN HLTH FACTOR</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>99406; 99407; G0375;</td>
<td>POV or Current Problem List: 305.1-305.13; 649.00-649.04, V15.82</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>G0376; 1034F; 1035F;</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1036F</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>T.2</td>
<td>CD4 Tests</td>
<td>BGP CD4 CPTS</td>
<td>BGP CD4 LOINC CODES</td>
<td>BGP CD4 TAX</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>86359-86361</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>T.1</td>
<td>CD4 Absolute Tests</td>
<td>BKMV CD4 ABS CPTS</td>
<td>BKMV CD4 ABS LOINC CODES</td>
<td>BKM CD4 TAX</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>86361</td>
<td>5472-6; 20605-2; 8127-3; 20606-0; 8128-1; 17822-8; 16274-3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>T.3</td>
<td>Chlamydia Test</td>
<td>BGP CHLAMYDIA CPTS</td>
<td>BGP CHLAMYDIA TEST PROCEDURES</td>
<td>BGP CHLAMYDIA TESTS TAX</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>86631; 86632; 87110;</td>
<td>V73.88, V73.98</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>87270; 87320; 87490-</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>87492; 87810</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>T.6</td>
<td>CMV Test</td>
<td>BKM CMV TEST CPTS</td>
<td>BKM CMV LOINC CODES</td>
<td>BKM CMV TEST TAX</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>86644, 86645; 87271;</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>87496; 87497</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>T.7</td>
<td>Cocci Antibody Screen</td>
<td>BKM COCCI ANTIBODY CPTS</td>
<td>BKM COCCI ANTIBODY CODES</td>
<td>BKM COCCI ANTIBODY TAX</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>86635</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ID</td>
<td>Definition</td>
<td>CPT</td>
<td>ICD</td>
<td>LOINC</td>
<td>Site-Defined Taxonomy (Labs or Meds)</td>
<td>Other</td>
</tr>
<tr>
<td>-----</td>
<td>-----------------------------</td>
<td>----------------------</td>
<td>----------------------</td>
<td>------------------------</td>
<td>--------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>T.9</td>
<td>FTA-ABS (Syphilis)</td>
<td>BKM FTA-ABS CPTS 86781; BKM FTA-ABS LOINC CODES</td>
<td>BKM FTA-ABS TEST TAX FTA-ABS</td>
<td>BKM FTA-ABS TEST TAX BKM FTA-ABS TEST TAX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>T.10</td>
<td>Gonorrhea Test</td>
<td>BKM GONORRHEA TESTS CPTS 87590-87592, 87850</td>
<td>BKM GONORRHEA LOINC CODES</td>
<td>BKM GONORRHEA TEST TAX BKM GONORRHEA TEST TAX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>T.29</td>
<td>Hepatitis Panel</td>
<td>BKM HEPATITIS PANEL CPTS 80074</td>
<td>BKM HEP PANEL LOINC CODES</td>
<td>BKM HEPATITIS PANEL TAX BKM HEPATITIS PANEL TAX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>T.31</td>
<td>Hepatitis A Tests</td>
<td>BKM HEP A TESTS CPTS 86708, 86709</td>
<td>BKM HEP A LOINC CODES</td>
<td>BKM HEP A TAX BKM HEP A TAX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>T.27</td>
<td>Hepatitis B</td>
<td>BKM HEP B TESTS CPTS 86704-86707; 87340-87350; 87515-87517</td>
<td>BKM HEP B LOINC CODES</td>
<td>BKM HEP B TAX BKM HEP B TAX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>T.13</td>
<td>Hepatitis C test (EIA)</td>
<td>BKM HEP C SCREEN TESTS CPTS 86803, 87520</td>
<td>BKM HEP C SCREEN LOINC CODES</td>
<td>BKM HEP C SCREENING TAX BKM HEP C SCREENING TAX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>T.14</td>
<td>Hepatitis C test (RIBA)</td>
<td>BKM HEP CONFIRM TESTS CPTS 86804, 87521, 87522</td>
<td>BKM HEP C CONFIRM LOINC CODES</td>
<td>BKM HEP C CONFIRMATOR Y TAX BKM HEP C CONFIRMATOR Y TAX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>T.15</td>
<td>HIV Genotype</td>
<td>BKMV HIV GENOTYPE CPTS 87901</td>
<td>BKMV HIV GENOTYPE TESTS TAX</td>
<td>BKMV HIV GENOTYPE TESTS TAX BKMV HIV GENOTYPE TESTS TAX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>T.16</td>
<td>HIV Phenotype</td>
<td>BKMV HIV PHENOTYPE CPTS 87903</td>
<td>BKMV HIV PHENOTYPE TESTS TAX</td>
<td>BKMV HIV PHENOTYPE TESTS TAX BKMV HIV PHENOTYPE TESTS TAX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>T.17</td>
<td>HIV Tests</td>
<td>BGP CPT HIV TESTS 86689; 86701-</td>
<td>BGP HIV TEST LOINC CODES</td>
<td>BGP HIV TEST TAX BGP HIV TEST TAX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ID</td>
<td>Definition</td>
<td>CPT</td>
<td>ICD</td>
<td>LOINC</td>
<td>Site-Defined Taxonomy (Labs or Meds)</td>
<td>Other</td>
</tr>
<tr>
<td>------</td>
<td>----------------------------</td>
<td>----------------------</td>
<td>----------------------</td>
<td>----------------------------</td>
<td>-------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>T.30</td>
<td>Lipid Profile</td>
<td>86703; 87390; 87391; 87534-87539</td>
<td></td>
<td>BGP LIPID PROFILE LOINC CODES</td>
<td>DM AUDIT LIPID PROFILE TAX</td>
<td></td>
</tr>
<tr>
<td>T.20</td>
<td>Pap Smear</td>
<td>BGP CPT PAP 88141-88167; 88174-88175; Q0091; G0101; G0123; G0124; G0141; G0143-G0145; G0147; G0148; P3000; P3001</td>
<td>BGP PAP SMEAR DXS POV: V72.3-V72.31; V72.32; V76.2; V76.47; 795.0-795.09; V67.01; BGP PAP PROCEDURES V Procedure: 91.46</td>
<td>BGP PAP LOINC CODES</td>
<td>BGP PAP SMEAR TAX</td>
<td>Women’s Health: procedure called Pap Smear Refusals: Lab Test Value Pap Smear</td>
</tr>
<tr>
<td>T.21</td>
<td>PPD (Tuberculosis Test)</td>
<td>BKM PPD CPTS 86580, 86585, 87555-87557</td>
<td>BKM PPD ICDS V74.1 Special Screening Pulmonary Tuberculosis (PPD)</td>
<td>In addition to V Lab, look in V Skin Test BKM PPD LOINC CODES BKM PPD TAX</td>
<td>In addition to V Lab, look in V Skin Test BKM PPD TAX</td>
<td></td>
</tr>
<tr>
<td>T.22</td>
<td>RPR (Syphilis)</td>
<td>BKM RPR CPTS 86592, 86593; 87285</td>
<td></td>
<td>BKM RPR LOINC CODES</td>
<td>BKM RPR TAX</td>
<td>BKM RPR TAX</td>
</tr>
<tr>
<td>T.28</td>
<td>Toxoplasmosis</td>
<td>BKM TOXOPLASMOSIS CPTS 86777, 86778</td>
<td></td>
<td>BKM TOXOPLASMOSIS LOINC CODES</td>
<td>BKM TOXOPLASMOSIS TESTS TAX</td>
<td></td>
</tr>
<tr>
<td>T.24</td>
<td>Trichomoniasis</td>
<td>Same as DX.13</td>
<td></td>
<td>BKM TRICH LOINC CODES</td>
<td>BKM TRICH TESTS TAX</td>
<td>BKM TRICH TESTS TAX</td>
</tr>
<tr>
<td>T.26</td>
<td>HIV RNA Viral Load Tests</td>
<td>BGP HIV VIRAL LOAD CPTS 87536, 87539</td>
<td></td>
<td>BGP VIRAL LOAD LOINC CODES</td>
<td>BGP HIV VIRAL LOAD</td>
<td></td>
</tr>
</tbody>
</table>
# 16.0 Appendix D: HIV/AIDS-Related Reminders - Logic and Tooltip Text

The information is the following table was updated March 3, 2009.

<table>
<thead>
<tr>
<th>Reminder Name</th>
<th>Description Field Text</th>
<th>Tooltip Text</th>
</tr>
</thead>
</table>
| CD4 Test      | Category: Care Management  
                Clinical Group: HIV  
                Reminder Name: CD4 Test  
                Default Status: On  
                Denominator: Patients with a proposed or accepted tag for HIV OR Active on HMS Register with Diagnosis Category of HIV or AIDS.  
                Definition (Frequency): Every 4 months  
                LOGIC DETAIL:  
                CD4 Test Definition:  
                Procedures (CPT Codes): VCPT 86359-86361 [BGP CD4 CPTS]  
                LOINC Codes: V Lab as predefined in [BGP CD4 LOINC CODES]  
                Site Defined Lab Tests: V Lab site-defined tests in [BGP CD4 TAX]  
                Site Configurable? No | A CD4 lab test is due every 4 months. |
| Chlamydia Test| Category: Care Management  
                Clinical Group: HIV  
                Reminder Name: Chlamydia Test  
                Default Status: On  
                Denominator: Patients with a proposed or accepted tag for HIV OR Active on HMS Register with Diagnosis Category of HIV or AIDS AND With a history of POV diagnosis of Gonorrhea, Syphilis, Trichomoniasis or other STD WITHOUT a negative Chlamydia test since the diagnosis OR With a history of positive test results for Gonorrhea or Syphilis since date of last Chlamydia test OR Most recent Chlamydia test was positive OR Greater than or equal to 18 years of age  
                Definition (Frequency): Variable  
                Now if there has been a diagnosis for either Gonorrhea, Syphilis, | A Chlamydia Test is due: 1) immediately after infection with Gonorrhea, Syphilis, Trichomoniasis or other sexually transmitted infection; 2) 8 weeks after a positive Chlamydia test to check for cure; 3) annually for all patients. |
<table>
<thead>
<tr>
<th>Reminder Name</th>
<th>Description Field Text</th>
<th>Tooltip Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chlamydia Test (cont.)</td>
<td>Trichomoniasis or other STD since the most recent Chlamydia test OR Now if there has been a positive test result for Gonorrhea or Syphilis since the date of the last Chlamydia test OR 8 weeks after most recent positive Chlamydia test to check for cure OR Annually if greater than or equal to 18 years of age</td>
<td>LOGIC DETAIL: Chlamydia Test Definition: Procedures (CPT Codes): V CPT 86631, 86632, 87110, 87270, 87320, 87490-87492, 87810 [BGP CHLAMYDIA CPTS] LOINC Codes: V Lab as predefined in [BGP CHLAMYDIA LOINC CODES] Site Defined Lab Tests: V Lab site-defined tests in [BGP CHLAMYDIA TESTS TAX] Gonorrhea Test Definition: Procedures (CPT Codes): 87590-87592, 87850 [BKM GONORRHEA TESTS CPTS] LOINC Codes: V Lab as predefined in [BKM GONORRHEA LOINC CODES] Site Defined Lab Tests: V Lab site-defined in [BKM GONORRHEA TEST TAX] RPR Lab (Syphilis) Test Definition: Procedures (CPT Codes): V CPT 86592, 86593, 87285 [BKM RPR CPTS] LOINC Codes: V Lab as predefined in [BKM RPR LOINC CODES] Site Defined Lab Tests: V Lab site-defined tests in [BKM RPR TAX] FTA-ABS (Syphilis) Test Definition: Procedures (CPT Codes): V CPT 86781 [BKM FTA-ABS CPTS] LOINC Codes: V Lab as predefined in [BKM FTA-ABS LOINC CODES] Site Defined Lab Tests: V Lab site-defined tests in [BKM FTA-ABS TEST TAX] Chlamydia Diagnosis Definition: Diagnosis (ICD Codes): POV or Problem List 078.8*, 079.88, 079.98, 099.41, 099.5*[BKM CHLAMYDIA DXS]</td>
</tr>
</tbody>
</table>
### Reminder Name | Description Field Text | Tooltip Text
---|---|---
**SYPHILIS DXS** | Trichomoniasis Diagnosis Definition: Diagnosis (ICD Codes): POV or Problem List 131.0-.9 [BKM TRICHOMONIASIS DXS] Other STD Diagnoses Definition: Diagnosis (ICD Codes): POV or Problem List 099.1-099.3, 099.40, 099.49,099.8, 099.9 [BKM OTHER STD DXS] Site Configurable? No | A Dental Exam is due annually for all patients.

**HMS Dental Exam** | Type: Care Management Category: HIV Reminder Name: HMS Dental Exam Default Status: On Denominator: Patients with a proposed or accepted tag for HIV OR Active on HMS Register with Diagnosis Category of HIV or AIDS Definition (Frequency): Annually LOGIC DETAIL: Dental Exam Definition: Procedure Code: V72.2 [BKM DENTAL EXAMINATION] Dental Code: ADA code 0000; 0190 [BGP DENTAL EXAM DENTAL CODE] V Exam Code: 30 Site Configurable? No | An Eye Exam is due: 1) every 6 months for patients whose most recent CD4 Absolute Count is less than 50; 2) annually for all patients whose most recent CD4 Absolute Count is greater than or equal to 50.

**HMS Eye Exam** | Type: Care Management Category: HIV Reminder Name: HMS Eye Exam Default Status: On Denominator: Patients with a proposed or accepted tag for HIV OR Active on HMS Register with Diagnosis Category of HIV or AIDS Definition (Frequency): Variable Every 6 months if most recent CD4 Absolute Count is less than 50 Annually if most recent CD4 Absolute Count is greater than or equal to 50 LOGIC DETAIL: Eye Exam Definition: Procedures (CPT Codes): V CPT 67028, 67038, 67039, 67040, 92002, 92004, 92012, 92014, [BGP EYE EXAM CPTS] Procedures (ICD Codes): POV 72.0 Procedure Code 95.02 Provider Codes: 79; 24; 08 Clinic Codes: 17; 18; 64; A2 |
<table>
<thead>
<tr>
<th>Reminder Name</th>
<th>Description Field Text</th>
<th>Tooltip Text</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Family Planning Education</strong></td>
<td>Type: Care Management</td>
<td>Family Planning Education is due every 6 months for: 1) all females ages 13 – 44; 2) all males starting at age 13.</td>
</tr>
<tr>
<td></td>
<td>Category: HIV</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reminder Name: Family Planning Education</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Default Status: On</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Denominator: Patients with a proposed or accepted tag for HIV OR Active on HMS Register with Diagnosis Category of HIV or AIDS AND Females starting at age 13 years through age 44 years. OR Males greater than or equal to age 13 years.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Definition (Frequency): Every 6 months</td>
<td></td>
</tr>
<tr>
<td></td>
<td>LOGIC DETAIL: Family Planning Definition: ICD Codes: V25.0-.9; V26.4 [BKM FAMILY PLANNING POV] Patient Education Codes: V PED Visits containing “FP”</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Site Configurable? No</td>
<td></td>
</tr>
<tr>
<td><strong>Syphilis (FTA-ABS) Test</strong></td>
<td>Type: Care Management</td>
<td>An FTA-ABS (Syphilis) Test is due 14 days after the date of positive test results on their most recent RPR (Syphilis) Test.</td>
</tr>
<tr>
<td></td>
<td>Category: HIV</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reminder Name: Syphilis (FTA-ABS) Test</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Default Status: On</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Denominator: Patients with a proposed or accepted tag for HIV OR Active on HMS Register with Diagnosis Category of HIV or AIDS AND With positive results on most recent RPR lab and no FTA-ABS test documented after the date of the positive RPR test</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Definition (Frequency): Due 14 days after the positive RPR test</td>
<td></td>
</tr>
<tr>
<td>Reminder Name</td>
<td>Description Field Text</td>
<td>Tooltip Text</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------</td>
<td>--------------</td>
</tr>
</tbody>
</table>
| Gonorrhea Test | Type: Care Management  
Category: HIV  
Reminder Name: Gonorrhea Test  
Default Status: On  
Denominator: Patients with a proposed or accepted tag for HIV OR Active on HMS Register with Diagnosis Category of HIV or AIDS AND With a history of POV diagnosis of Chlamydia, Syphilis, Trichomoniasis or other STDs WITHOUT a negative Gonorrhea test since the diagnosis OR With a history of positive test results for Chlamydia or Syphilis since date of last Gonorrhea test OR Greater than or equal to age 18 years  
Definition (Frequency): Variable - Now if there has been a diagnosis for either Chlamydia, Syphilis, Trichomoniasis or other STD since the most recent Gonorrhea test  
- Now if there has been a positive test result for either Chlamydia, Syphilis, Trichomoniasis or other STDs since the most recent Gonorrhea test OR  
- Annually if greater than or equal to age 18 years.  
LOGIC DETAIL:  
Gonorrhea Test Definition:  
- Procedures (CPT Codes): 87590-87592, 87850 [BKM GONORRHEA TESTS CPTS]  
- LOINC Codes: V Lab as predefined in [BKM GONORRHEA LOINC CODES]  
- Site Defined Lab Tests: V Lab site-defined in [BKM GONORRHEA TEST TAX]  
Chlamydia Test Definition:  
- Procedures (CPT Codes): V CPT 86631, 86632, 87110, 87270, 87320, 87490-87492, 87810 [BGP CHLAMYDIA CPTS] | A Gonorrhea Test is due: 1) immediately after infection with Chlamydia, Syphilis, Trichomoniasis or other sexually transmitted infection; 2) annually for all patients. |
<table>
<thead>
<tr>
<th>Reminder Name</th>
<th>Description Field Text</th>
<th>Tooltip Text</th>
</tr>
</thead>
</table>
| Gonorrhea Test (cont.) | - LOINC Codes: V Lab as predefined in [BGP CHLAMYDIA LOINC CODES]  
- Site Defined Lab Tests: V Lab site-defined tests in [BGP CHLAMYDIA TESTS TAX]  
RPR Lab (Syphilis) Test Definition: Procedures (CPT Codes): V CPT 86592, 86593, 87285 [BKM RPR CPTS]  
LOINC Codes: V Lab as predefined in [BKM RPR LOINC CODES]  
Site Defined Lab Tests: V Lab site-defined tests in [BKM RPR TAX]  
FTA-ABS (Syphilis) Test Definition: Procedures (CPT Codes): V CPT 86781 [BKM FTA-ABS CPTS]  
LOINC Codes: V Lab as predefined in [BKM FTA-ABS LOINC CODES]  
Site Defined Lab Tests: V Lab site-defined tests in [BKM FTA-ABS TEST TAX]  
Gonorrhea Diagnosis Definition: Diagnosis (ICD Codes): POV or Problem List 098.0-.89 [BKM GONORRHEA DXS]  
Chlamydia Diagnosis Definition: Diagnosis (ICD Codes): POV or Problem List 077.98, 078.88, 079.88, 079.98, 099.41, 099.50-59 [BKM CHLAMYDIA DXS]  
Syphilis Diagnosis Definition: Diagnosis (ICD Codes): POV or Problem List 090-093.9, 094.1-097.9 [BKM SYPHILIS DXS]  
Trichomonas Diagnosis Definition: Diagnosis (ICD Codes): POV or Problem List 131.0-.9 [BKM TRICHOMONIASIS DXS]  
Other STD Diagnoses Definition: Diagnosis (ICD Codes): POV or Problem List 099.1-099.3, 099.40, 099.49,099.8, 099.9 [BKM OTHER STD DXS]  
Site Configurable? No | The Hepatitis A Immunization (series of 2) is due for all patients with NO documented history of Hepatitis A. |
| Hepatitis A IZ | Type: Care Management  
Category: HIV  
Reminder Name: Hepatitis A IZ  
Default Status: On  
Denominator: Patients with a proposed or accepted tag for HIV OR Active on HMS Register with Diagnosis Category of HIV or AIDS AND  
With NO documented history of Hepatitis A diagnosis.  
Definition (Frequency): Series is given once in a lifetime. Series consists of 2 | |
<table>
<thead>
<tr>
<th>Reminder Name</th>
<th>Description Field Text</th>
<th>Tooltip Text</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>doses at least 5 months apart.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>LOGIC DETAIL:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hepatitis A Diagnosis Definition:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Diagnosis (ICD Codes): POV or Problem List 070.0, 070.1 [BKM HEP A DXS]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hepatitis A Immunization Definition:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Procedures (CPT Codes): V CPT 90632-34, 90636, 90730 [BKM HEP A IZ CPTS]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Immunization (CVX Codes): 85 Hep A NOS; 52 HEP A Adult; 83 HEP A PED 2; 84 HEP A PED 3; 31 HEP A PED NOS; 104 HepA &amp; B [BKM HEP A IZ CVX CODES]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Site Configurable? No</td>
<td></td>
</tr>
<tr>
<td>Hepatitis B IZ</td>
<td>Type: Care Management</td>
<td>A Hepatitis B Immunization (series of 3 doses where the first and last doses are at least 6 months apart) is due for all patients with NO documented history of Hepatitis B.</td>
</tr>
<tr>
<td></td>
<td>Category: HIV</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reminder Name: Hepatitis B IZ</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Default Status: On</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Denominator: Patients with a proposed or accepted tag for HIV OR Active on HMS Register with Diagnosis Category of HIV or AIDS AND With NO documented history of Hepatitis B diagnosis</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Definition (Frequency): Series is given once in a lifetime. Series consist of 3 doses where the first and last doses are at least 6 months apart.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>LOGIC DETAIL:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hepatitis B Diagnosis Definition:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Diagnosis (ICD Codes): POV or Problem List 070.20-.23, 070.30-.33 [BKM HEP B DXS]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hepatitis B Immunization Definition:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Procedures (CPT Codes): V CPT 90636, 90723, 90731,90740, 90743-90748 [BKM HEP B IZ CPTS]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Immunization (CVX Codes): 30 HBIG; 08 HEP B PED; 43 HEP B ADLT; HEP B NOS; HEP B Adol/High Risk Inf dosage; 44 dialysis/ immunosup patient dosage; 51 HepB-HIB; 102 DTP/Hep B; 104 HEP A&amp;B; 110 DTaP-HepB-IPV [BKM HEP B IZ CVX CODES]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Site Configurable? No</td>
<td></td>
</tr>
<tr>
<td>Hepatitis B Retest</td>
<td>Type: Care Management</td>
<td>A Hepatitis B Retest is due for all patients after they have received all 3 doses of the Hepatitis B Immunization.</td>
</tr>
<tr>
<td></td>
<td>Category: HIV</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reminder Name: Hepatitis B Retest</td>
<td></td>
</tr>
<tr>
<td>Reminder Name</td>
<td>Description Field Text</td>
<td>Tooltip Text</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td></td>
<td>Default Status: On</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Denominator: Patients with a proposed or accepted tag for HIV OR Active on HMS Register with Diagnosis Category of HIV or AIDS AND With 3 Hepatitis B immunization doses and no Hepatitis B test documented after the final dose Definition (Frequency): Once, after final dose in the Hepatitis B series LOGIC DETAIL: Hepatitis B Test Definition: Procedures (CPT Codes): V CPT 86704-86707; 87340-87350; 87515-87517 [BKM HEP B TESTS CPTS] LOINC Codes: V Lab as predefined in [BKM HEP B LOINC CODES] Site Defined Lab Tests: V Lab site-defined in [BKM HEP B TAX] Hepatitis B Immunization Definition: Procedures (CPT Codes): V CPT 90636, 90723, 90731, 90740, 90743-90748 [BKM HEP B IZ CPTS] Immunizations (CVX Codes): 30 HBIG; 08 HEP B PED; 43 HEP B ADLT; 45 HEP B NOS; 42 HEP B Adol/High Risk Inf dosage; 44 dialysis/ immunosup patient dosage; 51 HepB-HIB; 102 DTP/Hep B; 104 HEP A&amp;B; 110 DTaP-HepB-IPV [BKM HEP B IZ CVX CODES] Site Configurable? No</td>
<td></td>
</tr>
<tr>
<td>Hepatitis B Test</td>
<td>Type: Care Management Category: HIV Reminder Name: Hepatitis B Test Default Status: On Denominator: Patients with a proposed or accepted tag for HIV OR Active on HMS Register with Diagnosis Category of HIV or AIDS AND Patients with NO documented history of Hepatitis B Diagnosis ever AND NO documented Hepatitis B test results ever. Definition (Frequency): Once LOGIC DETAIL: Hepatitis B Test Definition: Procedures (CPT Codes): V CPT 86704-86707; 87340-87350; 87515-87517 [BKM HEP B TESTS CPTS] LOINC Codes: V Lab as predefined in [BKM HEP B LOINC CODES] Site Defined Lab Tests: V Lab site-defined in [BKM HEP B TAX]</td>
<td>A Hepatitis B Test is due for all patients who have never had a test for or been diagnosed with Hepatitis B.</td>
</tr>
<tr>
<td>Reminder Name</td>
<td>Description Field Text</td>
<td>Tooltip Text</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Hepatitis C Confirmatory Test</td>
<td></td>
<td>A Hepatitis C Confirmatory Test is due for all patients who have a positive Hepatitis C Screening Test.</td>
</tr>
<tr>
<td></td>
<td>Hepatitis C Diagnosis Definition: Diagnosis (ICD Codes): POV or Problem List 070.20-.23, 070.30-.33 [BKM HEP B DXS]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Site Configurable? No</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Type: Care Management</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Category: HIV</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reminder Name: Hepatitis C Confirmatory Test</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Default Status: On</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Denominator: Patients with a proposed or accepted tag for HIV OR Active on HMS Register with Diagnosis Category of HIV or AIDS AND</td>
<td></td>
</tr>
<tr>
<td></td>
<td>With a history of positive Hepatitis C Screening test and NO documentation of a positive Hepatitis C Confirmatory test after AND NO documented history of Hepatitis C diagnosis.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Type: Care Management</td>
<td>A Hepatitis C Screening Test is due annually for all patients who have never been diagnosed</td>
</tr>
<tr>
<td></td>
<td>Category: HIV</td>
<td></td>
</tr>
</tbody>
</table>

User Manual
November 2009

Appendix D: HIV/AIDS-Related Reminders - Logic and Tooltip Text
<table>
<thead>
<tr>
<th>Reminder Name</th>
<th>Description Field Text</th>
<th>Tooltip Text</th>
</tr>
</thead>
</table>
| Test          | Reminder Name: Hepatitis C Screening Test  
Default Status: On  
Denominator: Patients with a proposed or accepted tag for HIV OR Active on HMS Register with Diagnosis Category of HIV or AIDS AND With NO documented history of Hepatitis C diagnosis ever  
Definition (Frequency): Annually  
LOGIC DETAIL:  
Hepatitis C Screening Test Definition:  
Procedures (CPT Codes): V CPT 86803, 87520 [BKM HEP C SCREEN TESTS CPTS]  
LOINC Codes: V Lab predefined tests in [BKM HEP C SCREEN LOINC CODES]  
Site Defined Lab Tests: V Lab site-defined tests in [BKM HEP C SCREENING TAX]  
Hepatitis C Diagnosis Definition:  
Diagnosis (ICD Codes): POV or Problem List 070.41, 070.44, 070.51, 070.54, 070.70-.71 [BKM HEP C DXS] |
| HMS Influenza IZ | Type: Care Management  
Category: HIV  
Reminder Name: HMS Influenza IZ  
Default Status: On  
Denominator: Patients with a proposed or accepted tag for HIV OR Active on HMS Register with Diagnosis Category of HIV or AIDS  
Definition (Frequency): Annually  
LOGIC DETAIL:  
Influenza Immunization Definition:  
Procedures (CPT Codes): V CPT 90655-90662; 90724, G0008, G8108 [BGP CPT FLU]  
Procedures (ICD Codes): POV: V04.8, V04.81, V06.6 [BGP FLU IZ DXS]  
Procedures: V Proc 99.52 [BGP FLU IX PROCEDURES]  
Immunization (CVX Codes): 88 INFL NOS; 111 INFL intranasal; 15 INFL Split; 16 INFL Whole [BGP FLU IZ CVX CODES]  
Site Configurable? No | An Influenza Immunization is due annually for all high-risk patients. |
| HMS Mammogram | Type: Care Management  
Category: HIV | A Mammogram is due annually for all females ages 50-69 without a history of bilateral |
<table>
<thead>
<tr>
<th>Reminder Name</th>
<th>Description Field Text</th>
<th>Tooltip Text</th>
</tr>
</thead>
</table>
| **Reminder Name: HMS Mammogram**  
Default Status: On  
Denominator: Female patients with a proposed or accepted tag for HIV OR Active on HMS Register with Diagnosis Category of HIV or AIDS  
starting at age 50 years through 69 years WITHOUT documented bilateral mastectomy or 2 unilateral mastectomies.  
Definition (Frequency): Annually  
**LOGIC DETAIL:**  
Mammogram Definition:  
Procedures (CPT Codes): VRad or VCPT 76090-76092, G0202, G0204, G0206, 76083, 77051-77059 [BGP CPT MAMMOGRAM]  
Procedures (ICD Codes): POV: V76.11, V76.12, 793.80, 793.81, 793.89 [BGP MAMMOGRAM ICDS]  
Procedure Codes: V Proc: 87.36-87.37 [BGP MAMMOGRAM PROCEDURES]  
Women’s Health: Screening Mammogram, Mammogram Dx Bilat;  
Mammogram Dx Unilat  
Bilateral Mastectomy Definition:  
Procedures (CPT Codes): V CPT 19300-19307; 19180; 19200; 19220; 19240 (all codes to include modifier .50 or 09950 to indicate bilateral procedure) [BGP BILATERAL MASTECTOMY CPTS]  
Procedures Codes (ICD Codes): V Procedure 85.42, 85.44, 85.46, 85.48 [BGP MASTECTOMY PROCEDURES]  
Unilateral Mastectomy Definition:  
Procedures (CPT Codes): V CPT 19300-19307; 19180; 19200; 19220; 19240 [BGP UNI MASTECTOMY CPTS]  
Procedure Codes (ICD Codes): 85.41; 85.43; 85.45; 85.47 [BGP UNI MASTECTOMY PROC]  
Site Configurable? No | mastectomy or 2 unilateral mastectomies. |
| **HMS Pap Smear**  
Type: Care Management  
Category: HIV  
Reminder Name: HMS Pap Smear  
Default Status: On  
Denominator: Female patients with a proposed or accepted tag for HIV OR Active on HMS Register with Diagnosis Category of HIV or AIDS  
starting at age 18 years through 64 years WITHOUT a documented hysterectomy  
A Pap Smear is due: 1) every 6 months for females ages 18-64 if most recent CD4 Absolute Count is less that 200; 2) annually for females ages 18-64 if most recent CD4 count is greater than or equal to 200. |
<table>
<thead>
<tr>
<th>Reminder Name</th>
<th>Description Field Text</th>
<th>Tooltip Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>HMS Pneumovax Immunization</td>
<td>Type: Care Management Category: HIV Reminder Name: Pneumovax Immunization Default Status: On Denominator: Patients with a proposed or accepted tag for HIV OR Active on HMS Register with Diagnosis Category of HIV or AIDS Definition (Frequency): Every 5 years LOGIC DETAIL: \ Pneumococcal Immunization Definition: Procedures (CPT Codes): V CPT 90669; 90732, G0009, G8115 [BGP PNEUMO IZ CPTS]</td>
<td>A Pneumovax Immunization is due every 5 years for all patients.</td>
</tr>
</tbody>
</table>

User Manual November 2009
<table>
<thead>
<tr>
<th>Reminder Name</th>
<th>Description Field Text</th>
<th>Tooltip Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>PPD Test (TB)</td>
<td>Type: Care Management</td>
<td>A PPD Skin Test is due annually for all patients WITHOUT a history of: 1) treatment for TB; 2) previous positive PPD results.</td>
</tr>
<tr>
<td></td>
<td>Category: HIV</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reminder Name: PPD Test (TB)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Default Status: On</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Denominator: Patients with a proposed or accepted tag for HIV OR Active on HMS Register with Diagnosis Category of HIV or AIDS AND Without documentation of: history of Tuberculosis diagnosis ever history of treatment for Tuberculosis ever history of positive PPD results (Positive defined as: Positive in the Results field or greater than 5 in the Reading field)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Site Configurable? No</td>
<td></td>
</tr>
<tr>
<td>Syphilis (RPR)</td>
<td>Type: Care Management</td>
<td>An RPR Syphilis Test is due: 1) immediately after infection with Gonorrhea, Chlamydia, Trichomoniasis or other sexually transmitted infection; 2) annually for all patients.</td>
</tr>
<tr>
<td>Test</td>
<td>Category: HIV</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reminder Name: Syphilis (RPR) Test</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Default Status: On</td>
<td></td>
</tr>
<tr>
<td>Reminder Name</td>
<td>Description Field Text</td>
<td>Tooltip Text</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Reminder Name</td>
<td>Denominator: Patients with a proposed or accepted tag for HIV OR Active on HMS Register with Diagnosis Category of HIV or AIDS AND/OR With a history of POV diagnosis of Chlamydia, Gonorrhea, Trichomoniasis or other STDs WITHOUT a negative Syphilis test since the diagnosis OR With a history of positive test results for Chlamydia or Gonorrhea since date of last Syphilis test Definition (Frequency): Variable - Now if there has been a diagnosis of either Gonorrhea, Chlamydia, Trichomoniasis or other STD since the most recent Syphilis test - Now if there has been a positive test result for either Chlamydia or Gonorrhea since the most recent Syphilis test OR - Annually LOGIC DETAIL: RPR (Syphilis) Test Definition: Procedures (CPT Codes): V CPT 86592, 86593, 87285 [BKM RPR CPTS] LOINC Codes: V Lab as predefined in [BKM RPR LOINC CODES] Site Defined Lab Tests: V Lab site-defined tests in [BKM RPR TAX] Gonorrhea Test: Procedures (CPT Codes): 87590-87592, 87850 [BKM GONORRHEA TESTS CPTS] LOINC Codes: V Lab as predefined in [BKM GONORRHEA LOINC CODES] Site Defined Lab Tests: V Lab site-defined in [BKM GONORRHEA TEST TAX] Chlamydia Test Definition: Procedures (CPT Codes): V CPT 86631, 86632, 87110, 87270, 87320,87490-87492, 87810 [BGP CHLAMYDIA CPTS] LOINC Codes: V Lab as predefined in [BGP CHLAMYDIA LOINC CODES] Site Defined Lab Tests: V Lab site-defined tests in [BGP CHLAMYDIA TESTS TAX] Gonorrhea Diagnosis Definition: Diagnosis (ICD Codes): POV or Problem List 098.0-.89 [BKM GONORRHEA DXS] Chlamydia Diagnosis Definition: Diagnosis (ICD Codes): POV or Problem List 077.98, 078.88, 079.88,</td>
<td></td>
</tr>
<tr>
<td>Reminder Name</td>
<td>Description Field Text</td>
<td>Tooltip Text</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Safe Sex Education  | **Type:** Care Management  
**Category:** HIV  
**Reminder Name:** Safe Sex Education  
**Default Status:** On  
**Denominator:** Patients with a proposed or accepted tag for HIV OR Active on HMS Register with Diagnosis Category of HIV or AIDS starting at age 13 years  
**Definition (Frequency):** Every 6 months  
**Site Configurable?** No | Safe Sex Education is due every 6 months for all patients starting at age 13 years.                                                                                                                                                                                                                                                                  |
| Tetanus Immunization| **Type:** Care Management  
**Category:** HIV  
**Reminder Name:** Tetanus Immunization  
**Default Status:** On  
**Denominator:** Patients with a proposed or accepted tag for HIV OR Active on HMS Register with Diagnosis Category of HIV or AIDS  
**Definition (Frequency):** Every 10 years  
**LOGIC DETAIL:** Tetanus Immunization Definition: Procedures (CPT Codes): V CPT 90698, 90700-90703, 90711, 90718, 90720-21, 90723, 90839 [BKM TETANUS IZ CPTS]  
Procedures (ICD Codes): V03.7 Tetanus Vac, V06.1 DTP, V06.2 DTP+TAB, V06.3 DTP+polio, V06.5 DT [BKM TETANUS IZ DXS]  
Immunization (CVX Codes): 01 DTP; 20 DTaP; 28 DT-PEDS; 09Td Adult; 35 Tetanus Toxoid; 13 TIG; 106 DTaP 5; 107 DTaP NOS; 22 DTP [BKM] | A Tetanus Immunization is due every 10 years for all patients.                                                                                                                                                                                                                                     |
<table>
<thead>
<tr>
<th>Reminder Name</th>
<th>Description Field Text</th>
<th>Tooltip Text</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Toxoplasmosis</strong></td>
<td>TETANUS IZ CVX CODES] Site Configurable? No Type: Care Management Category: HIV Reminder Name: Toxoplasmosis Test Default Status: On Denominator: Patients with a proposed or accepted tag for HIV OR Active on HMS Register with Diagnosis Category of HIV or AIDS AND Without a history of positive Toxoplasmosis test Definition (Frequency): Annually LOGIC DETAIL: Toxoplasmosis Test Definition: Procedures (CPT Codes): V CPT 86777, 86778 [BKM TOXOPLASMOSIS CPTS] LOINC Codes: V Lab as predefined in [BKM TOXOPLASMOSIS LOINC CODES] Site Defined: V Lab site-defined in [BKM TOXOPLASMOSIS TESTS TAX] Site Configurability: No</td>
<td>A Toxoplasmosis test is due annually for all patients WITHOUT a history of positive Toxoplasmosis test.</td>
</tr>
<tr>
<td><strong>HIV Viral Load Test</strong></td>
<td>Type: Care Management Category: HMS Reminder Name: HIV Viral Load Test Status: On Denominator: Patients with a proposed or accepted tag for HIV OR Active on HMS Register with Diagnosis Category of HIV or AIDS Definition (Frequency): Every 4 months LOGIC DETAIL: HIV Viral Load Test Definition: Procedures (CPT Codes): V CPT 87536, 87539 [BGP HIV VIRAL LOAD CPTS] LOINC Codes: V Lab as predefined in [BGP VIRAL LOAD LOINC CODES] Site Defined Lab Tests: V Lab site-defined tests in [BGP HIV VIRAL LOAD TAX] Site Configurable? No.</td>
<td>An HIV Viral Load Test is due every 4 months for all patients.</td>
</tr>
</tbody>
</table>
17.0 Appendix E: CDC Clinical Classification

Classification of HIV disease can be undertaken for several purposes and should be distinguished from disease staging. Staging is disease classification that aims primarily to make groupings that have different prognosis and can be used in guiding treatment decisions. A number of classification and staging systems have been proposed for HIV disease, but the classification scheme constructed by the Centers for Disease Control and Prevention (CDC) has gained the widest acceptance.

The current CDC classification system, from the revision in 1993, combines three categories of the CD4 count with three symptom categories. It was first put forth as a categorization of HIV-related signs and symptoms and was explicitly for “public health purposes” and not intended as a staging system, although it is frequently treated as such. The CDC proposed that it be used to “guide clinical and therapeutic actions in the management of HIV-infected adolescents and adults.”

The three categories relating to the CD4+ cell count:

- Category 1 includes counts of 500 or more cells per microliter
- Category 2 includes counts from 200 to 499
- Category 3 includes counts below 200 cells

The three clinical categories for people who test HIV-positive:

- Category A includes individuals who have been asymptomatic except for persistent generalized lymphadenopathy and/or seroconversion syndrome.
- Category B comprises those who have never had an AIDS-defining illness but have had some of the less serious complications of HIV infection, including oral or vaginal candidiasis, constitutional symptoms such as fever or persistent diarrhea, oral hairy leukoplakia, herpes zoster, idiopathic thrombocytopenic purpura, listeriosis, peripheral neuropathy, cervical dysplasia, bacillary angiomatosis, or pelvic inflammatory disease.
- Category C is used to describe those who have had one or more of the AIDS-defining illnesses.

The use of both the CD4+ cell count and clinical categories provides shorthand for where the patient stands in the course of the HIV/AIDS continuum. A person placed in Category A1 has the least immune damage and fewest clinical complications; someone scoring C3 is seriously ill. Anyone placed in Category 3 and/or Category C has an AIDS diagnosis under the 1993 CDC case definition. A somewhat different classification scheme is used for pediatric cases: three classes using the letter P for pediatric matched with the numeral 0, 1, or 2 to indicate the stage, along with subclasses and categories of specific types of diseases.
While there are guidelines in place, assignation of this classification is made only after clinical evaluation. The decision of which category to assign is always made by a clinical person.

The table below provides a summary of the CDC clinical classification. The Sections following describe these classifications in more detail.

<table>
<thead>
<tr>
<th>Classification</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>Asymptomatic HIV infection + CD4 count &gt; or = 500</td>
</tr>
<tr>
<td>A2</td>
<td>Asymptomatic HIV infection + CD4 count between 200 and 499</td>
</tr>
<tr>
<td>A3</td>
<td>Asymptomatic HIV infection + CD4 count less than 200</td>
</tr>
<tr>
<td>B1</td>
<td>Symptoms attributable to HIV infection + CD4 count &gt;= 500</td>
</tr>
<tr>
<td>B2</td>
<td>Symptoms attributable to HIV infection + CD4 count between 200-499</td>
</tr>
<tr>
<td>B3</td>
<td>Symptoms attributable to HIV infection + CD4 count less than 200</td>
</tr>
<tr>
<td>C1</td>
<td>AIDS defining condition(s) + CD4 count &gt; or = 500</td>
</tr>
<tr>
<td>C2</td>
<td>AIDS defining condition(s) + CD4 count between 200 and 499</td>
</tr>
<tr>
<td>C3</td>
<td>AIDS defining condition(s) + CD4 count less than 200</td>
</tr>
</tbody>
</table>

The definitions of the three CD4 count categories are as follows:

- **Category 1**: > 500 cells/mm3 (or CD4% > 28%)
- **Category 2**: 200-499 cells/mm3 (or CD4% 14% - 28%)
- **Category 3**: < 200 cells/mm3 (or CD4% < 14%)

The lowest, most accurate CD4 count should be used for classification purposes. This will not necessarily be the most recent count but the most representative for the time frame being evaluated. This is a modifiable field and the user should expect to re-evaluate and change this frequently.

The definitions of the three clinical condition categories are as follows:

- **Category A**: Asymptomatic HIV infection; persistent generalized lymphadenopathy; acute, primary HIV infection with accompanying illness or history of acute HIV infection.
- **Category B**: Symptomatic conditions in an HIV-infected adolescent or adult that are not included among conditions listed in clinical Category C and that meet at least one of the following criteria: (a) the conditions are attributed to HIV infection or are indicative of a defect in cell-mediated immunity; or (b) the conditions are considered by physicians to have a clinical course or to require management that is complicated by HIV infection. Examples of conditions in clinical category B include but are not limited to are:
  - Bacillary angiomatosis
  - Candidiasis, oropharyngeal (thrush)
  - Candidiasis, vulvovaginal; persistent, frequent, or poorly responsive to therapy
- Cervical dysplasia (moderate or severe)/cervical carcinoma in situ
- Constitutional symptoms, such as fever (38.5 degrees centigrade) or diarrhea lasting greater than 1 month
- Hairy leukoplakia, oral
- Herpes zoster (shingles), involving at least two distinct episodes or more than one dermatome
- Idiopathic thrombocytopenic purpura
- Listeriosis
- Pelvic inflammatory disease, particularly if complicated by tubo-ovarian abscess
- Peripheral neuropathy

- **Category C:** Any incidence of one or more of the clinical conditions listed in the 1993 AIDS surveillance case definition, i.e., AIDS Defining Illnesses (see Section 15.2 AIDS Defining Illnesses). For classification purposes, once a Category C condition has occurred, the person will remain in Category C.

A patient’s clinical classification is dynamic. You can see from the definitions above that the numeric portion of the classification (1, 2, or 3) could change at each visit depending on the CD4 count. The alpha portion of the classification can change or progress from A to B to C but it cannot go back from C to B to A. In other words, once a patient has been assigned to the C classification which indicates AIDS, the clinical classification will never revert to an HIV classification even if the condition improves.
18.0 Appendix F: Medications

This Section describes the ARV/HAAART definitions and the medication categorization for taxonomy setup.

18.1 ARV/HAAART Definitions

ARV (Antiretroviral Therapy)/HAART (Highly Active Antiretroviral Therapy) is a specific treatment regimen defined as:

- 2 or more NRTI (M.03) together with at least one NNRTI (M.02) or PI (M.05)
- 2 or more PIs (M.05) with at least 1 NRTI (M.03)
- at least 3 NRTIs (M.03)

18.2 Medication Categorization for Taxonomy Setup

Use the following medication list to assist you in setting up the medication taxonomies that are used by the HIV Management System. (See Section 12.4 Taxonomy Management for detailed information about setting up medication taxonomies.) The following lists the medications that are commonly prescribed for each of the categories.

You should work with a pharmacist to determine which medications are available and how they are categorized at your facility.

<table>
<thead>
<tr>
<th>Name</th>
<th>NRTI MEDS</th>
<th>NNRTI MEDS</th>
<th>NRTI COMBO</th>
<th>NRTI/ NNRTI</th>
<th>PI MEDS</th>
<th>PI BOOSTER</th>
<th>EI MEDS</th>
<th>II MEDS</th>
<th>PCP PROPH MEDS</th>
<th>MAC PROPH MEDS</th>
<th>TB MEDS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abacavir (Ziagen, ABC)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Didanosine (Videx, Videx EC)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

User Manual
November 2009
| Name                                      | NRTI MEDS | NNRTI MEDS | NRTI COMBO | NRTI/NNRTI | PI MEDS | PI BOOSTER | EI MEDS | II MEDS | PCP PROPH MEDS | MAC PROPH MEDS | TB MEDS |
|---|--|--|--|--|--|--|--|--|--|--|--|--|--|
| Emtricitabine (Emtriva)                  | X          |            |            |            |         |           |         |        |                |                |        |
| Lamivudine (Epivir)                      | X          |            |            |            |         |           |         |        |                |                |        |
| Lamivudine/Abacavir (Epzicom)            | X          |            |            |            |         |           |         |        |                |                |        |
| Stavudine (Zerit)                        | X          |            |            |            |         |           |         |        |                |                |        |
| Tenofovir (Viread)                       | X          |            |            |            |         |           |         |        |                |                |        |
| Zalcitibine (Hivid)                      | X          |            |            |            |         |           |         |        |                |                |        |
| Zidovudine (Retrovir)                    | X          |            |            |            |         |           |         |        |                |                |        |
| Zidovudine/Lamivudine                    | X          |            |            |            |         |           |         |        |                |                |        |
| (Combivir)                               |            |            |            |            |         |           |         |        |                |                |        |
| Zidovudine/Lamivudine/Abacavir (Trizivir)| X          |            |            |            |         |           |         |        |                |                |        |
| Delavirdine (Rescriptor)                 |            |            | X          |            |         |           |         |        |                |                |        |
| Efavirenz (Sustiva)                      | X          |            |            |            |         |           |         |        |                |                |        |
| Nevirapine (Viramune)                    | X          |            |            |            |         |           |         |        |                |                |        |
| Etravirine (TMC-125) (Intelence)         | X          |            |            |            |         |           |         |        |                |                |        |
| Tenofovir/Emtricitabine (Truvada)        |            |            |            | X          |         |           |         |        |                |                |        |
| Tenofovir/Emtricitabine/Efavirenz (Atripla)| X              |            |            |            |         |           |         |        |                |                |        |
| Amprenavir (Agenerase)                   |            |            |            |            | X        |           |         |        |                |                |        |
| Atazanavir (Revataz)                     | X          |            |            |            |         |           |         |        |                |                |        |
| Fosamprenavir (Lexiva)                   | X          |            |            |            |         |           |         |        |                |                |        |
| HGC Saquinavir (Invirase)                | X          |            |            |            |         |           |         |        |                |                |        |
| Indinavir (Crixivan)                     | X          |            |            |            |         |           |         |        |                |                |        |
| Lopinavir/Ritonavir (Kaletra)            | X          |            |            |            |         |           |         |        |                |                |        |
| Nelfinavir (Viracept)                    | X          |            |            |            |         |           |         |        |                |                |        |
| SCG Saquinavir (Fortovase)               | X          |            |            |            |         |           |         |        |                |                |        |
| Tipranovir (Aptivus)                     | X          |            |            |            |         |           |         |        |                |                |        |
| Darunavir (Prezista)                     | X          |            |            |            |         |           |         |        |                |                |        |
| Ritonavir (Norvir)                       |            |            |            |            | X        |           |         |        |                |                |        |
| Enfurvirivirus (Fuzeon)                  |            |            |            |            | X        |           |         |        |                |                |        |
| Maraviroc (Selzentry)                    | X          |            |            |            |         |           |         |        |                |                |        |
| Raltegravir (Isentress)                  |            |            |            |            | X        |           |         |        |                |                |        |
| Atovaquone (Mepron)                      |            |            |            |            |         |           |         |        |                |                |        |
| Dapsone                                  | X          |            |            |            |         |           |         |        |                |                |        |
| Pentamidine, Pentam 300                  |            |            |            |            |         |           |         |        |                |                |        |

User Manual
November 2009

Appendix F: Medications
<table>
<thead>
<tr>
<th>Name</th>
<th>NRTI MEDS</th>
<th>NNRTI MEDS</th>
<th>NRTI COMBO</th>
<th>NRTI/NNRTI</th>
<th>PI MEDS</th>
<th>PI BOOSTER</th>
<th>EI MEDS</th>
<th>II MEDS</th>
<th>PCP PROPH MEDS</th>
<th>MAC PROPH MEDS</th>
<th>TB MEDS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pentacarinate (NebuPent)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sulfamethaxazole &amp; Trimethoprim/Cotrimoxazole</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Bactrim; Septra)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trimethoprim (Proloprim, Trimex)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trimetrexate, Glururonate &amp; Leucovorin (Neutrexin)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Azithromycin (Zithromax)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clarithromycin (Biaxin, Klacid)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rifabutin (Mycobutin, Ansamycin)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ethambutol (Myambutol)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Isoniazid (INH)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pyrazinamide</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rifamate</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rifampin</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rifater</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Streptomycin</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
19.0 Appendix G: Quality of Care Report Logic

The Quality of Care report provides a snapshot of the status of key care indicators for HIV/AIDS patients in the past 12 months. The general format is based on HIVQual, a HRSA-sponsored program built upon a model of quality improvement consultation that was developed in New York State. The goal of the HIVQual Continuous Quality Project is to improve the quality of care delivered to persons with HIV.

Users select an end date for the report, usually “today,” and the report will display the status and categorization of the various elements listed above for the patients you have chosen to include in the report. The patients are selected from an iCare panel, either created by or shared with the user. iCare users will then select one of three ways to further define the denominator for this report.

Denominator

Use one of the following:

- Patients on this panel who have an Active HMS Register Status with HMS Dx Category values empty, HIV or AIDS (i.e., no “At Risk” patients)
- Patient on this panel who have a Proposed or Accepted Dx tag of HIV/AIDS (user selects either or both Tag Status)
- Specified (by highlighting) patients on this particular panel

Any denominator is filtered automatically by the following logic: patients must have at least one HIV/AIDS POV or Active Problem List or HMS Initial HIV Dx Date or HMS Initial AIDS Dx Date 6 months or more prior to report end date. Patient names selected by the user that do not meet these criteria will be identified on the report.

Numerators

1. Gender breakdowns: 1A) Male patients; and 1B) Female patients.

2. Age breakdowns: 2A) younger than (<) 15); 2B) ages 15 through 44; 2C) ages 45 through 64; and 2D) older than 64. Age of patient is determined as of Report End date.

3. Most recent CD4 count in 4 months prior to end of Report period: Total # of patients reviewed with any completed CD4 test (either CD4 All (T.2) or CD4 Absolute (T.1)). 3A) CD4 Absolute (T.1) results less than (<) 50. 3B) CD4 Absolute (T.1) results equal to or greater than (=>) 50 and less than (<) 200. 3C) CD4 Absolute (T.1) results => 200. 3C) # with undetermined results.

If there are more than 1 test in the timeframe for the patient, use most recent result.
If most recent test result is undetermined (no appropriate value), look for next test in the timeframe (past 4 months) with results. If no tests are found with appropriate results within past 4 months, count as “Undetermined.”

4. Most recent Viral Load (T.26): Total # of patients with Viral Load test in 4 months prior to end of Report period. 4A) test results less than (<) 100,000 copies/ml. 4B) test results equal to or greater than (=>) 100,000 copies/ml. 4C) tests with undetermined results.

If there are more than 1 test in the timeframe for the patient, use most recent result.

If most recent test result is undetermined (no appropriate value), look for next test in the timeframe (past 4 months) with results. If no tests are found with appropriate results, count as “Undetermined.”

5. RPR (Rapid plasma reagin) (Syphilis screening): # with RPR or FTA-ABS (T.22 & T.09) completed or refused in year prior to end of report period. Use most recent results or refusal, if more than 1 test in the timeframe, to categorize as follows: 5A) # reactive (positive) tests r or R or Reactive; wr or WR or Weakly Reactive. 5B) # Non-reactive tests. n or N or Nonreactive. 5C) Undetermined values. 5D) Refused (Refusal type REF) 5E) NMI (Not Medically Indicated) (Refusal type NMI).

6. Chlamydia: # with Chlamydia test (T.3) completed or refused in year prior to end of report period. Use most recent results or refusal, if more than 1 test in the timeframe, to categorize as follows: 6A) # Females. 6B) # Males. 6C) # positive tests p or P or Positive or POS. 6D) # Negative tests n or N or Negative or NEG. 6E) Undetermined values. 6F) Refused (Refusal type REF). 6G) NMI (Not Medically Indicated) (Refusal type NMI).

7. Gonorrhea: # with gonorrhea test (T.10) completed or refused in year prior to end of report period. Break the total number in the Numerator into # Males and # Females. Use most recent results or refusal, if more than 1 test in the timeframe, to categorize as follows: 7A) # Females. 7B) # Males. 7C) # positive tests p or P or Positive or POS. 7D) # Negative tests n or N or Negative or NEG 7E) Undetermined values. 7F) Refused. 7G) NMI (Not Medically Indicated)

8. Tuberculosis Status: Total # of patients who needed PPD during Report Year, i.e., year previous to the end of the Report Period. Defined as including patients with 1) No TB diagnosis ever (DX.14); 2) No PPD ever; 3) no positive PPD results (T.21) on test performed more than one year previous to the end of the Report period, i.e. before the Report Year (see #8B below for definition of “positive”; or 4) No history of TB treatment (M.08) before the Report Year.

Use most recent results or refusal, if more than 1 test in the timeframe, to categorize as follows:
8A) # PPD received or refused (T.21) in previous year, regardless of result, with percentage of denominator Need PPD.

8B) # with positive PPD results in Report year, with percentage of denominator # PPD received. “Positive” result is defined as 1) Result field containing “p” or “P” or “POS” or “positive” or “+”; or 2) no value in Result field but Reading field ≥ 5.

8C) # from 8B who had treatment given (M.08) or refused treatment or treatment contraindicated ON or AFTER date of positive PPD result, with percentage of denominator Pos PPD.

8D) # with negative PPD results in previous year, with percentage of denominator # PPD received. “Negative” result defined as 1) Result field containing “n” or “-” or “N” or “NEG” or “negative” or “0”; or 2) no value in Result field but Reading field < 5.

8E) # who have documented PPD refusals, with percentage of denominator # PPD received. If the most recent test is a refusal, look for a previous test within the time frame and categorize as above. If only the refusal exists, categorize here as a refusal. (NOTE: this logic was not provided on the original document, but was included on the format layout.)

8F) # with undetermined results in previous year, with percentage of denominator # PPD received.

9. Lipids Screening: Total # of patients with Lipid Profile (T.30) completed or refused in year prior to end of report period. Use most recent panel or refusal, if more than 1 panel in the timeframe. Further categorize by: 9A) # of patients who had a Lipid panel AND are receiving any ARVs (M.02; M.03; M.05; M.09; M.10; M.11; M12; M13); 9B) # of refusals.

10. Colorectal Cancer Screen: Total # of patients who needed a Colorectal Cancer (CRC) Screen (S.05) in the 10 years prior to end date of the report. Defined as including patients: 1) Greater than or equal to 50 years of age on the date of the beginning of the report period. 2) No CRC diagnosis ever (DX.18); 3) No history of a total Colectomy (P.06). Use most recent screening or refusal, if more than 1 test in the timeframe, to categorize as follows: 10A) Total # of patients who received or refused CRC Screens in previous 10 years, with percentage of denominator Need CRC; 10B) # of refusals.

11. Hepatitis C Screen Baseline: Total # of patients with a Hepatitis C Screen (T.13; T.14) baseline completed ever or refused in past year.

12. Pneumovax Status: Total # of patients with 1 pneumovax (IZ.6) documented in the 5 years prior to the end of the Report period OR 2 pneumovax ever OR pneumovax refusal in past year.
13. Tetanus Status: Total # of patients with tetanus vaccine (IZ.7) in past 10 years, or contraindicated, or refusal in past year. NOTE: logic for contraindications is not currently provided.

14. Eye Exam Status: Total # of patients with any completed or non-DNKA ophthalmology eye exam (P.03) or refusal documented in year prior to end of Report period.

15. Dental Exam Status: Total # of patients with any completed or non-DNKA dental exam or refusal (P.02) documented in year prior to end of Report period.

16. Pap Smear Status: Total # of female patients ages 19 through 64 with no documented history of Hysterectomy (P.04) with Pap smear (T.20) or refusal documented in 1 year period to end of Report period.

17. ARV Therapy: # of patients for whom any ARV medications (M.02; M.03; M.05; M.09; M.10; M.11; M.12 M.13;) have been prescribed (Total of 17A, B, C) as their most recent regimen in 4 months previous to end of Report Period, with percentage of Total Patients.

17A) HAART: # of patients on HAART medications in most recent regimen during past 4 months, with percentage of ARV total. A HAART regimen can be defined by an Active or Chronic (not Discontinued or Expired) prescription for one of the following 9 regimens.

- At least 1 PI (M.05) medication AND 2 NRTI (M.03) medication
- At least 1 PI (M.05) medication AND 1 NRTI Combo (M.12) medication
- At least 2 NRTI (M.03) medications AND1 NNRTI (M.02) medication
- At least 1NRTI Combo (M.12) medication AND 1 NNRTI (M.02) medication
- At least 1 EI (M. 09) medication AND 2 of any NNRTI (M.02); NRTI (M.03); OR PI (M.05) medications
- At least 1 EI (M.09) medication AND 1 NRTI Combo (M.12) medication
- At least 1 II (M.10) medication AND 2 of any NNRTI (M.02); NRTI (M.03); OR PI (M.05) medications
- At least 1 II (M.10) medication AND 1 NRTI Combo (M.12) medication
- At least 1 NRTI/NNRTI (M.11) medication

17B) Mono therapy: # of patients who have had any one of the ARV medications prescribed for them one at a time in past 4 months. Defined as Active or Chronic (not Discontinued or Expired), with percentage of ARV total.
17C) Other Combination: # of patients who have had any other ARV medication combination (not included in 17A or 17B) prescribed for them in past 4 months. Defined as Active or Chronic (not Discontinued or Expired), with percentage of ARV total.

18. PCP Prophylaxis: from # of patients with any CD4 Absolute (T.1) results less than 200 in past 12 months, how many received PCP Prophylaxis (M.04), with percentage of patients (CD4 < 200). Look at date of appropriate CD4 Absolute result (T.1) and count any medications prescribed on or after that date (prior to end of Report period). NOTE: the total number of patients in this value range can be more than the number of patients in the same range documented in the CD4 Lab Exam Section (Section 3 above), which documents most recent value rather than any value during the time period.

19. MAC Prophylaxis: from # of patients with any CD4 Absolute (T.1) results <50 in past 12 months, how many received MAC prophylaxis (M.01), with percentage of patients (CD4 < 50). Look at date of appropriate CD4 Absolute (T.1) result and count any medications prescribed on or after that date (prior to end of Report period). NOTE: the total number of patients in this value range might be more than the number of patients in the same range documented in the CD4 Lab Exam Section, which documents most recent value rather than any value during the time period.

20. Tobacco Use: Total # of patients screened for tobacco use (S.04) in year prior to end of Report Period.

20A) # patients identified as tobacco users (DX.12) in year prior to end of Report Period.

20B) # counseled about tobacco use (ED.5) in past year.

20C) # identified as not current tobacco users (DX.7) in past year.

20D) # patients with undetermined tobacco use (Total patients minus any patient not categorized in 20A or 20B or 20C).

21. Substance Use: Total # of patients screened for substance use (S.1 and S.3) in year prior to end of Report Period.

The last page of the report will provide an overview of the Report logic and a list of the user-selected patients who were and were not included on the report. The following text and data should be included:

HMS Quality of Care Report.

This report includes all patients who meet the criteria of the selected denominator:
1) HMS Register Status Active with HMS Dx Category values empty, HIV or AIDS (i.e., no “At Risk” patients)

OR

2) Proposed and/or Accepted Dx tag of HIV/AIDS (user selects either or both Tag Status)

OR

3) Specific patients on the grid.

Any denominator is filtered automatically by the following logic: patients must have at least one HIV/AIDS POV or Active Problem List or HMS Initial HIV Dx Date or HMS Initial AIDS Dx Date 6 months or more prior to report end date.

Total Patients Reviewed (All patients in denominator): [#]

Number of Patients included on Report (filtered denominator): [#]

Number or Patients NOT included on Report: [#]

The following user selected patients are included on this report:

- Name (Last Name, First Middle format)
- HRN
- Age
- Gender
- Current Register Diagnosis
- Initial HIV Diagnosis Date
- Initial AIDS Diagnosis Date
- HIV/AIDS Diagnostic Tag Status

The following user selected patients are NOT included on this report:

- Name (Last Name, First Middle format)
- HRN
- Age
- Gender
- Current Register Diagnosis
- Initial HIV Diagnosis Date
• Initial AIDS Diagnosis Date
• HIV/AIDS Diagnostic Tag Status

19.1 Sample Format, Quality of Care Audit

[Initials] = initials of user who runs the report.

[Denominator Population] is identified from Step 1 above, e.g., HMS Active Patients; All RPMS HIV POV; Patients with Designated Provider [Name]; or Patient Panel [Name]

<table>
<thead>
<tr>
<th>ALA</th>
<th>Oct 02, 2008</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEMO HOSPITAL</td>
<td></td>
</tr>
<tr>
<td>HMS CUMULATIVE AUDIT REPORT</td>
<td></td>
</tr>
<tr>
<td>HIV QUALITY OF CARE</td>
<td></td>
</tr>
<tr>
<td>Copy of HMS patients</td>
<td></td>
</tr>
<tr>
<td>Active HMS Register Patients</td>
<td></td>
</tr>
<tr>
<td>PERIOD ENDING: Oct 01, 2008</td>
<td></td>
</tr>
<tr>
<td>**** CONFIDENTIAL PATIENT INFORMATION ****</td>
<td></td>
</tr>
<tr>
<td>-------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Total Patients Reviewed: 35</td>
<td></td>
</tr>
<tr>
<td>12 patients are included in this report.</td>
<td></td>
</tr>
<tr>
<td>#</td>
<td>%</td>
</tr>
<tr>
<td>Gender: Male</td>
<td>4   33.3%</td>
</tr>
<tr>
<td>Female</td>
<td>8   66.7%</td>
</tr>
<tr>
<td>Age &lt;15 yrs</td>
<td>1   8.3%</td>
</tr>
<tr>
<td>15-44 yrs</td>
<td>4   33.3%</td>
</tr>
<tr>
<td>45-64 yrs</td>
<td>6   50.0%</td>
</tr>
<tr>
<td>&gt;64 yrs</td>
<td>1   8.3%</td>
</tr>
<tr>
<td>LABORATORY EXAMS</td>
<td></td>
</tr>
<tr>
<td># w/ CD4 count in last 4 months</td>
<td>0   0.0%</td>
</tr>
<tr>
<td>most recent&lt;50</td>
<td>0   0.0%</td>
</tr>
<tr>
<td>most recent 50-199</td>
<td>0  0.0%</td>
</tr>
<tr>
<td>most recent=&gt;200</td>
<td>0  0.0%</td>
</tr>
<tr>
<td>Undetermined</td>
<td>0   0.0%</td>
</tr>
<tr>
<td># w/ Viral Load in last 4 months</td>
<td>0   0.0%</td>
</tr>
<tr>
<td>&lt;100,000 copies/ml</td>
<td>0   0.0%</td>
</tr>
<tr>
<td>=&gt;100,000 copies/ml</td>
<td>0  0.0%</td>
</tr>
<tr>
<td>Undetermined</td>
<td>0   0.0%</td>
</tr>
<tr>
<td># w/ RPR (Syphilis Test) in the last 12 month</td>
<td>0   0.0%</td>
</tr>
<tr>
<td>Reactive</td>
<td>0   0.0%</td>
</tr>
<tr>
<td>Non-Reactive</td>
<td>0  0.0%</td>
</tr>
<tr>
<td>Refused</td>
<td>0   0.0%</td>
</tr>
<tr>
<td>NMI</td>
<td>0   0.0%</td>
</tr>
<tr>
<td>Undetermined</td>
<td>0  0.0%</td>
</tr>
<tr>
<td># w/ Chlamydia Screen in the last 12 months</td>
<td>1   8.3%</td>
</tr>
<tr>
<td># Men</td>
<td>1   100.0%</td>
</tr>
<tr>
<td>Category</td>
<td>Total</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>-------</td>
</tr>
<tr>
<td># Women</td>
<td>0</td>
</tr>
<tr>
<td>Positive</td>
<td>0</td>
</tr>
<tr>
<td>Negative</td>
<td>1</td>
</tr>
<tr>
<td>Refused</td>
<td>0</td>
</tr>
<tr>
<td>NMI</td>
<td>0</td>
</tr>
<tr>
<td>Undetermined</td>
<td>0</td>
</tr>
</tbody>
</table>

# w/ Gonorrhea Screen in the last 12 months

<table>
<thead>
<tr>
<th>Category</th>
<th>Total</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td># Men</td>
<td>1</td>
<td>100.0%</td>
</tr>
<tr>
<td># Women</td>
<td>0</td>
<td>0.0%</td>
</tr>
<tr>
<td>Positive</td>
<td>0</td>
<td>0.0%</td>
</tr>
<tr>
<td>Negative</td>
<td>1</td>
<td>100.0%</td>
</tr>
<tr>
<td>Refused</td>
<td>0</td>
<td>0.0%</td>
</tr>
<tr>
<td>NMI</td>
<td>0</td>
<td>0.0%</td>
</tr>
<tr>
<td>Undetermined</td>
<td>0</td>
<td>0.0%</td>
</tr>
</tbody>
</table>

# w/ Tuberculosis test needed

<table>
<thead>
<tr>
<th>Category</th>
<th>Total</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td># w/ Lipids Screen</td>
<td>0</td>
<td>0.0%</td>
</tr>
<tr>
<td># on ARV</td>
<td>0</td>
<td>0.0%</td>
</tr>
<tr>
<td># Refused</td>
<td>0</td>
<td>0.0%</td>
</tr>
</tbody>
</table>

# Hep C Screen Baseline

<table>
<thead>
<tr>
<th>Category</th>
<th>Total</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>VACCINATION</td>
<td></td>
<td></td>
</tr>
<tr>
<td># w/ Pneumovax in last 5 years (or 2 ever)</td>
<td>2</td>
<td>16.7%</td>
</tr>
<tr>
<td># w/ Tetanus in past 10 years</td>
<td>4</td>
<td>33.3%</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Category</th>
<th>Total</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXAMS - Yearly</td>
<td></td>
<td></td>
</tr>
<tr>
<td># w/ Eye Exam</td>
<td>0</td>
<td>0.0%</td>
</tr>
<tr>
<td># w/ Dental Exam</td>
<td>0</td>
<td>0.0%</td>
</tr>
<tr>
<td># w/ Pap Smear</td>
<td>1</td>
<td>12.5%</td>
</tr>
</tbody>
</table>

# Colorectal Cancer Screens Needed

<table>
<thead>
<tr>
<th>Category</th>
<th>Total</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td># CRC screen in past 10 yrs</td>
<td>1</td>
<td>25.0%</td>
</tr>
<tr>
<td># CRC screen refused</td>
<td>1</td>
<td>25.0%</td>
</tr>
</tbody>
</table>

TREATMENT (past 4 months)

<table>
<thead>
<tr>
<th>Category</th>
<th>Total</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARV Therapy Given</td>
<td>3</td>
<td>25.0%</td>
</tr>
<tr>
<td>HAART</td>
<td>2</td>
<td>66.7%</td>
</tr>
<tr>
<td>Mono Therapy</td>
<td>1</td>
<td>33.3%</td>
</tr>
<tr>
<td>Other Combination</td>
<td>0</td>
<td>0.0%</td>
</tr>
</tbody>
</table>

PCP Prophylaxis given if CD4 <200 in last 12 months

<table>
<thead>
<tr>
<th>Category</th>
<th>Total</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAC Prophylaxis given if ANY CD4 &lt;50 in last 12 months</td>
<td>0</td>
<td>0.0%</td>
</tr>
</tbody>
</table>

RISK FACTORS

<table>
<thead>
<tr>
<th>Category</th>
<th>Total</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tobacco Use Screening</td>
<td>1</td>
<td>8.3%</td>
</tr>
<tr>
<td>Current Tobacco User</td>
<td>1</td>
<td>100.0%</td>
</tr>
<tr>
<td>Category</td>
<td>Count</td>
<td>Percentage</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------</td>
<td>------------</td>
</tr>
<tr>
<td>If Yes, Counseled</td>
<td>0</td>
<td>0.0%</td>
</tr>
<tr>
<td>Not a Current User</td>
<td>0</td>
<td>0.0%</td>
</tr>
<tr>
<td>Not Documented</td>
<td>0</td>
<td>0.0%</td>
</tr>
<tr>
<td>Substance Use Screening</td>
<td>0</td>
<td>0.0%</td>
</tr>
</tbody>
</table>

**ALA**  
**Oct 02, 2008**  
**DEMO HOSPITAL**  
**HMS CUMULATIVE AUDIT REPORT**  
**HIV QUALITY OF CARE**  
**Copy of HMS patients**  
**Active HMS Register Patients**  
**PERIOD ENDING: Oct 01, 2008**  
**** CONFIDENTIAL PATIENT INFORMATION ****  
---  

**HMS Quality of Care Report**

This report includes all patients who meet the criteria of the selected denominator:

1) HMS Register Status Active with HMS Dx Category values empty, HIV or AIDS (i.e., no "At Risk" patients);

OR

2) Proposed and/or Accepted Dx tag of HIV/AIDS (user selects either or both Tag Status);

OR

3) Specific patients on the grid.

Any denominator is filtered automatically by the following logic: patients must have at least one HIV/AIDS POV or Active Problem List or HMS Initial HIV Dx Date or HMS Initial AIDS Dx Date 6 months or more prior to report end date.

Total patients reviewed (All patients in denominator): 35  
Number of Patients included on Report (filtered denominator): 12  
Number of Patients NOT included on Report: 23

**Figure 19-1: Sample Report**

---
The following user selected patients are included on this report:

<table>
<thead>
<tr>
<th>REG</th>
<th>INITIAL HIV INITIAL AIDS TAG</th>
</tr>
</thead>
<tbody>
<tr>
<td>PATIENT NAME</td>
<td>HRN</td>
</tr>
<tr>
<td>--------------------</td>
<td>----</td>
</tr>
<tr>
<td>TEST, PATIENT AA</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT AB</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT AC</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT AD</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT AE</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT AF</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT AG</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT AI</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT AJ</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT AK</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT AL</td>
<td>nnnnnn</td>
</tr>
</tbody>
</table>

Figure 19-2: Sample Report

The following user selected patients are NOT included in the report:

<table>
<thead>
<tr>
<th>REG</th>
<th>INITIAL HIV INITIAL AIDS TAG</th>
</tr>
</thead>
<tbody>
<tr>
<td>PATIENT NAME</td>
<td>HRN</td>
</tr>
<tr>
<td>--------------------</td>
<td>----</td>
</tr>
<tr>
<td>TEST, PATIENT BA</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT BB</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT BC</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT BD</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT BE</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT BF</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT BG</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT BH</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT BI</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT BJ</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT BK</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT BL</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT BM</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT BN</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT BO</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT BP</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT BQ</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT BR</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT BS</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT BT</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT BU</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT BV</td>
<td>nnnnnn</td>
</tr>
<tr>
<td>TEST, PATIENT BW</td>
<td>nnnnnn</td>
</tr>
</tbody>
</table>
Figure 19-3: Sample Report
## 20.0 Appendix H: HMS Patient Care Supplement

This Section provides information about the HMS Patient Care Supplement.

### 20.1 Supplement Logic

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>How Data Obtained From RPMS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Date</td>
<td>Date Health Supplement was generated</td>
<td>Date Health Supplement was generated</td>
</tr>
<tr>
<td>Patient’s Name</td>
<td>Last Name, First Name, Middle Initial of patient.</td>
<td>Patient File</td>
</tr>
<tr>
<td>HRN</td>
<td>Patient’s Health Record Number</td>
<td>Patient Registration</td>
</tr>
<tr>
<td>Sex</td>
<td>Gender of patient</td>
<td>Patient Registration</td>
</tr>
<tr>
<td>DOB</td>
<td>Patient’s date of birth (mmm/dd/yyyy)</td>
<td>Patient Registration</td>
</tr>
<tr>
<td>Age</td>
<td>Age of patient in years on the date the summary was generated</td>
<td>Calculated</td>
</tr>
<tr>
<td>Designated Primary Care Provider</td>
<td>Name of the Primary Care Provider on the date the Health Supplement was generated</td>
<td>Designated Specialty Provider Management System (DSPM) or Patient File</td>
</tr>
<tr>
<td>HIV Provider</td>
<td>Name of the HIV Provider</td>
<td>Designated Specialty Provider Management System (DSPM) or Patient File</td>
</tr>
<tr>
<td>HIV Case Manager</td>
<td>Name of HIV Case Manager</td>
<td>Designated Specialty Provider Management System (DSPM) or Patient File</td>
</tr>
<tr>
<td>Last Height</td>
<td>The last <strong>height</strong> in inches and the <strong>date</strong> of the last height</td>
<td>PCC V Measurement. The last height value in inches and the date of the last height recorded in PCC is displayed</td>
</tr>
<tr>
<td>Last Weight</td>
<td>The last <strong>weight</strong> in pounds and the <strong>date</strong> of the last weight</td>
<td>PCC V Measurement. The last weight value in pounds and the date of the last weight recorded in PCC is displayed</td>
</tr>
<tr>
<td>BMI</td>
<td>The BMI is calculated using the last height and weight data for the patient</td>
<td>Calculated using NHANES II. For ages 18 and under, the most recent height and weight must be taken on the same day. For ages 19 through 50, both the most recent height and weight must be documented within last five years, not required to be on same day. For ages over 50, both the most recent height and weight must be documented within last two years, not required to be on same day. If BMI cannot be calculated, display “BMI cannot be calculated with current data.”</td>
</tr>
<tr>
<td>Register Diagnosis</td>
<td>Field value and date. Assigned by HMS user.</td>
<td>HMS, field [Register Diagnosis] + [Diagnosis Date]</td>
</tr>
<tr>
<td>Register Status</td>
<td>Most recent field value and date assigned.</td>
<td>HMS field [Register status] + [Date assigned]</td>
</tr>
<tr>
<td>HIV/ AIDS Diagnostic Tag Status</td>
<td>Most recent field value and date assigned.</td>
<td>iCare field [HIV/ AIDS Diagnostic Tag Status] + [Date Assigned]</td>
</tr>
<tr>
<td>HIV Clinical Classification</td>
<td>Field value and date. The HIV/AIDS related clinical</td>
<td>HMS, field [Clinical Classification] + [Clinical Classification Date]</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
<td>How Data Obtained From RPMS</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Diagnosis Comments</td>
<td>Field value and date. Entered by the HMS user</td>
<td>HMS, field [Diagnosis Comment]</td>
</tr>
<tr>
<td>Initial HIV diagnosis</td>
<td>Date assigned by HMS user; generally the first recorded date of either a positive HIV test or an HIV diagnosis</td>
<td>HMS, field [Date of Initial HIV Dx]</td>
</tr>
<tr>
<td></td>
<td>If no field value, use logic provided for field default value. Add [**] at the end of the date value to indicate the value is not in the Register. Otherwise, no value.</td>
<td>If no field value, use logic provided for field default value. Add [**] at the end of the date value to indicate the value is not in the Register. Otherwise, no value.</td>
</tr>
<tr>
<td>Initial AIDS diagnosis</td>
<td>Date assigned by HMS user; the first recorded date of an AIDS diagnosis</td>
<td>HMS, field [Date of Initial AIDS Dx]</td>
</tr>
<tr>
<td></td>
<td>If no field value, use logic provided for field default value. Add [**] at the end of the date value to indicate the value is not in the Register. Otherwise, no value.</td>
<td>If no field value, use logic provided for field default value. Add [**] at the end of the date value to indicate the value is not in the Register. Otherwise, no value.</td>
</tr>
<tr>
<td>Opportunistic infections / AIDS Defining Illnesses</td>
<td>A list of any incidence of Opportunistic infections (OI) or AIDS Defining Illnesses (ADI) recorded on the patient's Problem List.</td>
<td>The PCC Problem List file is scanned for any diagnoses contained in the DX.1 and DX.8 diagnosis definitions. If found, a list of OI or ADI will be displayed; [Onset date] + [Entry Date] + [ICD9] + [ICD Narrative] + [Provider Narrative] + [Status of Problem]. If the Problem List entry has no onset date, display the Entry date. If the Problem List has an onset date and an entry date that are different, display both dates. Display list in reverse order, most recent first.</td>
</tr>
<tr>
<td>State Notification(s)</td>
<td>Status and date the state of residence was notified of HIV/AIDS diagnosis</td>
<td>HMS, field [State Reporting Category] + [State Reporting Status] + [State Reporting Date], if any</td>
</tr>
<tr>
<td>Partner Notification</td>
<td>Status whether the patient’s partner was notified</td>
<td>HMS, field [Partner Notification Status] + [Date of Assessment]</td>
</tr>
<tr>
<td>Last 6 CD4</td>
<td>The six most recent CD4 lab tests and results, if available</td>
<td>Look for the 6 most recent CD4 lab tests not on the same day defined in the T.1 (CD4 Absolute) and T.2 (CD4 All Tests) definitions. For each visit date with any CD4 test, if there is no test that meets the CD4 Absolute definition, then use the CD4 All Tests definition. Only results for CD4 Absolute tests should be displayed. Only display one test for any date; if there are 2 CD4 Absolute tests documented on the same day, display the test with a result. If found, the results (for CD4 Absolute only) and respective dates will be displayed, most recent value first.</td>
</tr>
<tr>
<td>Last 6 HIV/RNA Viral Load</td>
<td>The six most recent HIV/RNA Viral Load lab test results</td>
<td>Look for the 6 most recent lab tests not on the same day contained in the T.26 (HIV Viral Load Tests) definitions. Only display one test for any date; if there are 2 tests documented on the same day, display the test with a result. Once found, the results and respective dates will be displayed, most recent value first.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
<td>How Data Obtained From RPMS</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Lipid Profile</td>
<td>The last Lipid Profile Results</td>
<td>Look for the last panel contained in the T.30 (Lipid Profile). Once found, display all tests contained in the panel, if any, for the most recent date. If none found, then the refusals file is scanned for a patient refusal of a Lipid Profile. If a refusal is documented, indicated date and [refusal type] (e.g., REF, NMI) in result label. NOTE: Panels will have multiple line values. Display ALL of the related test data in the panel.</td>
</tr>
<tr>
<td>RPR</td>
<td>The last RPR result</td>
<td>Look for the last test contained in the T.22 (RPR) definitions. Once found, the date and results are displayed. Only display one test for any date; if there are 2 tests documented on the same day, display the test with a result. If none found, then the refusals file is scanned for a patient refusal of an RPR. If a refusal is documented, indicate date and [refusal type] (e.g., REF, NMI) in Result label.</td>
</tr>
<tr>
<td>PAP Smear</td>
<td>The last Pap Smear result</td>
<td>Look for the last test or procedure contained in the T.20 (Pap Smear) definitions. Once found, the date and results are displayed. Only display one test for any date; if there are 2 tests documented on the same day, display the test with a result. If none found, then the refusals file is scanned for a patient refusal of a Pap Smear. If a refusal is documented, indicate date and [refusal type] (e.g., REF, NMI) in Result label. If patient is Male, display “Not Applicable”</td>
</tr>
<tr>
<td>Chlamydia</td>
<td>The last Chlamydia test result</td>
<td>Look for the last test contained in the T.3 (Chlamydia Test) definitions. Once found, the date and results are displayed. Only display one test for any date; if there are 2 tests documented on the same day, display the test with a result. If none found, then the refusals file is scanned for a patient refusal of a Chlamydia Test. If a refusal is documented, indicate date and [refusal type] (e.g., REF, NMI) in Result label.</td>
</tr>
<tr>
<td>Gonorrhea</td>
<td>The last Gonorrhea test result</td>
<td>Look for the last test contained in the T.10 (Gonorrhea Test) definitions. Once found, the date and results are displayed. Only display one test for any date; if there are 2 tests documented on the same day, display the test with a result. If none found, then the refusals file is scanned for a patient refusal of a Gonorrhea Test. If a refusal is documented, indicate date and [refusal type] (e.g., REF, NMI) in Result label.</td>
</tr>
<tr>
<td>Hepatitis Panel</td>
<td>The last Hepatitis Panel test results. Depending on the site-specific definition, all or some of</td>
<td>Look for the last panel contained in the T.29 (Hepatitis Panel) definitions. Once found, the dates and results for each element of the panel are displayed. If none found, then the refusals file is scanned for a patient refusal of a Hepatitis Panel. If a refusal is documented, indicate date and [refusal type] (e.g., REF, NMI) in Result label.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
<td>How Data Obtained From RPMS</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hep A</td>
<td>The most recent Hep A tests not included in a panel.</td>
<td>Display ALL of the related test data in the panel.</td>
</tr>
<tr>
<td>Hep B</td>
<td>The most recent Hep B test not included in a panel.</td>
<td>Look for the last test contained in the T.31 (Hepatitis A) definitions. If there was a documented Hepatitis Panel (see above) and the Hep B test date is not later (more recent) than the Panel date, do not display. If found, the date and result are displayed respectively. If more than one test on the same day meets the Hep B definition, display ALL test names and results. If none found, then the refusals file is scanned for a patient refusal of Hep B. If a refusal is documented, indicate date and [refusal type] (e.g., REF, NMI) in Result label.</td>
</tr>
<tr>
<td>Hep C</td>
<td>The most recent Hep C test not included in a panel.</td>
<td>Look for the last test contained in the T.27 (Hepatitis B) definitions. If there was a documented Hepatitis Panel (see above) and the Hep C test date is not later (more recent) than the Panel date, do not display. If found, the date and result are displayed respectively. If more than one test on the same day meets the Hep C definition, display ALL test names and results. If none found, then the refusals file is scanned for a patient refusal of Hep C. If a refusal is documented, indicate date and [refusal type] (e.g., REF, NMI) in Result label.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
<td>How Data Obtained From RPMS</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CMV</td>
<td>The last Cytomegalo virus test</td>
<td>Look for the last test contained in the T.6 (CMV test) definitions. If found, the date and results are displayed. Only display one test for any date; if there are 2 tests documented on the same day, display the test with a result. If none found, then the refusals file is scanned for a patient refusal of a CMV test. If a refusal is documented, indicate date and [refusal type] (e.g., REF, NMI) in Result label.</td>
</tr>
<tr>
<td>Toxoplasmosis</td>
<td>The last Toxoplasmosis test</td>
<td>Look for the last test contained in the T.28 (Toxoplasmosis) definitions. If found, the date and results are displayed. Only display one test for any date; if there are 2 tests documented on the same day, display the test with a result. If none found, then the refusals file is scanned for a patient refusal of a Toxoplasmosis test. If a refusal is documented, indicate date and [refusal type] (e.g., REF, NMI) in Result label.</td>
</tr>
<tr>
<td>Cocci test</td>
<td>The last Coccidiomycosis test</td>
<td>Look for the last test contained in the T.7 (Cocci Antibody Screen) definitions. Once found, the date and results are displayed. Only display one test for any date; if there are 2 tests documented on the same day, display the test with a result. If none found, then the refusals file is scanned for a patient refusal of a Cocci test. If a refusal is documented, indicate date and [refusal type] (e.g., REF, NMI) in Result label.</td>
</tr>
<tr>
<td>PPD Skin Test</td>
<td>The date of the last PPD applied and read</td>
<td>Look for the last test contained in the T.21 (PPD (Tuberculosis Test)) definitions. Once found, the date and results are displayed. Only display one test for any date; if there are 2 tests documented on the same day, display the test with a result. If none are found, then the PCC V POV are scanned for a diagnosis of V74.1. If one is found, the date is displayed along with a phrase “(by Diagnosis)”. If none found, then the refusals file is scanned for a patient refusal of a PPD test. If a refusal is documented, indicate date and [refusal type] (e.g., REF, NMI) in Result label.</td>
</tr>
<tr>
<td>HIV Phenotype</td>
<td>HIV Phenotype Testing</td>
<td>Look for the last 5 tests contained in the T.16 (HIV Phenotype) definitions. If found, display [Yes] + [Date] for each test. Do not display the results.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
<td>How Data Obtained From RPMS</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HIV Genotype</td>
<td>HIV Genotype Testing</td>
<td>Look for the last 5 tests contained in the T.15 (HIV Genotype) definitions. If found, display [Yes] + [Date] for each test. Do not display the results.</td>
</tr>
<tr>
<td>Pneumococcal Immunization</td>
<td>The date of the last Pneumococcal Immunation given</td>
<td>Look for last immunization defined in IZ.6 (Pneumococcal) definitions. If found, the date is displayed. If none is found, the refusals file is checked to see if a refusal of a pneumococcal immunization is documented. If so, indicate date and [refusal type] (e.g., REF, NMI) in Result label.</td>
</tr>
<tr>
<td>Influenza Vaccine</td>
<td>The date of the last Influenza Vaccine given</td>
<td>Look for the last immunization contained in the IZ.5 (Influenza IZ) definitions. If found, the date is displayed. If none is found, the refusals file is checked to see if a refusal of an influenza immunization is documented. If so, indicate date and [refusal type] (e.g., REF, NMI) in Result label.</td>
</tr>
<tr>
<td>Hepatitis A Diagnosis and/or Immunizations</td>
<td>The dates of any Hep A diagnosis and/or the last 2 Hepatitis A Immunizations given</td>
<td>Look for most recent documented Hep A diagnosis (DX.5) in POV or Active Problem List and display, if any. Display the DX label even if no date is available. Look for the last 2 documented immunizations not on the same date contained in the IZ.3 (Hep A) definitions. The dates of the last 2 immunizations are displayed, most recent first. If only 1 immunization is documented, that date will be displayed. If none are found, the refusals file is checked to see if a refusal of a Hepatitis A Vaccine is documented. If so, indicate date and [refusal type] (e.g., REF, NMI) in Result label.</td>
</tr>
<tr>
<td>Hepatitis B Diagnosis and/or Immunizations</td>
<td>The dates of any Hep B diagnosis and/or the last 3 Hepatitis B Vaccines given</td>
<td>Look for most recent documented Hep B diagnosis (DX.15) in POV or Active Problem List and display, if any. Display the DX label even if no date is available. Look for the last 3 documented immunizations not on the same date contained in the IZ.4 (Hep B) definitions. The dates of the last 3 immunizations are displayed, most recent first. If only 1 or 2 immunizations are documented, then those dates will be displayed. If none are found, the refusals file is checked to see if a refusal of a Hepatitis B Vaccine is documented. If so, indicate date and [refusal type] (e.g., REF, NMI) in Result label.</td>
</tr>
<tr>
<td>Tetanus Vaccine</td>
<td>The date of the last Tetanus vaccine given</td>
<td>Look for the last immunization contained in IZ.7 (Tetanus) definitions. If found, the date is displayed. If none is found, the refusals file is checked to see if a refusal of a tetanus immunization is documented. If so, indicate date and [refusal type] (e.g., REF, NMI) in Result label.</td>
</tr>
<tr>
<td>ARV Appropriate</td>
<td>Display for the last 6 months any</td>
<td>HMS: If any value in [ARV Appropriate] field,</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
<td>How Data Obtained From RPMS</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ARV Adherence</td>
<td>Display for the last 6 months any of the 2 fields associated with whether ARV is appropriate for the patient.</td>
<td>How Data Obtained From RPMS: If any value in [ARV Adherent] field, display [Date] + [ARV Adherent] + [ARV Adherent Comment] – because these are visit-related fields, there can be multiple values – display any values for last 6 months, with most recent at top.</td>
</tr>
<tr>
<td>Current ARV Medications</td>
<td>A list of ARV medications filled in past 6 months</td>
<td>how data obtained from rpms: look for any (non discontinued) prescriptions filled in the prior 6 months for medications defined in M.02 (NNRTIs), M.03 (NRTIs), M.05 (PIs) and M.09 (Els); M.10 (Ilis); M.11 (NRTI/NNRTIs); M.12 (NRTI Combo) and M.13 (Pl Booster). The names of each individual medication, date last filled, SIG and quantity will be displayed. List by date filled, with most current at top. If none are found, the refusal file is scanned for any refusal of any ARV medications. If found, indicate date and [refusal type] (e.g., REF, NMI) in Result label.</td>
</tr>
<tr>
<td>MAC and PCP Prophylaxis</td>
<td>A list of medications prescribed in the past 6 months for the prevention of MAC (Disseminated Mycobacterium Avium Complex) or PCP (Pneumocystis Carinii Pneumonia)</td>
<td>how data obtained from rpms: look for any prescriptions filled in the prior 6 months for medications defined in M.01 (MAC Proph) or M.04 (PCP Prophylaxis) definitions. The names of each individual medication and the date last filled, SIG and quantity will be displayed. If none are found, the refusal file is scanned for any refusal of MAC pr PCP Prophylaxis medications. If found, indicate date and [refusal type] (e.g., REF, NMI) in Result label.</td>
</tr>
<tr>
<td>Depression Screening</td>
<td>Date the patient was most recently screened for Depression in the past year.</td>
<td>How Data Obtained From RPMS: Look for the last depression screening in the past year contained in the S.2 (Depression Screen) definitions. If found, display date, code type and identifying code (e.g. POV, Patient Education code, etc.)</td>
</tr>
<tr>
<td>IPV/DV Screening</td>
<td>Date the patient was most recently screened for Intimate Partner/ Domestic Violence in the past year.</td>
<td>How Data Obtained From RPMS: Look for the most recent IPV/DV screening in the past year contained in the S.6 (IPV/DV Screen) definitions. If found, display date, code type and identifying code (e.g. POV, Patient Education code, etc.) If patient is Male, display “Not Applicable”</td>
</tr>
<tr>
<td>Alcohol Screening</td>
<td>Date the patient was most recently screened for alcohol use in the past year.</td>
<td>How Data Obtained From RPMS: Look for the last alcohol screening in the past year contained in the S.1 (Alcohol Screen) definitions. If found, display date, code type and identifying code (e.g. POV, Patient Education code, etc.)</td>
</tr>
<tr>
<td>Dilated eye exam</td>
<td>The date of the most recent Dilated eye exam in the past year.</td>
<td>How Data Obtained From RPMS: Look for the most recent dilated eye exam performed in the past year, defined as P.03 (Eye Exam) in definitions table. If found, display date. If none is found, the refusal file is checked to see if a refusal of the dilated eye was performed.</td>
</tr>
</tbody>
</table>
### Item

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>How Data Obtained From RPMS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dental exam</td>
<td>Date of most recent documented dental exam.</td>
<td>If so, indicate date and [refusal type] (e.g., REF, NMI) in Result label. Look for the most recent dental exam performed in the past year, defined as P.02 (Dental Exam) in definitions table. If found, display date. If none is found, the refusal file is checked to see if a refusal of the dilated eye exam is documented. If so, indicate date and [refusal type] (e.g., REF, NMI) in Result label.</td>
</tr>
<tr>
<td>Mammogram:</td>
<td>Date of most recent documented Mammogram in the past year.</td>
<td>Look for the most recent mammogram performed in the past year, defined as P.05 (Mammogram) in definitions table. If none is found, the refusal file is checked to see if a refusal of the dilated eye exam is documented. If so, indicate date and [refusal type] (e.g., REF, NMI) in Result label.</td>
</tr>
<tr>
<td>HIV-related education</td>
<td>List any patient education provided in the past year that is related to HIV</td>
<td>If patient is Male, display “Not Applicable”</td>
</tr>
<tr>
<td>HIV-related Reminders</td>
<td>List any reminders here in due date order, beginning with overdue</td>
<td>Look at all HMS related reminders and display all in order of most overdue first. Display [Name of Reminder] + [Date Last Done] + [Date Due]. Dates are displayed in mm/dd/yyyy format. If there is no 'Date last done' leave a blank space. NOTE: For PPD reminder, if patient has a history of Tuberculosis diagnosis (DX14) or history of positive PPD test (T.21), display [Name of Reminder (PPD)] + [the phrase &quot;Diagnosis&quot;] + [Date (if known)]. Positive PPD test results are defined in the reminder logic.</td>
</tr>
</tbody>
</table>

### 20.2 Flow Sheet Logic

Look for the 6 most recent HIV Viral Load lab tests WITH RESULTS contained in the T.26 (HIV Viral Load Tests) definitions.

Look for the 6 most recent CD4 lab tests WITH RESULTS defined in the T.1 (CD4 Absolute Tests) and T.2 (CD4 Tests) definitions.

Display the results in columns associated with the date of the lab test. If both tests are within 7 days of each other, they can counted in the same column. Some columns might only have one test. Only 6 columns can be displayed, so not all of the “found” lab values can be used.
List all ARV medications for this patient active on each of the column dates. ARV medications are defined in M.02 (NNRTIs), M.03 (NRTIs), M.05 (PIs) and M.09 (EIs); M.10 (IIs); M.11 (NRTI/NNRTI); M.12 (NRTI Combo); M.13 (PI Booster)

“Active” medication is defined as:

- Has not been discontinued as of column date (NOTE: a single prescription can be “active” for one date and discontinued by the second date)
- \([\text{Date filled}] + [\text{Days}]\) equals or is greater than column date

20.3 Example

```
******* CONFIDENTIAL PATIENT INFORMATION -- 03/13/2008 1:37 PM [CG] *******
******* HMS PATIENT CARE SUPPLEMENT ******

Report Date: 03/13/2008
Page: 1

Patient's Name: MOUSE, MICKEY HRN: 111111
Sex: M DOB: 12/06/1969 Age: 38Y
Designated Primary Care Provider: CPROVIDER
HIV Provider: APROVIDER
HIV Case Manager: BPROVIDER
Last Height: 70 11/10/2005 Last Weight: 212 07/20/2007
BMI: 30.4

Register Diagnosis: AIDS 03/06/2008
Register Status: Active 03/01/2008
HIV/ AIDS Diagnostic Tag Status: Accepted 03/01/2008
HIV Clinical Classification (A1-C3): C1 03/13/2008
Diagnosis Comments:
Initial HIV Diagnosis: 11/16/2005
Initial AIDS Diagnosis: 04/17/2006

Opportunistic infections and AIDS Defining Illnesses
Onset Entry ICD Code Narrative Problem
06/23/2006 112.0 CANDIDIASIS Candidiasis Inactive
04/17/2006 05/01/2006 117.5 CRYPTO Cryptococcal Meningitis Inactive
04/07/2006 486. PNEUM Pneumonia Active

State Notification(s):
Partner Notification:

RECENT LABORATORY RESULTS:
Last 6 CD4:
Last 6 HIV/RNA Viral Load:
Date: 04/08/2006 Result: >100000
```
Lipid Profile  Date: 01/01/2006
RPR:          Date: 04/07/2006 Result: NR
PAP:          Not Applicable
Chlamydia:    Not Applicable
Gonorrhea:    Not Applicable
Hepatitis:
  Hepatitis Panel:   Date: 11/10/2005
  HEPATITIS A,B,C PANEL
    HBsAg HEP B SURFACE ANTIGEN Result:
    HbcAb HEP B CORE ANTIBODY Result:
    HCV-Ab HEPATITIS C ANTIBODY Result:
    HEPATITIS A ANTIBODY TOTAL Result:
    HAVAb IgG Result:
    Hep A:  Not Applicable
    Hep B:  Not Applicable
    Hep C:  Not Applicable
CMV:          Date: 04/08/2006 Result: 2.70
Toxoplasmosis: Date: 04/08/2006 Result: 0.05
Cocci:        Not Applicable
PPD:          Date: 02/22/2008 Result: POSITIVE 8
HIV Phenotype: Not Applicable
HIV Genotype:  Not Applicable
LAST DOCUMENTED IMMUNIZATIONS:

Pneumococcal: Date: 09/05/2006
Influenza:     Date: 11/16/2005
Hepatitis A (last 2): Dx Date:
Hepatitis B (last 3): Dx Date:
Tetanus:       Date: 11/16/2005

RECENT MEDICATIONS (past 6 months):

ARV Status:
  ARV Appropriate:
  ARV Adherence:

Current ARV Medications (past 6 months):

Prophylaxis Medications for MAC and/or PCP (past 6 months):

IN THE PAST 12 MONTHS:
Depression Screening: Date: 08/14/2007 311.
IPV/DV Screening: Date:
Alcohol Screening: Date:
Dilated eye exam: Date:
Dental exam: Date: 08/03/2007

Last HIV-related education given (past 12 months):

Calculating HIV-RELATED REMINDERS - Please wait.

HIV-RELATED REMINDERS:

Reminder       Last       Due
Lipid Profile  01/01/2006  01/01/2007)
Figure 20-1: Example of HMS PATIENT CARE SUPPLEMENT
21.0 Appendix I: Keyboard Navigation

You can use various combinations of keys to navigate with the iCare application. In addition, there are short-cut keys for various functions.

21.1 General Instructions

<table>
<thead>
<tr>
<th>Desired Action</th>
<th>Use These Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>To move to different areas on a screen</td>
<td>Tab and Shift-Tab</td>
</tr>
<tr>
<td>To activate drop-down lists ox and view the text</td>
<td>Alt-Up or Alt-Down</td>
</tr>
<tr>
<td>To move one row/record at a time</td>
<td>Up or Down arrows</td>
</tr>
<tr>
<td>To move a page worth</td>
<td>Page Up or Page Down</td>
</tr>
<tr>
<td>To make a selection of a highlighted choice from a</td>
<td>Tab</td>
</tr>
<tr>
<td>drop-down box</td>
<td></td>
</tr>
<tr>
<td>To select or de-select a radio button or check box</td>
<td>Space Bar</td>
</tr>
</tbody>
</table>

21.2 iCare Main Window

Use the following keys while in the iCare Main window.

21.2.1 Split Window

<table>
<thead>
<tr>
<th>Desired Action</th>
<th>Use These Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch between Panel List tab and Flag List tab</td>
<td>Ctrl-Tab</td>
</tr>
<tr>
<td>(Show drop-down box is active)</td>
<td></td>
</tr>
<tr>
<td>To see list in box</td>
<td>Alt-up or Alt-down arrow keys</td>
</tr>
<tr>
<td>To select highlighted choice</td>
<td>Tab</td>
</tr>
<tr>
<td>Shift-Tab in active window</td>
<td>Up and down arrows to move from row to row (e.g., panel name rows, or flag rows)</td>
</tr>
<tr>
<td>After the first arrow movement, to move Up or down rows</td>
<td>Tab key to go a row down</td>
</tr>
<tr>
<td></td>
<td>Shift-Tab to go a row up</td>
</tr>
</tbody>
</table>

21.2.2 Panel View

<table>
<thead>
<tr>
<th>Desired Action</th>
<th>Use These Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move the focus to the first row</td>
<td>Tab</td>
</tr>
<tr>
<td>Move from row to row</td>
<td>Up and Down arrows</td>
</tr>
<tr>
<td>After first arrow movement</td>
<td>Tab moves you a row down and Shift-Tab moves you a row up</td>
</tr>
<tr>
<td>To change the tab focus when a tab that has the focus</td>
<td>Left or Right arrow keys (e.g., Panel List, Flag, GPRA, Aggregate)</td>
</tr>
<tr>
<td>To open a patient record</td>
<td>Enter</td>
</tr>
</tbody>
</table>
### 21.2.3 Flag View

<table>
<thead>
<tr>
<th>Desired Action</th>
<th>Use These Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the focus from the tab to the Show box and then to the first flag row</td>
<td>Tab</td>
</tr>
<tr>
<td>Move from row to row</td>
<td>Up and Down arrows</td>
</tr>
<tr>
<td>After first arrow movement</td>
<td>Tab moves you a row down and Shift-Tab moves you a row up</td>
</tr>
<tr>
<td>To change the tab focus when a tab has the focus</td>
<td>Left or Right arrow keys (e.g., Panel List, Flag, GPRA, Aggregate)</td>
</tr>
<tr>
<td>To open a patient record</td>
<td>Enter</td>
</tr>
</tbody>
</table>

#### 21.2.4 Patient Record View

The Tab key moves the focus to the first row in Providers, then Last drop down box under Recent Visits. Next the focus moves to the first row in Recent Visits. Continuing to tab moves the user through each group.

Once the focus moves to the first row in a grouping:

- The up and down arrow keys move the focus between rows.
- Shift-Tab reverses the order of the focus.

### 21.2.5 Panel Definition Dialog Box

Use the following on the main control areas on the Definitions tab.

Initial focus is in the Panel Name field.

<table>
<thead>
<tr>
<th>Desired Action</th>
<th>Use These Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move the focus between the controls on the Definition tab (e.g., Definition tab, Panel Name, Panel Description, Population Options, Ok, and Cancel)</td>
<td>Tab and Shift-Tab</td>
</tr>
</tbody>
</table>

Once an option other than No search logic is selected, Additional Filters is an additional control that is displayed.

To select a Population Option, move the focus to the first option (No search logic), then use the up and down arrows to select other options.

<table>
<thead>
<tr>
<th>Desired Action</th>
<th>Use These Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>To move to the different fields/options if the options has other selection</td>
<td>Tab and Shift-Tab (e.g., Patients Assigned radio button is active, tab to the Provider field)</td>
</tr>
<tr>
<td>To activate drop-down boxes</td>
<td>Alt-up or Alt-down arrows</td>
</tr>
<tr>
<td>To make a selection</td>
<td>Tab</td>
</tr>
<tr>
<td>To select/de-select the check boxes</td>
<td>Space bar</td>
</tr>
<tr>
<td>To move among the grouped check boxes</td>
<td>Up and Down arrow keys</td>
</tr>
</tbody>
</table>
The order of the tab is: Add list, Add button, Remove button, Remove List, OK, and Cancel on the Add/Remove dialog boxes (Community, Diagnosis).

To move up and down on the Add/Remove lists, use up or down arrow, Page Up and Page Down.

21.3 Short-Cut Keys

When a menu has a letter underlined, use that letter and Alt to activate the function (e.g., for File, use Alt-F to view the File menu).

### 21.3.1 Main View

<table>
<thead>
<tr>
<th>Desired Action</th>
<th>Use These Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Panel</td>
<td>Ctrl-N</td>
</tr>
<tr>
<td>Open Panel</td>
<td>Ctrl-O</td>
</tr>
<tr>
<td>Delete Panel</td>
<td>Delete</td>
</tr>
<tr>
<td>Refresh</td>
<td>F5</td>
</tr>
<tr>
<td>Quick Patient Search</td>
<td>F8</td>
</tr>
<tr>
<td>Help</td>
<td>F1</td>
</tr>
</tbody>
</table>

### 21.3.2 Panel View

<table>
<thead>
<tr>
<th>Desired Action</th>
<th>Use These Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Panel</td>
<td>Ctrl-N</td>
</tr>
<tr>
<td>Save Panel</td>
<td>Ctrl-S</td>
</tr>
<tr>
<td>Print</td>
<td>Ctrl-P</td>
</tr>
<tr>
<td>Open Patient Record</td>
<td>Ctrl-O</td>
</tr>
<tr>
<td>Remove Patient Record</td>
<td>Delete</td>
</tr>
<tr>
<td>Copy selected rows</td>
<td>Ctrl-C</td>
</tr>
<tr>
<td>Cut selected rows</td>
<td>Ctrl-X</td>
</tr>
<tr>
<td>Paste selected rows</td>
<td>Ctrl-V</td>
</tr>
<tr>
<td>Select all rows</td>
<td>Ctrl-A</td>
</tr>
<tr>
<td>Quick Patient Search</td>
<td>F8</td>
</tr>
<tr>
<td>Search This Screen</td>
<td>Ctrl-F</td>
</tr>
<tr>
<td>Excel Export</td>
<td>Ctrl-E</td>
</tr>
<tr>
<td>Copy Rows to Windows Window</td>
<td>Ctrl-Shift-C</td>
</tr>
</tbody>
</table>
### 21.3.3 Patient Record

<table>
<thead>
<tr>
<th>Desired Action</th>
<th>Use These Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Panel</td>
<td>Ctrl-N</td>
</tr>
<tr>
<td>Quick Patient Search</td>
<td>F8</td>
</tr>
<tr>
<td>Depending upon the selected tab, other keys will be available.</td>
<td></td>
</tr>
<tr>
<td>Print</td>
<td>Ctrl-P</td>
</tr>
<tr>
<td>Hide Flags</td>
<td>F3</td>
</tr>
<tr>
<td>Show Flags</td>
<td>F4</td>
</tr>
<tr>
<td>Refresh Flags</td>
<td>F5</td>
</tr>
<tr>
<td>Search This Screen</td>
<td>Ctrl-F</td>
</tr>
<tr>
<td>Excel Export</td>
<td>Ctrl-E</td>
</tr>
<tr>
<td>Copy Rows to Windows Window</td>
<td>Ctrl-Shift-C</td>
</tr>
</tbody>
</table>


22.0 Appendix J: RPMS Rules of Behavior

The Resource and Patient Management (RPMS) system is a United States Department of Health and Human Services (HHS), Indian Health Service (IHS) information system that is FOR OFFICIAL USE ONLY. The RPMS system is subject to monitoring; therefore, no expectation of privacy shall be assumed. Individuals found performing unauthorized activities are subject to disciplinary action including criminal prosecution.

All users (Contractors and IHS Employees) of RPMS will be provided a copy of the Rules of Behavior (RoB) and must acknowledge that they have received and read them prior to being granted access to a RPMS system, in accordance IHS policy.

• For a listing of general Rules of Behavior for all users, see the most recent edition of *IHS General User Security Handbook* (SOP 06-11a).

• For a listing of system administrators/managers rules, see the most recent edition of the *IHS Technical and Managerial Handbook* (SOP 06-11b).

Both documents are available at this IHS web site, http://security.ihs.gov/

The Rules of Behavior listed in the following Sections are specific to RPMS.
22.1 All RPMS Users

In addition to these rules, each application may include additional RoBs that may be defined within the documentation of that application (e.g., PCC, Dental, Pharmacy).

22.1.1 Access

RPMS users shall

- Only use data for which you have been granted authorization.
- Only give information to personnel who have access authority and have a need to know.
- Always verify a caller’s identification and job purpose with your supervisor or the entity provided as employer before providing any type of information system access, sensitive information, or non-public agency information.
- Be aware that personal use of information resources is authorized on a limited basis within the provisions Indian Health Manual Part 8, “Information Resources Management,” Chapter 6, “Limited Personal Use of Information Technology Resources.”

RPMS users shall not

- Retrieve information for someone who does not have authority to access the information.
- Access, research, or change any user account, file, directory, table, or record not required to perform your OFFICIAL duties.
- Store sensitive files on a PC hard drive, or portable devices or media, if access to the PC or files cannot be physically or technically limited.
- Exceed their authorized access limits in RPMS by changing information or searching databases beyond the responsibilities of their job or by divulging information to anyone not authorized to know that information.
22.1.2 Information Accessibility

RPMS shall restrict access to information based on the type and identity of the user. However, regardless of the type of user, access shall be restricted to the minimum level necessary to perform the job.

RPMS users shall

- Access only those documents they created and those other documents to which they have a valid need-to-know and to which they have specifically granted access through an RPMS application based on their menus (job roles), keys, and FileMan access codes. Some users may be afforded additional privileges based on the function they perform such as system administrator or application administrator.

- Acquire a written preauthorization in accordance with IHS polices and procedures prior to interconnection to or transferring data from RPMS.

22.1.3 Accountability

RPMS users shall

- Behave in an ethical, technically proficient, informed, and trustworthy manner.
- Logout of the system whenever they leave the vicinity of their PC.
- Be alert to threats and vulnerabilities in the security of the system.
- Report all security incidents to their local Information System Security Officer (ISSO)
- Differentiate tasks and functions to ensure that no one person has sole access to or control over important resources.
- Protect all sensitive data entrusted to them as part of their government employment.
- Shall abide by all Department and Agency policies and procedures and guidelines related to ethics, conduct, behavior, and IT information processes.

22.1.4 Confidentiality

RPMS users shall

- Be aware of the sensitivity of electronic and hardcopy information, and protect it accordingly.
- Store hardcopy reports/storage media containing confidential information in a locked room or cabinet.
- Erase sensitive data on storage media, prior to reusing or disposing of the media.
• Protect all RPMS terminals from public viewing at all times.
• Abide by all HIPAA regulations to ensure patient confidentiality.

RPMS users shall not
• Allow confidential information to remain on the PC screen when someone who is not authorized to that data is in the vicinity.
• Store sensitive files on a portable device or media without encrypting.

22.1.5 Integrity
RPMS users shall
• Protect your system against viruses and similar malicious programs.
• Observe all software license agreements.
• Follow industry standard procedures for maintaining and managing RPMS hardware, operating system software, application software, and/or database software and database tables.
• Comply with all copyright regulations and license agreements associated with RPMS software.

RPMS users shall not
• Violate Federal copyright laws.
• Install or use unauthorized software within the system libraries or folders
• Use freeware, shareware, or public domain software on/with the system without your manager’s written permission and without scanning it for viruses first.

22.1.6 System Logon
RPMS users shall
• Have a unique User Identification/Account name and password.
• Be granted access based on authenticating the account name and password entered.
• Be locked out of an account after 5 successive failed login attempts within a specified time period (e.g., one hour).
22.1.7 Passwords

RPMS users shall

- Change passwords a minimum of every 90 days.
- Create passwords with a minimum of eight characters.
- If the system allows, use a combination of alpha, numeric characters for passwords, with at least one uppercase letter, one lower case letter, and one number. It is recommended, if possible, that a special character also be used in the password.
- Change vendor-supplied passwords immediately.
- Protect passwords by committing them to memory or store them in a safe place (do not store passwords in login scripts, or batch files.
- Change password immediately if password has been seen, guessed, or otherwise compromised; and report the compromise or suspected compromise to your ISSO.
- Keep user identifications (ID) and passwords confidential.

RPMS users shall not

- Use common words found in any dictionary as a password.
- Use obvious readable passwords or passwords that incorporate personal data elements (e.g., user’s name, date of birth, address, telephone number, or social security number; names of children or spouses; favorite band, sports team, or automobile; or other personal attributes).
- Share passwords/IDs with anyone or accept the use of another’s password/ID, even if offered.
- Reuse passwords. A new password must contain no more than five characters per 8 characters from the previous password.
- Post passwords.
- Keep a password list in an obvious place, such as under keyboards, in desk drawers, or in any other location where it might be disclosed.
- Give a password out over the phone.
22.1.8 Backups

RPMS users shall

- Plan for contingencies such as physical disasters, loss of processing, and disclosure of information by preparing alternate work strategies and system recovery mechanisms.
- Make backups of systems and files on a regular, defined basis.
- If possible, store backups away from the system in a secure environment.

22.1.9 Reporting

RPMS users shall

- Contact and inform your ISSO that you have identified an IT security incident and you will begin the reporting process by providing an IT Incident Reporting Form regarding this incident.
- Report security incidents as detailed in the *IHS Incident Handling Guide* (SOP 05-03).

RPMS users shall not

- Assume that someone else has already reported an incident. The risk of an incident going unreported far outweighs the possibility that an incident gets reported more than once.

22.1.10 Session Timeouts

RPMS system implements system-based timeouts that back users out of a prompt after no more than 5 minutes of inactivity.

RPMS users shall

- Utilize a screen saver with password protection set to suspend operations at no greater than 10-minutes of inactivity. This will prevent inappropriate access and viewing of any material displayed on your screen after some period of inactivity.

22.1.11 Hardware

RPMS users shall

- Avoid placing system equipment near obvious environmental hazards (e.g., water pipes).
- Keep an inventory of all system equipment.
- Keep records of maintenance/repairs performed on system equipment.
RPMS users shall not
- Eat or drink near system equipment

22.1.12 Awareness

RPMS users shall
- Participate in organization-wide security training as required.
- Read and adhere to security information pertaining to system hardware and software.
- Take the annual information security awareness.
- Read all applicable RPMS Manuals for the applications used in their jobs.

22.1.13 Remote Access

Each subscriber organization establishes its own policies for determining which employees may work at home or in other remote workplace locations. Any remote work arrangement should include policies that
- Are in writing.
- Provide authentication of the remote user through the use of ID and password or other acceptable technical means.
- Outline the work requirements and the security safeguards and procedures the employee is expected to follow.
- Ensure adequate storage of files, removal, and non-recovery of temporary files created in processing sensitive data, virus protection, intrusion detection, and provides physical security for government equipment and sensitive data.
- Establish mechanisms to back up data created and/or stored at alternate work locations.

Remote RPMS users shall
- Remotely access RPMS through a virtual private network (VPN) when ever possible. Use of direct dial in access must be justified and approved in writing and its use secured in accordance with industry best practices or government procedures.

Remote RPMS users shall not
- Disable any encryption established for network, internet, and web browser communications.
22.2 RPMS Developers

RPMS developers shall

- Always be mindful of protecting the confidentiality, availability, and integrity of RPMS when writing or revising code.
- Always follow the IHS RPMS Programming Standards and Conventions (SAC) when developing for RPMS.
- Only access information or code within the namespaces for which they have been assigned as part of their duties.
- Remember that all RPMS code is the property of the U.S. Government, not the developer.
- Shall not access live production systems without obtaining appropriate written access, shall only retain that access for the shortest period possible to accomplish the task that requires the access.
- Shall observe separation of duties policies and procedures to the fullest extent possible.
- Shall document or comment all changes to any RPMS software at the time the change or update is made. Documentation shall include the programmer’s initials, date of change and reason for the change.
- Shall use checksums or other integrity mechanism when releasing their certified applications to assure the integrity of the routines within their RPMS applications.
- Shall follow industry best standards for systems they are assigned to develop or maintain; abide by all Department and Agency policies and procedures.
- Shall document and implement security processes whenever available.

RPMS developers shall not

- Write any code that adversely impacts RPMS, such as backdoor access, “Easter eggs,” time bombs, or any other malicious code or make inappropriate comments within the code, manuals, or help frames.
- Grant any user or system administrator access to RPMS unless proper documentation is provided.
- Not release any sensitive agency or patient information.
22.3 Privileged Users

Personnel who have significant access to processes and data in RPMS, such as, system security administrators, systems administrators, and database administrators have added responsibilities to ensure the secure operation of RPMS.

Privileged RPMS users shall

- Verify that any user requesting access to any RPMS system has completed the appropriate access request forms.
- Ensure that government personnel and contractor personnel understand and comply with license requirements. End users, supervisors, and functional managers are ultimately responsible for this compliance.
- Advise the system owner on matters concerning information technology security.
- Assist the system owner in developing security plans, risk assessments, and supporting documentation for the certification and accreditation process.
- Ensure that any changes to RPMS that affect contingency and disaster recovery plans are conveyed to the person responsible for maintaining continuity of operations plans.
- Ensure that adequate physical and administrative safeguards are operational within their areas of responsibility and that access to information and data is restricted to authorized personnel on a need to know basis.
- Verify that users have received appropriate security training before allowing access to RPMS.
- Implement applicable security access procedures and mechanisms, incorporate appropriate levels of system auditing, and review audit logs.
- Document and investigate known or suspected security incidents or violations and report them to the ISSO, CISO, and systems owner.
- Protect the supervisor, superuser, or system administrator passwords.
- Avoid instances where the same individual has responsibility for several functions (i.e., transaction entry and transaction approval).
- Watch for unscheduled, unusual, and unauthorized programs.
- Help train system users on the appropriate use and security of the system.
- Establish protective controls to ensure the accountability, integrity, confidentiality, and availability of the system.
- Replace passwords when a compromise is suspected. Delete user accounts as quickly as possible from the time that the user is no longer authorized system. Passwords forgotten by their owner should be replaced, not reissued.
• Terminate user accounts when a user transfers or has been terminated. If the user has authority to grant authorizations to others, review these other authorizations. Retrieve any devices used to gain access to the system or equipment. Cancel logon IDs and passwords, and delete or reassign related active and back up files.

• Use a suspend program to prevent an unauthorized user from logging on with the current user's ID if the system is left on and unattended.

• Verify the identity of the user when resetting passwords. This can be done either in person or having the user answer a question that can be compared to one in the administrator’s database.

• Shall follow industry best standards for systems they are assigned to; abide by all Department and Agency policies and procedures.

Privileged RPMS users shall not

• Access any files, records, systems, etc., that are not explicitly needed to perform their duties

• Grant any user or system administrator access to RPMS unless proper documentation is provided.

• Not release any sensitive agency or patient information.
23.0 Glossary

There are many terms used in the User Manual that might be new to you or might have slightly different meanings in other program environments. To clarify, a glossary of terms commonly used in this User Manual is included.

ACM
Namespace for Case Management System

BDM
Namespace for Diabetes Management System

BKM
Namespace for HIV Management System

Case File Manager(s)
The system owner(s) of an individual CM application. The Case File Manager(s) have full security access to the application to perform various setup functions and to assign access roles to other users.

Case Management
Most often synonymous with "disease" management, where groups of patients with like disease conditions are evaluated and managed to a specific set of clinical guidelines, e.g. diabetes management. In the context of iCare, case management also refers to the evaluation and treatment of a patient within the context of ALL factors related to the patient’s health, not just a single disease condition. This might include multiple disease conditions, gender or age specific factors, environmental, and/or family factors, etc.

Case Manager(s)
A term used to describe a particular type of clinical role within a clinic. Case Managers are typically, but not always, nurses who perform clinical management tasks for specified groups of patients, e.g. diabetics.

Designated Primary Care Provider (DPCP)
In RPMS, the provider name that is assigned as the primary care physician for a patient or group of patients at a specific facility. This is not a required function.
DSPM
Acronym for Designated Specialty Provider Management

Editor
Access level to an application that allows a user to read and write data, but not to perform manager-level set up functions.

Flags
Flags are critical, usually time-sensitive, information points related to a patient that might affect diagnosis or care. Flags are defined specifically for each RPMS application and might include formal clinical or administrative alerts as defined in RPMS Kernel Alerts application, and other definitions.

Patient Panel
A list of patients defined in iCare by the user.

PCC (or PCC+) form
The paper form used in most I/T/U clinics on which the provider(s) document all data from the patient’s visit. Used by data entry staff to enter patient data into RPMS PCC.

Providers
Any staff member in an I/T/U facility who provides direct healthcare to patients, e.g. general practice or specialty physicians, registered nurses, social workers, physician assistants, etc.

Within RPMS, the term “provider” has different specific meanings. See definitions for Designated Primary Care Provider (DPCP); Primary Provider; Visit Providers.

Reader
Access level to an application that allows a user to read but not write data.

Register
A software application that provides the ability to maintain a permanent list of patients and associated clinical data that is not located within other RPMS applications. Register applications are often disease-condition specific and contain specific clinical care guidelines that do not apply to the overall patient population. Examples of RPMS register management systems are Diabetes Management System and Asthma Register System.
Reminders
Health Maintenance Reminders review patient data and alert the provider to procedures that might be overdue for the patient. Reminders can be based on age and gender and include typical clinical prevention measures, such as pap smears.

RPMS
Resource and Patient Management System, a series of integrated software components that includes clinical, administrative, and financial functions.

Site Manager
The staff member at an I/T/U site who is responsible for managing all IT functions, including loading RPMS software on the site’s server. The Site Manager assigns the initial security keys of any new software to a designated user.

“Tagging”
A process to review the patient’s data and categorize (‘’tag’’) the patient with one or more clinical diagnoses, such as Known CVD or Diabetes. Tags will be used to provide more accurate reminders that are prioritized more appropriately for a patient’s multiple conditions.

Taxonomy
In RPMS, a grouping of functionally related data elements, such as ICD codes, that are created and maintained within the RPMS Taxonomy Setup application. Taxonomies will be used as definitions for diagnoses, procedures, lab tests, medications, and other clinical data types.

If you need a change or addition to an existing taxonomy, please see your CRS coordinator.

Visit Provider
In RPMS, the provider(s) who cared for a patient on a specific visit. Each patient visit must have at least a primary provider entered. Visits can also have one or more secondary providers. The primary visit provider might or might not be the same provider as the patient’s DPCP, and can change on each visit, depending on the visit type or the clinic staffing.
24.0 **Contact Information**

If you have any questions or comments regarding this distribution, please contact the OIT Help Desk (IHS).

**Phone:** (505) 248-4371 or (888) 830-7280 (toll free)

**Fax:** (505) 248-4363

**Web:** [http://www.ihs.gov/GeneralWeb/HelpCenter/Helpdesk/index.cfm](http://www.ihs.gov/GeneralWeb/HelpCenter/Helpdesk/index.cfm)

**Email:** support@ihs.gov